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just exploded the myth that all drawing programs are expensive,

hard to master, and for art school graduates only.

More than 2,600 ready-to-use clip art images make Windows Draw perfect

for business graphics, home office projects, even presentations.

Cut and paste images. Customize them. Or draw up your own ideas

with a box full of smart tools and special effects.

In no time, you'll be confidently creating great-looking logos, illustra

tions, charts, posters, memos, newsletters and more.

Helpful on-screen hints keep you drawing in the right direction.

But if you need to talk, we're here 24 hours every weekday, and most of the

weekend.

Best of all Windows Draw won't blow your budget. Along with being fun,

fast and friendly, it's affordable —just S 149.95 suggested retail. According

to InfoWorld, "...a real steal." So get your copy today. And have a blast!

MICROGRAFX

Visit your local software dealer or call us toll-free at 1 -800-34 7-3715 for the name of a store near you.

© 1991. Micrografx. Inc. All rights reserved. Micrografx and ihi: Micrografx logo are regislered trademarks and Windows Draw

is a trademark of Micrografx. Inc.
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EDITORIAL LICENSE
Clifton Karnes

The response to

our January 1992

survey was

overwhelming—

nearly twice

as large as we've

ever received.

y favorite day of the

year at COMPUTE is

the one when all of our

readership surveys

are tallied and I can see the fi

nal results. I'm fascinated by

our readers and their prefer

ences. As I turn each page, I

feel like I'm uncovering part of

an exciting mystery. I know

that in the survey's pages, I'll

discover how your tastes

have changed over the last

year, and if our magazine is

meeting your needs.

COMPUTE'S last survey,

printed in the January 1992 is

sue, was one of our most suc

cessful yet, and I want to

thank those of you who took

the time to complete it and

send it in. The response was

overwhelming—nearly twice

as large as we've ever re

ceived. Not only does this

show that COMPUTE'S read

ership is an interested and ac

tive group, but more respons

es make the survey's results

much more significant.

I want to underscore how im

portant these surveys are to us

at COMPUTE. Knowing what

kind of equipment you have,

what your favorite articles are,

and what you like to read

about gives us the data we

need to create a magazine

that provides you with the in

formation you want most.

But these surveys are impor

tant for another reason, too:

They're just plain interesting.

If you've ever wondered how

you fit in with COMPUTE'S oth

er readers, here's a quick

look at what you're like.

The first question on the sur

vey relates to the type of com

puter you're using. Here we

see a marked increase in 386

ownership, from 29 percent in

1991 to 35 percent in 1992. If

we look at 286 and 386 ma

chines as a group, then 72 per

cent of you have these ad

vanced CPUs. It's also notewor

thy that the number of you us

ing laptops or notebooks has

nearly doubled in the last

year, from 5 percent in 1991 to

more than 9 percent in 1992.

Just two short years ago,

CGA and EGA were the dom

inant graphics systems, but to

day, it's a different story. VGA

has seen spectacular growth,

especially in the last year, mov

ing from 51 percent in 1991

to 73 percent in 1992. Of this

73 percent, 24 percent of you

own Super VGA systems.

In peripherals, there are sev

eral growth areas. The big

gest increase is in mice, scur

rying from 71 to 82 percent.

We also see 31/2-inch disk

drives spinning from 68 to 81

percent. Modems have in

creased their bandwidth from

a healthy 58 to 64 percent.

And sound cards have blast

ed from 12 percent to a whop

ping 21 percent.

When it comes to printers,

the tried-and-true dot-matrix

is still king of the hill with 85

percent (about 15 percent of

you own laser printers).

The operating system infor

mation we received from you

was a bit of a surprise. In a

very short time, MS-DOS 5.0

has become your dominant op

erating system, with 61 per

cent. Digital Research's DR

DOS clocks in at a respecta

ble 5 percent.

Moving from operating sys

tems to operating environ

ments, Windows has been an

other boom area, growing

from 14 percent in 1990 to 22

percent in 1991 to 31 percent

in 1992. GeoWorks comes in

at a healthy 12 percent. In the

next survey, we're going to

find out how many of you are

using IBM's new OS/2, ver

sion 2.0.

Looking at your favorite col

umns, we see something very

interesting. The order of pref

erence hasn't changed from

last year, but the numbers are

larger, which indicates that

you're reading more of the mag

azine. For example, "Tips &

Tools" is still the number one

column, but the readership

has grown from 62 percent

last year to 68 percent this

year. "Feedback," the number

two column, was at 48 percent

last year and has grown to 59

percent this year.

Looking at favorite topics,

we see disk management

and MS-DOS leading the list,

followed closely by new hard

ware, how to upgrade your

PC, and word processing.

Just as with columns, the way

you rank these hasn't

changed much from last

year, but each topic shows a

higher percentage of readers

interested in it.

With our readership chang

ing as fast as it is, we're go

ing to start running two sur

veys each year—one in Janu

ary and one in July. So in this

issue of COMPUTE, you'll

find another readership sur

vey and another chance to

tell us a little about yourselves

and your equipment. □
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ADVERTISEMENT

JOIN THE COMPUTE SEARCHSTAKES

YOU MAY WIN THIS
NEO GEO HOME ARCADE SYSTEM FROM

SNK HOME ENTERTAINMENT!
NEO GEO is the first TRUE ARCADE system designed

especially for the home. And SNK Home Entertainment's NEO

GEO surpasses all the competition - delivering motion picture-

quality graphics, real voice speech, stereo-symphonic sound,

and characters that are as large as life! Enter the July Compute

SearchStakes and you may win a NEO GEO Gold System and

this great software line up including Fatal Fury.Top Players' Golf,

King of the Monsters, Blue's Journey, League Bowling,

Magician Lord and an MVS/Arcade Compatible Memory Card.

IT'S GRAND TO WIN

Every month, from now until November, you'll have the

chance to win fabulous prizes by playing the Compute

SearchStakes. And by solving a minimum of just two

monthly SearchStakes, you'll be in the position to compete

for the SearchStakes Grand Prize, to be featured in our

upcoming December issue.

IT'S FUN TO PLAY
Each of the six picture disks displayed below is a portion of

a photo or illustration taken from an ad in this issue. To

solve the July SearchStakes, locate the ads from which

these disks were taken and note the page number for

each. If the ad has no page number, simply count that

page or cover as zero. Then add up all six page numbers.

That is the solution to this month's SearchStakes.

IT'S EASY TO ENTER

Once you find the solution, you may enter the July

SearchStakes automatically on a touch-tone phone by

calling 1-900-454-8681. The cost for the call is $1.50
for the first minute, $1.00 for each additional minute.

Average call is estimated to be 2-3 minutes. Callers must

be 18 or older or have a parent's or guardian's permission

to place call. You may also enter by mailing your answer

on a 3" x 5" piece of paper, along with your name,

address, and phone number to: "July Compute

SearchStakes," 324 West Wendover Avenue, Suite 200,

Greensboro, N.C. 27408 by 8/31/92. For more information

on how you may win this month's prize, valued at more

than $1,500, turn to page 40.

The NEO GEO Home Arcade System from SNK Home

Entertainment! Enter early...and enter often!
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The word programming brings to

mind never-ending lines of confus

ing and unforgiving computer

code complete with bugs and a lot

of trial and error. Who needs it? Let the

programmers program. Just give me

software that does what it's supposed

to. Sound familiar? What many users

fail to realize is that creating program

code for a word processor is often no

different from performing normal func

tions within the software. Wouldn't you

like to format a letter complete with mar

gins, date, heading, salutation, font

style, and signature block—all with one

keystroke? Or how about transposing

words or paragraphs by merely press

ing Alt-T? You can automate these and

other routine tasks. It's easy, once you

understand how to use your word proc

essor's macro feature.

What's a Macro?
Put simply, a macro is a file containing

recorded keystrokes and commands

that your word processor can execute.

Most word processors come with a mac

ro recorder built in. Turning it on re

quires only a couple of keystrokes or

mouse clicks. As with a high-speed

tape recorder, everything you do until

you turn off the macro recorder is

saved. You can replay the keystrokes

anytime you want.

Each of the three word processors

discussed in this article—WordPerfect

for DOS (WPDOS), WordPerfect for Win

dows (WPWin), and Word for Windows

(WinWord)—handles macros a little dif

ferently. But the result is the same: You

save time by automating repetitive

tasks.

WPDOS lets you create one-key

stroke-combination (Alt-letter) macros

and one-word macros. The two Win

dows applications also let you assign

macros to keystrokes, although they're

a little more difficult. And you can

place them on the Button Bar in

WPWin and on the Toolbar in Win

Word. To learn how, see "Mapping Men

us and Keyboards."

Ten Handy Macros
The key to recording macros is to

know exactly what you want them to

do before you start. Know each step. I

go through the process once or twice

before invoking the macro recorder.

For practice in creating macros,

here are ten popular, useful macros.

Note that WPWin doesn't automatically

assign macros to keystrokes. You

must do that with Preferences; see

"Mapping Menus and Keyboards."

Insert Today's Date
WPDOS. To start the macro recorder

in WPDOS, press Ctrl-F1O (hold down
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the Ctrl key and press F10). Name (or

define) the macro by pressing Alt-D. At

the Description prompt, type Insert

date and press Enter. The recorder

will now record your keystrokes. Enter

the date as you normally do in

WPDOS: Press Shift-F5; then press 2.

The date is entered. Press Enter twice

to put a line between the date and the

next text you type, and then press Ctrl-

F10 to turn off the macro recorder.

You can now enter the date anytime

by simply pressing Alt-D.

WPWin. To start the macro recorder

in WPWin, click on the Macro menu;

then click on Record. In the Filename

field, type Date (WPWin automatically

gives the file the default WCM macro ex

tension). In the Descriptive Name

field, type Insert date, and then click

on OK. WPWin is now recording key

strokes and commands. (While the re

corder is on, the mouse isn't available

for selecting text and graphics.) Click

on the Tools menu; then click on Date.

Select Text from the submenu. Press En

ter twice to place a blank line before

the next text you type. Now turn off the

macro recorder by clicking on the Mac

ro menu and selecting Stop.

To run this macro now, select Play

from the Macro menu, find the filename

DATE.WCM in the Play Macro dialog

box, and double-click on it (or select it

and click on the Play button),

WinWord. To start the macro record

er in WinWord, select Record Macro

from the Tools menu (version 2.0).

Type Date in the Record Macro Name

field, place the cursor in the Key field,

and press Shift-Ctrl-Q (this assigns the

macro to this keystroke combination).

Type Insert date in the Description

field and click on OK. WinWord is now

recording your keystrokes. To enter the

current date, select Date and Time

from the Insert menu. Find the date for

mat you want and double-click on it.

The date is inserted. Press Enter twice

to insert a blank line, and turn off the re

corder by selecting Stop Recorder

from the Tools menu.

To run this macro now, select Mac

ro from the Tools menu, find the mac

ro Date in the Macro Name list, and dou

ble-click on it.

Italicize a Word
To record this macro, you should have

some text on your screen.

WPDOS. Begin by placing the cur

sor anywhere on the word you want to

italicize. Start the macro recorder;

then define the macro by pressing Alt-

I. At the Description prompt, type Itali

cize a word and press Enter. The re

corder is on. Press Ctrl-Right Arrow to

move the cursor to the next word.

Press F12 to turn on Block, and then

press Ctrl-Left Arrow. The word you

want to italicize is highlighted. Press

Ctrl-F8 for Font, 2 for Appearance, and

4 for Italic. The word is italicized.

Press Ctrl-Right Arrow to move the cur

sor to the next word, and then turn off

the macro recorder (Ctrl-F10).

You can run this macro anytime by

placing the cursor on a word and press

ing Alt-I.

WPWin. Begin by placing the cursor

anywhere on the word you want to ital

icize. Start the macro recorder; then

type Italic in the Filename field. In the

Descriptive Name field, type Italicize a

word and click on OK. The recorder is

on. Press Ctrl-Right Arrow to move the

cursor to the next word, press F12 to

turn on Select Mode, and then press

Ctrl-Left Arrow. The word is highlight

ed. Press Ctrl-l. The word is italicized.

Press Ctrl-Right Arrow to move the cur

sor to the next word, press F12 to turn

off Select Mode, and then select Stop

from the Macro menu to turn off the

macro recorder.

WinWord. Begin by placing the cur

sor anywhere on the word you want to

italicize. Start the macro recorder and

then type ItalicWjrd in the Record Mac

ro Name field. Place the cursor in the

Key field and press the I key. In the De

scription field, type Italicized word and

then click on OK. The recorder is on,

ready to record your keystrokes. Press

Ctrl-Right Arrow to move the cursor to

the next word. Press Shift-Left Arrow to

select the word. The word is highlight

ed. Press Ctrl-l. The word is italicized.

Press Right Arrow to move the cursor

to the end of the word, and select

Stop Recorder from the Tools menu.

Spell Check a Word
If you've ever typed a word and then

wondered if it was spelled correctly,

this macro makes checking it easy. Be

gin with some text on your page.

WPDOS. Place the cursor on or di

rectly after the word to check. Start the

macro recorder, and then press Alt-W

to define the macro. Type Spell check

a word at the Description prompt.

Press Ctrl-F2 for Spell; then press 1 for

Word. Remember to turn off the macro

recorder (Ctrl-F10).

If the word is spelled correctly, the

cursor will move to the next word. If it's

incorrect, the word will be highlighted.

Correct it as you normally would. Re

turn to your document by pressing the

Esc key.

WPWin. Place the cursor on or direct

ly after the word you want to check.

Start the macro recorder, and type Spel-

word in the Filename field. Type Spell

check a word in the Descriptive Name

field, and click on OK. Press Ctrl-

Right Arrow to move the cursor to the

The word programming brings to 
mind never-ending lines of confus­
ing and unforgiving computer 
code complete with bugs and a lot 

of trial and error. Who needs it? Let the 
programmers program. Just give me 
software that does what it's supposed 
to. Sound familiar? What many users 
fail to realize is that creating program 
code for a word processor is often no 
different from performing normal func­
tions within the software. Wouldn't you 
like to format a letter complete with mar­
gins, date , heading, salutation, font 
style, and signature block-all with one 
keystroke? Or how about transposing 
words or paragraphs by merely press­
ing Alt-T? You can automate these and 
other routine tasks. It's easy, once you 
understand how to use your word proc­
essor's macro feature. 

What's a Macro? 
Put simply, a macro is a file containing 
recorded keystrokes and commands 
that your word processor can execute. 
Most word processors come with a mac­
ro recorder built in. Turning it on re­
quires only a couple of keystrokes or 
mouse clicks. As with a high-speed 
tape recorder, everything you do until 
you turn off the macro recorder is 
sav~d. You can replay the keystrokes 
anytime you want. 

Each of the three word processors 
discussed in this article-WordPerfect 
for DOS (WPDOS), WbrdPerfect for Win­
dows (WPWin), and Word for Windows 
(WinWbrd)-handles macros a little dif­
ferently. But the result is the same: You 
save time by automating repet itive 
tasks. 

WPDOS lets you create one-key­
stroke-combination (Alt-Ietter) macros 
and one-word macros. The two Win­
dows applications also let you assign 
macros to keystrokes, although they're 
a little more difficult. And you can 
place them on the Button Bar in 
WPWin and on the Toolbar in Win­
Wbrd. To learn how, see "Mapping Men­
us and Keyboards." 

Ten Handy Macros 
The key to recording macros is to 
know exactly what you want them to 
do before you start. Know each step. I 
go through the process once or twice 
before invoking the macro recorder. 

For practice in creating macros , 
here are ten popular, useful macros. 
Note that WPWin doesn' t automatically 
assign macros to keystrokes. You 
must do that with Preferences ; see 
"Mapping Menus and Keyboards." 

Insert Today's Date 
WPDOS. To start the macro recorder 
in WPDOS, press Gtrl-F10 (hold down 
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the Gtrl key and press F10). Name (or 
define) the macro by pressing Alt-D. At 
the Description prompt , type Insert 
date and press Enter. The recorder 
will now record your keystrokes. Enter 
the date as you normally do in 
WPDOS: Press Shift-F5; then press 2. 
The date is entered. Press Enter twice 
to put a line between the date and the 
next text you type, and then press Gtrl­
F10 to turn off the macro recorder. 

You can now enter the date anytime 
by simply pressing Alt-D. 

WPWin. To start the macro recorder 
in WPWin, click on the Macro menu; 
then click on Record. In the Filename 
field, type Date (WPWin automatically 
gives the file the default WGM macro ex­
tension) . In the Descriptive Name 
field , type Insert date, and then click 
on OK. WPWin is now recording key­
strokes and commands. (While the re ­
corder is on, the mouse isn't available 
for selecting text and graphics.) Glick 
on the Tools menu; then click on Date. 
Select Text from the submenu. Press En­
ter twice to place a blank line before 
the next text you type . Now turn off the 
macro recorder by clicking on the Mac­
ro menu and selecting Stop. 

To run this macro now, select Play 
from the Macro menu, find the filename 
DATEWGM in the Play Macro dialog 
box, and double-click on it (or select it 
and click on the Play button). 

WinWord. To start the macro record­
er in WinWord, setect Record Macro 
from the Tools menu (version 2.0). 
Type Date in the Record Macro Name 
field, place the cursor in the Key field, 
and press Shift-Gtrl-O (this assigns the 
macro to this keystroke combination). 
Type Insert date in the Description 
field and click on OK. WinWord is now 
recording your keystrokes. To enter the 
current date, select Date and Time 
from the Insert menu. Find the date for­
mat you want and double-click on it. 
The date is inserted. Press Enter twice 
to insert a blank line, and turn off the re­
corder by selecting Stop Recorder 
from the Tools menu. 

To run this macro now, select Mac­
ro from the Tools menu, find the mac­
ro Date in the Macro Name list, and dou­
ble-click on it. 

Italicize a Word 
To record this macro, you should have 
some text on your screen. 

WPDOS. Begin by placing the cur­
sor anywhere on the word you want to 
italicize. Start the macro recorder; 
then define the macro by pressing Alt­
I. At the Description prompt, type Itali­
cize a word and press Enter. The re­
corder is on. Press Gtrl-Right Arrow to 
move the cursor to the next word. 
Press F12 to turn on Block, and then 

press Ghl-Left Arrow. The word you 
want to italicize is highlighted. Press 
Gtrl-F8 for Font, 2 for Appearance, and 
4 for Italic . The word is ital icized . 
Press Gtrl-Right Arrow to move the cur­
sor to the next word , and then turn off 
the macro recorder (Gtrl-F10). 

You can run this macro anytime by 
placing the cursor on a word and press­
ing Alt-I. 

WPWin. Begin by placing the cursor 
anywhere on the word you want to ital­
icize. Start the macro recorder; then 
type Italic in the Fi lename field. In the 
Descriptive Name field , type Italicize a 
word and click on OK. The recorder is 
on. Press Gtrl- Right Arrow to move the 
cursor to the next word, press F12 to 
turn on Select Mode, and then press 
Gtrl-Left Arrow. The word is highlight­
ed. Press Girl-I. The word is italicized. 
Press Gtrl- Right Arrow to move the cur­
sor to the next word , press F12 to turn 
off Select Mode, and then select Stop 
from the Macro menu to turn off the 
macro recorder. 

WinWord. Begin by placing th~ cur­
sor anywhere on the word you want to 
italicize. Start the macro recorder and 
then type ltalicVlOrd in the Record Mac­
ro Name field. Place the cursor in the 
Key field and press the I key. In the De­
scription field, type Italicize a word and 
then click on OK. The recorder is on , 
ready to record your keystrokes. Press 
Gtrl-Right Arrow to move the cursor to 
the next word. Press Shift- Left Arrow to 
select the word. The word is highlight­
ed. Press Gtrl:1. The word is italicized. 
Press Right Arrow to move the cursor 
to the end of the word , and select 
Stop Recorder from the Tools menu. 

Spell Check a Word 
If you've ever typed a word and then 
wondered if it was spelled correct ly, 
this macro makes checking it easy. Be­
gin with some text on your page. 

WPDOS. Place the cursor on or di­
rectly after the word to check. Start the 
macro recorder, and then press AltW 
to define the macro. Type Spell check 
a word at the Description prompt. 
Press Gtrl-F2 for Spell; then press 1 for 
Word. Remember to turn off the macro 
recorder (Gtrl-F10). . 

If the word is spelled correctly, the 
cursor will move to the next word . If it's 
incorrect, the word will be highlighted. 
Gorrect it as you normally would. Re­
turn to your document by pressing the 
Esc key. 

WPWin. Place the cursor on or direct­
ly after the word you want to check. 
Start the macro recorder, and type Spel­
word in the Filename field . Type Spell 
check a word in the Descriptive Name 
field , and click on OK. Press Gtrl­
Right Arrow to move the cursor to the 
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EDITING MACROS

Why would you want to edit a macro? To

make it do something it wasn't pro

grammed to do—such as run (chain) an

other macro, pause so that you can enter

data from the keyboard, or run itself over

and over {say, to embolden the first line of

15,000 addresses). Another common rea

son is to change text in long macros, rath

er than rerecording them. The more you

think about it, the more reasons there are.

Each program's macro language is differ

ent (and complex). Once you've learned to

use it, though, you'll increase your efficien

cy. Here's a review on how to edit macros

in WPDOS, WPWin, and WinWord.

WPDOS. To edit a macro in WordPer

fect for DOS, the macro file must already

exist. First, start the macro editor just as

you'd begin to record a macro (press Ctri-

F10). Next, type the name of the macro

{Alt-Tor Alt-C, for example) you want to ed

it; then select 2 for Edit. You can enter

text and commands into the macro direct

ly from the keyboard (see the top figure)

or by pressing Shift-Ctrl-Page Up to

bring up a list of macro programming com

mands- The WordPerfect 5.1 manual de

scribes each of the commands and how to

use them.

WPWin. This program's macros are writ

ten and edited in the word processor; see

WPDOS macro editor lets you insert text and

commands from the keyboard

: MM

WPWin macros are written and edited in the

word processor.

the bottom figure. Edit a macro in WordPer

fect for Windows the same way you would

a document—select Open from the File

menu and load it. You can enter text and

commands directly, or you can insert com

mands with the Macro Command Inserter,

which is nothing more than a very sophis

ticated macro itself. WPWin comes with an

extensive macro language. Instructions for

using it, however, aren't included. You can

order the WPWin Macros Manual—com

plete with a good tutor and the Macro Com

mand Inserter—from the company for

$19.95.

WPWin also comes with a feature you'll

find very handy: a (racer that alerts you to

errors in the macro code and possible prob

lems and solutions.

WinWord. Word for Windows comes

with a macro editor accessible through the

Macro command. Text and commands

are entered directly from the keyboard. For

commands that use variables, you can

use the Variables option, which opens a di

alog box containing the variables available

to the selected command. The manual

doesn't contain much information on Word-

Basic, WinWord's macro language, but it's

shipped with a file (TECREF.DOC) that you

can load and print. TECREF.DOC also has

online macro help.

next word. Press F12 to turn on Select

Mode, and then press Ctrl-Left Arrow.

The word is highlighted. Click on Spell

er on the Button Bar (or select Speller

from the Tools menu), click on Start,

and then turn off the macro recorder.

If the word is spelled correctly, a

Spell check completed box appears. If

the word's incorrect, change it as you

normally would in WPWin.

WinWord. WinWord doesn't allow

you to access the Macro menu while

the Spelling dialog box is open. You

can create this macro, but it requires

some fairly sophisticated program

ming. See "Editing Macros" below for

information on modifying macros.

Transpose Two Words
Begin with some text on your screen.

WPDOS. Place the cursor on the

first of the two words you want to trans

pose. Turn on the macro recorder, and

then press Alt-T to define the macro.

Type Transpose two words at the De

scription prompt and press Enter.

Press Ctrl-Right Arrow to move to the

next word. Press F12 to turn on Block;

then press Ctrl-Left Arrow. The first

word is selected. Press Ctrl-F4 for

Move, enter 1 for Block, and then en

ter 1 for Move. The word is deleted.

Now press Ctrl-Right Arrow and press

Enter. Turn off the macro recorder.

When you run this macro, be sure to
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begin with the cursor on the first word

you want to transpose.

WPWin. Place the cursor on the

first of the two words you want to trans

pose. Turn on the macro recorder.

Type Tpose-w in the Filename field,

type Transpose two words in the De

scriptive Name field, and then click on

OK. Press Ctrl-Right Arrow to move to

the next word, press F12 to turn on

Block, and then press Ctrl-Left Arrow.

The first word is selected. Click on Cut

in the Edit menu (or on the Button Bar).

The word is deleted. Press Ctrl-Right Ar

row to place the cursor one space af

ter the word you want to transpose. Se

lect Paste from the Edit menu (or from

the Button Bar) and turn off the macro

recorder.

When you run this macro, be sure to

begin with the cursor on the first word

you want to transpose.

WinWord. Place the cursor on the

first of the two words you want to trans

pose. Turn on the macro recorder.

Type TransposeWords for the Record

Macro Name. Press 2 in the Key field

and type Transpose two words for the

Description; then click on OK. Press

Ctrl-Right Arrow to move to the next

word and Shift-Ctrl-Left Arrow to select

the word. Click on Cut in the Edit

menu. The word is deleted. Press Ctrl-

Right Arrow to place the cursor one

space after the next word. Select

Paste from the Edit menu; then turn off

the macro recorder.

When you run this macro, be sure to

begin with the cursor on the first word

you want to transpose.

Count Words
Make sure you have some text on

screen before you start.

WPDOS. Start the macro recorder;

then press Alt-C to define the macro.

Type Count words at the Description

prompt and press Enter. Press Ctrl-F2

for Spell and 6 for Count. When

WordPerfect stops counting, turn off

the macro recorder. Press Esc twice to

return to your document.

WPWin. You don't need a macro to

count words in WPWin. Simply select

Word Count from the Tools menu.

WinWord. WinWord doesn't allow

you to access the Macro menu while

the Statistics dialog box is open. You

can create this macro, but it requires

some fairly sophisticated program

ming. See "Editing Macros" above for

information on modifying macros.

Transpose Two Paragraphs
Make sure you have at least two para

graphs of text on your monitor.

WPDOS. Begin with the cursor any

where in the first of the two paragraphs

you want to transpose. Turn on the mac

ro recorder; then press Alt-P to define

Why would you want 10 edit a macro? To 
make it do something it wasn't pro­
grammed to do-such as run (chain) an­
other macro, pause so that you can enter 
data from the keyboard, or run itself over 
and over (say, to embolden the first line of 
15,()(X) addresses). Another common rea­
son is 10 change text in long macros, rath­
er than rerecording them. The more you 
think about it, the more reasons there are. 

Each program's macro language is differ­
ent (and complex). Once you've learned to 
use it, though, you'll increase your efficien­
cy. Here's a review on how to edit macros 
in WPDOS, WPWin, and WinWord. 

WPDOS. To edit a macro in WordPer­
fect for DOS, the macro file must already 
exist. First, start the macro editor just as 
you'd begin to record a macro (press Ctrl­
FlO). Next. type the name of the macro 
(Alt-T or Alt-C, for example) you want to ed­
it; then select 2 for Edit. You can enter 
text and commands into the macro direct­
ly from the keyboard (see the top figure) 
or by pressing Shift-Clri-Page Up to 
bring up a list of macro programming com­
mands. The WordPerfect 5.1 manual de­
scribes each of the commands and how to 
use them. 

WPWin. This program's macros are writ­
ten and edited in the word processor; see 

next word. Press F12 to turn on Select 
Mode, and then press Ctrl- Left Arrow. 
The word is highlighted. Click on Spell­
er on the Button Bar (or select Speller 
from the Tools menu), click on Start , 
and then turn off the macro recorder. 

If the word is spelled correctly, a 
Spell check completed box appears. If 
the word 's incorrect , change it as you 
normally would in WPWin. 

WinWord. WinWord doesn't allow 
you to access the Macro menu while 
the Spelling dialog box is open. You 
can create this macro, but it requires 
some fairly sophisticated program­
ming. See "Editing Macros" below for 
information on modifying macros. 

Transpose Tvvo VVords 
Begin with some text on your screen. 

WPDOS. Place the cursor on the 
first of the two words you want to trans­
pose. Turn on the macro recorder, and 
then press AII-T to define the macro. 
Type Transpose two words at the De­
scription prompt and press Enter. 
Press Ctrl-Right Arrow to move to the 
next word . Press F12 to turn on Block; 
then press Ctrl- Left Arrow. The first 
word is selected . Press Ctrl-F4 for 
Move, enter 1 for Block, and then en­
ter 1 for Move. The word is deleted. 
Now press Ctrl- Right Arrow and press 
Enter. Turn off the macro recorder. 

When you run this macro, be sure to 
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EDITING MACROS 

WPDOS macro editor lets you insert text and 
commands from the keyboard. 

: . { . .. . 

WPWin macros are written and edited in the 
word processor. 

begin with the cursor on the first word 
you want to transpose. 

WPWin . Place the cursor on the 
first of the two words you want to trans­
pose . Turn on the macro recorder. 
Type Tpose-w in the Filename field, 
type Transpose two words in the De­
scriptive Name field, and then click on 
OK. Press Ctrl-Right Arrow to move to 
the next word , press F12 to turn on 
Block, and then press Ctrl-Left Arrow. 
The first word is selected. Click on Cut 
in the Edit menu (or on the Button Bar). 
The word is deleted. Press Ctrl- Right Ar­
row to place the cursor one space af­
ter the word you want to transpose. Se­
lect Paste from the Edit menu (or from 
the Button Bar) and turn off the macro 
recorder. 

When you run this macro, be sure to 
begin with the cursor on the first word 
you want to transpose. 

WinWord. Place the cursor on the 
first of the two words you want to trans­
pose. Turn on the macro recorder. 
Type TransposeWords for the Record 
Macro Name. Press 2 in the Key field 
and type Transpose two words for the 
Description ; then click on OK. Press 
Ctrl- Right Arrow to move to the next 
word and Shift-Ctrl- Left Arrow to select 
the word . Click on Cut in the Edit 
menu. The word is deleted. Press Ctrl­
Right Arrow to place the cursor one 
space after the next word. Select 

the bottom figure. Edit a macro in WordPer­
fect for Windows the same way you would 
a document-select Open from the File 
menu and load it. You can enter text and 
commands directly, or you can insert com­
mands with the Macro Command Inserter, 
which is nothing more than a very sophis­
ticated macro itself. WPWin comes with an 
extensive macro language. Instructions for 
using it, however, aren't included. You can 
order the WPWin Macros Manual-com­
plete with a good tutor and the Macro C0m­
mand Inserter- from the company for 
$19.95. 

WPWin also comes with a feature you'll 
find very handy: a tracer that alerts you to 
errors in the macro code and possible prob­
lems and solutions. 

WinWord. Word for Windows comes 
with a macro editor accessible through the 
Macro command . Text and commands 
are entered directly from the keyboard. For 
commands that use variables, you can 
use the Variables option. which opens a di­
alog box containing the variables available 
to the selected command. The manual 
doesn't contain much information on Word­
Basic, WinV\brd's macro language, but it's 
shipped with a file (TECREF.DOC) that you 
can load and print. TECREF.DOC also has 
online macro help. 

Paste from the Edit menu; then turn off 
the macro recorder. 

When you run this macro, be sure to 
begin with the cursor on the first word 
you want to transpose. 

(ount VVords 
Make sure you have some text on­
screen before you start. 

WPDOS. Start the macro recorder; 
then press Alt-C to define the macro. 
Type Count words at the Description 
prompt and press Enter. Press Ctrl-F2 
for Spell and 6 for Count. When 
WordPerfect stops counting, turn off 
the macro recorder. Press Esc twice to 
return to your document. 

WPWin. You don' t need a macro to 
count words in WPWin . Simply select 
Word Count from the Tools menu. 

WinWord . WinWord doesn't al low 
you to access the Macro menu while 
the Statistics dialog box is open. You 
can create this macro, but it requires 
some fa irly sophisticated program­
ming. See "Editing Macros" above for 
information on modifying macros. 

Transpose TYto Paragraphs 
Make sure you have at least two pa ra­
graphs of text on your monitor. 

WPDOS. Begin with the cursor any­
where in the first of the two paragraphs 
you want to transpose. Turn on the mac­
ro recorder; then press Alt-P to define 
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MAPPING MENUS AND KEYBOARDS

Macros are useless if they don't save time

and keystrokes. Running macros in Win

dows applications can take several

mouse clicks. And if you forget what you

named a macro, you have to scroll

through a list looking at descriptions.

WPDOS (without keyboard mapping) al

lows you to assign only 26 macros to Alt-

letter combinations. Then, you're relegated

to using one-word macros, which require

several keystrokes—and it's not always

easy to remember what you named them.

Word processors overcome these nui

sances in several ways. WPDOS lets you de

fine as many different keyboard setups as

you need. In other words, if you use a cer

tain set of macros for letter writing and an

other set for reports, you can load a dif

ferent keyboard file for each task. The

Windows applications offer even more

files as you have disk space.

WPWin. Mapping options abound. Not

only can you assign macros to Ctrl-x and

Shift-Ctrl-x (x being a number, letter, or func

tion key), but you can also assign com

mands to keystrokes. (Consider this before

creating macros that do the same things

as commands.) You can assign macros to

the Macro menu and Button Bar, and you

can create multiple keyboards and Button

Bars.

To assign macros to trie keyboard, se

lect Preferences from the File menu and

Keyboard from the submenu. To assign a

macro to an existing keyboard, click on Ed

it (to create a new keyboard, click on Cre

ate). In Keyboard Editor, select Macros

from Hem Type; then click on Add. You're

given a list of macros. Double-click on the

macro you want to add and press the

ever. You can assign macros globally or to

templates—so be sure you assign macros

in the setup you want.

To assign macros to the keyboard, se

lect Options from the Tools menu, and

then scroll through the Category icons and

select Keyboard. Select the macro you

want to assign; then press the keys you

want it assigned to (Currently tells you

whether the combination is already as

signed). Click on Assign and then on OK.

To assign macros to menus, select Op

tions from the Toofs menu. Scroll through

the Category icons and select Menus. Mak

ing sure that Macros is checked in the

Show option, select the macro you want to

assign; select the target menu in the Menu

list; and then, in the Menu Text box, type

what you want the menu listing to say (for

example, Transpose words). If you place

WPWin's Keyboard Editor assigns macros to

keystrokes and creates new keyboards.

flexibility—assigning macros not only to key

strokes but also to menus and, in WPWin,

to the Button Bar. WinWord 2.0 supports

macros on its Toolbar.

Each program's approach is slightly dif

ferent. The following includes a description

of the procedure for each one.

WPDOS. WPDOS supports two types of

macros: Alt-letter combinations and word

macros. It also lets you change keyboard

layouts. To do so, go into Setup (Shift-F1),

select Keyboard Layout, and then select

Create. You're prompted to name the new

keyboard file. Type the new name (eight or

fewer characters), highlight the new key

board name with Dov/n Arrow or Up Arrow,

press Enter to select it, and press Enter

again to return to the document screen.

You can assign macros to the keyboard as

desired and create as many keyboard

WPWin lets you assign up to 18 macros to

the Macro menu.

keys you want to assign the macro to (no

AH combinations are allowed). Click on OK

to close Keyboard Editor and again on OK

to ciose Keyboard.

Please note that before you map a mac

ro to the keyboard, it must be run once to

be compiled.

To assign macros to the Button Bar, se

lect Button Bar Setup from the View menu;

then click on Edit in the submenu. Click on

Assign Macro to Button in the Edit Button

Bar. Doubie-click on the macro you want to

assign; then click on OK to close the But

ton Bar editor.

You assign macros to the Macro menu

with the Assign to Menu command on the

Macro menu.

WinWord. Word for Windows lets you as

sign macros to any menu, to the Toolbar,

and to keystrokes. A word of caution, how-

WinVltord lets you reassign macros to

keystrokes through Options.

an ampersand (&) before a letter, then af

ter opening the menu, you can run the mac

ro with a keystroke. &Transpose words

would appear on the menu like this: Trans

pose words. If you also assign a keystroke

combination, it would appear as Transpose

words Shift+Ctrl+T.

To assign macros to the Toolbar, select

Options from the Tools menu, and then

scroll through Category icons and select

Toolbar. The Options dialog box changes.

Select the macro you want to assign from

the Macros list, and choose the button you

want to represent it from the Buttons list. In

the Tool to Change list, select the tool you

want to replace. Click on Change and

then on Close.

You can assign macros to keystrokes

during creation or at any other time with

Options.

the macro. At the Description prompt,

type Transpose paragraphs and press

Enter. Press Ctrl-F4 for Move, select 2

for Paragraph, and enter 1 for Move.

The first paragraph is deleted. Press

F2 for Search, and at the Srch prompt,

press Enter to search for a hard return.

Press F2 to start the search. The cur

sor is on the line beneath the second

paragraph. Press Enter, and then turn

off the macro recorder.

When you run this macro, make

sure you place the cursor on the first of

the two paragraphs.
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WPWin. Begin with the cursor any

where in the first of the two paragraphs

you want to transpose. Turn on the mac

ro recorder; type Tpose-p in the File

name field and Transpose paragraphs

in the Descriptive Name field. Click on

OK. Choose Select from the Edit menu

and Paragraph from the submenu. Se

lect Cut from the Edit menu. The first

paragraph is deleted. Now select

Search from the Edit menu. In the

Search dialog box, click on the Codes

button. Scroll through the list of codes

and double-click on HRt; then click on

Close. Click on Search. To insert the

first paragraph, select Paste from the

Edit menu (or the Button Bar). Turn off

the macro recorder.

When you run this macro, make

sure you place the cursor on the first

paragraph.

WinWord. Begin with the cursor at

the beginning of the first line (before

the tab indention) in the first of the two

paragraphs you want to transpose.

Turn on the macro recorder; type Trans-

poseParagraphs for the Macro Record

Name and Transpose adjacent para-

MAPPING MENUS AND KEYBOARDS 
Macros are useless if they don't save time 
and keystrokes. Running macros in Win­
dows applications can take several 
mouse clicks. And if you forget what you 
named a macro, you have to scroll 
through a list looking at descriptions. 
WPDOS (without keyboard mapping) al­
lows you to assign only 26 macros to Alt­
letter combinations. Then, you're relegated 
to using one-word macros, which require 
several keystrokes-and it's not always 
easy to remember what you named them. 

Word processors overcome these nui­
sances in several ways. WPOOS lets you de­
fine as many different keyboard setups as 
you need. In other words, if you use a cer­
tain set of macros for letter writing and an­
other set for reports, you can load a dif­
ferent keyboard file for each task. The 
Windows applications offer even more 

files as you have disk space. 
WPWin. Mapping options abound. Not 

only can you assign macros to Ctrl-x and 
Shift-Ctrl-x (x being a number, letter, or func­
tion key), but you can also assign com­
mands to keystrokes. (Consider this before 
creating macros that do the same things 
as commands.) You can assign macros to 
the Macro menu and Button Bar, and you 
can creale multiple keyboards and Button 
Bars. 

To assign macros to the keyboard, se­
lect Preferences from the File menu and 
Keyboard from the submenu. To assign a 
macro to an existing keyboard, click on Ed­
it (to create a new keyboard, click on Cre­
ate). In Keyboard Editor, select Macros 
from Item Type: then click on Add. You're 
given a list of macros. Double-click on the 
macro you want to add and press the 
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WPWin's Keyboard Editor assigns macros to WPWin lets you assign up to 18 macros to 
keystrokes and creates new keyboards. the Macro menu. 

flexibility-assigning macros not only to key­
strokes but also to menus and, in WPWin, 
to the Button Bar. WinWord 2.0 supports 
macros on its Toolbar. 

Each program's approach is slightly dif­
ferent. The following includes a description 
of the procedure for each one. 

WPDOS_ WPDOS supports two types 01 
macros: AIHeller combinations and word 
macros. It also lets you change keyboard 
layouts. To do so, go into Setup (Shift-Fl), 
select Keyboard Layout, and then select 
Create. You're prompted to name the new 
keyboard file. Type the new name (eight or 
fewer characters), highlight the new key­
board name with Down Arrow or Up Arrow, 
press Enter to select it, and press Enter 
again to return to the document screen. 
You can assign macros to the keyboard as 
desired and create as many keyboard 

the macro. At the Description prompt, 
type Transpose paragraphs and press 
Enter. Press Ctrl-F4 for Move, select 2 
for Paragraph, and enter 1 for Move. 
The first paragraph is deleted. Press 
F2 for Search, and at the Srch prompt, 
press Enter to search for a hard return. 
Press F2 to start the search. The cur­
sor is on the line beneath the second 
paragraph. Press Enter, and then turn 
off the macro recorder. 

When you run this macro , make 
sure you place the cursor on the first of 
the two paragraphs. 
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keys you want to assign the macro to (no 
Alt combinations are allowed). Click on OK 
to close Keyboard Editor and again on OK 
to close Keyboard. 

Please note that before you map a mac­
ro to the keyboard, it must be run once to 
be compiled. 

To assign macros to the Button Bar, se­
lect Button Bar Setup from the View menu; 
then click on Edit in the submenu. Click on 
Assign Macro to Button in the Edit Button 
Bar. Double-click on the macro yoo want to 
assign; then click on OK to close the But­
ton Bar editor. 

You assign macros to the Macro menu 
with the Assign to Menu command on the 
Macro menu. 

WinWord. Word for Windows lets you as­
sign macros to any menu, to the Toolbar, 
and to keystrokes. A word of caution, how-

WPWin. Begin with the cursor any­
where in the first of the two paragraphs 
you want to transpose. Turn on the mac­
ro recorder; type Tpose-p in the File­
name field and Transpose paragraphs 
in the Descriptive Name field. Click on 
OK. Choose Select from the Edit menu 
and Paragraph from the submenu. Se­
lect Cut from the Edit menu. The first 
paragraph is deleted . Now select 
Search from the Edi t menu. In Ihe 
Search dialog box, click on the Codes 
button. Scroll through the list of codes 
and double-click on HAt; then click on 

ever. You can assign macros globally or to 
templates-so be sure you assign macros 
in the setup you want. 

To assign macros to the keyboard, se­
lect Options from the Tools menu, and 
then scroll through the Category icons and 
select Keyboard. Select the macro you 
want to assign; then press the keys you 
want it aSSigned to (Currently tells you 
whether the combination is already as­
signed). Click on Assign and then on OK. 

To assign macros to menus, select Op­
tions from the Toots menu. ScrOll through 
the Category icons and select Menus. Mak­
ing sure that Macros is checked in the 
Show option, select the macro you want to 
assign; select the target menu in the Menu 
list; and then, in the Menu Text box, type 
what you want the menu listing to say (for 
example, Transpose words). If you place 
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Win\l\tlrd lets you reassign macros to 
keystrokes through Options. 

an ampersand (&) before a leHer, then af­
ter opening the menu, you can run the mac­
ro with a keystroke. & Transpose words 
would appear on the menu like this: Trans­
pose words. If you also assign a keystroke 
combination, it would appear as Transpose 
words Shift+Ctrl+ T. 

To assign macros to the Toolbar, select 
Options from the Tools menu, and then 
scroll through Category icons and select 
Toolbar. The Options dialog box changes. 
Select the macro you want to assign from 
the Macros list, and choose the button you 
want to represent it from the Buttons Jist. In 
the Tool to Change list, select the tool you 
want to replace. Click on Change and 
then on Close. 

You can assign macros to keystrokes 
during creation or at any other time with 
Options. 

Close. Click on Search. To insert the 
fi rst paragraph, select Paste from the 
Edit menu (or the Button Bar). Turn off 
the macro recorder. 

When you run this macro , make 
sure you place the cursor on the first 
paragraph. 

WinWord. Begin with the cursor at 
the beginning of the first line (before 
the tab indention) in the first of the two 
paragraphs you want to transpose . 
Turn on the macro recorder; type Trans­
poseParagraphs for the Macro Aecord 
Name and Transpose adjacent para-
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graphs for the Description. Press P in

the Key field. Click on OK. Press Shift—

Ctri-Down Arrow to select the first par

agraph. Choose Cut from the Edit

menu (or the Toolbar). The first para

graph is deleted. Press Shift-Down Ar

row to move to the next paragraph. To

insert the first paragraph, select Paste

from the Edit menu (or the Toolbar).

Turn off the macro recorder.

When you run this macro, be sure to

place the cursor at the beginning of

the first line in the first of the two para

graphs you want to transpose.

Insert Bullet
You can make items in a list stand out

from straight text if you set them up as

a bulleted list with a hanging indent.

WPDOS. Begin with the cursor

where you want to start a bulleted list.

Start the macro recorder and press Alt-

B to define the macro. Type Bullet at

the Description prompt; then press En

ter. Press Ctrl-V for Compose. At the

Key= prompt, type 4,0 and press En

ter. Press F4 for Indent, and stop the

macro recorder.

WPWin. Begin with the cursor

where you want to start a bulleted list.

Start the macro recorder and type Bul

let in the Filename field and Insert bul

letin the Descriptive Name field. Click

on OK. Press Ctrl-W for WordPerfect

Characters. Type 4,0 in the Number

field and click on Insert and then on

Close. Select Paragraph from the Lay

out menu, and select Indent from the

submenu. Stop the macro recorder.

WinWord. WinWord is shipped with

a bullet macro on the Toolbar.

Letter Template
Begin with a new document screen. At

the instruction Type return address,

type in the following information:

Your Name, Title

Your Company

Your Company's Street Address

The City, State ZIP code

WPDOS. Start the macro recorder.

Press Alt-L to define the macro, and

type Letter template at the Description

prompt. Press Enter. Press Shift-F8 for

Format; select 2 for Page and 5 for Top/

Bottom margins. Type 1.75 (or the

measurement for your stationery).

Press Enter twice. Select 1 for Center

Page and Y for Yes; then press Enter.

Press 1 for Line, 3 for Justification, and

1 for Left. Then press Enter twice to re

turn to the document screen.

To enter the current date, press Shift-

F5, and then select 2 for Date. Press En-
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ter twice to insert a blank line. Type Re

turn address. Press Enter twice, and

then type Dear Press Ctrl-F1O to end

the macro record. You're now ready to

type the letter.

WPWin. Start the macro recorder. In

the Filename field, type Letter. Type Let

ter template in the Descriptive Name

field. Click on OK. Select Margins

from the Layout menu, press Tab

twice to move to Top, and type 1.75

(or the measurement for your station

ery). Click on OK. Select Page from the

Layout menu; then select Center Page

from the submenu. Select Date from

the Tools menu and select Text from

the submenu. Press Enter twice to in

sert a biank space. Type Return ad

dress, press Enter twice, and type

Dear. Turn off the recorder. You're now

ready to begin typing the letter.

WinWord. WinWord is shipped with

a very sophisticated letter-template mac

ro. It is, in fact, an impressive example

of the power of WordBasic, WinWord's

macro language. Access the template

by selecting New from the File menu

and then double-clicking on Letter in

the templates list. You can modify mar

gins, fonts, and other settings as need

ed. Be sure to save the template after

you've changed the settings.

Insert Text (Closing a Letter)
Begin with an empty screen or at the

end of a letter you want to close. At the

Type the signature block instruction in

each procedure, follow these steps:

Type Thanks for your time and consid

eration. Then press Enter. Type Sincere

ly, and press Enter 4 times. Then type

in your name, title, and company.

WPDOS. Start the macro recorder,

and then press Alt-E. Type End letter

at the Description prompt and press En

ter. Type the signature block. Stop the

macro recorder.

WPWin. Start the macro recorder.

Type Close in the Filename field and

Close letter in the Descriptive Name

field. Click on OK. Type the signature

block, and stop the macro recorder.

WinWord. The letter template

shipped with WinWord provides sever

al letter-closing options.

Sign a Letter
For this macro, you need a scanned im

age of your signature. If you don't

have a scanner, you can have your

signature scanned at a desktop publish

ing service bureau for a nominal fee.

First, use your word processor's

graphics import, placing, and sizing op

tions to create a document that looks

like the one in the following example.

WPDOS and WPWin users, save the

file as SIGNBL0C.WP5. WinWord us

ers, don't save the document; instead,

go to the WinWord procedure below.

WPWin users, record the macro at the

end of a letter you want to sign.

WPDOS. Turn on the recorder.

Press Alt-S to define the macro, type

Sign letter at Description, and press En-

i r i "i u

.isj.ui.asd

Using a scanned image of your signature,

create a document like this.

ter. Press Shift-10 for Retrieve; then

type SIGNBL0C.WP5 (be sure to in

clude path information, if applicable).

Press Y to retrieve current document.

Stop the recorder.

WPWin. Select Record from the Mac

ro menu. Type Sign in the Filename

field and Sign letter in the Descriptive

Name field. Click on OK. Select Re

trieve from the File menu; then type

SIGNBL0C.WP5 for the Filename (be

sure to include path information, if ap

plicable). Click on OK; then click on

Yes to retrieve current document.

Stop the macro recorder.

WinWord. The most efficient way to

insert data into a WinWord document

is with Glossary, an extension of Win

Word's Merge feature. The procedure

is simple: Select the data you want to

include in the glossary, choose Glossa

ry from the Edit menu, name the glos

sary, and then click on Define. Each

time you want to use the data, insert a

glossary bookmark using the Field op

tion on the Insert menu.

This procedure is detailed in the Win

Word manual. If you'd rather create a

macro, the procedure is almost identi

cal to the one in WPWin except that

you'd name the signature block file

SIGNBLOC.DOC and select File. . .

from the Insert menu to retrieve it.

The Sky's the Limit
As macros go, these ten are simple.

Once you get the hang of creating

them, you're limited only by your inge

nuity (and bravado). You can make

them pause so you can type text and

then restart them again, and you can

create different versions of the same

document based on different variables.

The two for Windows even let you pro

gram dialog boxes that ask questions

on how to proceed. Let your imagina

tion be your guide. Q

graphs for the Description. Press P in 
the Key field. Click on OK. Press Shift­
Ctrl-Down Arrow to select the first par­
agraph. Choose Cut from the Ed it 
menu (or the Toolbar). The first para­
graph is deleted. Press Shift- Down Ar­
row to move to the next paragraph. To 
insert the first paragraph, select Paste 
from the Edit menu (or the Toolbar). 
Turn off the macro recorder. 

When you run this macro, be sure to 
place the cursor at the beginning of 
the first line in the first of the two para­
graphs you want to transpose. 

Insert Bullet 
You can make items in a list stand out 
from straight text if you set them up as 
a bulleted list with a hanging indent. 

WPDOS. Begin with the cursor 
where you want to start a bulleted list. 
Start the macro recorder and press Alt­
B to define the macro. Type Bullet at 
the Description prompt; then press En­
ter. Press Ctrl-V for Compose. At the 
Key= prompt, type 4,0 and press En­
ter. Press F4 for Indent, and stop the 
macro recorder. 

WPWin . Begin with the cursor 
where you want to start a bulleted list. 
Start the macro recorder and type Bul­
let in the Filename field and Insert bul­
let in the Descriptive Name field . Click 
on OK. Press Ctrl-W for WordPerfect 
Characters. Type 4,0 in the Number 
field and cl ick on Insert and then on 
Close. Select Paragraph from the Lay­
out menu, and select Indent from the 
submenu. Stop the macro recorder. 

WinWord. WinWord is shipped with 
a bullet macro on the Toolbar. 

Letter Template 
Begin with a new document screen. At 
the instruction Type return address, 
type in the following information: 

Your Name, Title 

Your Company 

Your Company's Street Address 

The City, State ZIP code 

WPDOS. Start the macro recorder. 
Press AIt -L to define the macro, and 
type Letter template at the Description 
prompt. Press Enter. Press Shift-FS for 
Format; select 2 for Page and 5 for Topl 
Bottom margins. Type 1.75 (or the 
measurement for your stationery) . 
Press Enter twice. Select 1 for Center 
Page and Y for Yes; then press Enter. 
Press t for Line, 3 for Justification, and 
1 for Left. Then press Enter twice to re­
turn to the document screen. 

To enter the current date, press Shift­
F5, and then select 2 for Date. Press En-
14 COMPUTE JULY 1992 

ter twice to insert a blank line. Type Re­
turn address. Press Enter twice, and 
then type Dear. Press Ctrl-Fl0 to end 
the macro record . You're now ready to 
type the letter. 

WPWin. Start the macro recorder. In 
the Filename field, type Lener. Type Let­
ler lemplale in the Descriptive Name 
fie ld. Click on OK. Select Margins 
from the Layout menu, press Tab 
twice to move to Top , and type 1.75 
(or the measurement for your station­
ery). Click on OK. Select Page from the 
Layout menu; then select Center Page 
from the submenu. Select Date from 
the Tools menu and select Text from 
the submenu. Press Enter twice to in­
sert a blank space. Type Relurn ad­
dress, press Enter twice, and type 
Dear. Turn off the recorder. You're now 
ready to begin typing the letter. 

WinWord. WinWord is shipped with 
a very sophisticated letter-template mac­
ro. It is, in fact, an impressive exampfe 
of the power of WordBasic, WinWord's 
macro language. Access the template 
by selecting New from the File menu 
and then double-clicking on Letter in 
the templates list. You can modify mar­
gins, fonts, and other settings as need­
ed. Be sure to save the template after 
you've changed the settings. 

Insert Text (Closing a Letter) 
Begin with an empty screen or at the 
end of a letter you want to close. At the 
Type Ihe signa lure block instruction in 
each procedure, follow these steps: 
Type Thanks for your time and consid­
eration. Then press Enter. Type Sincere­
ly, and press Enter 4 times. Then type 
in your name, title, and company. 

WPDOS. Start the macro recorder, 
and then press Alt-E. Type End letter 
at the Description prompt and press En­
ter. Type the signature block. Stop the 
macro recorder. 

WPWin . Start the macro recorder. 
Type Close in the Filename field and 
Close letter in the Descriptive Name 
field . Click on OK. Type the signature 
block, and stop the macro recorder. 

WinWord . The letter template 
shipped with WinWord provides sever­
al letter-closing options. 

Sign a Letter 
For this macro, you need a scanned im­
age of your signature . If you don't 
have a scanner, you can have your 
Signature scanned at a desktop publish­
ing service bureau for a nominal fee. 

First, use your word processor's 
graphics import, placing, and sizing op­
tions to create a document that looks 
like the one in the following example. 

WPDOS and WPWin users, save the 
file as SIGNBLOCWP5. WinWord us­
ers, don't save the document; instead, 

go to the WinWord procedure below. 
WPWin users, record the macro at the 
end of a letter you want to sign. 

WPDOS. Turn on the recorder. 
Press Alt-S to define the macro, type 
Sign lener at Description, and press En-

Using a scanned image of your signature, 
create a document like this. 

ter. Press Shift-l0 for Retrieve; then 
type SIGNBLOC. WP5 (be sure to in­
clude path information, if applicable). 
Press Y to retrieve current document. 
Stop the recorder. 

WPWin. Select Record from the Mac­
ro menu. Type Sign in the Filename 
field and Sign letter in the Descriptive 
Name field. Click on OK. Select Re­
trieve from the File menu; then type 
SIGNBLOC. WP5 for the Filename (be 
sure to include path information, if ap­
plicable). Click on OK; then click on 
Yes to retr ieve current document. 
Stop the macro recorder. 

WinWord. The most efficient way to 
insert data into a WinWord document 
is with Glossary, an extension of Win­
Word's Merge feature. The procedure 
is simple: Select the data you want to 
include in the glossary, choose Glossa­
ry from the Edit menu, name the glos­
sary, and then click on Define. Each 
time you want to use the data, insert a 
glossary bookmark using the Field op­
tion on the Insert menu. 

This procedure is detailed in the Win­
Word manual. If you'd rather create a 
macro, the procedure is almost identi­
cal to the one in WPWin except that 
you'd name the signature block file 
SIGNBLOC.DOC and select File . 
from the Insert menu to retrieve it. 

The Sky's the Limit 
As macros go, these ten are simple. 
Once you get the hang of creating 
them, you're limited only by your inge­
nuity (and bravado) . You can make 
them pause so you can type text and 
then restart them again , and you can 
create different versions of the same 
document based on different variables. 
The two for Windows even let you pro­
gram dialog boxes that ask questions 
on how to proceed. Let your imagina­
tion be your guide. 0 
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automatic emulation switching. What 's more, its print quality is excellent for both 
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READERSHIP SURVEY

We want COMPUTE to be as useful

and interesting as possible and to pro

vide you with the coverage you want.

Please help us by taking a moment to

fill out and send us this questionnaire.

You can mail the completed question

naire to us (photocopies are fine), fax

it, or use COMPUTE/NET to respond.

Mail: COMPUTE Readership Survey,

324 West Wendover Avenue, Suite 200,

Greensboro, North Carolina 27408

Fax:(919)275-9837

COMPUTE/NET: COMPUTE on GEnie

or America Online

What computer(s) do you own or use?

° 8088/8086 (IBM PC, XT, or compati

ble), brand

D 80286, brand

D 80386. brand

Notebook/laptop, brand

Macintosh, model

u Game system, brand
D Other

I don't own or use a computer.

Which video display system(s) do you

use?

° Monochrome
Hercules

CGA

EGA

VGA

Super VGA

Which peripheral(s) do you own or use

with your computer?

5%-inch disk drive

D 3V2-inch disk drive
D CD-ROM drive
" Dot-matrix printer
n Fax modem
D Hard disk
3 Laser printer
D Letter quality printer
n MIDI device
D Modem

Mouse

PostScript printer

D Sound card
a Speakers
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How much memory does your comput

er have?

° 640K or less

° 1MB

° 2MB

D 4MB

n 8MB

Which operating systems/environ

ments) do you use?

a MS-DOS version
D DR DOS version
D OS/2

Microsoft Windows
a

Tandy DeskMate

D Other

Which parts of the magazine do you

like the most?

Art Works

COMPUTE/NET

D

□

□

D COMPUTE'S Getting Started With spe
cial sections

Editorial License

Features

D Feedback

D GamePlay
D Hardware Clinic
D IntroDOS
D Multimedia PC

D News & Notes
n On Disk
a Pathways
a Personal Productivity
D Point & Click
D Programming Power

D Reviews

D SharePak

P Test Lab

□ Tips & Tools

Which of the following computer-related

topics do you like to read about?

□ Databases

E Desktop publishing

n Disk management and MS-DOS

E Education

d Games and entertainment

n Graphics (paint, draw, or CAD)

n How to upgrade your PC

D Integrated software

D Local area networks (LANs)

n Money management

D Multimedia

n New computer technologies

D New hardware

n Pen computing

D Programming

D Spreadsheets
D Telecommunications

D Windows

D Word processing
D Other

Where do you use your PC?

D Home
D Work
D School
D Other

Where did you get this copy of

COMPUTE?
□

Subscription

Newsstand

D Other

How long have you been reading

COMPUTE?

D Less than two years
n Two years or more

If you have a modem, which online serv-

ice(s) do you use?

D America Online

n CompuServe
D COMPUTE/NET
D Delphi

D GEnie
D Other

READERSHIP SURVEY 

We want COMPUTE to be as useful 
and interesting as possible and to pro­
vide you with the coverage you want. 
Please help us by taking a moment to 
fill out and send us this questionnaire. 
You can mail the completed question­
naire to us (photocopies are fine J, fax 
it, or use COMPUTE/NET to respond. 

Mail: COMPUTE Readership Survey, 
324 West Wendover Avenue, Suite 200, 
Greensboro, North Carolina 27408 

Fax: (919) 275-9837 

COMPUTE/NET: COMPUTE on GEnie 
or America Online 

What computer(s) do you own or use? 
o 8088/8086 (IBM PC, XT, or compati-

ble), brand _______ _ 
o 80286, brand ______ _ 
o 80386, brand ______ _ 

o NotebOOk/laptop, brand ___ _ 
o Macintosh, model _____ _ 
o Game system, brand ____ _ 
o Other _________ _ 

o I don't own or use a computer. 

Which video display system(s) do you 
use? 
o Monochrome 
o Hercules 
o CGA 
o EGA 
o VGA 
o Super VGA 

Which peripheral(s) do you own or use 
with your computer? 
o 5 V4-inch disk drive 
o 3 V,-inch disk drive 
o CD-ROM drive 
o Dot-matrix printer 
o Fax modem 
o Hard disk 
o Laser printer 
o Letter quality printer 
o MIDI device 
o Modem 
o Mouse 
o PostScript printer 
o Sound card 
o Speakers 
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How much memory does your comput­
er have? 
o 640K or less 
o 1MB 
o 2MB 
o 4MB 
o 8MB 

Which operating system(s)/environ­
ment(s) do you use? 
o MS-DOS version ___ ___ _ 
o DR DOS version ______ _ 
o OS/2 
o Microsoft Windows 
o Tandy DeskMate 
o Other __________ _ 

Which parts of the magazine do you 
like the most? 
o Art Works 
o COMPUTE/NET 
o COMPUTE's Getting Started With spe-

cial sections 
o Editorial License 
o Features 
o Feedback 
o GamePlay 
o Hardware Clinic 
o IntroDOS 
o Multimedia PC 
o News & Notes 
o On Disk 
o PathWays 
o Personal Productivity 
o Point & Click 
o Programming Power 

o Reviews 
o SharePak 
o Test Lab 
o Tips & Tools 

Which of the following computer-related 
topics do you like to read about? 
o Databases 
o Desktop publ ishing 
o Disk management and MS-DOS 
o Education 
o Games and entertainment 
o Graphics (paint, draw, or CAD) 
o How to upgrade your PC 
o Integrated software 
o Local area networks (LANs) 
o Money management 
o Multimedia 
o New computer technologies 
o New hardware 
o Pen computing 
o Programming 
o Spreadsheets 
o Telecommunications 
o Windows 
o Word processing 
o Other _________ _ 

Where do you use your PC? 
o Home 
o Work 
o School 
o Other 

Where did you get this copy of 
COMPUTE? 
o Subscription 
o Newsstand 
o Other 

How long have you been reading 
COMPUTE? 
o Less than two years 
o Two years or more 

If you have a modem, which online serv­
ice(s) do you use? 
o America Online 
o CompuServe 
o COMPUTE/NET 
o Delph i 
o GEnie 
o Other _________ _ 



With CompuServe,you'll always

have more tolook forward to.

It's one thing to discover something you like.

But to realize there's more of it than you ever

imagined is even better. And that's what CompuServe

is all about.

Tap into travel information, hotel reserva

tions, stock quotes, hardware and software support,

a shopping mall, the news, interactive games, and

forums. For the experienced user, there's even free

software and shareware. On-screen menus and an

index make it all easy to access, so you get the most

out of your time and money.

A one-time membership fee and S7.95 a

month let you use our basic services as often as you

like: news, sports, weather, shopping, reference

materials, our E-mail service of 60 messages a month,

and more. Plus, there's a whole universe of other

services available at nominal additional charges.

For more information or to order, sec your

computer dealer or call 1 800 848-8199. Outside

the United States, call 614 457-0802. Because no

information service lets you dig deeper or farther

than CompuServe.

CompuServe0
The information service you won't outgrow.

Circle Reader Service Number 103

With CompuServe, you'll always 
have more to look forward to. 

It's one thing to discover something you like. 

But to realize there's more of it than you ever 

imagined is even better. And that's what CompuServc 

is all about. 

Tap in to travel information, hotel rescrV3-

[,ions, stock quotes, hardware and software support, 

a shopping mall, the news, interactive games, and 

forums. For the experienced user, there 's even free 

software and shareware. On-screen menus and an 

index make it all easy to access, so you get the most 

out of your rime and money. 

A one-time membership ree and 57.95 a 

month let you use OUf basic sen 'ices as often as you 

like: news, sports, weather, shopping, reference 

materials, our E-mail service of 60 messages a month, 

and more. Plus, there's a whole universe of other 

services available at nominal additional charges, 

For more infonnation or to order, see your 

computer dealer or call 1 800 848-8199. Outside 

the United States, call 614 457-0802. Because no 

infonnation service lets you dig deeper or farther 

than CompuServe. 

CompuServe~ 
The information service you won't outgrow. 

Circle Reader Service Number 103 



TEST LAB

Edited by Mike Hudnall

s there a Windows word proc

essor in your future? If you're

looking for power and fea
tures, the packages in this

month's Test Lab offer a number

of capabilities rarely seen in DOS

word processors: WYSIWYG ed

iting, desktop publishing's graph

ical and formatting tools, Win

dows' interactivity, and a com

mon user interface. Many of the

packages also boast special

tools to make them stand out

from the crowd, such as grammar

checkers, complete drawing pro

grams, equation editors, and ad

vanced macro languages.

One requirement shared by all

Windows word processors dis

cussed in this section is a power

ful computer: at least a 386SX

(though a 386DX or one of the 486

chips woufd be preferable) and

4MB of RAM. Most of the products

claim that they can run on a 286

with 1MB of RAM. But when you

read this claim, remember that you

can also jog underwater. Doing so,

however, will test your endurance,

and it won't take you very far. If you

have a lesser system, you'll have

to put up with very poor perform

ance from these programs; in

fact, you'd be better off using a

DOS word processor or GeoWrite.

That said, let's take a look at

the features most of the Windows

word processors share. You

might think of these as the

baseline of features—reasons to

make the switch to word process

ing under Windows. If you're con

sidering a word processor that

doesn't offer one or more of the

options mentioned here, you'll be

missing out on something

everyone else takes for granted.

Although most Windows word

processors share a majority of fea

tures, implementation varies con

siderably. WordPerfect still uses

boxes (entities separate from the

page and featuring their own edi

tor) instead of the more common

frames (entities integrated into the

page and using the same editor
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as the page) for graphics and

incidental text. Describe requires

that frames be created to contain

all text and graphics. Ami Pro's

frames are much easier to work

with than Word's. Ami Pro seems

to assume that you want to work

with the frame itself—sizing and

moving it—whereas Word seems

to assume that you're more inter

ested in working with the contents

of the frame and makes selecting

the frame and working with its size

and shape more awkward.

Almost all of the word proces-

Windows word processors al

most universally offer styles for

specially formatting paragraphs

(WordPerfect also allows for open-

ended styles that format the en

tire document). In addition, they

provide options like lines and bor

ders that allow you to box a page

or a frame and to put lines be

tween paragraphs and columns.

You can find table editors on

many Windows word processors.

Most allow you to create a table by

simply specifying the number of

cells and rows, while others re-
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An attractive, easy interface is part of the Windows appeal

sors feature draft mode (allowing

you to work with text as text rath

er than as formatted copy), but

Ami Pro retains almost all of the

formatting in draft mode while

WordPerfect's draft mode looks al

most exactly like what you would

find in WordPerfect for DOS

(right down to the light gray let

ters and the blue background).

Most Windows word proces

sors also provide a series of dif

ferent kinds of views. In addition

to the draft mode, most allow you

to zoom in on your text to see it

enlarged and zoom out to see a

whole page or two side-by-side

pages at once. Some allow you

to specify a view according to per

centage of full size.

quire additional information about

the width of the table. Some allow

for the full range of table customi

zation, including varying column

width and row height, different out

line schemes, shading, table out

line, captioning, and even colors.

Most also offer a rudimentary

spreadsheet operation.

Not only Windows word proc

essors but nearly all word proc

essors now offer spelling checkers

as standard equipment. Thesaurus-

es have also gone from useful ex

tras to must-haves, and now the

thesaurus in WordStar for Win

dows goes the extra mile, offering

definitions, alternative words,

near synonyms, and antonyms.

Mail merge (or simply merge)

TEST LAB 

Edited by Mike Hudnall 

I
s there a Windows word proc­
essor in your future? tf you 're 
looking for power and fea­
tures , the packages in this 

month's Test Lab offer a number 
of capabilities rarely seen in DOS 
word processors: WYSIWYG ed­
iting, desktop publishing's graph­
ical and formatting tools, Win­
dows' interactivity, and a com­
mon user interface. Many of the 
packages also boast special 
tools to make them stand out 
from the crowd, such as grammar 
checkers, complete drawing pro­
grams, equation editors, and ad­
vanced macro languages. 

One requirement shared by all . 
Windows word processors dis­
cussed in this section is a power­
ful computer: at least a 386SX 
(though a 386DX or one of the 486 
chips would be preferable) and 
4MB of RAM. Most of the products 
claim that they can run on a 286 
with 1 MB of RAM. But when you 
read this claim, remember that you 
can also jog underwater. Doing so, 
however, will test your endurance, 
and it won't take you very far. If you 
have a lesser system, you'll have 
to put up with very poor perform­
ance from these programs; in 
fact , you'd be better off using a 
DOS word processor or GeoWrite. 

That said, let's take a look at 
the features most of the Windows 
word processors share. You 
might think of these as the 
baseline of features-reasons to 
make the switch to word process­
ing under Windows. If you're con­
sidering a word processor that 
doesn't offer one or more of the 
options mentioned here, you'll be 
missing out on something 
everyone else takes for granted. 

Although most Windows word 
processors share a majority of fea­
tures, implementation varies con­
siderably. WordPerfect still uses 
boxes (entities separate from the 
page and featuring their own edi­
tor) instead of the more common 
frames (entities integrated into the 
page and using the same editor 
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as the page) for graphics and 
incidental text. DeScribe requires 
that frames be created to contain 
all text and graphics. Ami Pro's 
frames are much easier to work 
with than Word's. Ami Pro seems 
to assume that you want to work 
with the frame itself-sizing and 
moving ii-whereas Word seems 
to assume that you're more inter­
ested in working with the contents 
of the frame and makes selecting 
the frame and working with its size 
and shape more awkward. 

Almost all of the word proces-

I . : : 

Windows word processors al­
most universally offer styles for 
specially formatting paragraphs 
(WordPerfect also allows for open­
ended styles that format the en­
tire document). In addition, they 
provide options like lines and bor­
ders that allow you to box a page 
or a frame and to put lines be­
tween paragraphs and columns. 

You can find table editors on 
many Windows word processors. 
Most allow you to create a table by 
simply specifying the number of 
cells and rows, whi le others re-
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An attractive. easy interface is part of the Windows appeal. 

sors feature draft mode (allowing 
you to work with text as text rath­
er than as formatted copy), but 
Ami Pro retains almost all of the 
formatting in draft mode while 
\M:JrdPerfect's draft mode looks al­
most exactly like what you would 
find in WordPerfect for DOS 
(right down to the light gray let­
ters and the blue background). 

Most Windows word proces­
sors also provide a series of dif­
ferent kinds of views. In addition 
to the draft mode, most allow you 
to zoom in on your text to see it 
enlarged and zoom out to see a 
whole page or two side-by-side 
pages at once. Some allow you 
to specify a view according to per­
centage of full size. 

quire additional information about 
the width of the table. Some allow 
for the full range of table customi­
zation, including varying column 
width and row height, different out­
line schemes, shading, table out­
line, captioning, and even colors. 
Most also offer a rudimentary 
spreadsheet operation. 

Not only Windows word proc­
essors but nearly all word proc­
essors now offer spelling checkers 
as standard ecuipment. Thesaurus­
es have also gone from useful ex­
tras to must-haves, and now the 
thesaurus in WordStar for Win­
dows goes the extra mile, offering 
definitions, alternative words, 
near synonyms, and antonyms. 

Mail merge (or Simply merge) 



is a powerful feature that you can

use for preparing mass mailings

for business purposes (you can

also use it to generate a Christ

mas letter or other announce

ments of family events} using a da

ta file and a form letter.

Most of the programs dis

cussed here offer macros, allow

ing you to assign a macro to a

menu or to an icon bar. In this

way, you can make your person

al commands as much a part of

the program as the commands

created by the programmers.

Look for special file managers

with your word processor. Look for

master document features, too.

Most Windows word processors

allow you to group document files

into complete publications for print

ing and editing. Most also offer ta

ble of contents and index genera

tors that will automatically create

these features for a master doc

ument, checking each of the com

ponent documents in turn.

The remainder of the shared fea

tures are common user interface

features—the standard keypress

es and the file-management and

document-processing tools.

What will probably impress you

most about these packages is

their desktop publishing capabil

ities. Each approaches desktop

publishing in a slightly different

way, but all seem to have it as

their central focus. Let's face it—

no one would put up with a Win

dows application if it didn't offer

superior formatting and control

along with its WYSIWYG interface.

Many writers will prefer to stick

with the DOS word processor they

know and love. If you're looking be

yond writing and you want to turn

out splendid documents, you

must ask yourself which tools are

most valuable to you, seek out the

word processor that offers them,

and start publishing.

No one can pick the perfect

word processor for you, but the

reviews and the features grid in

this month's Test Lab will help

you make that decision.

ROBERT 8IXBY

Ami Pro 2.0

IBM PC and compatibles (80286 or

faster), 1MB RAM (2MB or more

recommended)—$495*

LOTUS DEVELOPMENT

1000 Abernathy Rd. NE

Building 400, Ste. 1700
Atlanta, GA 30328

(800)831-9679

(404) 391-0011

AMI PRO 2.0
Like the other word processors in

this month's Test Lab, Ami Pro

2.0 has a long list of text-editing,

page-formatting, screen-display,

and file-handling features. It's

both fast and polished, as you'd

expect with a second-generation

application from a company the

size of Lotus. Choosing the best

of the group is a tough decision;

these are all powerful programs.

However, Ami Pro clearly stands

out from the others in three are

as: advanced layout features, ex

tensive support for styles and mac

ros, and a fully integrated design.

Using Ami Pro's layout fea

tures, it's relatively easy to create

documents that look as though

they've been desktop published.

Ami Pro uses frames to let you cre

ate, move, and alter the size of

your graphics. You can fix a

frame on a page, repeat it across

multiple pages, make it transpar

ent, and have text flow around it.

Graphics can be rotated, flipped,

scaled, cropped, edited, adjusted

for gray scale, and created from

scratch with the built-in drawing

and charting programs.

Ami Pro includes support for 24-

bit color graphics (for 16 million col

ors) and can create multiple col

umns of varying widths and gutter

sizes. Styles let you save and

reuse a document's text and lay

out preferences. In Ami Pro, styles

can include text, graphics, and au

tomatic macros. They're very flexi

ble; you can move a style from a

document to a style sheet or the

other way around. You can create

AmiPro
. Windows

-

■

global styles that operate across

more than one document—so that

when you change a style, the con

nected documents are updated

automatically.

The macro language is just as

powerful. Add your own menu

items and create dialog boxes

that change according to the us

er's response. Once you've cre

ated a macro, link it to one of Ami

Pro's Smartlcons. These are small

icons that you can place at the

top, bottom, left, or right of the

screen. You can also float them so

they can be quickly moved to the

least obtrusive position.

The package ships with 100

icons; you can use the integrated

drawing program to create your

own. The program comes with 27

preprogrammed Smartlcons, in

cluding ones that let you save,

print, cut, paste, change viewing

levels, show or hide the ruler, and

check a document's spelling.

With the new Power Fields fea

ture, you can embed a macro di

rectly into a document. For exam

ple, a business letter could auto

matically request the name of a per

son, look up the current address

in another file, and place the

name and address into the letter

using a special predefined format.

In the area of integrated de

sign, Ami Pro receives top honors

for its group of tightly integrated pro-

"Cuslomers who have purchased a version

of Ami Pro since March 1, 1991. are eligi

ble lo upgrade to Ami Pro 2.0 for a suggest

ed retail price of S49. For all other Ami Pro

users, upgrades are S99.
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is a powerful feature that you can 
use for preparing mass mailings 
for business purposes (you can 
also use it to generate a Christ­
mas letter or other announce­
ments of family events) using a da­
ta file and a form letter 

Most of the prog rams dis­
cussed here offer macros, allow­
ing you to assign a macro to a 
menu or to an icon ba r. In this 
way, you can make your person­
al commands as much a part of 
the program as the commands 
created by the programmers. 

Look for special file managers 
with your word processor Look for 
master document features, too. 
Most Windows word processors 
allow you to group document files 
into complete publications for print­
ing and editing. Most also offer ta­
ble of contents and index genera­
tors that wi ll automatically create 
these features for a master doc­
ument, checking each of the com­
ponent documents in turn. 

The remainder of the shared fea­
tures are common user interface 
features- the standard keypress­
es and the file-management and 
document-processing tools. 

What will probably impress you 
most about these packages is 
their desktop publishing capabil­
ities. Each approaches desktop 
publishing in a slightly different 
way, but all seem to have it as 
their central focus. Let's face it­
no one would put up with a Win­
dows application if it didn't offer 
superior formatting and co ntrol 
along with its WYSIWYG intertace. 
Many wri ters wi ll prefer to stick 
with the DOS word processor they 
know and love. If you're looking be­
yond writing and you want to turn 
out splendid documents, you 
must ask yourself which tools are 
most valuable to you, seek out the 
word processor that offers them, 
and start publishing. 

No one can pick the perfect 
word processor for you, but the 
reviews and the features grid in 
this month's Test Lab will help 
you make that decision. 
ROBERT BIXBY 

Ami Pro 2,0 
IBM PC and compatibles (80286 or 
laster), 1 MB RAM (2MB or mol'll 
recommended)-$495' 

LOTUS DEVELOPMENT 
1000 Abernalhy Rd, NE 
Building 400, Sle, 1700 
Atlanla, GA 30328 
(800) 831-9679 
(404) 391-0011 

AMI PRO 2.0 
Like the other word processors in 
this month's Test Lab, Ami Pro 
2.0 has a long lisl of text-editing, 
page-formatting , screen-display, 
and file-handling features . It 's 
both fast and polished, as you'd 
expect with a second-generation 
application from a company the 
size of Lotus. Choosing the best 
of the group is a lough decision; 
these are all powerfu l programs. 
However, Ami Pro clearly stands 
out from the others in three are­
as: advanced layout features, ex­
tensive support for styles and mac­
ros, and a fully integrated design. 

Using Ami Pro's layout fea­
tures, it's relatively easy to create 
documents that look as though 
they've been desktop published. 
Ami Pro uses frames to let you cre­
ate, move, and alter the size of 
your graphics . You can fix a 
frame on a page, repeat it across 
multiple pages, make it transpar­
ent, and have text flow around it. 
Graphics can be rotated, flipped, 
scaled, cropped, edi led, adjusted 
for gray scale, and created from 
scratch with the built-in drawing 
and charting programs. 

Ami Pro includes support for 24-
bit color graphics (for 16 million col­
ors) and can create multiple col­
umns of varying widths and gutter 
sizes. Styles let you save and 
reuse a document's text and lay­
out preferences. In Ami Pro, styles 
can include text, graphics, and au­
tomatic macros. They're very flexi­
ble; you can move a style from a 
document to a slyle sheet or the 
other way around. You can create 

• 
~ AmiPrO 
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global styles that operate across 
more than one document-so that 
when you change a style, the con­
nected documents are updated 
automatically. 

The macro language is just as 
powerful. Add your own menu 
items and create dialog boxes 
that change according to the us­
er's response. Once you've cre­
ated a macro, link it to one of Ami 
Pro's Smartlcons. These are small 
icons that you can place at the 
top, bottom, left, or right of Ihe 
screen. You can also float them so 
they can be quickly moved to the 
least obtrusive position. 

The package ships with 100 
icons; you can use the integrated 
drawing program to create your 
own. The program comes with 27 
pre programmed Smarttcons, in­
cluding ones that let you save, 
print, cut, paste, change viewing 
levels, show or hide the ruler, and 
check a document's spelling. 

With the new Power Fields fea­
ture, you can embed a macro di­
rectly into a document. For exam­
ple, a business letter could auto­
matically request the name of a per­
son, look up the current address 
in another file , and place the 
name and address into the letter 
using a special predefined format. 

In the area of integrated de­
sign, Ami Pro receives top honors 
for its group of tightly integrated pro-

-Customers who have purchased a version 
of Ami Pro since March " 1991, are eligi­
ble to upgrade to Ami Pro 2.0 for a suggest­
ed retail price of $49. For all other Ami Pro 
users. upgrades are S99. 
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Use Ami Pro 2.0's revision marking to keep track of document changes.

grams: a draw program, a chart-

making program, an image-proc

essing program, a table editor, an

equation editor, and an outlining

program. Because of its unique in

tegration of component programs,

everything in a document can be

edited in place, right on the page,

including drawings, charts, equa

tions, scanned images, and ta

bles. You make your changes in

the document itself, not in a sepa

rate screen or view.

Other significant features in

Ami Pro include the ability to in

telligently import documents in a

variety of word processor for

mats, including WordPerfect, Mi

crosoft Word, Microsoft Word for

Windows 1.0, WordStar, Multi-

Mate, DisplayWrite, ASCII, RFT,

and DCA. Lotus calls this "no-

questions-asked file import." You

simply select the file, and the pro

gram takes care of converting the

file to Ami Pro's native format.

Ami Pro can also import an

impressive number of graphics for

mats, including EPS, PIC, PCX,

CGM, HPGL, WMF, TIF, BMP,

and DrawPerfect. In addition, you

can import data from other kinds

of applications, including those

that save in dBASE, Paradox, Lo

tus 1-2-3, Excel, SuperCalc, and
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DIF formats. A handy Status Bar

lets you quickly alter the current

style sheet, typeface, type size,

editing mode, page number, and

location of the Smartlcon display.

It dynamically displays program

information by showing such mes

sages as Playing macros and

Comparing documents. It also

works with Lotus's own cc:Mail

for Windows to let you know

when you have new mail.

Add extensive revision marking

and document comparison, ex

tremely fast printing, four-level un

do, and a free copy of Adobe

Type Manager, and you have a

powerful word processor that you

won't outgrow any time soon. On

the downside, you can't edit in the

facing-pages view, select a whole

document, or flow text from frame

to frame. And if you want the mac

ros manual, you'll have to spring

for the developer's kit, which

costs an additional $9.95.

All in all, Ami Pro is well round

ed and feature rich. It stands up

well against any Windows word

processor, including Microsoft

Word for Windows 2.0. For ad

vanced layout features, it's defi

nitely the one to choose.

DAVID ENGLISH

Circle Reader Service Number 304

DESCRIBE WORD
PROCESSOR 3.0
Describe Word Processor 3.0 is

sort of like a quirky college friend

of mine: It doesn't always act the

way you expect it to; it's not afraid

to take a different route to reach

the same destination; and, de

spite its strange appearance, it's

a hard worker that gets the job

done. Some of the program's ec

centricities can be traced back to

its origin—it was first released for

IBM's OS/2 operating system.

The Describe disks include ver

sions for both Windows and OS/2,

making the program a logical

choice if your working environment

includes both operating systems.

Describe works with the con

cept of objects. Each distinct

block of text—such as a head

line, footnote, outline, or body

copy—is treated as a separate ob

ject, which can be moved, re

sized, and restyled. Graphics are

treated as objects as well. While

this approach makes working

with complicated document for

mats a snap, it does take some

getting used to if you've never

dealt with an object-oriented

word processor.

The text and graphics tools,

contained in small, movable

toolbar windows, can be sent

away or summoned back with a

simple click of the right mouse but

ton, so they don't use valuable

screen real estate when they're

not needed. The dialog boxes

and menu choices are logically la

beled and arranged, and compre

hensive help is available for

each item. You hide the toolbars

and turn off the rulers and bor

ders to get the maximum amount

of text onscreen.

Describe deviates from accept

ed Windows standards in some

operations, probably a by-prod

uct of its OS/2 heritage. For exam

ple, to access a menu, you press

and then release Alt before press

ing the letter of the menu, instead

of holding Ait down while press-
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Use Ami Pro 2.0'5 revision marking to keep track of document changes. 

grams: a draw program, a chart­
making program, an image-proc­
essing program, a table editor, an 
equation editor, and an outlining 
program. Because of its unique in­
tegration of component programs, 
everything in a document can be 
edited in place, right on the page, 
including drawings, charts, equa­
tions , scanned images, and ta­
bles. You make your changes in 
the document itself, not in a sepa­
rate screen or view. 

Other significant featu res in 
Ami Pro include the ability to in­
telligently import documents in a 
variety of word processor for­
mats, including WordPerfect, Mi­
crosoft Word, Microsoft Word for 
Windows 1.0, WordStar, Multi­
Mate, DisplayWrite, ASCII , RFT, 
and DCA. Lotus calls this "no­
questions-asked file import" You 
simply select the file , and the pro­
gram takes care of converting the 
file to Ami Pro's native format. 

Ami Pro can also import an 
impressive number of graphics for­
mats, including EPS, PIC , PCX, 
CGM, HPGL, WMF, TIF, BMP, 
and DrawPerfect In addition, you 
can import data from other kinds 
of applications, including those 
that save in dBASE, Paradox, Lo­
tus 1-2-3, Excel , SuperCalc , and 
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DIF formats. A handy Status Bar 
lets you quickly alter the current 
style sheet, typeface, type size , 
editing mode, page number, and 
location of the Smartlcon display. 
It dynamically displays program 
information by showing such mes­
sages as Playing macros and 
Comparing documents. It also 
works with Lotus's own cc :Mail 
for Windows to let you know 
when you have new mail. 

Add extensive revision marking 
and document comparison, ex­
tremely fast printing, four-level un­
do , and a free copy of Adobe 
Type Manager, and you have a 
powerful word processor that you 
won't outgrow any time soon. On 
the downside, you can't edit in the 
facing-pages view, select a whole 
document, or flow text from frame 
to frame. And if you want the mac­
ros manual , you'll have to spring 
for the developer's kit , which 
costs an additional $9.95. 

All in all , Ami Pro is well round­
ed and feature rich. It stands up 
well against any Windows word 
processor, including Microsoft 
Word for Windows 2.0. For ad­
vanced layout features , it's defi­
nitely the one to choose. 
DAVID ENGLISH 

Circle Reader Service Number 304 

DESCRIBE WORD 
PROCESSOR 3.0 
DeScribe Word Processor 3.0 is 
sort of like a quirky college friend 
of mine: It doesn't always act the 
way you expect it to; it's not afraid 
to take a different route to reach 
the same destination; and , de­
spite its strange appearance, it's 
a hard worker that gets the job 
done. Some of the program's ec­
centricities can be traced back to 
its origin-it was first released for 
IBM's OS/2 operating system. 

The DeScribe disks include ver­
sions for both Windows and OS/2, 
making the program a logical 
choice if your working environment 
includes both operating systems. 

DeScribe works with the con­
cept of objects. Each distinct 
block of text-such as a head­
line, footnote, cutline, or body 
copy-is treated as a separate ob­
ject , which can be moved, re­
sized, and restyled. Graphics are 
treated as objects as well. While 
this approach makes working 
with complicated document for­
mats a snap, it does take some 
getting used to if you 've never 
dealt with an object-oriented 
word processor . . 

The text and graphics tools, 
contained in small, movable 
tool bar windows , can be sent 
away or summoned back with a 
simple click of the right mouse but­
ton, so they don't use valuable 
screen real estate when they're 
not needed. The dialog boxes 
and menu choices are logically la­
beled and arranged, and compre­
hensive help is available for 
each item. You hide the toolbars 
and turn off the ru lers and bor­
ders to get the maximum amount 
of text onscreen. 

DeScribe deviates from accept­
ed Windows standards in some 
operations, probably a by-prod­
uct of its OS/2 heritage. For exam­
ple, to access a menu, you press 
and then release Alt before press­
ing the letter of the menu, instead 
of holding Alt down while press-



PLAN-MAKING SOFTWARE:

DESIGN YOUR OWN HOME™

&bracadata
the source ol plan-making software

ARCHITECTURE
Everything you need to draw architectural plans, from floor plans to
structural details, is now available at the click of your computer mouse.

This object oriented program features auto dimensions, pre-drawn objects,
plan layering, and printer support.

. r

INTERIORS LANDSCAPE
Draw room plans, arrange furniture Create complete landscape plans,
and explore color schemes. Great age plants to determine correct
for kitchen and bath design! placement, and prepare shopping

list for your trip to the nursery.

MacConnection Price Per Program '5900

PC Connection Price Per Program $4goo

EVERYBODY'S PLANNER"

"... our low-priced

favorite"

Eric W. Skopec and

Laree Kiely, Taking

Charge: Time

Management For

Personal And

Professional

Productivity(1991

Addison-Wesley

Publishing Co., Inc.)-

Everybody's Planner

is an affordable and

easy-to-use project

manager which

contains two complete programs. SCHEDULES creates

critical-path-based P.E.R.T. charts and calendars, providing

7 text reports and 2 graph (Gantt) reports. FLOWCHARTS

uses 19 rotatable shapes in 9 sizes, vertical and horizontal

labeling, and color to depict flow.

*PC Connection $49 80

For FREE Color Catalog from Abracadata:

Call: 800-451-4871 or FAX: 503-683-1925
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GRAPHIC

VEGETABLE

GARDEN DESIGN

SPROUT! is a complete

planning tool for vegetable

gardeners. Its unique planting

tool produces a graphic,

scalable garden plan with

correct plant and row spacing.

In addition, SPROUT! contains

a fully editable database of vegetables for 7 climate regions; and it

prints out garden layouts, calendars, shopping lists, and reports.

!-

MacConnection...

$4j oo

PC Connection ...

$35°°

DESIGN YOUR OWN RAILROAD

vrlt it i.^.

■; . r. - i—

Design precision, to-scale, (HO, N, 2, 0, S, G) layouts and run Z

realistic railroad simulations. f

*PC Connection $3900 \
* Not currently available for Macintosh

PC Connection8 800-800-6823 j
MacConnectiorf 800-800-6827 1
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Everything you need to draw architectural plans. from floor plans to 
structural details, is now available althe chck of your computer mouse. 
This object oriented program features auto dimensions, pre-drawn objects. 
plan layering, and printer support. 
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INTERIORS 
Draw room plans, arrange furniture 
and explore color schemes. Great 
for kitchen and bath design! 

LANDSCAPE 
Creale complete landscape plans, 
age plants to determine correct 
placement, and prepare shopping 
list fot your trip to the nursery. 

MacConnection Price Per Program . . . ... ..... .. . t59 00 

PC Connection Price Per Program . ... . ... . ..... $49 00 

EVERYBODY'S PLANNER™ 
" .. . our low-priced 
favorite" 
Eric W. Skopec and 
Laree Kiely, Taking 
Charge: Time 
Management For 
Personat And 
Professional 
Productivity (1991 
Addison·Wesley 
Publishing Co. , Inc.). 

Everybody 's Planner 
is an affordable and 
easy-to-use project 
manager which 

contains two complete programs. SCHEDULES creates 
critical·path·based P.E.R.T. charts and calendars, providing 
7 text reports and 2 graph (Gantt) reports. FLOWCHARTS 
uses t 9 rotatable shapes in 9 sizes, vertical and horizonlal 
label ing, and color to depict flow. 
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For FREE Color Catalog from Abracadata: 
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' PC Connection .. .... .... ...... .. .. .$39 00 ~ 
• Not currenlfy available for Macinlosh .l! 
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ing the letter. And perhaps the

most annoying omission is the

lack of a draft mode for faster

screen refreshes. Although De-

Scribe is reasonably speedy on

machines with a 386DX chip or

better, it's quite poky on a 386SX.

What makes Describe a seri

ous contender in the Windows

word processor race? It features

a wonderful set of 50 predefined

style sheets, including brochures,

invitations, faxes, invoices, mem-

os, to-do lists, envelopes, and

more. Other well-implemented fea

tures include automatic drop

caps, DDE support, mail merge,

search and replace with pattern

matching, table generation, and au

tomatic handling of widows and or

phans. There's even a facility that

allows programmers to launch a

compiler from within DeScribe and

compile the current document, al

lowing you to use DeScribe as a

sophisticated text editor.

DeScribe's most unique fea

ture is its infinite undo capability.

Every action you've taken since

you most recently saved the file—

whether it's changing a word or

inserting a graphic—can be un

done a step at a time.

If there's a feature you're miss

ing, such as word count, you can

probably add it with DML (De

scribe Macro Language). This

comprehensive language, struc

tured like a hybrid of BASIC and

Pascal, is reasonably easy to
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Describe Word Processor 3.0
IBM PC and compatibles (80386SX

or faster, 80486 recommended),

3MB RAM (4MB recommended),

CGA or higher graphics (VGA

recommended), 2MB tree hard disk

space (10MB recommended);

mouse recommended—$495

(upgrades trom previous versions

free)

DESCRIBE

4047 N. Freeway Blvd.

Sacramento, CA 95834

(916) 646-1111

learn. DeScribe includes 30 sam

ple macros and a Macro Manual

with the package.

DeScribe's spelling checker

and thesaurus are a pleasure to

use. You can check the spelling of

a particular word, or you can auto

matically check all the text in a sin

gle object or the entire document.

The spelling checker also includes

definitions, which are particularly

handy if you're not sure you're us

ing the correct spelling of a word

for a particular context. While De

scribe has a conventional user dic

tionary, it also allows individual doc

ument dictionaries, so you can

add words and abbreviations that

are specific to a particular docu

ment. The thesaurus offers syno

nyms, antonyms, related words,

contrasted words, and compared

words, as well as definitions.

DeScribe's drawing tools are

as good as those found in some

basic structured drawing pro

grams. You can create art in 16

colors using filled or hollow cir

cles, Bezier curves, ovals, lines,

polygons, rectangles, rounded

rectangles, and squares. Line siz

es from hairline to 12 points and

22 fill patterns are also support

ed. Graphics may be grouped

and placed in front of or behind

other graphics or text. You can al

so import bitmap graphics in 20

formats, thanks to DeScribe's li

censed HiJaak technology. Text

import and export are flexible as

well, with almost 60 different for

mats supported. Most DOS word

processors and spreadsheets

are supported, but the only Win

dows formats included are Ami

Pro and Excel. You'll have to use

DDE or Microsoft Rich Text For

mat to transfer formatted data to

other Windows programs.

For any question not covered

in one of the exemplary manuals,

the company provides 90 days of

free technical support. After that,

File £d(t Search Styto Spell Ohjerls Draw Ulililirs Options Winitnw Help

DeScribe incorporates a powerful drawing package. Here is an example

of what you can do wilh the tools provided:

Efc* "p —■

lillliMily. |Cv|r 1.

DeScribe lets you import bitmap graphics in 20 formats.
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ing the letter. And perhaps the 
most annoying omission is the 
lack of a draft mode for faster 
screen refreshes. Although De­
Scribe is reasonably speedy on 
machines with a 386DX chip or 
better, it 's quite poky on a 386SX. 

What makes DeScribe a seri­
ous contender in the Windows 
word processor race? It features 
a wonderful set of 50 predefined 
style sheets, including brochures, 
invitations, faxes, invoices. mem­
os , to-do lists , envelopes, and 
more. Other well-implemented fea­
tures inc lude automatic drop 
caps, DDE support, mail merge, 
search and replace with pattern 
matching, table generation, and au­
tomatic handling of widows and or­
phans. There's even a facility that 
allows programmers to launch a 
compiler from within DeScribe and 
compile the current document, al­
lowing you to use DeScribe as a 
sophisticated text editor. 

DeScribe's most unique fea­
ture is its infinite undo capability. 
Every action you've taken since 
you most recently saved the file-­
whether it's changing a word or 
inserting a graphic- can be un­
done a step at a time. 

If there's a feature you're miss­
ing , such as word count, you can 
probably add it with DML (De­
Scribe Macro Language) . This 
comprehensive language, struc­
tured like a hybrid of BASIC and 
Pascal, is reasonably easy to 
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DeScribe Word Processor 3,0 
IBM PC and compatibles (80386SX 
orlasler, 80486 recommended), 
3MB RAM (4MB recommended), 
CGA or higher graphics (VGA 
recommended), 2MB Iree hard disk 
space (10MB recommended); 
mouse recommended:-S495 
(upgrades lrom previous versions 
Iree) 

DESCRIBE 
4047 N, Freewav Blvd. 
Sacramenlo, CA 95834 
(916) 646-1111 

learn. DeScribe includes 30 sam­
ple macros and a Macro Manual 
with the package. 

DeScribe's spelling checker 
and thesaurus are a pleasure to 
use. You can check the spelling of 
a particular word, or you can auto­
matically check all the text in a sin­
gle object or the entire document. 
The spelling checker also includes 
definitions, which are particularly 
handy if you're not sure you're us­
ing the correct spelling of a word 
for a particular context. While De­
Scribe has a conventional user dic­
tionary, it also allows individual doc­
ument dictionaries, so you can 
add words and abbreviations that 

are specific to a particular docu­
ment. The thesaurus offers syno­
nyms, antonyms, related words, 
contrasted words, and compared 
words, as well as definitions. 

DeScribe's drawing tools are 
as good as those found in some 
basic structured drawing pro­
grams. You can create art in 16 
colors using filled or hollow cir­
cles, Bezief curves, ovals, lines, 
polygons, rectang les, rounded 
rectangles, and squares. Line siz­
es from hairline to 12 points and 
22 fill patterns are also support­
ed. Graphics may be g rouped 
and placed in front of or behind 
other graphics or text. You can al­
so import bitmap graphics in 20 
formats, thanks to DeScribe's li­
censed HiJaak technology. Text 
import and export are flexible as 
well , with almost 60 different for­
mats supported. Most DOS word 
processors and spreadsheets 
are supported, but the only Win­
dows formats included are Ami 
Pro and Excel. You' ll have to use 
DDE or Microsoft Rich Text For­
mat to transfer formatted data to 
other Windows programs. 

For any question not covered 
in one of the exemplary manuals, 
the company provides 90 days of 
free technical support. After that, 

::; - - - - DesctIbe-c:\nrSCRmE\DATA\COMPUTE -~ - II 

DeScribe incorporates a powerful drawing packaee. Here is an example 
of what you can do with the lools provided: 

OeScribe lets you import bitmap graphics in 20 formats. 



Although
We Carry A
Variety Of
Products,

We Only Offer

Orchid Technology
Ramques 16/32

OK S229 2MB S329

2-8MB for PS/2 50/55/60/70/80

Ramqucst 8/16 OK $149 2MB S245

BOCA Research
BocaramAl Plus

OK St 19 2MB S199 2-BMB UM 4.0 ATs

Bocaram 2 for PS/2'sOK$159 2MB S219

BocaramXT-PS/2 30 1MBS159

AST Research
Rampa$ Rus 286 OK S189 2MB $289

up to 8MB for AT UM 4.0

Fastram2861MBS279

Cupld32OKS250

VIDEO GRAPHICS CARDS

ATI
Rr>14 Ultra 1MB PS/2 or ISA BUS $449

Graphics Ultra 1 MB S mouse S549

Graphics fentapw/l MB S389

NEW!!! VGA Stereo XL W/1MBS375

VGA Wonder XL 1 MB w/mouse S239

Orchid Technology
Fahrenheit 1280 w/IMB & Sierra $379

Pradesiener IIS B12K S199 1MB $219

Prafcsigner HMC for PS/2 I MB $399

BOCA Research
BOCA Super VGA512KS139 1MBS179

PRINTER UPGRADES

Hewlett Packard
Lasniet IIR 111. HID. IUP

1MB SG9 2MB Silfl 4MB S199

LaserJet II. UD

1MB S89 2MB S119 4MB S199

Panasonic 4420 & 44501
1MB S109 2MB $129 4MB S229

4450 1MB S179 4455 2MB S269

Epson EPL 6000 &EPL 7000
1MB S129 2MB $14f» 4MB S23n

IBM 4019 &4019E
1MB SUfi 2MB S139 3.5MBS199

OKI400,800,820,830,840
1MB S119 2MB $166 4MB S199

Canon
LBP 4 2MB S209 IJJP 8 2MB $119

MEMORY CHIPS & MODULES

DRAM

1X1-70SSS4.95 2F>6X4-80NS$4.99

1X1-8ONSR50 256X4-100NSS4.95

256X1-80NS $1.99 256X1-120NS S1.75

2r>6Xl-100NS S1.8T) 250X1-150NS $1.50

64X4-8K6 S3JM 64X1-100N5 S1.75

64X4-I00NS S2.75 &4X1-12QNR S1.60

SIMM/SIPP Modules
4X9-70NSS1694X£80NS$159

1X9-11X1NS S40

MATH CO-PROCESSORS

IIT
US83C87-16.-25.-20&-33S169

US83C87-16SX S115-20SX S129

New US83C87-40 S199

Intel
80387-16. -20. -25 & -33 $239

80387-1GSX S139 -20SX St89
80287-10 S7580287XLS99

o matter what you buy from us, you won't have

to worry. Because at Universal, we only stock

the most reliable products in the industry.

That's why, we can offer a 5 year warranty with a 30

day, money back guarantee on every product.

Plus, everything you buy is guaranteed to be

compatible with your computer. Because when you call

to order, our sales service department will help you

figure out exactly what you need. They're knowledgeable

about every product. So they'll be there for you every

step of the way.

And just to make sure nothing is overlooked, we also

check every product for quality before it's shipped. After

that, it's sent to you anyway you like.

So if you want to upgrade your

computer, use Universal. Because

everyone who orders a product

from us, gets the same thing.

IBM PS/2 UPGRADES I LAPTOP UPGRADES

IBM PS/2 Memory
6450604 2MB MOD 50Z. 55SX. 70 $99

6450608 2MB MOD 7QA21 S119

34R933& 77 4MB PS/2 SIMMS 199
6450129 8MB SIMM S564

30F5360 2MB &r 30-286 S99

6450128 4MB MOD 90 & 95 S219

6450902 2MB MOD 00 & 95 $129
6450609 2-8MB MOD 50,50Z. 60 S29H

6450605 2-8MB MOD 70 & 80 $350

34F3077 2-14MB MOD 70 & 80

w/2MB S298

34*3011 4-I6MB MOD 70S 80

w/4MB S429

PS/2 Hard Drives
Zero Skit for 50,50Z

52MB S395 80MB S495 105MB $599

124MB for 55SX. 70 S740 240MB $999

200MB SJ065

124M8 MDL 55SX. 70 S740 200MB S1065

Processor Upgrades
by Kingston
IBM PS/2 50.60.50Z, 30/286, 25/286.
AT. XT/286. AST Prmium/Bravo 286,

Compaq Deskpro 286. Portable III. HP

fedra ES/12. ES/8, NEC ftwrMae

286+, ftxtable +. V\sm 2R6; 20MHZ for

S34125MHZIbr$419

COMPAQ UPGRADES

Compaq Deskpro
Deskpro 386/20.25.20E, 25K & 386S

4MB Module S229 4MB exptoard S327

ttekpro 3B6/33 486/25 SiSempro

2MB Module 5149 6 soda imbrd.

w/2MB $395

1/3 height floppy disk drives
1.44MB S129 1.2MB S139

Portables
LTE 286 fMB S99 2MB S169 4MB $449

LTK 386S/20 1MB S209 4MB $399

386/20 1MB Upgrade kit 5145

4MBcxp/exlbrt)S375

SLT 286 1 MB S119 4MB S429
SLT386 1MB S129 2MB S255

4MBS435

800/899-8518

UNIVERSAL

UNIVERSAL MEMORY PRODUCTS 15451 Redhill. Suite E,

Tustin, CA 92680 □ Phone: 714/258-2018 Fax: 714/258-2818

Hours M - F 6:30 - 5:00 SAT 8*0 -1-00 PST

Toshiba
TI200XE/SE, T1600, T3100E, T3100SX.

T3200SX. T5100. T5200.2MB S112

T320OSXC 2MB S159 4MB 8329

TJOOOSE/XE/LB & T2000SX 1MB $119

2MB $229

T1000I£ S T2000SX 4MB S4I9

13100SX. 13200SX 4MB S229

13200 3MB S254

Megahertz Laptop Modems
2400 BD internal Sl49w/MNP5S210

2400/9600 KAX/Modem w/MNP5 S319

NEC UPGRADES

Rwmnale SX 2MB S395 4MB S575

Poutrmale SX Plus 2MB $299 4MB S525

PowermaeSX/20

2MB CPU $189

2MBEXPS235

Powismale 386/

20/25 2MB S325

8MB S799

ZENITH

UPGRADES

Z-386/20/25/33

sid33K 1MBS64

4 MB $21!)

MatcrsfalSL.

386SX 2MB S199

SlimsPoH/

SuperSpon. SX.

286KS159

TurbnSpon 386,

3fXlE 1MB S149

4M!) $495

Same day

shipping by

UPS. Federal

Express or

DHL Order

worldwide by

RO, C.O.D..

APO, FPO &

credit card

with no

surcharge

added. 20%

restocking fee

□n all non-

defective

MEMORY PRODUCTS
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Although 
We Carry A 
Variety Of 
Products, 

We Only Offer 
Quality. 

EXPANSION BOARDS 
Orchid Technology 

Ramques. 16(32 
OK S229 2MB $329 
2.lJMB for PS/2 50/5:,/00/70/00 
Ramques. 8/16 OK $149 2MB S245 

BOCA Research 
Ilornrim N. Rus 
OK SI19 2MB SI99 2.lJMB UM 4.0 A., 
Ilornrim 2 for PS/2', OK SI59 2MB S219 
\looJr;m AT·PS/2 30 1MB SI59 

AST Research 
Raint'lll' Rus 296 OK SlIll 2MB S289 
up w 8MB for AT UM 4.0 
"""" 296 1MB S279 
OJpi! 32 OK S250 

VIDEO GRAPHICS CARDS 
ATI 
8514 U"' 1MB PS/2 or lSI BUS $449 
Grnphics Uirn 1MB & """'" S549 
~\iln"""w/IMB S389 
NEWl !! VGASmnXL w/ lMB 8375 
VGA " bnOCr XL 1MB w/""" S239 

Orchid Technology 
f'ahrenlicill296 w/IMB & Slcm! $379 
_;gner liS ,,12KSI99 1MB $219 
-$1<f liMe for PS/2 1MB $399 

BOCA Research 
BOCASufX'f \'GA 512KSI39 1MB SI79 

PRINTER UPGRADES 
Hewlett Packard 
1"",,-, li P. III. 1I1D. IIIP 
1MB S69 2MB SII9 4MB SI99 
\.mieI II. 110 
1MB S89 2MB 5119 4MB SI99 

Panasonlc 4420 & 44501 
1MB 51\lJ 2MB SI29 4MB S229 
4450 1MB SI79 4455 2MB S26f) 

Epson EPL 6000 & EPL 7000 
1MB SI29 2MB SI45 4MB S235 

IBM 4019 & 4019E 
1MB 5115 2MB SI39 3.5MB8199 

OKI 400, 800, 820, 830, 840 
1MB 5119 2MB SI69 4MB SI99 

Canon 
UlP 42MB 5289 IBP 82MB $ 119 

MEMORY CHIPS & MODULES 
DRAAI 

I X 1-701<> $4.95 256.\4.lJ01<> 54.99 
IXI.lJOI<> 54l">D 256.14-1001<> 54.95 
2'"J6X I.lJO>S 51.99 256X1-12I11<> 51.75 
256X\-IOOi':3 SI.85 256X 1-150i':3 51.50 
64X4.lJ01<> $3.00 64XI-lOOI<> SI.75 
6414-1001<> S2.75 64X I -12I1~ 51.00 

SIMM/SIPP Modules 
4XS-701<> S 169 41f9.lJO~ S 159 
I XS- 70~ 54 2 IIf9.lJO $41 
IXS-lOO~ 540 

MATH CO-PROCESSORS 
liT 
tmlC87-16. -25. -211 & ~5169 
tmlC87-16SX 5115 -2fl)X 5129 
New =7-40 Sf99 

Intel 
00397-16. -211. -25 & ~ S239 
003B7-16SX SI39 -2fl)X SIII9 
B0287-1O 875 00297X1. S99 

N
o matter what you buy from us, you won't have 
to worry. Because at Universal, we only stock 
tbe most reliable products in tbe industry_ 

That's wby, we can offer a 5 year warranty witb a 30 
day, money back guarantee on every product. 

Plus, everything you buy is guaranteed to be 
compatible with your computer. Because when you call 
to order, our sales service department will help you 
figure out exactly what you need. They're knowledgeable 
about every product. So they'll be there For you every 
step of the way. 

And just to make sure notbing is overlooked, we also 
check every product for quality before it's After 
that, it's sent to you anyway you like. 

So if you want to upgrade your 
computer, use Universal. Because 
everyone who orders a product 
from us, gets the same thing. 

IBM PS/2 UPGRADES 
IBM PS/ 2 Memory 
6451J6Ol 2MB MOD SOZ. 55SX. 70 S89 
645060B 2MB MOD 70A21 SI19 
34r2933 & 77 4MB PS/ 2 SIMM $199 
6450129 BMB SIMM 5564 
3Of031iO 2MB for 30-296 S99 
6450129 4MB MOD 90 & 95 5219 
6450002 2MB MOD 90 & 115 $129 
64501i09 2.lJMB ~«JD 50. SOZ.OO 5296 
6450005 2.lJMB ~«JD 70 & 00 $350 
34rJ077 2-14MB ~«JD 70 & 00 
w/2MB S29B 
34rJO II 4-16MB MOD 70& 00 
w/4MB 5429 

PS/ 2 Hard Drives 
7.ero SItt for 50. SOZ 
52MB $31l5 111MB 5495 1115MB SS99 
124MB for 55iil 70 S740 240MB S!I99 
2110MB $1065 
124MB MDL 55SX. 70 S740 2110 MB SUm 

Processor Upgrades 
by KIngston 

IBM PS/2 50.00. fIJI.. 3012lI6. 2512l16. 
AT. ATI2lI6. !Sf Pmnlurn/Brolo 296. 
(»m\XII \XsI:pro 296. _ III. HP 
\\:am m/ 12. m/8. Nfl: flJ>mll:lI: 
286>. _ ' . f:p<Ml2ffi 2I1MHZ for 
$34 1 25MHZ ror S419 

COMPA UPGRADES 
Compaq Deskpro 
\XsI:pro 300/211. 25. 2OE. 25E & 300S 
4MB ~kKIJ. S229 4MB eqXxmf 5327 
\XsI:pro 300/33 400/25 Sy.;ianpro 
2MB ~kKIJ. $149 6 ""*" c:ql \rd. 
w/2MB $31l5 

1/ 3 height noppy disk drives 
1.44MB 5129 1.2MB $139 

Portables 
Lm 296 1MB S!19 2MB 5169 4MB $449 

Lm 300S/2I1 1MB S289 4MB S300 
300/211 1M B \WOIl kil SI45 
4MB cxp/"-'l Ird $375 
SLT 200 1MB SII9 4MB 5429 
SLT 300 1MB SI29 2MB 8255 
4MB 5435 

LAPTOP UPGRADES 
Toshiba 
T12QOWSI: T11iOO. r.JlOO& r.J lOOSt 
r.J2OOlX. 75100. 102110. 2MB S 112 
r.J2QOSXC 2MB SI59 4MB $329 
THXIOOE/XE/LE&T.!!XXllX IM BSII9 
2MB $2..'9 
TlfXXIlE& T.!!XXllX4MB $419 
r.JlOOSl T.l2OOSX 4MB S229 
r.J2QO 3MB $254 

Megahertz Laptop Modems 
2400 BD intcrna\ 8 149 w/~I~P5 5210 
2400/9600 ~'AX/~f<xbn w/ MNP5 $319 

NEC UPGRADES 
fIJ>"""" SX 2MB $31l5 4MB 5575 
fIJ>"""" SX R", 2MB 5299 4MB S525 
fIJ>"""" SXI20 
2MBC~81119 
2MB EXP 5235 
fl>wcm"" 386/ 
211/25 2MB $325 
BMBS799 

7n1OO/2I1/25/33 
Old 33f; 1MB S64 
4 MB S219 
M.wl"" SI. 
3IfflX 2MB SI99 
~ .. 11>rt/ 
SU~.SX. 
296E SI59 
ThrOOStx>rt 300. 
386E 1MB $149 
4MB $495 

800/899-8518 

UNIVERSAL 
UNIVERSAL MEMORY PRODUCTS 15451 Redhill, Suite E. 
Tustin. CA 92680 0 Phone: 714 1258-2018 Fax: 7141258·2818 

Hou~ M • F 6:30 - S:OO SAT 8:00 - 2:00 PST 

Same day 
shipping by 
UPS, FedenJ 
Express or 
OHl. Order 
worldwide by 
P.O .. C.O.D .. 
APO, FPO & 
credit card 
with no 
surcharge 
added. 20% 
restocking fee 
on all non­
defective 
returns. 

MEMORY PRODUCTS 
Tsr' -
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plan to pay $95 per year or $10

for the first three minutes and $1

per minute after that to get your

questions answered. The compa

ny also has a support BBS.

If you can live with DeScribe's

user-interface oddities, you'll find

it a capable and powerful word

processor. Although it lacks some

features, such as automatic foot

notes and a draft mode, its superi

or object-oriented page-layout

capabilities make it an excellent

choice for those needing a word

processor with desktop publishing

capabilities.

DENNY ATKIN

Circle Reader Service Number 305

MICROSOFT WORD
FOR WINDOWS 2.0
In Windows-land, Microsoft Word

for Windows has always been the

word processor to beat. With Ami

Pro 2.0 and WordPerfect 5.1 for

Windows, the competition's hotter,

but for my money, Word for Win

dows 2.0 is still king of the hill.

WinWord 1.1 was a solid word

processor that introduced a fea

ture that was to become the most

imitated interface element in the

Windows world—the toolbar.

With version 2.0 of WinWord, Mi

crosoft has taken the toolbar and

dramatically extended it to in

clude a full row of buttons for the

most common tasks.

*S129 for previous users of Word for Win

dows and for competitive upgrades.
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Microsoft Word for Windows 2.0

IBM PC and compatibles (80286 or

taster). 2MB RAM, EGA or higher

graphics, 5MB free hard disk space

(15MB for all options); mouse

recommended—$495*

MICROSOFT

One Microsoft Way

Redmond, WA 98052-6399

(800) 426-9400

(206) 882-8080

Since the features accessed

by the toolbar are at the heart of

WinWord, iet's take a quick

toolbar tour. Going from left to

right, you'll find buttons for open

ing and saving files; cutting, cop

ying, and pasting; undoing; cre

ating numbered and bulleted

lists; building tables; creating

frames; drawing (WinWord has

an on-board drawing program);

graphing; printing envelopes;

checking your spelling; printing;

and zooming between full-page

and 100-percent views.

Almost better than these new but

tons is the fact that you can add

your own. You can map any native

WinWord command or any macro

you've created to a button. Here's

a simple example of a button I've

added to WinWord's toolbar.

I found that I spent a lot of time

either typing the date in docu

ments or going through WinWord's

menus to insert the current date.

I decided it would be nice to have

a button on the toolbar for this

chore. First, 1 created a macro to

insert the date using the following

keystrokes: Alt-!, T, Down Arrow,

Down Arrow, Enter. Next, I double-

clicked on the toolbar to bring up

the options dialog. I selected my

insert-date macro's name, indicat

ed where on the toolbar I wanted

my button, and chose a button de

sign from the list of those available.

I clicked on Change, and my new

button was on the toolbar. That's

all there was to it.

Looking beyond WinWord's

new buttons, you'll find that the rib

bon and ruler, familiar from Win

Word 1.0, are present in 2.0 but

they're combined. The ribbon

sports drop-down list boxes for

styles, fonts, and font sizes, plus

buttons for styles (bold, italic, and

underline), justification (left, cen

ter, right, and proportional), and

tab settings (left, right, center,

and decimal), as well as a button

to turn paragraph marks on or off.

With 2.0, you can double-click

on each of these elements to call
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Printing envelopes is a snap with V\brd for Windows 2.0.
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plan to pay $95 per year or $10 
for the first three minutes and $1 
per minute aher that to get your 
questions answered. The compa­
ny also has a support BBS. 

If you can live with DeScribe's 
user-interface oddities, you'll find 
it a capable and powerful word 
processor. Although it lacks some 
features, such as automatic foot­
notes and a drah mode, its superi­
or object-oriented page-layout 
capabilities make it an excellent 
choice for those needing a word 
processor with desktop publishing 
capabilities. 
DENNY ATKIN 

Circle Reader Service Number 305 

MICROSOFT WORD 
FOR WINDOWS 2.0 
In Windows-land, Microsoft Word 
for Windows has always been the 
word processor to beat. With Ami 
Pro 2.0 and WordPerfect 5.1 for 
Windows, the competition's hotter, 
but for my money, Word for Win­
dows 2.0 is still king of the hill. 

WinWord 1.1 was a solid word 
processor that introduced a fea­
ture that was to become the most 
imitated interface element in the 
Windows world-the tool bar. 
With version 2.0 of WinWord , Mi­
crosoft has taken the toolbar and 
dramatically extended it to in­
clude a full row of buttons for the 
most common tasks. 
'$129 for previous users of Word for Win-

Microsoft Wonllor Windows 2_0 
10M PC and compallbles (00206 or 
lasler), 2MO RAM, EGA or higher 
graphics, SMO Iree hard disk space 
(lSMO lor all opllons); mouse 
recommended-$49S' 

MICROSOFT 
One Microsoft Way 
Redmond, WA 980S2-6399 
(000) 426-9400 
(206) 002-8080 

Since the features accessed 
by the toolbar are at the heart of 
WinWord, let's take a quick 
toolbar tour. Going from left to 
right, you 'll find buttons for open­
ing and saving files; cutting, cop­
ying , and pasting ; undoing; cre­
ating numbered and bulleted 
lists; bui lding tables; creating 
frames; drawing (WinWord has 
an on-board drawing program); 
graphing; prin ting envelopes; 
checking your spelling ; printing; 
and zooming between full-page 
and 100-percent views. 

Almost better than these new but­
tons is the fact that you can add 
your own. You can map any native 
WinWord command or any macro 
you've created to a button. Here's 
a simple example of a button I've 

added to WinWord's tcolbar. 
I found that I spent a lot of time 

either typing the date in docu­
ments or going through WinWord's 
menus to insert the current date. 
I decided it would be nice to have 
a button on the toolbar for this 
chore. First, I created a macro to 
insert the date using the following 
keystrokes: Alt-I , T, Down Arrow, 
Down Arrow, Enter. Next, I double­
clicked on the tool bar to bring up 
the options dialog. I selected my 
insert-date macro's name, indicat­
ed where on the tcolbar I wanted 
my button, and chose a button de­
sign from the list of those available. 
I clicked on Change, and my new 
button was on the tool bar. That's 
all there was to it. 

Looking beyond WinWord 's 
new buttons, you'll find that the rib­
bon and ruler, familiar from Win­
Word 1.0, are present in 2.0 but 
they 're combined. The ribbon 
sports drop-down list boxes for 
styles, fonts, and font sizes, plus 
buttons for styles (bold, italic, and 
underline), justification (Ieh, cen­
ter, right, and proportional), and 
tab settings (left, right , center, 
and decimal) , as well as a button 
to turn paragraph marks on or off. 

With 2.0, you can double-click 
on each of these elements to call 

Create Envelope 
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dows and for competitive upgrades. Printing envelopes is a snap with ~rd for Windows 2.0. 
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Indiana Jones:Fate of Atlantis. 40
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TEST LAB

WordPerfect

important dialogs. For example,

double-click on the ruler, and you'll

pull up the paragraph style dialog

box. If you double-click on the rib

bon, you'll get WinWord's charac

ter-formatting dialog box. And if

you double-click on the toolbar,

you'll find yourself in WinWord's Op

tion module, where you change but

tons and keyboard assignments,

among other things.

As you may have gathered

from the description of the but

tons, there's more to WinWord

than just an improved interface—

there's a boatload of new fea

tures. I'll touch on some of the

most important.

For desktop publishing, this ver

sion of WinWord has frames. A

frame is simply a way of unifying

a graphic or a region of text so it

can be moved. And moving

frames is easy with WinWord's

new drag-and-drop capability. To

move a frame, select it, click the

mouse on it, and drag it to its des

tination. (Drag and drop works

with any WinWord object and is

not limited to frames.)

Another great DTP feature is

text rotation, which lets you alter

the angle at which text appears.

Desktop publishing features are

exciting, but those of us using a

word processor for day-to-day

tasks will be glad to find some im

pressive business muscle in Win

Word. At the top of the list is enve

lope printing. For a year, I've been

debating whether to get a dedicat

ed label printer, but this feature is

so nice that I've decided that Win

Word and my printer are all I

need. To print an envelope, all you

do is click on the Envelope button

and put an envelope in your print

er. If you have an inside address

in your letter, WinWord will find it

and supply it in the dialog box. If

there's no inside address, you sim

ply type it in. This may seem like

a small feature, but it's one that

will save you hours every month.

As you'd expect with any top-

of-the-line word processor, Win

Word comes with an on-board

spelling checker and thesaurus,
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WordPerfect 5.1 lor Windows

IBM PC and compatibles (80286 or

taster, 80386 or faster recom

mended), 2MB RAM (4MB strongly

recommended), hard drive—$495

WORDPERFECT

1555 N. Technology Way

Orem, UT 84057

(800) 451-5151

but what's new in 2.0 is a gram

mar checker. Most writers will get

at least some useful advice from

this tool.

Other features that bear men

tioning include topflight file con

version, superior help for WordPer

fect users, excellent print merge,

and a first-rate tutorial. When you

come down to the bottom line, Win

Word is hard to beat. It's done eve

rything I've asked of it and more.

I unreservedly recommend it.

CLIFTON KARNES

Circle Reader Service Number 306

WORDPERFECT 5.1
FOR WINDOWS
WordPerfect has entered the Win

dows word-processing arena, and

pundits wait with bated breath to

see whether it will be a success.

Unlike WordPerfect's entry in

to the Mac, Amiga, and ST envi

ronments, this release comes at

the tail end of a pack of serious

contenders. It's identified as 5.1

(probably to get an edge on the

2.0s and 1,0s on the market), and

it's very much analogous to the lat

est DOS version, with the advan

tages of a graphic interface. The

major complaint about the DOS

version has been the length of

time it takes to learn the simplest

of tasks. Just setting the margins

or defining a page layout takes

several keypresses, and the log

ic of the menu system is enough

to try any new user's patience.

WordPerfect 5.1 for Windows

is a piece of cake to use. Ironical

ly, the people who'll probably

have the most trouble adapting to

foj

it will be those poor souls who've

already invested months and

years of effort into learning the

DOS version. For them, WordPer

fect has provided a keyboard over

lay that reminds you a little of the

command structure of the DOS

version, but no matter what you

do, the rules in Windows are dif

ferent from the rules in DOS.

If you have a large collection

of macros from WordPerfect 5.1

for DOS, you can convert them

with a handy conversion utility,

though some of them won't be

usable. But you might need few

er macros because the com

mands are so much handier in

the current version. Also, the mac

ro language has been complete

ly redone, making writing a mac

ro much easier. You can write

your macro right in the main edit

ing screen and call it up for edit

ing anytime. WordPerfect for Win

dows has a rich macro language

that provides means to create

your own dialog boxes and men

us, though in my opinion Ami Pro

2.0 does an even better job in

both of these areas.

WordPerfect also provides a

file manager that allows you to

leave behind the superawkward

file handler of Windows 3.0 and

the merely awkward file handler

of Windows 3.1. However, if

you've ever used a truly effective

file handler like the ones offered

for Macintosh or in GeoWorks En

semble, you'll look at this collec

tion of file managers (including

WordPerfect's) and wonder why
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important dialogs. For example, 
double-click on the ruler, and you'll 
pull up the paragraph style dialog 
box. If you double-click on the rib­
bon, you'll get WinWord's charac­
ter-formatting dialog box. And if 
you double-click on the toolbar, 
you'll find yourself in WinWord's Op­
tion module, where you change but­
tons and keyboard assignments, 
among other things. 

As you may have gathered 
from the description of the but­
tons , there's more to WinWo rd 
than just an improved interface­
there 's a boatload of new fea­
tures. I'll touch on some of the 
most important. 

For desktop publishing, this ver­
sion of WinWord has frames. A 
frame is simply a way of unifying 
a graphic or a region of text so it 
can be moved. And moving 
frames is easy wi th WinWord 's 
new drag-and-drop capabi lity. To 
move a frame, select it, cl ick the 
mouse on it, and drag it to its des­
tination. (Drag and drop works 
with any WinWord object and is 
not limited to frames.) 

Another great DTP featu re is 
text rotation, which lets you alter 
the angle at which text appears. 

Desktop publishing features are 
exciting, but those of us using a 
word processor for day-to-day 
lasks will be glad to find some im­
pressive business muscle in Win~ 
Word. At the top of the list is enve­
lope printing. For a year, I've been 
debating whether to get a dedicat­
ed label printer, but th is feature is 
so nice that I've decided that Win­
Word and my printer are all I 
need. To print an envelope, all you 
do is click on the Envelope button 
and put an envelope in your print­
er. If you have an inside address 
in your letter, WinWord wi ll find it 
and supply it in the dialog box. If 
there's no inside address, you sim­
ply type it in. This may seem like 
a small feature, but it's one that 
will save you hours every month. 

As you 'd expect with any top­
of-the-line word processor, Win­
Word comes with an on-board 
spelling checker and thesaurus, 

26 COMPUTE JULY 1992 

WonlPerlect 5,1 lor Windows 
tBM PC and compatibles (B02B6 or 
laster, B0386 or laster recom­
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WORDPERFECT 
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Orem, UT 84057 
(800) 451 -5151 

but what's new in 2.0 is a gram­
mar checker. Most writers will get 
at least some useful advice from 
this too l. 

Other features that bear men­
tioning include topflight file con­
version, superior help for WordPer­
fect users, excellent print merge, 
and a fi rst-rate tutorial. When you 
come down to the bottom line, Win­
Word is hard to beat. It's done eve­
ryth ing I've asked of it and more. 
I unreservedly recommend it. 
CLIFTON KARNES 

CIrcle Reader Service Number 306 

WORDPERFECT S.l 
FOR WINDOWS 
WordPerfect has entered the Win­
dows word-processing arena, and 
pundits wait with bated breath to 
see whether it will be a success. 

Unlike WordPerfect's entry in­
to the Mac, Amiga, and ST envi­
ronments, this release comes at 
the tail end of a pack of serious 
contenders. It's identified as 5.1 
(probably to get an edge on the 
2.0s and 1.0s on the market), and 
it's very much analogous to the lat­
est DOS version , with the advan­
tages of a graphic interface. The 
major complaint about the DOS 
version has been the length of 
time it takes to learn the simplest 
of tasks. Just setting the margins 
or defining a page layout takes 
several keypresses, and the log­
ic of the menu system is enough 
to try any new user's patience. 

WordPerfect 5. 1 for Windows 
is a piece of cake to use. Ironical­
ly, the people who'l l probably 
have the most trouble adapting to 

\",ord Perfect 
for \\ lIld(l\'" 
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it will be those poor souls who've 
already invested months and 
years of effort into learn ing the 
DOS version. For them, WordPer­
fect has provided a keyboard over­
lay that reminds you a little of the 
command structure of the DOS 
version, but no matter what you 
do, the rules in Windows are dif­
fe rent from the ru les in DOS. 

If you have a large collection 
of macros from WordPerfect 5. 1 
for DOS, you can convert them 
with a handy conversion uti lity, 
though some of them won' t be 
usable. But you might need few­
er macros because the com­
mands are so much handier in 
the current version. Also, the mac­
ro language has been complete­
ly redone, making writing a mac­
ro much easier. You can wri te 
your macro right in the main edit­
ing screen and call it up for edit­
ing anytime. WordPerfect for Win­
dows has a rich macro language 
that prov ides means to create 
your own dialog boxes and men­
us, though in my opinion Ami Pro 
2.0 does an even better job in 
both of these areas. 

WordPerfec t also provides a 
fi le manager that allows you to 
leave behind the superawkward 
file handler of Windows 3.0 and 
the merely awkward file handler 
of Wi ndows 3.1. However, if 
you've ever used a truly effective 
file handler like the ones offered 
for Macintosh or in GeoWorks En­
semble, you 'll look at th is collec­
tion of file managers (inc luding 
WordPerfect's) and wonder why 
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they can't be better. I know I do.

As for object linking, WordPer

fect doesn't have it yet, Microsoft

Word for Windows 2.0 just got it,

and Ami Pro has always had it.

WordPerfect supports DDE, how

ever, so it's not completely link-

less, and it features a handy

spreadsheet importer that will con

vert the most common spread

sheet formats into a WordPerfect

table for insertion into text.

WordPerfect doesn't handle

frames (or boxes, in WordPerfect

parlance) as well as Ami Pro, or

even as well as Word (though the

boxes appear to be more reliable

and leakproof than Word's

frames). Rather than letting you

an important part of your publica

tion, you should consider Ami Pro

over Word or WordPerfect in their

current releases.

Another drawback for many

users will be WordPerfect's vora

cious appetite for RAM. I attempt

ed running it on two machines

with only 2MB. The 80386 ma

chine simply crashed at regular

intervals. When I ran the program

on an 80286, it was more insidi

ous and would begin failing in un

predictable ways before eventu

ally dying. On an 80386 with 4MB,

its performance was flawless. The

lesson is clear: If you have less

than 4MB, beef up before install

ing WordPerfect. It will save hours
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WordPerfect commands are easier in Windows, thanks to the interface.

simply select a tool and drag a

box, WordPerfect requires you to

make at least two menu selec

tions. And when WordPerfect box

es contain text, the text isn't direct

ly editable. You have to double

click on the box, which takes you

to a separate text editor, where

you enter the text in a distinctly

marginal WYSIWYG environment.

This procedure is a serious draw

back for desktop publishers (al

though it's a vast improvement

over the command structure of

the DOS product). If frames are
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of frustration with marginal and un

predictable performance.

WordPerfect for Windows is

best for users who will be sharing

documents with WordPerfect for

DOS or another platform. Under

these circumstances, DOS

WordPerfect users will be drawn

to the Windows product and even

tually demand to have their own

machines refurbished for Win

dows so they can use WordPer

fect for Windows, too.

ROBERT BIXBY

Circle Reader Service Number 307

WORDSTAR FOR
WINDOWS
WordStar for Windows has the dis

tinction of being the only Win

dows word processor to offer you

WordStar- and WordStar 2000-

compatible keystrokes, and for

that reason it will automatically at

tract the attention of longtime

users of those DOS programs. The

real strengths of this program, how

ever, are advanced text editing

and desktop publishing.

In part because it's a Windows

product, WSWin handles text ed

iting with lots of flexibility and often

with ease. I like being able to use

the old WordStar-compatible key

commands, and the pull-down men

us are fine, but I really like press

ing a single button at the top of the

screen to choose a paragraph

style, font, point size, emphasis

(bold, italic, underline, or double un

derline), or view mode. A press of

a button also changes alignment,

number of columns, spacing, and

other features. There's even a Tool

box bar with buttons that allow you

to create and insert graphics. As

a touch-typist, I was pleasantly sur

prised to find how easily I could ma

nipulate text and use the buttons

in this interface.

The program's extensive array

of text-editing features includes

search and replace, spelling

checks, a thesaurus, footnotes,

endnotes, superscripts, sub

scripts, headers, footers, and con

tents- and index-generating capa

bilities—and the list goes on and

on. (See the features grid for the

full story.) Gone are the dot com

mands of earlier WordStar pack

ages, but with Windows, you

won't really need them.

According to WordStar, this is

the only word processor with a the

saurus that provides synonyms,

antonyms, near synonyms, near

antonyms, and see-also referenc

es. In addition, the thesaurus

gives you definitions so that you

can choose the best word to con

vey your meaning. I found 18
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simply select a tool and drag a 
box, WordPerfect requi res you to 
make at least two menu selec­
tions. And when IM:lrdPerfect box­
es contain text, the text isn't direct­
ly editable. You have to double­
click on the box, which takes you 
to a separate text editor, where 
you enter the text in a distinctly 
marginal WYSIWYG environment. 
This procedure is a serious draw­
back for desktop publishers (al­
though it's a vast improvement 
over the command structure of 
the DOS product). If frames are 
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of frustration with marginal and un­
predictable performance. 

WordPerfect for Windows is 
best for users who will be sharing 
documents with WordPerfect for 
DOS or another platform. Under 
these circumstances, DOS 
WordPerfect users will be drawn 
to the Windows product and even­
tually demand to have their own 
machines refurbished for Win­
dows so they can use WordPer­
fect for Windows, too. 
ROBERT BIXBY 
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WORDSTAR FOR 
WINDOWS 
IM:lrdStar for Windows has the dis­
tinction of being the only Win­
dows word processor to offer you 
WordStar- and WordStar 2000-
compatible keystrokes, and for 
that reason it will automatically at­
tract the attention of longtime 
users of those DOS programs, The 
real strengths of this program, how­
ever, are advanced text editing 
and desktop publishing. 

In part because it's a Windows 
product, WSWin handles text ed­
iting with lots of flexibility and often 
with ease. I like being able to use 
the old WordStar-compatible key 
commands, and the pull-down men­
us are fine, but I really like press­
ing a single button at the top of the 
screen to choose a pa ragraph 
style, font , point size, emphasis 
(bold, italic, underline, or double un­
derline), or view mode. A press of 
a button also changes alignment, 
number of columns, spacing , and 
other features. There's even a Tool­
box bar with buttons that allow you 
to create and insert graphics. As 
a touch-typist, I was pleasantly sur­
prised to find how easily I could ma­
nipulate text and use the buttons 
in this interface. 

The program's extensive array 
of text-editing features includes 
search and replace , spelling 
checks, a thesaurus, footnotes, 
endnotes , superscripts , sub­
scripts, headers, footers, and con­
tents- and index-generating capa­
bil ities-and the list goes on and 
on. (See the features grid for the 
full story.) Gone are the dot com­
mands of earlier WordStar pack­
ages, but with Windows, you 
won' t really need them. 

According to WordStar, this is 
the only word processor with a the­
saurus that provides synonyms, 
antonyms, near synonyms, near 
antonyms, and see-also referenc­
es . In addition, the thesaurus 
gives you definitions so that you 
can choose the best word to con­
vey your meaning. I found 18 
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up calculator, a programmer's reference
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definitions for the nondescript

good, and for each definition,

there's a list of synonyms—pretty

impressive. This degree of help

and control is available for a num

ber of features.

The package comes with

more than 20 paragraph styles,

and each controls over 60 para

graph attributes. Need color in

your documents? You can

choose from 16.7 million colors

for text, graphics, tables, bor

ders, and background. There's

even widow and orphan control.

To make life easier and show you

the capabilities of the program,

WordStar provides more than 45

document templates—reports,

memos, a newsletter, and more.

I like being able to open a new

file, designate a template, and re

place sample text and graphics

with my own for a sharp, impres

sive document.

Probably the biggest adjust

ment for you if you're a longtime

WordStar user is working with

frames in this frame-based pro

gram. Whether you're creating or

importing text, graphics, or tables,

you'll use these frames; and the

controls you use will take some get

ting used to, especially if you're

not accustomed to Windows.

For getting a handle on using

frames and other features, I

found the online tutorial indispen

sable; the four manuals that

come with the program are well

■$129 upgrade from WordStar or competi

tive product.
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WordStar lor Windows

IBM PC and compatibles (80266 or

faster), 2MB RAM, Windows-

compatible graphics, mouse—495*

WORDSTAR INTERNATIONAL

201 Almeda del Prado

Novato, CA 94949

(BOO) 227-5609

(800)426-8855,6X1.19

done, too. If you stick with the tu

torial and practice using these

frames, the payoff is a remarka

ble degree of control over the

way your document looks.

With WSWin, you also get

Bitstream FaceLift, which includes

13 scalable typefaces, and Cor

rect Grammar, the company's

grammar checker, which works

with several Windows products.

Need to import or reference

spreadsheet data files? WSWin

can do it. It can also import major

graphics formats, including

DRW, PLT, EPS, WMF, MacPaint,

TIF, PIX, PCX, and BMP. And

WordStar offers you a long list of

major word processors that you

can import from or export to.

What's more, in addition to its

DDE linking capabilities with oth

er Windows applications, WSWin

offers links to DOS applications.

As powerful and attractive as

WSWin is, there are some signifi

cant omissions you need to be

aware of. For example, you can

open only one document at a

lime, although it's possible to open

two versions of the WordStar pro

gram. Also, WSWin doesn't offer

macros, which keeps you from au

tomating certain procedures. Final

ly, I wasn't able to get a word

count without running Correct

Grammar. This isn't a tremendous

inconvenience, but the word

counts aren't as easy as they

were in the DOS version.

I found performance lacking

on a 386SX/20 but just fine on a

486SX/25. If you lack powerful

hardware and especially if you

need speed without a multitude

of desktop publishing features, a

great DOS word processor like

WordStar 6.0 or 7.0 will probably

better meet your needs. Howev

er, if you want WordStar com

mand-key compatibility and if the

features and speed of WSWin

meet your needs, it's a capable

program you'll want to consider.

MIKE HUDNALL

Circle Reader Service Number 308
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WSWin's thesaurus provides synonyms, antonyms, definitions, and more.
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and each controls over 60 para­
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for text , graphics, tables , bor­
ders, and background. There's 
even widow and orphan control. 
To make life easier and show you 
the capabilities of the program, 
WordStar provides more than 45 
document templates- reports, 
memos, a newsletter, and more. 
I like being able to open a new 
file , designate a template, and re­
place sample text and graphics 
with my own for a sharp, impres­
sive document. 

Probably the biggest adjust­
ment for you if you're a longtime 
WordStar user is working with 
frames in this frame-based pro­
gram. Whether you're creating or 
importing text, graphics, or tables, 
you 'll use these frames; and the 
controls you use will take some get­
ting used to, especially if you're 
not accustomed to Windows. 

For getting a handle on using 
frames and other features, I 
found the onl ine tutorial indispen­
sable; the four manuals that 
come with the program are well 

·$129 upgrade !tom WordStar or competi­
live product. 
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done, too. If you stick wi th the tu­
torial and practice using these 
frames, the payoff is a remarka­
ble degree of control over the 
way your document looks. 

With WSWin , you also get 
Bitstream FaceLift, which includes 
13 scalable typefaces, and Cor­
rect Grammar, the company's 
grammar checker, which works 
with several Windows products. 

Need to import or reference 
spreadsheet data files? WSWin 
can do it. It can also import major 
graphics formats, including 
DRW, PLT, EPS, WMF, MacPaint, 
TIF, PIX, PCX, and BMP. And 
WordStar offers you a long list of 
major word processors that you 
can import from or export to. 
What's more, in addition to its 
DOE linking capabilities with oth-

\ 11 ,,¥ I h ..... 

er Windows applications, WSWin 
offers links to DOS applications. 

As powerful and attractive as 
WSWin is, there are some signifi­
cant omissions you need to be 
aware of. For example, you can 
open only one document at a 
time, although it's possible to open 
two versions of the WordStar pro­
gram. Also, WSWin doesn't offer 
macros, which keeps you from au­
tomating certain procedures. Final­
ly, I wasn ' t able to get a word 
count wi thout running Correct 
Grammar. This isn't a tremendous 
inconvenience, but the word 
counts aren' t as easy as they 
were in the DOS version. 

I found performance lacking 
on a 386SXl20 but just fine on a 
486SX/25. If you lack powerful 
hardware and especially if you 
need speed without a multitude 
of desktop publishing features, a 
great DOS word processor like 
WordStar 6.0 or 7.0 wi ll probably 
better meet your needs. Howev­
er, if you want WordStar com­
mand-key compatibility and if the 
features and speed of WSWin 
meet your needs, it's a capable 
program you'll want to consider. 
MIKE HUDNAll 
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II • • ,,, . Ih"h • • ,~ I "'l'''''''_ 
:, .. .,. "I, nalh.·~, \\ . , 
:-<.~ . l. f .M~ .... .", ... 

I ... , \ , 1, ... 

I~ .. l ,. I~ ,t. .... u r .'. " ... , • 10, ..... ,.,. ,~l~ I ~,.u 

, •••• ~ '1 " " .... ~ •• \\"'~.,.1, a!IDI!l ~"k"4.J . . '. .. , . , .,. 
WSWin 's thesaurus provides synonyms. antonyms, definitions, and more. 



DELPHI—The $1 per hour online solution!
DELPHI'S 20/20 Advantage Plan sets the standard for online value:
20 hours for only $20, for all the services you want!

Thousands of files to download.

Chat lines with hundreds of participants.

Worldwide e-mail.

Hobby and computer support groups.

Multi-player games.

Local access numbers

in over 600 cities and towns.

THal Offer: 5 hours for $5!
Try DELPHI at $1 per hour. Join today and get 5 hours of evening and weekend

access for only $5. If you're not satisfied, simply cancel your account before the
end of the calendar month with no further obligation. Keep your account active

and you'll automatically be enrolled in the 20/20 plan for the next month.

1. Via modem, dial 1-800-365-4636.

2. When connected, press RETURN once or twice.

3. At Password, enter CP55

Questions? Call 1-800-695-4005.

Rates apply for evening and weekend access from within the mainland US. There is a one-time enrollment fee of $19

when you join the 20/20 Advantage Plan. Further details are provided during the online registration.

DELPHI is a service of

General Videotex Corporation

1030 Massachusetts Avenue

Cambridge, MA 02138-5302

800-695-4005 • 617-491-3393

Circle Reader Service Number 161

DELPID - The ~1 per hour online solution! 
DELPHI's 20/20 Advantage Plan sets the standard for online value: 
20 hours for only $20, for all the services you want! 

• Thousands of files to download. 
• Chat lines with hundreds of participants. 
• Worldwide e-mail. 
• Hobby and computer support groups. 
• Multi-player games. 
• Local access numbers 

in over 600 cities and towns. 

1rial Offer: 5 hours for ~5! 
Try DELPHI at $1 per hour. Join today and get 5 hours of evening and weekend 
access for only $5. If you're not satisfied, simply cancel your account before the 
end ofthe calendar month with no further obligation. Keep your account active 
and you'll automatically be enrolled in the 20/20 plan for the next month. 

1. Via modem, dial 1-800-365-4636. 
2. When connected, press RETURN once or twice. 
3. At Password, enter CP55 
Questions? Call 1-800-695-4005. 

Rates apply for evening and weekend access from within the mainland US. There is 8 one-time enrollment fee of $19 
when you join the 20/20 Advantage Plan. Further details are provided during the online registration. 

DELPHI is a service of 
General Videotex Corporation 

1030 Massachusetts Avenue 
Cambridge, MA 02138-5302 

800-695-4005.617-491-3393 

Circle Reeder Service Number 161 



TEXT EDITING

Draft editor

Search and replace

Wildcards

Formats (tags)

Grammar checker

Spell'ng dictionaries

Legal dictionary

Medical dictionary

Scientific dictionary

Rsrsonal dictionary

Foreign.language dictionary

Thesaurus

Synonyms

Antonyms

Definitions

indexing

Contents generator

Footnotes

Endnotes

Headers

Footers

Word counts

Maximum number of documents open

at one time

Editable macros

Number of undo levels

Accelerator keys

Widow and orphan control

Autofiyphenation

Autopagination

Aulosave

Nonprinting annotations

Number of colors

Number of paragraph styles supplied

Windows Word Processor Features

Ami Pro 2.0

■

■

■

3

3

n

a

■

■

(option)

■

3

■

■

■

■

■

■

■

■

9

■

(ships with 68

macros)

4

■

■

■

■

■

16 million

48 (style sheets)

Describe Word

Processor 3.0

D

■

3

3

*

{option—S149.95)

■

(option—SI 49.95)

■

(Option—S149.95)

■

■

(option—$149.95)

■

■

■

■

■

□

3

■

■

a

limited by memory

■

unlimited

■

■

■

■

3

3

16

50

Microsoft Word for

Windows 2.0

■

■

■

■

■

(option)

■

(option)

■

(option)

■

■

(option)

■

■

(and related words)

■

■

■

■

■

■

■

9

■

1

■

■

■

■

■

■

16

4 (more through the

templates)

WordPerfect 5.1

for Windows

■

a

■

a

3

3

G

■

■

(option—$99.00,

$149.00 for Hebrew

and Arabic)

■

■

3

■

■

■

■

■

■

■

9

■

1 (3 undeletes)

■

■

■

■

■

■

256

0

I
WordStar for

Windows

I
■

■

■

■

O

3

3

m

■

(oplion~$69.95

each for French,

German, Italian,

Spanish, or

Norwegian)

■

(also near

synonyms)

■

(also near

antonyms)

■

■

■

■

■

■

■

■

(through Correct

Grammar)

1

□

1

■

(for WSWin,

WordStar, and

WordStar 2000

■

■

■

■

■

16.7 million

24
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Legal dictionary 0 

Medical dictionary 0 

Scientific dictionary 0 • 
(oplion---SI49.95) 

ForeignJanguage dictionary • • 
(option) (option--SI49.95) 

Synonyms • • 

Antonyms 0 • 

!Nord counts • 0 

Maximum number 01 documents open 9 limited by memory 
alone lime 

Editable macros • • 
(ships wIth 68 

macros) 

Accelerator keys • • 

Number of paragraph styles supplied 48 (slyle sheets) 50 
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• 
(option) 

• 
(option) 

• 
(option) 

• 

• 
(and related words) 

• 

9 

• 

• 

4 (more through the 
templates) 

0 

0 

0 

• 
{oplion-$99.00, 

$149.00 for Hebrew 
and Arabic) 

• 

• 

• 

9 

• 

• 

0 

0 

0 

• 
(option-S69.95 
each for French, 
German, Italian, 

0< 

• 
(also near 

• 
(through Correct 

Grammar) 

0 

• 
(for WSWin, 

'M::lrdStar, and 
'NordStar 2000 



DESKTOP PUBLISHING

Magnification range

Maximum number of columns

Rulers

Choice of units

of measurement

(pis., in., picas, cm.)

Number of built-in templates

Drawing tools

Graphic editing

Scaling

Cropping

Number of clip art images

TABLES

Automatic text wrap in cells

Equation editor

Column math

Fixed or variabfe column widths

Table line styles

TYPOGRAPHY

Tracking

Leading

Kerning

Point size range

Degree of increments (how small)

CONNECTIVITY

DDE linking

OLE

Links lo DOS app fifes

Network support

Number of word processor types

supported

LEARNING TOOLS

Online tutorial

Online help

Duration of customer support

BBS support

Fax support

Special help

■ —yes 3 —no

Ami Pro 2.0

10%-400%

8

■

■

48

■

■

■

■

1004

■

■

■

variable

■

■

■

■

(PostScript printers

only)

1-999

1 point

■

■

3

■

33

D

(manual-based

tutorial)

■

unlimited

3

■

CompuServe

Describe Word

Processor 3.0

10%-500%

20

■

■

50

■

■

■

■

6 (extra disk when

you register)

■

1

variable

■

■

any (ATM or

PostScript)

Vigo point

■

■

■

59

n

(manual-based

tutorial and disk

examples)

■

90 days

■

□

a

Microsoft Word for

Windows 2.0

25^200%

32

■

■

18

■

■

■

■

48

■

■

■

variable

■

■

■

■

1-127

1 point

■

■

■

■

20

■

■

unlimited

■

D

CompuServe

WordPerfect 5.1

for Windows

58%-100%

as many as fit on a

page

■

■

0

a

■

(size and color)

■

■

36

■

■

■

(only in tables)

variable

■

■

■

■

.00001-largest size

paper can

accommodate

Vrao point

■

3

■

13 (not counting

version numbers)

O

■

unlimited

■

■

CompuServe,

GEnie, America

Online

WordStar for

Windows

25%-200%

4

■

■

50

■

■

■

■

77

1
■

□

a

variable

■

■

■

■

1-792

Vio point

■

■

■

73

1
■

■

life of product

3

a

CompuServe
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Ami Pro 2.0 DeScribe Word 

8 20 32 4 

Choice 01 units • • • • • of measurement 
(pIS .. in., picas. em.) 

Graphic editing • • • • • 
(size and color) 

clip art images 100+ 6 (extra disk when 48 38 77 
you register) 

TABLES 

Automatic text wrap in cells • • • • • 
Equation editor • D • • D 

Column math • D • • D 
(only in lables) 

Axed or variable column widths variable variable variable variable variable 

Table line styles • • • • • 
TYPOGRAPHY 

Tracking • • • • • 
leading • • • • • 
Kerning • • • • • 

(PostScript printers 
only) 

Point sile range 1-999 any (ATM or 1-127 .cXXlOHargest sile 1-792 
PostScript) paper can 

accornnoclate 

Degree of incremenlS (how small) 1 point l/n:11 point 1 point 1Jtm point I/IfJ point 

CONNECTIVITY 

DOE linking • • • • • 
OLE • D • D D 

Unks 10 OOS app files D • • D • 
Network support • • • • • 
Number of word processor types 33 59 20 13 (not counting 73 
supported version numbers) 

LEA RUING TOOLS 

Coline tutorial D D • D • 
(manual-based (manual-based 

tutorial) tutorial and disk 
examples) 

Online help • • • • • 
Duration of customer support unlimited 90 days unlimited unlimited life of product 

BSS support 0 • • • D 

Fax support • D D • D 

Special help CompuSe<Ve D CompuServe CompuServe, CompuServe 
GEnie, America 

Online 

. -yes D-no 
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NEWS & NOTES
Nil Champion

Wedding Planner

takes the

stress out of getting

married—or

at least some o! it.

Get Me to the Church on Time
No one can guarantee a

marriage will last, but a new

software product from Ninga

Software will at least make

sure the wedding ceremony

is a dream instead of a night

mare. Ninga is a young com

pany determined to fill a

niche in the home-software

market with Wedding Planner,

a complete guide to orches

trating a wedding.

Designed for IBM PCs and

compatibles, Wedding Plan

ner helps prospective brides

and grooms completely organ

ize all those time-consuming

WEDDING

but necessary wedding de

tails in a concise, alphabeti

cal format that's simple to ac

cess. Perhaps the biggest ad

vantage of using the program

is that it handles all list keep

ing by tracking invitations,

RSVPs, gifts, and thank-you

notes. You can view up-to-the-

minute information in each of

15 different reports that will

tell you, for instance, which

RSVPs you're still waiting for.

Daily calendar prompts

serve as reminders for an as

sortment of things, such as

when to order the bride's

gown and when to book a re

ception hall. A budget feature

allows you to keep a running

total of all wedding expendi

tures. Tips on everything

from buying an engagement

ring to ordering a wedding

cake are included in the Gen

eral Wedding Information fea

ture. You can even print out

address labels for your invita

tions and thank-you notes.

Suggested retail price for

Wedding Planner is $49.95.

For further information, con

tact Ninga Software, 736 8th

Avenue SW, Suite 330, Cal

gary, Alberta, Canada T2P

1H4; (800)265-5555.

Schemers Unite
Don't let the name fool you.

The SCHEMER'S Guide, pub

lished by Schemers of Fort

Lauderdale, Florida, isn't a

handbook for conspiracy; it's

a guide to what some astute

educators hope will be the fu

ture programming language

of choice. Scheme is a stream

lined programming language,

derived from the artificial-intel

ligence language LISP, which

places concept above syntax—

unlike BASIC and Pascal.

The president of Schem

ers, Terry Kaufman, says the

way computer science is intro

duced to students in school

these days could jeopardize

the country's future as a com

petitor in the technology mar

ketplace. "Colleges are al

ready noticing a drop in the

number of students choosing

to major in computer sci

ence," Kaufman says.

After spending ten years

working for IBM, Kaufman

thinks businesses, too,

should be concerned about

the quality of computer-sci

ence knowledge new employ

ees—especially recent col

lege graduates—bring to their

jobs. Scheme, he says, is

such a simple language to

learn (it encompasses object-

oriented programming and

techniques), yet it's very pow

erful, and it helps you learn oth

er languages more easily. To

find out more, contact Schem

ers, 4250 Gait Ocean Mile.

Suite 7U, Fort Lauderdale, Flor

ida 33308; (305) 776-7376.

Life Can Be Easier
A new development from Mi

crosystems Software should

help some of the 43 million dis

abled Americans who are ei

ther currently working or look

ing for a job. ADAPTA-LAN, a

set of local-area-network pro

grams designed for physical

ly challenged users, is in

stalled on a network of IBM

PCs or compatibles, provid

ing employees with screen

magnification; word predic

tion; and access to the PC by

way of external switches, vis

ual beeps, and more. ADAP-

TA-LAN's nine software pack

ages include MAGic and MAG-

ic Deluxe screen-magnifica

tion software for DOS and Win

dows; HandiKEY and Handi-

CODE for PC access without

a keyboard; HandiSHIFT and

HandiWORD for those with lim

ited keyboarding ability; Han-

diCHAT for nonspeaking per

sons; HandiPHONE tele

phone and modem access

for people with physical limita

tions; and SeeBEEP, a visual

indicator of a PC audio beep

for the hearing-impaired.

The package retails for

$2,995 per server with an un

limited number of users. For

more information, contact Mi

crosystems Software, 600

Worcester Road, Framing-

ham. Massachusetts 01701-

5342; (508) 879-9000.

Super Floppy
Maxell says its new Super RD

(Reliable and Durable) 3V6-

inch floppy disk, the MF2-HD,

is for "less accommodating"

environments—as in ul-

tradusty offices and different

floppy drives. One of Maxell's

improvements over other disk

brands is its patented, airtight

Dual Interlocking Flex-Shutter,

which provides "a virtually

contamination-free internal flop

py disk environment." The

shutter fits more tightly

against the disk casing than

other shutters do, helping to
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Jill Champion 

Gel Me 10 Ihe Chunh on Time 
No one can guarantee a 
marriage will last, but a new 
software product from Ninga 
Software will at least make 
sure the wedding ceremony 
is a dream instead of a night­
mare. Ninga is a young com­
pany determined to fill a 
niche in the home-software 
market with Wedding Planner, 
a complete guide to orches­
trating a wedding . 

Designed for IBM PCs and 
compatibles, Wedding Plan­
ner helps prospective brides 
and grooms completely organ­
ize all those time-consuming 

but necessary wedding de­
tails in a concise, alphabeti­
cal format that's simple to ac­
cess. Perhaps the biggest ad­
vantage of using the program 
is that it handles all list keep­
ing by tracking invitations, 
RSVPs , gifts, and thank-you 
noles. You can view up-Ia-the­
minute information in each of 
15 different reports that will 
tell you, for instance, which 
RSVPs you're still wai ting for. 

Daily calendar prompts 
serve as reminders for an as­
sortment of things, such as 
when to order the bride's 
gown and when to book a re­
ception hall. A budget feature 
allows you io keep a running 
total of all wedding expendi­
tures . Tips on everything 
from buying an engagement 
ring to ordering a wedding 

cake are included in the Gen­
eral Wedding Information fea­
ture. You can even print out 
address labels for your invita­
tions and thank-you notes. 

Suggested re tail price for 
Wedding Planner is $49.95 . 
For further information, con­
tact Ninga Software, 736 8th 
Avenue SW, Sui te 330 , Cal­
gary, Alberta, Canada T2P 
1 H4; (800) 265-5555. 

Schemers Unile 
Don't let the name fool you. 
The SCHEMER's Guide, pub­
lished by Schemers of Fort 
Lauderdale, Florida, isn ' t a 
handbook for conspiracy; it's 
a guide to what some astute 
educators hope wi ll be the fu­
ture programming language 
of choice. Scheme is a stream­
lined programming language, 
derived from the artificial-intel­
ligence language LISP, which 
places concept above syntax­
unlike BASIC and Pascal. 

The president of Schem­
ers, Terry Kaufman, says the 
way computer science is intro­
duced to students in school 
these days could jeopardize 
the country's future as a com­
petitor in the technology mar­
ketplace. "Colleges are al­
ready noticing a drop in the 
number of students choosing 
to major in computer sci­
ence," Kaufman says. 

After spending ten years 
working for IBM, Kaufman 
thinks businesses , too, 
should be concerned about 
the quality of computer-sci­
ence knowledge new employ­
ees-especially recent col­
lege graduates- bring to their 
jobs. Scheme, he says , is 
such a simple language to 
learn (it encompasses object­
oriented programming and 
techniques), yet it's very pow­
erful, and it helps you learn oth­
er languages more easily. To 
find out more, contact Schem­
ers, 4250 Galt Ocean Mile, 
Suite 7U, Fort Lauderdale, Flor­
ida 33308; (305) 776-7376. 

Life Can Be Easier 
A new development from Mi­
crosystems Software should 
help some of the 43 million dis­
abled Americans who are ei­
ther currently working or look­
ing for a job. ADAPTA-LAN, a 
set of local-area-network pro­
grams designed for physical­
ly challenged users, is in­
stalled on a network of IBM 
PCs or compatibles , provid­
ing employees with screen 
magnifi cation; word predic­
tion; and access to the PC by 
way of external switches, vis­
ual beeps, and more. ADAP­
TA-LAN's nine sottware pack­
ages include MAGic and MAG­
ic Deluxe screen-magnifica­
tion software for DOS and Win­
dows; HandiKEY and Handi­
CODE for PC access without 
a keyboard; HandiSHIFT and 
HandiWORD for those with lim­
ited keyboarding ability; Han­
diCHAT for nonspeaking per­
sons; HandiPHONE tele­
phone and modem access 
for people with physicallimita­
tions; and SeeBEEP, a visual 
indicator of a PC audio beep 
for the hearing-impaired. 

The package retails for 
$2,995 per server with an un­
limited number of users. For 
more information, contact Mi­
crosystems Software, 600 
Worcester Road , Framing­
ham, Massachusetts 01701 -
5342; (508) 879-9000. 

Super Floppy 
Maxell says its new Super RD 
(Reliable and Durable) 3 '12 -
inch floppy disk, the MF2-HD, 
is for "less accommodating" 
environments-as in ul­
tradusty offices and different 
floppy drives. One of Maxell's 
improvements over other disk 
brands is its patented, airtight 
Dual Interlocking Flex-Shutler, 
which provides "a virtually 
contamination-free internal flop­
py disk environment." The 
shutter fits more tightly 
against the disk casing than 
other shutters do, helping to 
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Store floppies in

Sliriex disk-storage unit

without worrying

about stray static or

magnetism.

keep out all kinds of dust and

microscopic particles that

could contaminate the inside

magnetic surface.

Both the shutter and cas

ing are made of new materi

als developed by Maxell. Ac

cording to Maxell's tests, no

visible wear occurs even after

more than 10,000 shutter open

ings and closings. The highly

flexible cartridge casing lets it

adapt to changes such as the

level of pressure applied by

different disk drives. As a re

sult, the magnetic head

achieves optimal contact with

the magnetic disk at all

times, and that maximizes the

reading and writing accuracy

of the disk drive.

Maxeli has set the suggest

ed retail prices at $35.70 for a

package of ten unformatted

disks and $38.60 for a pack

age of ten formatted disks.

A Better Mousetrap
The ideal mouse might not be

a mouse at all, according to In

terlink Electronics, maker of a

mouse replacement for those

who find conventional mice

and trackballs cumbersome.

Interlink has adapted its

Force Sensing Resistors

(FSRs) to allow you to use a

key, button, or joystick as a

full two-button mouse with fin

gertip control. The device is

integrated into your keyboard

rather than attached as a pe

ripheral. Toggling a key, but

ton, or joystick lets you con

trol the direction and speed

of the cursor.

Interlink's alternatives in

clude a Dedicated Pointer Lo

cation, which is like having a

two-button mouse integrated

into your laptop case or key

board and with which you

can perform point-and-cfick

operations with one hand; a

Joystick Pointer, which is a

hinged, collapsible stick the

size of a keyboard key that's

integrated into the keyboard;

and the Key Mouse (devel

oped in conjunction with Key

Tronic), which is a key-cap

pointer that uses FSRs

placed under a key cap.

Integration into existing key

board designs is simple and in

expensive through a fully de

bugged, single-chip interface

that supports RS-232C serial

ports, the IBM PS/2 mouse

port, and standard bus

mouse interfaces. Designed

to operate with both DOS and

Windows mouse drivers, the

devices require no software

modification to the host com

puter. For more information,

contact Interlink Electronics,

1110 Mark Avenue, Carpin-

teria, California 93013-2918;

(805) 684-2100.

Siidex Disk-Storage System
Now there's hope that sci

ence will cure disk-zap in our

lifetimes. The Siidex FD-3000

is a patented filing system for

31/2-inch floppies that protects

disks from static and magnet

ism while allowing you to file

and retrieve them easily.

Disks are "snapped" onto

rigid plastic pages that can

be stored as hanging files, in

three-ring binders, or as

stand-alone books holding up

to 24 disks per book. A thick,

stainless-steel plate inside the

front and back covers pro

vides magnetic protection.
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To find out where to buy

Siidex disk-storage units, con

tact TRIWEF (Siidex distribu

tor), 200 Valley Road, Suite

204. Mount Arlington, New Jer

sey 07856; (201)770-2800.

Roll-Your-Own Manuals
Any company, large or small,

stands to benefit from having

a policy handbook that an

swers questions most often

asked by employees—informa

tion on salary reviews, compa

ny holidays, benefits, leaves

of absence, and other critical

policies. Lack of such policies

can affect employee morale

and even result in legal prob

lems down the road. Prepar

ing an employee manual can

give employers the impetus to

form policies when they

haven't previously done so.

Employee ManualMaker

has been edited and re

viewed by a variety of indus

try specialists. It includes

more than 125 policies and

30 benefits, which are organ

ized, defined, and written for

review and customization.

A special primer section in

cludes advice on the best

ways to find and hire employ

ees, an employee application

with a special preemployment

release to help gain informa

tion from previous employers,

and much more. Employee

ManualMaker retails for $130.

For more information, contact

JIAN Tools for Sales, 127 Sec

ond Street, Los Altos, Califor

nia 94022; (800) 346-5426.

Companies with items of inter

est suitable (or "News &

Notes" should send informa

tion along with a color slide or

color transparency to News &

Notes, Attn: Jill Champion,

COMPUTE, 324 West Wen-

dover Avenue, Suite 200,

Greensboro, North Carolina

27408. Although space is lim

ited, all items will be consid

ered for publication. O

Slore floppies In 
Slider disk-storage un" 

wltflout wonylng 
about stray stalic or 

magneUsm. 
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keep out all kinds of dust and 
microscopic particles that 
could contaminate the inside 
magnetic surface. 

Both the shutter and cas­
ing are made of new materi­
als developed by Maxell. Ac­
cording to Maxell 's tests, no 
visible wear occurs even after 
more than 10,000 shutter open­
ings and closings. The highly 
flexible cartridge casing lets it 
adapt to changes such as the 
level of pressure applied by 
different disk drives. As a re­
sult , the magnetic head 
achieves optimal contact with 
the magnetic disk at all 
times, and that maximizes the 
reading and writing accuracy 
of the disk drive. 

Maxell has set the suggest­
ed retail prices at $35.70 for a 
package of ten unformatted 
disks and $38.60 for a pack­
age of ten formatted disks. 

A Beller Mousetrap 
The ideal mouse might not be 
a mouse at all , according to In­
terl ink Electronics, maker of a 
mouse replacement for those 
who find conventional mice 
and trackballs cumbersome. 

In terlink has adapted its 
Force Sensing Resistors 
(FSRs) to allow you to use a 
key, button, or joystick as a 
fu ll two-button mouse wi th fin­
gertip control. The device is 

integrated into your keyboard 
rather than attached as a pe­
ripheral. Toggling a key, but­
ton , or joystick lets you con­
trol the direction and speed 
of the cursor. 

Interl ink's alternatives in­
clude a Dedicated Pointer Lo­
cation, which is like having a 
two-button mouse integrated 
into your laptop case or key­
board and with which you 
can perform point-and-click 
operations with one hand; a 
Joystick POinter, which is a 
hinged, collapsible stick the 
size of a keyboard key that's 
integrated into the keyboard; 
and the Key Mouse (devel­
oped in conjunction with Key 
Tronic), which is a key-cap 
pointer that uses FSRs 
placed under a key cap. 

Integration into existing key­
board designs is simple and in­
expensive through a fully de­
bugged, single-chip interface 
that supports RS-232C serial 
ports, the IBM PS/2 mouse 
port, and standard bus 
mouse interfaces. Designed 
to operate with both DOS and 
Windows mouse drivers, the 
devices require no software 
modification to the host com­
puter. For more information, 
contact Interlink Electronics, 
11 10 Mark Avenue, Carpin­
teria, California 93013-2918; 
(805) 684-2100. 

Slidex Disk-Storage System 
Now there's hope that sci­
ence will cure disk-zap in our 
lifetimes. The Slidex FD-3000 
is a patented filing system for 
3V,-inch floppies that protects 
disks from static and magnet­
ism while allowing you to file 
and retr ieve them easily. 

Disks are "snapped" onlo 
rigid plastic pages that can 
be stored as hanging files, in 
three-ring binders, or as 
stand-alone books holding up 
to 24 disks per book. A thick, 
stainless-steel plate inside the 
front and back covers pro­
vides magnetic protection. 

To find out where to buy 
Slidex disk-storage units, con­
tact TR IWEF (Slidex distribu­
tor), 200 Valley Road , Suite 
204, Mount Arlington, New Jer­
sey 07856; (201) 770-2800. 

Roll-Your-Own Manuals 
Any company, large or small, 
stands to benefit from having 
a policy handbook that an­
swers questions most often 
asked by employees-informa­
tion on salary reviews, compa­
ny holidays, benefits, leaves 
of absence, and other critical 
policies. Lack of such policies 
can affect employee morale 
and even result in legal prob­
lems down the road. Prepar­
ing an employee manual can 
give employers the impetus to 
form policies when they 
haven't previously done so. 

Employee ManualMaker 
has been edited and re­
viewed by a variety of indus­
try specialists. It includes 
more than 125 policies and 
30 benefits, which are organ­
ized, defined, and written for 
review and cuslomization. 

A special primer section in­
cludes advice on the best 
ways to find and hire employ­
ees, an employee application 
with a special preemployment 
release to help gain informa­
tion from previous employers, 
and much more. Employee 
ManualMaker retails for $130. 
For more information, contact 
JIAN Tools for Sales, 127 Sec­
ond Street, Los Altos, Califor­
nia 94022; (800) 346-5426. 

Companies with items of inter­
est suitable lor "News & 
Notes" should send inlorma­
lion along with a color slide or 
color transparency to News & 
Notes, Attn: Jill Champion, 
COMPUTE, 324 West Wen­
dover Avenue, Suite 200, 
Greensboro, North Carolina 
27408. Although space is lim­
ited, all items will be consid­
ered lor publication. 0 



a HardBall III takes a full cut at major league realism. A power line-up lhal includes printable slats, standings and

box scores; the ability to import data from HardBallICEarl Weaveriranti Tony LaRussa"; plus aTeam & Player Editor

that allows you to alter everything from team logos to a player's ability.

a HardBall III zooms in on the bang-bang plays.

Five camera angles cover the entire ballpark.

Watch instant replays and save the best for

your own personal Highlight Reel.

'Em
Baseball

WePlay
Hardball

HardBallIII

plays textbook "team

eftort" defense. Trie strongest

fundamentals in the game. Outfielders back

up one another and inf ielders act as cut-off

men, coming out to take the throw.

\/

a. HardBall III has the

bestplay-by-play man in thebusiness. Network

broadcast great Al Michaels joins ttie HardBall

///Team up in the booth, with a digitized

description of all the action.

a HardBall III thrusts you into the heatofa pennant

race. It's a 162 game, major league season -complete with

road trips and an all-star game. Compilegood numbers

along the way and maybe you'll make the roster.

The only computer game with Hall of Fame credentfa/s. You don't

outsell every baseball title in history by standing pat in the

off-season. New HardBall III redefines computer baseball once

more with real play-by-play announcing; unprecedented graphics,
realism and payability; plus more of the authentic baseball

nuances that serious fans want in a simulation. More runs.

More hits. No errors.

To order, visit your fa vorite software retailer or call

1-800-245-7744.

a HardBall III leads off with digitized players

and 256 color VGA graphics. Nobody beats this

double play combo. Visuals as eye opening as a line

drive up the middle. Animation as smooth as a

Gold Glove shortstop. From fresh mowed grass

to ivy covered walls.details that capture

The Show.

HardBall III tests each hitter's power with eight

real ballparks. Famous fields from both major

leagues. Your catcher may have just enough pop

to put it out of Chicago's "friendly confines;1 but

can he go deep in Toronto?

The best in entertainment software

Play-by-play announcing requires 2MB of RAM. Actual game screens from IBM PC VGA version olttegame Other versions mayvary HardBall Ml. HardBall II and HarflBall1 are trademark olAcmlaOelnc Earl Weaver II isa

Iraflemartof ElMranic Arts.Tr^ LaRussa iSalra'Jemarko'Slraiega&mulalioni Ire All mt^p'odud and COr^
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... HardBall 1fJ takes a full cut at ma/or league realism. A power line-up that includes printable stats, standings and 
box scores; the ability to import data from HardBall II,'" Earl Weaver II"' and Tony LaRussa"'; plus a Team & Player Editor 
that allows you to alter everything from team logos to a player's ability. 

... HardBall fJ/ zooms In on the bang-bang plays. 
Five camera angles cover the entire ballpark. 
Watch instant replays and save the best for 
your own personal Highlight Reel. 

Hard8afl lll 
plays textbook "team;;--'::::::::::::::::--:~i1 
effort" defense. The strongest 

fundamentals in the game. Outfielders back 
up one another and infielders act as cut-off 

mer~!"inll Oul: 10 take Ihe throw. 

... HardBall1ll has the 
best play-by-play man In the business. Network 
broadcast great AI Michaels joins the HardBall 
fllTeam up in the booth, with a digitized 
description of all the action. 

WE PLAy 
HARDBALC 

... HardBall1lf thrusts you into the heal of a pennant 
race. It's a 162 game. majolleague season -complete with 
load trips and an all-stal game. Compile good numbers 
along the way and maybe you'll make the roster. 

The only computer game with Hall of Fame credentials. You don't 
outsell every baseball title in history by standing pat in the ' 

off-season. New HardBall III redefines computer baseball once 
more with real play-by-play announcing; unprecedented graphics, 

realism and playability; plus mOfe of the authentic baseball 
nuances that serious fans want in a simulation. More runs. 

More hits. No errors. 
To order, visit your favorite software retailer or call 

1-800-245-7744. 

.& HardBa" III /eads off with dIgitized players 
and 256 color VGA graphIcs. Nobody beats this 
double play combo. Visuals as eye opening as a line 
drive up the middle. Animation as smooth as a 

Gold Glove shortstop. From fresh mowed grass 
to ivy covered walls,details that capture 

The Show. 

HardBall1ll tests each hiner's power with eIght 
real ballparks. Famous fields from both major 
leagues. Your catcher may have just enough pop 
to put it out of Chicago's "friendly confines:' but 
can he go deep In Toronto? 

, -
r'\LL~~L 
The bes t in entertainment software."" 

p~ iIIYIClJroci~ rfQuires 2MB 01 RAM.Actualgamescreens fram IBM PC VGA Vl!l'Wloi the game.Other v=ons mayvary. HardBaU III HardBall II ard HardBallllre trJdemarltsof AccdaOe.I~ Earl Weava II is a 
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FEEDBACK

Padding the phone

bill, freeing up directory

space, coping with

EMS, waiting for the

globe to settle,

packing your system,

and providing

for modem errors

Obscene Phone Charges
Please make your readers

aware that the FCC is quietly

working on a resolution that us

ers of modems should pay ex

tra charges for use of the pub

lic telephone network. Com

puServe, Tymnet, and Telenet

would also be charged as

much as $6.00 per hour per

user for use of the public tel

ephone network. The money

is to offset funds lost due to de

regulation.

If you own a computer or

plan to purchase one, telecom

munications is probably a big

part of your computing life.

Charges like this wil! either

kill or severely cripple the com

mercial online services. Write

to the following people to let

them know you're opposed to

this surcharge.

Chairman of the FCC

1919 M St. NW

Washington, DC 20549

Chairman. Senate Communica

tions Subcommittee

SH-227 Hart Building

Washington, DC 20510

Chairman, House Telecommu

nications Subcommittee

B-331 Rayburn Building

Washington, DC 20515

Remember that modem us

ers already pay fees for use

of the public telephone lines—

their phone bills.

ANTHONY J. HONER

DENT, UN

Thanks for letting our readers

know about this action. The

chairman of the House Tele

communications Subcommit

tee, Edward Markey, is al

ready opposed to the sur

charge. You might have more

effect sending your letters to

the ranking minority member

of the subcommittee, Mat

thew Rinaldo (Room 2469,

Rayburn Building, Washing

ton, DC 20515). Since this is

an issue that seems to come

up again and again, and

since this is an election year,

perhaps it would be a good

idea to find out how the con

gressional candidates in your

area stand on this surcharge

and vote accordingly

Space Cadet
When my son was using his

Joe Montana Football game,

he named one of his leagues

DREAM TEAM. This created

the directory DREAM TE. The

program seems to use it OK

and saves game files there,

but I want to get into it to

erase some of the old files

that are taking up room on

my hard disk. The DOS com

mand to change directory

won't recognize DREAM TE be

cause of the space. What can

I do?

CLARK HARPER

WINSTON-SALEM. NC

Although you could not cre

ate or access a file or directo

ry with that name using the nor

mal DOS commands, a pro

gram that bypasses the com

mand interpreter would have

no trouble creating such a

directory. The solution is there

fore fairly simple. Just get

hold of PC Tools and use the

PCSHELL program. It pro

vides a desktop from which

you can create, rename, ac

cess, and delete subdirecto

ries with spaces in their

names.

It's My Parity
I have a problem with my 286

clone. Soon after upgrading

from a CGA to a VGA system,

I started getting memory pari

ty interrupt errors. I get these

when using the DOS BACK

UP program and when trying

to install programs to my

hard disk, i replaced the

board and monitor with the

old CGA versions, and the er

rors stopped.

I called Orchid, the maker

of the VGA card, and was

told that there was a conflict

with the video memory at loca

tion A00OH to C7FFH be

cause another program was

trying to use that memory. I

was encouraged to buy a

memory-manager program,

such as QRAM by Quarter

deck. I purchased QRAM,

then found out that I need ei

ther EMS, EEMS, or Chips

and Technologies' shadow

RAM. I don't know what these

are or where to get them.

At this time I have a 286

with 1 MB of RAM, Phoenix BI

OS version 3.1, and DOS 5.0.

I use ProDesigner II. Can you

tell me what I can do to keep

this system and not spend a

lot more money to solve this

problem?

DAVID J. GRAVERT

DAVENPORT, IA

In short, Orchid is right—

you're a victim of progress,

and you'll need to shell out

even more money to make

this work.

EMS, or Expanded Memo

ry Specification, is a standard

for extra memory on PCs that

allows PCs to use more than

640K, allowing you to add up

to 16MB of memory for data

storage. It's a hardware/soft

ware combination that both

memory manufacturers and

software developers ha ve

agreed upon. The 286 and

higher-numbered chips allow

use of much more than 640K,

but only by running the chip

in a different mode, called pro

tected mode, that's nominally

incompatible with DOS.

That's why OS/2 and the up

coming 32-bit Windows can

address huge amounts of

memory, but only by running

in protected mode and forc

ing you to run DOS programs

in a separate compatibility

box mode. This memory, con-

fusingly is called extended

memory and is not compati

ble with EMS. EEMS is a revi-
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Obscene Phone Charges 
Please make your readers 
aware that the FCC is quietly 
working on a resolution that us­
ers of modems should pay ex­
tra charges for use of the pub­
lic telephone network. Com­
puServe, Tymnet, and Telenet 
would also be charged as 
much as $6.00 per hour per 
user for use of the public tel­
ephone network. The money 
is to offset funds lost due to de­
regulation. 

If you own a computer or 
plan to purchase one, telecom­
munications is probably a big 
part of your computing life. 
Charges like this will either 
kill or severely cripple the com­
mercial online services. Write 
to the following people to let 
them know you're opposed to 
this surcharge. 

Chairman of the FCC 
1919 M SI. NW 
Washington, DC 20549 

Chairman, Senate Communica­
tions Subcommittee 
SH-227 Hart Building 
Washington, DC 20510 

Chair.man, House Telecommu­
nications Subcommittee 
B-331 Rayburn Building 
Washington, DC 20515 

Remember that modem us­
ers already pay fees for use 
of the public telephone lines­
their phone bi lls. 
ANTHONY J. HONER 
DENT. MN 

Thanks for letting our readers 
know about this action. The 
chairman of the House Tele­
communications Subcommit­
tee, Edward Markey, is al­
ready opposed to the sur­
charge. You might have more 
effect sending your letters to 
the ranking minority member 
of the subcommittee, Mat­
thew Rinaldo (Room 2469. 
Rayburn Building, Washing­
ton, DC 20515). Since this is 

an issue that seems to come 
up again and again, and 
since this is an election year, 
perhaps it would be a good 
idea to find out how the con­
gressional candidates in your 
area stand on this surcharge 
and vote accordingly 

Space Cadet 
When my son was using his 
Joe Montana Foolball game, 
he named one of his leagues 
DREAM TEAM. This created 
the directory DREAM TE. The 
program seems to use it OK 
and saves game files there, 
but I want to get into it to 
erase some of the old files 
that are taking up room on 
my hard disk. The DOS com­
mand to change directory 
won't recognize DREAM TE be­
cause of the space. What can 
I do? 
CLARK HARPER 
WINSTQN·SALEM , NC 

Although you could not cre­
ate or access a file or directo­
ry with that name using the nor­
mal DOS commands, a pro­
gram that bypasses the com­
mand interpreter would have 
no trouble creating such a 
directory The solution is there­
fore fairty simple. Just get 
hold of PC Tools and use the 
PCSHELL program. It pro­
vides a desktop from which 
you can create, rename, ac­
cess, and delete subdirecto­
ries with spaces in their 
names. 

It's My Parity 
I have a problem with my 286 
clone. Soon after upgrading 
from a CGA to a VGA system, 
I started getling memory pari­
ty interrupt errors. I get these 
when using the DOS BACK­
UP program and when trying 
to install programs to my 
hard disk. I replaced the 
board and monitor with the 
old CGA versions, and the er­
rors stopped. 

I called Orchid, the maker 

of the VGA ca rd, and was 
told that there was a conflic t 
with the video memory at loca­
tion AOOOH to C7FFH be­
cause another program was 
trying to use that memory. I 
was encouraged to buy a 
memory-manager program , 
such as QRAM by Quarter­
deck. I purchased QRAM , 
then found out that I need ei­
ther EMS, EEMS, or Chips 
and Technologies' shadow 
RAM. I don't know what these 
are or where to get them. 

At this time I have a 286 
with 1 MB of RAM, Phoenix BI ­
OS version 3.1 , and DOS 5.0. 
I use ProDesigner II. Can you 
tell me what I can do to keep 
this system and not spend a 
lot more money to solve this 
problem? 
DAVID J. GRAVERT 
DAVENPORT, IA 

In short, Orchid is right­
you 're a victim of progress, 
and you'll need to shell out 
even more money to make 
this work. 

EMS, or Expanded Memo­
ry SpeCification, is a standard 
for extra memory on PCs that 
allows PCs to use more than 
640K, allowing you to add up 
to 16MB of memory for data 
storage. It's a hardware/soft­
ware combination that both 
memory manufacturers and 
software developers ha ve 
agreed upon. The 286 and 
higher-numbered chips allow 
use of much more Ulan 640K, 
but only by running the chip 
in a different mode, called pro­
tected mode, that's nominally 
incompatible with DOS. 
That 's why OS/2 and the up­
coming 32-bit Windows can 
address huge amounts of 
memory, but only by running 
in protected mode and forc­
ing you to run DOS programs 
in a separate compatibility 
box mode. This memory; con­
fusingly, is called extended 
memory and is not compati­
ble with EMS. EEMS is a revi-
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Now Falcon 3.0"takes you places you've never flown before.

Operation: Fighting Tigeftakes you on action-packed

missions in three new Asian campaigns. Fly your F-16

to Korea, to the Pakistan/India border, to Japan and

the disputed Kurile Islands, where you can also fly

Operation: Fighting Tiger requires Falcon 3.0

For Visa/MasterCard orders call 24 hours a day. Tdaysa weak: i-BOO-695-GAMe (Orders Only)
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the advanced FSX. The incredible scope of Falcon 3-0

delivers everything from Instant Action arcade excite

ment to plotting your own Red Flag training missions

to engaging in a dramatically different campaign

every time you play. The flight models and terrain are

real. The radar and weapons are real. The enemies,

missions and campaigns nothing less than spine-

tingling. Joining forces with the most sophisticated

flight simulation of all time, Operation: Fighting Tiger

broadens your horizons as never before. And makes

the wild blue yonder a whole lot wilder.
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Now Falcon 3.0
B

takes you places you've never 
Operation: Fighting Tigeftakes you on action-packed 
missions in three new Asian campaigns. Fly your F-16 
to Korea, to the Pakistan/India border, to Japan and 
the disputed Kurile Islands, where you can also fly 
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the advanced FSX. The incredible of Falcon 3.0 
delivers everything from Instant Action arcade excite­
ment to plotting your own Red Flag training missions 
to engaging in a dramatically different campaign 
every time you play. The flight models and terrain are 
real. The radar and weapons are real. The enemies, 
missions and campaigns nothing less than spine­
tingling. Joining forces with the most sophisticated 
flight simulation of all time, Operation: Fighting Tiger 
broadens your horizons as never before. And makes 
the wild blue yonder a whole lot wilder. 

Spectrum HoloByte® 
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Live psychics reveal what the

future holds lor your love lite.

LIVE! Specializing in
questions of love

1-900

$5 first min./$3 ea. addl. min.

Use the wisdom of

psychic forces to

guide you in money,

career and happiness

1-900

773-OMEN
1 -900-773-6636

$5 first min./S3 ea. addl. min.

TALK TO A UVE PSYCHIC!

For entertainment purposes

only. If you are under 18 years

of age, please get parental

permission. Live psychics are

available 24 hours a day.

Sponsored by Pet Inc., P.O. Box

166, Hollywood, CA 90078.

FEEDBACK
sion of EMS that allows programs to

run in expanded memory Just to

make things even tougher to under

stand, some software—QRAM includ

ed—converts extended memory

(which the 286 understands natively) to

expanded memory This is probably

the best choice for you, since it gives

you both options on your 286. So we

suggest you go the extended memory

route. This will cost you, at mail-order

prices, about S50-S100 for an empty ex

tended memory board and about $60

per megabyte of memory. One meg is

enough, but I suggest two or three—

or as much as you can afford. The

price for EMS boards is similar.

Some things to remember ifyou pur

chase EMS:

1. Make sure the chips are fast

enough to run on your computer (for ex

ample, buy 80-ns chips if those are

what your machine is equipped with)..

2. Note that to work its magic, an

EMS board or emulator snatches 64K

from your precious 640K. So if you

have 580K free before the EMS is in

stalled, you 'II end up with only 516K af

ter—but you'll have access to all the ex

tra memory you can afford.

3. Make sure the software you use—

ProDesigner, in this case—knows how

to use EMS. Many programs don't.

Golden Globe
PC Globe sounds really good, but

what about the way the Soviet Union is

changing? Should I wait until that situa

tion is resolved before buying it?

NAOMI R. SMITH

PEKIN, IL

If you wait for the world to settle down

and borders to remain firm, you'll have

a long wait. Companies that manufac

ture products on changing situations of

fer regular upgrades. PC Globe is up

dated every 12-18 months. The most

recent update was in April 1992. The

charge to receive these updates is $35

per year.

Stranger in a Strange Land
I work for the U.S. Foreign Service and

have to ship my belongings, including

my computer and peripherals, on a fair

ly regular basis. I already know about

packing my hard drive, but I was hop

ing you could give me some addition

al pointers on how to secure delicate

PC equipment for international trans

port.

THOMAS C. PROCTOR

JAKARTA. INDONESIA

The best advice is to keep the ship

ping containers your components

COMPUTE SEARCHSTAKES!
No purchase or phone call required. For automatic

enty. call 1-900454-8681 on a touch-tone phone. The
cost for the cat! is $1.50 (or the first minute and S1.00
per minute thereafter average call is estimated to be 2-

3 minutes. Charges lor calls to the above number will
appear on your phone til Callers must be 18orolder.

To enter monthly SearchStakes drawings, call from 9

AM EDT on 4£&92 through midnight EST 12/31/92

to give your name, address, telephone number, the

Compute issue date (month), and the solution for the
month you select. To enter the Grand Prize drawina

call from 9:00 AM EST 11/1/92 through midnight EST

1/31/93 to give your name, address, telephone number,

the solution to the Grand Prize SearchStakes pjus. the
solution to any two of the previous monthly

SearchStakes. All call-in entrants will receive a S5.00

savings coupon toward caller's choice of: (1) Kathy

Keeton's newest book, Longevity, or (2) a two-year

subscription to Compute. Multiple coupons may not be

combined on a single book of subscription purchase.

Call as often as you wish; each call is a separate entry.

Call-in entry option is void in GA. LA, MN, OR. NJ and
where prohibited.
Alternate Entry Method: Print your name, address,

and phone number on a 3" x 5" piece of paper. (1) To

enter the monthly drawings, print the Compute issue

date (month) and solution for that month on your entry

and address your envelope to include the issue date

(month), for example: "June Compute SearchStakes."

(2) To enter the Grand Prize drawing, print the words

"Grand Prize," the Grand Prize solution, plus the
solution to any two previous monthly SearchStakes
on your entry. Address your envelope: "Compute

SearchStakes Grand Prize." Mail all entries,

addressed as directed above, to: 324 West Wendover
Avenue, Suite 200, Greensboro, N.C. 27408. Enter

as often as you wish: each entry must be mailed

separately. All write-in entries must be postmarked by

1/31/93 and received by 2/15/93.

For the solution(s), complete rules, and detailed

description of prizes including prize values, send a

self-addressed stamped envelope to Compute

SearchStakes Solutions, Dept RRS.1965 Broadway,

NY, N.Y. 10023-5965 by 12/31/92; no return postage

required for residents of VT and WA. Solutions and

prize information will be provided through the issue

date in which the request is received.

Odds determined by number ol entries received.

Prizes/Values: Grand Prize (1), minimum value

$15,000-maximum value $40,000. Monthly prizes

(6), one for each of the following Compute 1992

issue dates: June, July. August, September,
October, and November, minimum value $1,500-

maximum value $7,500. Maximum total prize

value: $85,000. A description of each prize,

including its approximate value, will appear in

Compute prior to the first entry date for that prize.

Prizes are not transferable or redeemable for cash.

No substitution of prizes except as necessary, due

to availability. Licensing, transportation,

registration, and dealer charges, if applicable, are

winner's responsibility. Winners may be required

to pick up some prizes from the nearest dealership.

Travel prizes must be from a major airport nearest

winner's home and must be used within 12 months

ol award date. Additional restrictions may apply.

Taxes are the winner's responsibility.

Open only to U.S. residents 18 and older, except

employees and their families of Compute Int'l Ltd.,

POWER GROUP, INC., their respective subsidiaries,

affiliates, and advertising agencies. Ail federal, state,

local laws and regulations apply. Void where prohibited.

This program is sponsored by Compute International

Ltd., 1965 Broadway, NY, N.Y. 10033, (212) 496-

6100. Monthly winners will be selected at random

from among all eligible entries received by the judges

by the following drawing dates: June issue-7/31&2,
July issue-8/31/92, August issue-9/30/92. September

issue-10/30/92, October issue-11/30/92, November

issue-12/31/92. Grand Prize winner will be selected at

random from among all eligible entries received by
2/15/93. Winners will be selected by POWER

GROUP, INC., an independent judging organization

whose decisions are final. Winners wil be notified by

mail and required to execute and return an affidavit of

eligibility and release within 21 days of date on

notification letter or alternates will be selected at

random. Limit one winner per household.

This sweepstakes is subject to the Official Rules
and Regulations. For a list of winners, send a self-

addressed stamped envelope to: Compute

SearchStakes Winners, Dept. RRW, 1965 Broadway,

NY, N.Y. 10023-5965 by 331/93. Requests will be
fulfilled after the sweepstakes ends.
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FEEDBACK 
sian of EMS that allows programs to 
run in expanded memory. Just to 
make things even tougher to under­
stand, some software- QRAM includ­
ed-converts extended memory 
(which the 286 understands natively) to 
expanded memory. This is probably 
the best choice for you, since it gives 
you both options on your 286. So we 
suggest you go the extended memory 
route. This will cost you, at mail-order 
prices, about $50-$100 for an empty ex­
tended memory board and about $60 
per megabyte of memory One meg is 
enough, but I suggest two or three­
or as much as you can afford. The 
price for EMS boards is similar. 

Some things to remember if you pur­
chase EMS: 

1. Make sure the chips are fast 
enough to run on your computer (for ex­
ample, buy 80-ns chips if those are 
what your machine is equipped with) .. 

2. Note that to work its magic, an 
EMS board or emulator snatches 64K 
from your precious 640K. So if you 
have 580K free before the EMS is in­
stalled, you 'll end up with only 5 16K af­
ter- but you'll have access to all the ex­
tra memory you can afford. 

3. Make sure the software you use­
ProDesigner, in this case-knows how 
to use EMS. Many programs don't. 

Golden Globe 
PC Globe sounds really good, but 
what about the way the Soviet Union is 
changing? Should I wait unti l that situa­
tion is resolved before buying it? 
NAOMI R SMJTH 
PEKIN,IL 

tf you wait for the world to settle down 
and borders to remain firm, you'll have 
a long wait. Companies that manufac­
ture products on changing situations of­
fer regular upgrades. PC Globe is up­
dated every 12-18 months. The most 
recent update was in April 7992. The 
charge to receive these updates is $35 
per year. 

Stranger in a Strange Land 
I work for the U.S. Foreign Service and 
have to ship my belongings, including 
my computer and peripherals, on a fair­
ly regular basis. I already know about 
packing my hard drive, but I was hop­
ing you could give me some addition­
al pointers on how to secure delicate 
PC equipment for international trans­
port. 
THOMAS C PROCTOR 
JAKARTA. INDONESIA 

The best advice is to keep tile ship­
p ing containers your components 

COMPUTE SEARCHSTAKES! 
No purchase or phone call required. For automatic 
entry, caB 1·900-454-8681 on a touch-ble phone. The 
cost lor !he cal is $1.50 for the tirsl mute and $1.00 
per rrftJte IhereatIer, avemge cal is estina!ed 10 be 2· 
3 minutes. awges tor csIs tI the aw.e rurtJer"l1 
appear on)Qlf pIr:re bi. cahs roost be 18" older. 
To ente< monthly Sean:hS1akes dravoT>gs. cal """ 9 
A.M. EDT on <V2&'92111rou!1> fri<h!j1t EST 121311!l2 
to give your name, address, telephone number, the 
Coopute issue date (month), and the solution lor the 
month you select To enter the Grand Prize dra'oWlg, 
cal hom 9:00 A.M. EST , W92 _ fri<h!j1t EST 
113M131O rj.Ie yot.X name, ao;ess,leiephone ru"tt:Ier, 
It-. _ 10 It-. Grand PrIze Sean:hS1akes 1M It-. 
solution to any two 01 the previous monthly 
SearchStakes. AI call·in entrants wiB receive a $5.00 
savings coupon toward calle(s choice of: (1) Kathy 
Keeton's newest book, Longevity, or (2) a two-year 
scbsaipIion to Ccnp.JW. Muhiple ~ may not .. 
combined 00 a single book 01' ~ purchase. 
caR as otten as you 'Wish; each cal is a sepal8te entry. 
Cakl "'tty option Is >dd In GA.LA MN. OA. NJ ar<l 
when> pro/lb1ed. 
Alternate Entry Method: Print your name, address, 
and phone number on a:r x 5" piece of paper. (1) To 
enter !he monthly drawings, print !he Compute issue 
date (month) and solution for thatlTlOl"th on your entry 
and adcress your envelope 10 include the issue date 

lroonth), lor .x"n,"''' -Jule Con-.>u1' Seaithstakes'-
2) To enter the Grand Prize drawilg, print the words 

'Grand Prize,' the Grand Prize solulion, Q/.uj the 
solution to any MOO previous monthly SearchStakes 
on your entry. Address your envefope: 'Compute 
SearchStakes Grand Prize.~ Mai l all entries , 
addressed as cirected above, to: 324 West Wendover 
Averue, Suite 200, Greensboro, N.C. 27408. Enter 
as often as you wish; each entry must be mailed 
separately. AI wri'.e-in entries must be postmaJ1<ed by 
IfJlf.1Jand ~ by 2/15J93. 
For the solution(s), complete rules, and detailed 
description of prizes including prize values, send a 
self-addressed stamped envelope 10 Compute 
Seon:hS1akes SoMions, Dept. AAS,l965 Broadway, 
NY, N.Y. 10023-5965 by 12fJ1192; no retum postage 
required for residents of vr and WA. Solutions and 
prize Information will be provided through the Issue 
date In which the request Is reoe/ved. 
Odds determined by number of entries received. 
PrizesNalues: Grand Prize (I ), minimum value 
$15,QOO-maximum value $40,000. Monthly prizes 
(6), one for each of the following Compute 1992 
issue dates: June. July , August, September, 
October, and November, minimum value SI ,5OO­
maximum value S7,500. Maximum total prize 
value: S85,000. A description 01 each prize . 
Including its approximalo value, will appear in 
Compute prior to the first ontry date for that prize. 
Prizes are nol lransferable or redeemable for cash. 
No substitution 01 priZes except as necessary. due 
to availability. licensing, transportation, 
registration, and dealer charges, if applicable, are 
winner's responsibility. Winners may be required 
to pick up some prizes from the nearest dealership. 
Travel prizes must be from a major airpor1 nearest 
winne(s home and must be used within t2 months 
of award date. Addillonal restrictions may apply. 
Taxes are the wime(s responsibility. 
Open only to U.S. residents 18 and older. except 
employees and their families of Compute Inl'l ltd., 
POWER GROUP, tNC., their respective subsidiaries, 
affiliates, and advertising agencies. All federal , state, 
IocaIlsws am regulations awfy. Void v.here prohlDted. 
ThIs program is sponsored by Compute Intemalional 
ltd., 1965 Broadway, NY, N.Y. 10023, (212) 496-
6100. Monthly I'Mners will be selected at random 
""" among aI ._ ",tries receNed by It-. judges 
by the fotlowing drawing dates: June issue-7fJll92, 
July issue-Bl31192. August lssue-9I3OO2. September 
issue·10130192. October issue·11130192. November 
issue-12131192. Grand Prize wimer wi! be selected at 
random from among all eligible entries received by 
2/15/93. Winners will be selected by POWER 
GROUP, INC., an independent judglllQ organization 
~ decisions are final. Wrmers wil be notified by 
mai and reqt.ired to execute and retum an affidavit of 
eligibility and release within 21 days of date on 
notification letter or altemates will be selected at 
random. LimiI one winner per househDd. 
This sweepstakes is subject to the Official Rules 
and Regulations. For a list of winners, send a self· 
addressed stamped envelope 10: Compute 
Sean::hStakes Wrmers. Dept. RR'N, 1965 Broadway, 
NY, N.Y. 10023-5965 by l'31193. Requests Wlil be 
fulfilled after the sweepstakes ends. 
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came in, including the styroform

blocks that held your computer in

place, but we assume that it's too late

for that.

If you threw away your original pack

ing materials, you need plastic bags,

and lots of 'em. If you receive bags

from the federal government, the heavy

garbage bags will fill the bill

single-strength.

If you're using regular plastic bags,

double or triple them so that each unit

of your computer is air- and watertight.

Put each component in its own bag

(use zip-lock sandwich bags for the

mouse and cables).

Pack everything in at least one thick

ness of corrugated cardboard with the

highest burst strength you can find. If

you're also shipping clothing, it makes

excellent packing material.

Just pack your off-season clothing

around the computer and save some

boxes. With a computer, there's noth

ing to leak or rub off on your clothes.

If you kept the cardboard inserts

that came with your disk drives, rein

sert them before moving the computer.

This prevents the read/write heads in a

disk drive from knocking against each

other.

If you threw them away, cut a piece

of cardstock about the width of a com

puter disk and a couple of inches long

er (so you can pull it out) for each

drive and insert that instead. Protect

the keyboard from anything that might

press on the keys.

Pro Communication
I enjoyed Tony Roberls's article on tel

ecommunications in the December is

sue. However, he made one small mis

take at the end when he said that Pro-

Comm Plus doesn't provide much infor

mation about errors.

ProComm Plus creates an error file

with the same name as the script file

but with an ERR extension. This file

will tell you what line in the script con

tains the error. It also contains informa

tion about the nature of the error, such

as NO ENDPROC or INVALID TOKEN.

CHET MILLER

GREAT FALLS. MT

Readers whose letters appear in "Feed

back" will receive a free COMPUTE'S

PC clock radio while supplies last. Do

you have a question about hardware or

software? Or have you discovered

something that could help other PC us

ers? If so, we want to hear from you.

Write to COMPUTE'S Feedback, 324

West Wendover Avenue, Suite 200,

Greensboro, North Carolina 27408. We

regret that we cannot provide person

al replies to technical questions. D

Dr. Schueler's

Home Medical

Advisor
COMPUTER PROGRAM

i_LJ

Send your computer lo medical school and

access updated info on self care, symptom

analysis, and preventative medicine.

Using color graphics Dr. Schueler's takesyour

medical history and analyzes your symptoms.

S v in |i 10 in F i 11

Conceived and designed over a two-year

period by an Emergency Ph/sician and a

team of over 40 Physician Specialists.

The Home Medical Advisor contains vast

databases on pediatric and adult diseases,

poisons, drug info, injuries, and medical tests.

95 PC ■ Hard Disk
EGA or VGAOnly $69

See your Software V--&-J

Dealer or call

1-800-788-2099
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came in, including the styroform 
blocks that held your computer in 
p lace, but we assume that it's too late 
for that. 

II you threw away your original pack­
ing materials, you need plastic bags, 
and lots of 'em. II you receive bags 
from the federal government, the heavy 
garbage bags will fill the bill 
single-strength. 

II you're using regular plastic bags, 
double or triple them so that each unit 
of your computer is air- and watertight. 
Put each component in its own bag 
(use zip-lock sandwich bags for the 
mouse and cables). 

Pack everything in at least one thick­
ness of corrugated cardboard with the 
highest burst strength you can find. II 
you 're also shipping clothing, it makes 
excellent packing material. 

Just pack your off-season clothing 
around the computer and save some 
boxes. With a computer, there's noth­
ing to leak or rub off on your clothes. 

II you kept the cardboard inser ts 
that came with your disk drives, rein ­
sert them before moving the computer. 
This prevents the read/write heads in a 
disk drive from knocking against each 
other. 

II you threw them away, cut a piece 
of cardstock about the width of a com­
puter disk and a couple of inches long­
er (so you can pull it oul) for each 
drive and insert that instead. Protect 
the keyboard from anything that might 
press on the keys. 

Pro Communication 
I enjoyed Tony Roberts's article on tel­
ecommunications in the December is­
sue_ However, he made one small mis­
take at the end when he said that Pro­
Comm Plus doesn't provide much inlor­
mation about errors. 

ProComm Plus creates an error file 
with the same name as the script fi le 
but with an ERR extension . This fi le 
will tell you what line in the script con­
tains the error. It also contains informa­
tion about the nature of the error, such 
as NO ENDPROC or INVALID TOKEN. 
C H ET MILLER 

GREAT FALLS. MT 

Readers whose letters appear in "feed­
back" will receive a free COMPUTE's 
PC clock radio while supplies last. Do 
you have a question about hardware or 
software? Or have you discovered 
something that could help other PC us­
ers? II so, we want to hear from you. 
Write to COMPUTE's Feedback, 324 
West Wend.over Avenue, Suite 200, 
Greensboro, North Carolina 27408. We 
regret that we cannot provide person­
al replies to technical questions. 0 

Dr. Schueler's ~ 

Home Medical 
Advisor 

COMPUTER PROGRAM 

Send your computer to medical school and 
access updated info on self care, symptom 
analysis, and preventative medicine. 

Using color graphics Dr. Schueler's takes your 
medical history and analyzes your symptoms. 

Conceived and designed over a two-year 
period by an Emergency Phl'Sician and a 
team of over 40 Physician Specialists. 

The Home Medical Advisor contains vast 
databases on pediatric and adult diseases, 
poisons, drug info, injuries, and medical tests. 

only$6995 PC ' Hard Disk 
EGA or VGA 

IZI See your Software 
Dealer or call 

1-800-788-2099 
PIXEL PERFECT, INC. 

10460 S. TropIcal Tr., Merritt Island, FL 32952 

Circ le Reader Service Nu mber 169 
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Protect your

computer, checksum

COMPUTE'S

DEBUG scripts, and

much more.

Checking DEBUG Codes
We've started a tradition of

publishing small COM pro

grams that you can type in us

ing DOS's DEBUG program.

It can be a challenge to get

them right, though, since you

are entering pure machine

code in hexadecimal form.

Here's a program that will

give you a checksum value

for a COM file. Each DEBUG

example we publish from now

on will have a checksum val

ue given. To use the pro

gram, just type CHECKSUM

FILENAME.COM, and it'll

give you a three-digit value.

Compare this number to the

number printed in the maga

zine. If it's different, then you

have an error in your typing. If

it's the same, chances are

pretty good that you haven't

made any errors typing it in.

Before you try to create

this program, make sure the

DOS program called DEBUG

is in your path or the current di

rectory. In these examples

the italic text is what the com

puter prints; the roman text is

what you should type. One

way to be sure you get these

programs exactly right is to

have someone read the num

bers to you as you type them

in. Another way suggested by

one of our readers is to read

the numbers into a tape re

corder and then play them

back as you enter the pro

gram code.

DEBUG CHECKSUM.COM

File not found

-e 100 be 80 00 ac 0a cO 74 64

-e108 ac 3c Od 74 5f 3c 20 74

-e 110 f7 8b d6 4a ac 3c Od 74

-e 118 04 3c 20 75 f7 c6 44 ff

-e120 00 bf 70 01 2b (6 b8 00

-e 128 3d cd 21 72 3f 8b d8 8b

-e 130 d7 b9 01 00 b4 3f cd 21

-e 138 8a 05 03 10 0b cD 75 ef

-e 140 b4 3e cd 21 81 e6 ff 00

-e 148 bb 64 00 8b c6 2b d2 !7

-e 150 f3 04 30 88 05 8b VI 8b

-e158 (17 Ij4 09 cd 21 2b d2 8b

-e160 c3 bb 0a 00 f7 f3 8b d8

-e168 0b db 75 df b4 4c cd 21

-e170 00 24

-RCX

CX 0000

:72

-W

Writing 0072 bytes

-Q

Test it out. The checksum you

get for CHECKSUM.COM

should be 062.

RICHARD C. LEINECKER

MIAMI. FL

Easy Security
If you worry about your PC

while you're away from it,

there may be an easy way to

keep people from accessing

your computer when it's left

running without supervision.

This program waits for you to

press the F4 key. It won't re

spond to any other key, even

the Ctrl-Alt-Delete combina

tion. You can put it in your

AUTOEXEC.BAT file for a sim

ple password system.

-e 100 b8 09 35 cd 21 89 1e 50

-e 108 01 8c 06 52 01 b8 09 25

-e 110 ba 2d 01 cd 21 83 3e 54

-e 118 01 00 74 19 8b 16 50 01

-e 120 8c 1e 52 01 b8 09 25 cd

-e 128 21 b4 4c cd 21 50 e4 60

-e 130 3c 3e 75 0c 1e 8c c8 Be

-e 138 (18 c7 06 54 01 01 00 1f

-e 140 e4 61 0c 80 e6 61 24 7f

-e 146 e6 61 bO 20 e6 20 58 cf

-e 150 00 00 00 00 00 00

-RCX

CX 0000

:56

-W

Writing 0056 bytes

-Q

The checksum for this pro

gram should be 147.

You can change it to ac

cept any function key. Find

the second hex number in the

line that starts -e 130. Its val

ue is 3e. Change this value to

anything you want. Remem

ber, though, this isn't an AS

CII code but a raw scan

code from the keyboard.

Here are the values for func

tion keys 1-10.

F1 3b

F2 3c

F3 3d

F4 3e

F5 31

THOMAS E. HINES

KANSAS CITY. MO

F6

F7

F8

F9

40

41

42

43

F10 44

More Printer Control
Several months ago we fea

tured a couple ot DEBUG pro

grams that let you send con

trol codes to your printer.

Since then we've developed

some batch files to do the

same thing.

Here's one called FF.BAT

that sends a form feed to the

printer. To create this file,

type COPY CON FF.BAT and

press Enter. Type echo and

press the space bar. Hold

down the Left-Shift and Left-

Alt keys while you type 1 then

2 on the numeric keypad.

Type the > character and

then pm. Press Enter to end

the line. Then press F6 and En

ter to create the file.

Make sure this batch file is

in your path or the current di

rectory and type FF. When

run, it sends a form feed to

your printer.

You can send any single

code or combination of

codes to your printer. Some

of the more common ones

are a carriage return (ASCII

value 13) and a linefeed (AS

CII value 10).

Consult your printer manu

al for other useful codes like

the one for setting the printer

to near letter quality or the

one for setting it to one of its

built-in fonts. Once you've

made your list of control

codes, you can combine

them into one big batch file.

Here's a simple example

called PCODES.BAT. Where

you see {CHARACTER 12},

hold down the Left-Shift and
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Checking DEBUG Codes 
We've started a tradition of 
publishing small COM pro­
grams that you can type in us­
ing DOS's DEBUG program. 
It can be a challenge 10 get 
them right, though , since you 
are entering pure machine 
code in hexadecimal form. 

Here's a program that will 
give you a checksum value 
for a COM file. Each DEBUG 
example we publish Irom now 
on will have a checksum val­
ue given . To use the pro­
gram, just type CHECKSUM 
FILENAME. COM, and it'll 
give you a three-digit value . 
Compare this number to the 
number printed in the maga­
zine. If it's different, then you 
have an error in your typing . If 
it's the same , chances are 
pretty good that you haven 't 
made any errors typing it in. 

Before you try to c reate 
this program, make sure the 
DOS program called DEBUG 
is in your path or the current di­
rectory. In these examples 
the italic text is what the com­
puter prints; the roman text is 
what you should type . One 
way to be sure you get these 
programs exactly right is to 
have someone read the num­
bers to you as you type them 
in. Anolher way suggested by 
one of our readers is to read 
the numbers into a tape re­
corder and then play them 
back as you enter the pro­
gram code. 

DEBUG CHECKSUM.CDM 
File not lound 
-.100 b. 80 00 ac Oa cO 74 64 
-.108 ac 3c Od 74 5f 3c 20 74 
-.110 17 8b d6 4a ac 3c Od 74 
-e 118 04 3c 20 75 t7 c6 44 It 
-.120 00 bt 70 01 2b 16 b8 00 
-.128 3d cd 21 72 31 8b d8 8b 
-.130 d7 b9 01 00 b4 3t cd 21 
-.138 8a 05 03 to Db cO 75 .1 
-.140 b4 3. cd 21 81 .6 It 00 
-e 148 bb 64 00 8b c6 2b d2 t7 
-.150 13 04 30 88 05 8b 12 8b 
-.158 d7 b4 09 cd 21 2b d2 8b 
-e 160 c3 bb Oa 00 17 f3 8b d8 

-.168 Db db 75 df b4 4c cd 21 
-.170 00 24 
-RCX 
ex 0000 
:72 
-W 
Writing 0072 bytes 
-Q 

Test it out. The checksum you 
get for CHECKSUM. COM 
should be 062. 
RICHARD C lEINECKER 
MIAMI , Fl 

Easy Security 
If you worry about your PC 
while you're away from it , 
there may be an easy way to 
keep people from accessing 
your computer when it's left 
running without supervision. 
This program waits for you to 
press the F4 key. It won't re­
spond to any other key, even 
Ihe Clri -Alt-Delete combina­
tion . You can put it in your 
AUTOEXEC.BAT file for a sim­
ple password system. 

DEBUG PASSWORD.COM 
File not found 
-.100 b8 09 35 cd 21 89 1. 50 
-.108 01 8c 06 52 01 b8 09 25 
-.110 ba 2d 01 cd 21 83 3. 54 
-.118 01 00 74 f9 8b 16 50 01 
-.120 8. 1. 52 01 bB 09 25 cd 
·.128 21 b4 4c cd 21 50 .4 60 
-.130 3c 3. 75 Dc 1. 8c c8 8. 
-.138 d8 c7 06 54 01 01 00 11 
-.140 .4 61 Dc 80 .6 61 24 7t 
-.148 .6 61 bO 20 .6 20 58 ct 
-.150 00 00 00 00 00 00 
-RCX 
ex 0000 
:56 
-W 
Writing 0056 bytes 
-Q 

The checksum for th is pro­
gram should be 147. 

You can change it to ac­
cept any funct ion key. Find 
the second hex number in the 
line that starts -e 130. Its val­
ue is 3e. Change this value to 
anything you want. Remem­
ber, though , this isn't an AS-

CII code but a raw scan 
code from the keyboard . 
Here are the values for func­
tion keys 1- 10. 

Fl 3b F6 40 
F2 3c F7 41 
F3 3d F8 42 
F4 3e F9 43 
F5 31 FlO 44 
THOMAS E. HINES III 
KANSAS CITY, MO 

More Printer Control 
Several months ago we fea­
tured a couple of DEBUG pro­
grams that let you send con­
trol codes to your printer. 
Since then we've developed 
some batch files to do the 
same thing. 

Here's one called FF.BAT 
that sends a form feed to the 
printer. To c reate this file, 
type COPY CON FF.BAT and 
press Enter. Type echo and 
press the space bar. Hold 
down the Left-Shill and Lell­
All keys while you type 1 then 
2 on the numeric keypad . 
Type the > character and 
then pm. Press Enter to end 
the line. Then press F6 and En­
ter to create the file . 

Make sure this batch file is 
in your path or the current di­
rectory and type FF. When 
run , it sends a form feed to 
your printer. 

You can send any single 
code or combination of 
codes to your printer. Some 
of the more common ones 
are a carr iage return (ASCII 
value 13) and a linefeed (AS­
CII value 10). 

Consult your printer manu­
al for other useful codes like 
the one for setting the printer 
to near letter quality or the 
one for setting it to one of its 
built-in fonts . Once you've 
made your list of control 
codes, you can combine 
them into one big batch file . 
Here 's a simple example 
called PCODES.BAT. Where 
you see ICHARACTER 12}, 
hold down the Left-Shift and 
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TIPS & TOOLS

Wield more powerful

printer controls,

slice your hard disk

up to 23 ways,

and create decorative

LaserJet fonts.

Left-Alt keys while you type 1

then 2 on the numeric key

pad. Where you see |CHAR-

ACTER 10), hold down the

Left-Shift and Left-Alt keys

while you type 1 then Don the

numeric keypad.

©ECHO OFF

IF %1==FF GOTO FORMFEED

IF %1=ff GOTO FORMFEED

IF %1=LF GOTO LINEFEED

IF %1=lf GOTO LINEFEED

IF %1=DP GOTO PRINTDIR

IF %1=dp GOTO PRINTDIR

ECHO .

ECHO To use this batch file, type

ECHO PCODES and what you want

ECHO to send to the printer.

ECHO Here's what's available in

ECHO this batch file.

ECHO .

ECHO FF for form feed

ECHO LF for linefeed

ECHO DP for printing the directory

ECHO .

GOTO END

:FORMFEED

ECHO (CHARACTER 121 > PRN

GOTO END

LINEFEED

ECHO {CHARACTER 10| > PRN

GOTO END

:PRINTDIR

DIR > PRN

:END

COMPUTE EDITORS

GREENS3ORO, NC

Drives from A to Z
How would you like to have

all of your word-processing

files on drive E, games on F,

and BASIC programs on G?

When you first organized

your hard disk, you sectioned

things off using subdirecto

ries. Now you can make navi

gating your system even easi

er by using the SUBST com

mand to trick DOS into think

ing those subdirectories are

separate drives.

First, decide the highest

drive letter that you'll be us

ing. If it's higher than E, you'll

need to add a line to the CON

FIG.SYS file. Suppose that M

will be the highest drive spec

ification you want to use. (Z is

the absolute maximum.) Call

up your CONFIG.SYS file in a

text editor. Save a copy of the

file as CONFIG.OLD, in case

something goes wrong. At the

end of the file, type LAST-

DRIVE=M and press Enter.

Save the file as CONFIG.SYS.

Now you must reboot.

You can define the drives

using the SUBST command.

Suppose you want F: to refer

to your WordStar subdirecto

ry. Type SUBST F: CAWS and

press the Enter key. Typing

DIR F: will now give you a di

rectory of the WS subdirecto

ry. Many other commands be

sides DIR, such as COPY

and DELETE, will work with

the F drive.

To create your new drives

automatically when your sys

tem boots, add the SUBST

commands to your AUTOEX

EC.BAT to specify the aliases.

Several DOS commands

won't work with a substituted

drive. They are ASSIGN, FOR

MAT, BACKUP, RESTORE, LA

BEL, JOIN, DISKCOPY, DtSK-

COMP, and FDISK.

RICHARD C. LEINECKER

MIAMI, FL

Making Headlines
One of the drawbacks of ear

ly LaserJet compatibles is

that they can't print fonts big

ger than 30 points. The later

models, up through Series II,

can print bigger fonts but re

quire huge soft font files to do

so. Before I bought my first

PostScript printer, I had to re

linquish over half of my mea

ger 40MB hard disk to soft

fonts—for just three type

styles! An alternative to get

ting squeezed out of your

hard disk is creating head

lines and decorative fonts in

your graphics paint or draw

program. CorelDRAW!, Design

er, Arts & Letters, Illustrator,

Paintbrush, and several other

graphics programs come

with an assortment of fonts

that can be scaled to almost

any size. You can also

shade, shape, or color the

text, if, for example, you want

ed to create a headline in

Arts & Letters for inclusion in

a PageMaker document, all

you'd have to do is create the

headline as a graphic ele

ment; save it to a common

file format such as TIF, PCX,

or CGM; and import it into

PageMaker. Another option

would be to bring the graphic

into your document on the Win

dows Clipboard. Say you

want to place a graphic from

CorelDRAW! into Ventura Pub

lisher. Here's how: Create

your headline in CorelDRAW!,

select it with the mouse, and

place it on the Clipboard with

the Copy command on the Ed

it menu. Open both Ventura

Publisher and the document in

to which you want to place

the headline. Create a frame

for the graphic and then

choose Paste Metafile from

the Edit menu. Ventura will

ask you to name the graphic

file. After you name the file, it

will appear in your document.

You can then size, crop, col

or, or place your headline as

you like. Using a graphics pro

gram to create the text also al

lows you to treat the text as a

graphic. For example, Co

relDRAW! allows you to ex

trude your text or put a gradi

ent or vector fill in it.

WILLIAM HARREL

VENTURA, CA

If you have an interesting tip

that you think would help oth

er PC users, send it along

with your name, address, and

Social Security number to

COMPUTE'S Tips & Tools,

324 West Wendover Avenue,

Suite 200, Greensboro, North

Carolina 27408. For each tip

we publish, we'll pay you $25-

$50 and send you a COM-

PUTE's PC clock radio while

supplies last. O
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Left-Alt keys while you type 1 
then 2 on the numeric key­
pad. Where you see ICHAR­
ACTER 10), hold down the 
Left-Shift and Left-Alt keys 
while you type 1 then a on the 
numeric keypad. 

@ECHO OFF 
IF %1= FF GOTO FORMFEEO 
IF %1=11 GOTO FORMFEED 
IF %1=LF GOTO LlNEFEED 
IF %1=11 GOTO LlNEFEED 
IF %1=DP GOTO PRINTDIR 
IF %1=dp GOTO PRINTDIR 
ECHO . 
ECHO To use this batch lile, type 
ECHO PCODES and what you want 
ECHO to send to the printer. 
ECHO Here's what's available in 
ECHO this batch file . 
ECHO . 
ECHO FF lor lorm leed 
ECHO LF lor lineleed 
ECHO OP lor printing the directory 
ECHO . 
GOTO END 
:FORMFEED 
ECHO ICHARACTER 121 > PRN 
GOTO END 
:LlNEFEED 
ECHO ICHARACTER 101 > PRN 
GOTO END 
:PR INTDIR 
DIR > PRN 
:END 
COMPUTE EDITORS 
GREENS30AO. NC 

Drives from A to Z 
How would you like to have 
all of your word-processing 
files on drive E. games on F. 
and BASIC programs on G? 
When you first organized 
your hard disk. you sectioned 
things off using subdirecto­
ries. Now you can make navi­
gating your system even easi­
er by using the SUBST com­
mand to trick DOS into think­
ing those subdirectories are 
separate drives. 

First, 'decide the highest 
drive letter that you'll be us­
ing. If it's higher than E, you'll 
need to add a line to the CON­
FIG.SYS file. Suppose that M 
will be the highest drive spec-

ification you want to use. (2 is 
the absolute maximum.) Call 
up your CONFIG.SYS file in a 
text editor. Save a copy of the 
file as CONFIG.OLD, in case 
something goes wrong. At the 
end of the file , type LAST­
ORIVE=M and press Enter. 
Save the file as CONFIG.SYS. 
Now you must reboot. 

You can define the drives 
using the SUBST command . 
Suppose you want F: to refer 
to your WordStar subdirecto­
ry. Type SUBST F: C:IWS and 
press the Enter key. Typing 
OIR F: will now give you a di­
rectory of the WS subdirecto­
ry. Many other commands be­
sides DIR, such as COPY 
and DELETE, will work with 
the F drive. 

To create your new drives 
automatically when your sys­
tem boots, add the SUBST 
commands to your AUTO EX­
EC.BAT to specify the aliases. 

Several DOS commands 
won' t work with a substituted 
drive. They are ASSIGN, FOR­
MAT, BACKUP, RESTORE, LA­
BEL, JOIN, DISKCOPY, DISK­
COMP, and FOISK. 
RICHARD C. LEINECKER 
MIAMI. Fl 

Making Headlines 
One of the drawbacks of ear­
ly LaserJet compatibles is 
that they can ' t print fonts big­
ger than 30 paints. The later 
models, up through Series II . 
can print bigger fonts but re­
quire huge soft font files to do 
so. Before I bought my first 
PostScript printer. I had to re­
linquish over half of my mea­
ger 40MB hard disk to soft 
fonts- for just three type 
styles! An alternative to get­
ting squeezed out of your 
hard disk is creating head­
lines and decorative fonts in 
your graphics paint or draw 
program. CoreIDRAW!, Design­
er, Arts & Letters, Illustrator, 
Paintbrush, and several other 
graphics programs come 
with an assortment of fonts 

that can be scaled to almost 
any size. You can also 
shade . shape. or color the 
text. If, for example, you want­
ed to create a headline in 
Arts & Letters for inclusion in 
a PageMaker document , all 
you 'd have to do is create the 
headline as a graphic ele­
ment; save it to a common 
file format such as TIF, PCX, 
or CGM; and import it into 
PageMaker. Another option 
would be to bring the graphic 
into your document on the Win­
dows Clipboard . Say you 
want to place a graphic from 
CoreIDRAW! into Ventura Pub­
lisher. Here's how: Create 
your headline in CoreIDRAW! , 
select it with the mouse, and 
place it on the Clipboard with 
the Copy command on the Ed­
it menu. Open both Ventu ra 
Publisher and the document in­
to which you want to place 
the headline. Create a frame 
for the graphic and then 
choose Paste Metafile from 
the Edit menu. Ventura will 
ask you to name the graphic 
file. After you name the file, it 
wi ll appear in your document. 
You can then size, crop, col­
or, or place your headline as 
you like. Using a graphics pro­
gram to create the text also al­
lows you to treat the text as a 
graphic . For example , Co­
reIDRAW! allows you to ex­
trude your text or put a gradi­
ent or vector fill in it. 
WILLIAM HARREL 
VENTURA, CA 

If you have an interesting tip 
that you Ihink would help oth­
er PC users, send it along 
with your name, address, and 
Social Security number 10 
COMPUTE's Tips & Tools, 
324 West Wendover Avenue, 
Suite 200, Greensboro, North 
Carolina 27408. For each tip 
we publish, we 'll pay you $25-
$50 and send you a COM­
PUTE's PC clock radio whife 
supplies last. 0 
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POINT & CLICK
Clifton Karnes

Cleaning up after

Windows installation

programs is

simpler than you'd

expect

WINDOWS APPS:
BEFORE AND AFTER
Not long ago each PC program

came in a single COM file, less

than 64K in size. You didn't re

ally install a program in those

days—you just copied it to a

floppy disk and ran it.

The next level in size escala

tion came when programs

started to require overlays,

which allowed parts of a pro

gram to be shuttled in and out

of memory as needed. And

as programs became more

complicated, additional sup

port files for printing and vari

ous other things were added.

To install these programs that

occupied several files, you

simply copied all the files on

the distribution disks to your

hard drive.

Things are not so simple in

Windows-land. Windows apps

can use scores of files, and the

installation programs are notori

ously sloppy about distributing

these files all over your hard

disk as well as making chang

es to your CONFIG.SYS, AU

TOEXEC.BAT, WIN.INI, SYS

TEM. INI, or all four.

Typically, a program will de

posit its main files in a special

subdirectory {or group of sub

directories) it creates on your

hard disk, and it will add an

INI file to your Windows sub

directory. It may also add a

file or two to your SYSTEM

subdirectory. And it will prob

ably alter your AUTOEX

EC.BAT (to include itself on

your already bulging path), per

haps add a driver or two to

your SYSTEM.INI or CON

FIG.SYS files, and almost cer

tainly make some entries to

your WIN.INI file.

There's really no problem

with all of this until you want to

get rid of one of these pro

grams. Where are all the files?

And what changes were

made to your system files that

you need to undo?

Because Windows pro

grams tend to install files in so

many subdirectories and alter

so many files, each program

should have its own uninstall

option. I've never seen one

that does, however.

Here's a solution. With the

two batch files listed below,

called Before and After, you

can create a list of all the

changes a program makes

when it installs itself.

The principle is simple. You

run Before before you install

any new software. It makes a

list of every file on your hard

disk. To this list it appends the

contents of your CONFIG.SYS,

AUTOEXEC.BAT, WIN.INI, and

SYSTEM.INI files.

Next you install your soft

ware, and after you've fin

ished, you run After. The first

thing After does is make a list

of all the files on your system

and the contents of your sys

tem files, just like Before has

done. But this list includes the

files added by the program

you've just installed as well as

any changes made to your sys

tem files. Next, After com

pares the list it's just made

with Before's list. Any files add

ed or deleted from your sys

tem show up in the compari

son, as well as any changes to

your system files.

Here's the listing for BE

FORE. BAT:

@echo off

els

c:

cd \windows

echo [BEFORE] Recording files on

disk (this will take a while) . . .

chkdsk/v >c:snapshot.tm|]

echo [BEFORE] Checking system

files . . .

copy c:snapshot.tmp + (^autoex

ec.bat + c:\canfig.sys +

c:\windows\win.ini + c:\win-

dows\system.ini c:before.txt

>nul

echo [BEFORE] Cleaning up ...

erase c:snapshot.tmp

cd\

The CHKDSK command with

the V switch isn't used very of

ten, but it's great for us. It

causes CHKDSK to list every

file on the disk with its com

plete path. We redirect its out

put to SNAPSHOTTMP.

The next step is to append

the system files to SNAP

SHOTTMP and store the com

plete list in a new file, BE

FORE.TXT. Now we have a

snapshot of our system before

we install a new program.

Here's the listing for AF

TER. BAT:

@echo off

if "%1" as "" goto end

els

c:

cd \windows

echo [AFTER] Recording files on

disk (this will take a while) . . .

chkdsk/v >c:snapshot.tmp

echo [AFTER] Checking system

files . . .

copy c:snapshot.tmp + c:\autoex-

ec.bat + c:\config.sys +

c:\windows\win.ini +

c:\windows\system.ini

czaiter.txt >nul

erase c:snapshot.tmp

echo [AFTER] Checking for

changes . . .

fc c:betore.txt c:after.txt >c:%1

type %1 I more

goto stop

:end

echo Please specify a filename for

the changes.

stop

When you run After, you'll

need to specify a filename for

the changes it finds.

The first few lines of After

do just what Before does—

they make a snapshot of your

system.

The line fc c-.before.txt c:af-

ter.txt >c:%1 compares the

two snapshots and puts the re

sults in the file you specified

on the command line.

You can then use the file

created by After to locate the

files introduced and altered

by the installation. □
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WINDOWS APPS: 
BEFORE AND AFTER 
Not long ago each PC program 
came in a single COM file, less 
than 64K in size. You didn't re­
ally install a program in those 
days-you just copied it to a 
floppy disk and ran it. 

The next level in size escala­
tion came when programs 
started to requ ire overlays , 
which allowed parts of a pro­
gram to be shuttled in and out 
of memory as needed. And 
as programs became more 
complicated , additional sup­
port files for printing and var i­
ous other things were added. 
To install these programs that 
occupied several files , you 
simply copied all the files on 
the distribution disks to your 
hard drive. 

Things are not so simple in 
Windows-land. Windows apps 
can use scores of files, and the 
installation programs are notori­
ously sloppy about distributing 
these files all over your hard 
disk as well as making chang­
es to your CONFIG.SYS, AU­
TOEXEC.BAT, WIN.INI , SYS­
TEM.INI, or all four. 

Typically, a program will de­
posit tts main files in a special 
subdirectory (or group of sub­
directories) it creates on your 
hard disk, and it will add an 
INI file to your Windows sub­
directory. It may also add a 
file or Iwo to your SYSTEM 
subdirectory. And it will prob­
ably alter your AUTOEX­
EC .BAT (to include itself on 
your already bulging path), per­
haps add a driver or two to 
your SYSTEM.INI or CON­
FIG.SYS files, and almost cer­
tainly make some entries to 
your WIN. IN I file . 

There's really no problem 
with all of this until you want to 
get rid of one of these pro­
grams. Where are all the files? 
And what changes were 
made to your system files that 
you need to undo? 

Because Windows pro­
grams tend to install files in so 
many subdirectories and alter 
so many files, each program 
should have its own uninstall 
option . I've never seen one 
that does, however. 

Here's a solution. With the 
two batch files listed below, 
called Before and After. you 
can create a list of all the 
changes a program makes 
when it installs itself. 

The principle is simple. You 
run Before before you install 
any new software. It makes a 
list of every file on your hard 
disk. To this list it appends the 
contents of your CONFIG.SYS, 
AUTOEXEC.BAT, WIN.INI . and 
SYSTEM.lNI liles. 

Next you install your soft­
ware , and after you 've fin­
ished, you run After. The fi rst 
thing After does is make a list 
of all the files on your system 
and the contents of your sys­
tem files, just like Before has 
done. But this list includes the 
files added by the program 
you've just installed as well as 
any changes made to your sys­
tem files . Next, After com­
pares the list it's just made 
with Before's list. Any files add­
ed or deleted from your sys­
tem show up in the compari­
son, as well as any changes to 
your syslem files. 

Here's the listing for BE­
FORE.BAT: 

@echo off 
cis 
c: 
cd \ windows 
echo (BEFORE] Recording files on 
disk (this will take a while) ... 

chkdsk/v >c:snapshoUmp 
echo (BEFORE] Checking system 
files ... 

copy c:snapshoUmp + c:\ autoex­
eC.bat + c:\tonfig .sys + 
c:\windows\Win .ini + c:\win­
dows\system .ini c:belore .txt 
>nul 

echo (BEFORE] Cleaning up . .. 
erase c:snapshoUmp 
cd \ 

The CHKDSK command with 
the V switch isn' t used very of­
ten , but it's great for us. It 
causes CHKDSK to list every 
file on the disk with its com­
plete path. We redirect its out­
put to SNAPSHOlTMP. 

The next step is to append 
the system files to SNAP­
SHOITMP and store the com­
plete list in a new file, BE­
FORE.TXT. Now we have a 
snapshot of our system belore 
we install a new program. 

Here's the listing for AF­
TER.BAT: 

@echo off 
if "%1" = .... golo end 
cis 
c: 
cd \ windows 
echo (AFTER] Recording liles on 
disk (this will take a while) . .. 

chkdsk/V >c:snapshoUmp 
echo (AFTER] Checking system 
liles ... 

copy c:snapshoUmp + c:\ autoex­
eC.bat + c:\conlig .sys + 
c:\Windows\Win.ini + 
c:\Windows\system.ini 
c:after.txt >nul 

erase c:snapshoUmp 
echo (AFTER] Checking lor 
changes . . . 

Ie c:before.txt c:after.txt >c:%1 
type %1 I more 
goto stop 
:end 
echo Please specity a Iilename for 
the changes. 

:stop 

When you run After, you 'll 
need to specify a filename for 
the changes it finds. 

The lirst few lines of After 
do just what Before does­
they make a snapshot of your 
system. 

The line Ic c:before. txt c:af­
ter.txt >c:% 1 compares the 
two snapshots and puts the re­
sults in the file you specified 
on the command line. 

You can then use the file 
created by After to locate the 
files in troduced and altered 
by the installation. 0 



How this $149 software will:
1) Improve the way you work and think,
2) Instantly find the info you need, and
3) Help you make brilliant decisions ...

The next generation

of TORNADO

is here at

last!

Surprisingly, there is a whole new

world of uses for your computer!

You can use your computer to deal

with all Ihe countless bits of "random"

informalion scattered across your desk:

plans, notes, lisis. actions, contacts, ideas.

Info Select

and much more. INKO SELECT™ will

not only give you instant access to this

important information ... il will help you

make better decisions and sec important

new relationship;,. Try INFO SELECT

risk-free and discover a whole new

dimension of computing.

Photographic

memory

INFO SELECT is like having a

'photographic memory' that gives you

perfect supcrfasl recall of up to 64,000

items of infoimation.

Telephone notes

When Harry calls you on Ihe phone,

you'll display the six windows on Harry

before he finishes his first sentence! No

more embarrassing pauses or scrambling

for infonnaiion.

INFO

SELECT also

includes the

world's firsl

"3-D" word

processor.

You'll be

amazed at how it

works.

Instead of

one window or

len. imagine up to 64.000! The uses are

endless.

INFO SELECT » easy

lo use - yet powerful.

Are you forgetful?

Were you bom with a memory

situated squarely on ihe tip of your

tongue1.' Do you forget things like which

day you placed an order or important

numbers'? If you are forgetful you

especially need INFO SELECT- the

software that remembers almost

everything for you.

Thinking tool

Have you ever worked on a complex

project and fell lost? With INFO

SELECT you'll group, scan, and cross

search through all your notes so fast

you'll see the big picture in seconds.

Will 1 be better off doing this now or

that later? Keeping priorities straight can

make or break your career or your

business INFO SELECT lets you keep

on top of what's hot.

Should you use an cast or west coast

supplier? To make decisions you need

facts. Now you can view the facts any

way you like ... us fast as you can think.

You' II make the best decisions ever —

and fewer expensive mistakes.

The #1 PIM

What's all the fuss

about PIMs (Persona!

Information

Mangers)?

Simple - you

probably have

more RANDOM

information than

any other type and

you need a PIM to

properly handle

this kind of

information. The

right PIM will

save you time and

make everything

you do go

smoothly.

Why is info

Select the # I PIM?

Because Info Select is based

on ideas you can identify

with - like stacks of paper.

And it's free-form too. You

won't wasie days or weeks learning

complex structures. Instead you'll be up

and running in minutes. Info Select also

discs more and costs less than other PIMs.

Man

ComputerHI ppi\/i

Shopper I

"Rarely do I

recommend a

product as

wholeheartedly'

David Harvey,

Comp. Shopper

"Beats the pants

off just about

everythiog else."

Jeffrey Parker,

PCM

'As easy as

remembering

your own name."

Patrick Marshall.

Info World

Owners of <iur TORNADO software (symbolized

by ihe famous "blue tornado") can trade up K> [he

Nxiind-generation Info Select under our special

offer. There arc over 200 improvements.

Feature packed

INFO SELECT is memory resident

(if you choose), so you can quickly jump

in from other programs. Info Select

windows can hold: notes, plans, lists,

facts, letters, contacts, and much more.

You can search for a window or a group

ofwindow.rclatedbyawordorphra.se.

There are five way.s lo see overviews;

hypertext, a fast sort, and line drawing.

Save lime with the dialer, dale tickler;

and searching by text or date ranges.

Info Select allows

you lo: add

columns of

numbers: store

data in EMS; use

template or

free-form

windows; import

and export files,

screens, and

databases; move,

join, and duplicate

windows and

much more.

LAN

option

The new LAN version allows

integrated E-mail, sharing company

rolodexes and distributing company

policies. You can share any kind of

informalion. It's your first step into the

exciting new world of groupware! Ask

about ihe five node LAN starter pack.

Easy power

Info Select is easy to use yet offers

ihe power you need with infobases up lo

10 megabytes; text searches up to

700kb/sec; up to 32.000 characters per

window: and up to 64.1)00 windows per

infobase. Even better. Info Select can

swap down to us little as 7K memory!

TORNADO owners

INFO SELECT is based on Ihe

pioneering TORNADO™ software PC

World called "Excellent. Excellent.

Excellent. Excellent" and PC Magazine

awarded Editor's Choice - twice. Call

about our special trade-up offer.

If you have miles, ideas. cunlucL.

or other unorganized RANDOM

nlbrmalion. jou need Info Select.

Endless

uses

Info Select can

do much more than manage

all your RANDOM

informalion. Use il to

manage business correspondence, sales

leads, orders, and client notes. Track

facts, plan projects, or interrelate all your

ideas. You can catalogue parts,

documents, and inventory items. Match

buyers and sellers or doctors and patients.

Setup an informalion desk. Edit E-mail.

Store nines on magazine articles,

software operation techniques, orjust

names and addresses. Whether you are a

lawyer tracking court cases or a zoologisl

collecting feeding habits you'll find

COUntleSS uses for Info Select.

Info Select keeps your information in intelligent

automatically positioned windows.

Risk-Free Guarantee

InfoSelccl is soeffeciiveyou will be

amazed. Thai's why we offcrour

mniiey-back puaranlce. Try it for 30 days.

IfyOB are mil fully satisfied, accept uur full

piumpl refund. Could any offer bir inure

fair?

All for just

$149.95! Ver2.0!
INTO SELECT has a special price of

justS!49.95. You can even try it

risk-free with a 30-day money back

guarantee. But hurry - this is a limited

time offer.

Doesn't it make sense to gel the

software package lhai can open up a

whole new world of important uses for

your computer? Order today. Call

loll-free:

(800)342-5930
... and get ready for a new dimension

of computing.

Micro*Logi6
POB 70, Dept. A608

Hackensack, NJ 07602

(800) 342-5930 (201) 342-651B

Fax:(201)342-0370

Makers of: Tornado, Into Select,

Key Watch & Micro Charts

MAIL ORDERS: Send name, address, phone number, and payment by check. Visa, or MC to address shown. Please include S3.50 shipping (S15 ciuwtlc coniincmal USA). EUROPEAN CUSTOMERS:

Contact Atlanlcx U.S.A. (203) 655-6980. TRADEMARKS: Trademark (uwner>: Tornado. Info Select. Key Watch (Micro Logic). IBM PC XT. AT. PS/2 HUM}. © 1990 Micro Logic Corp. U.S.A.

How this $ 149 software will: 11 Improve the way ~ou work and think, 
2 Instantly find the Info you need, and 
3 Help you make br illiant decisions ••• 

Surprisingly. there is a \'\"hole new 
world of uses for your computer! 
Yoo can use your computer to deal 

with a ll the countless bilS of wr.lIldomw 
info rmatio n scattered across your desk: 
plans. noles. lists. actions. cOntacts. ideas, 

Info Select" 

and much more. INFO SELECT'"'" will 
not only g ive you instant access to this' 
impon:mt infont\lltion ... it will help you 
make betlcr decisions and sec imponant 
new relationships. Try IN .. U SELECT 
risk-free and discon~r II whole new 
dimension of computing. 

Photographic 
memory 

INFO SELECT is like having a 
'phOlogrnphic memory' that gives you 
perfect superfast realll of up to 64,000 
items of information. 

Telephone notes 
When Hurry calls you on the phone. 

you' ll display the six windows on Hany 
before he rinislles his first sentence! No 
more embarrassing pauses or scrambling 
for infofln:lI.ion. 

INA) SELECT i.~ el.\Y 
10 use -)'CI P'O"·crful. 

INFO 
SELECf also 
includes the 
world's first 
"3-~" word 
processor. 
You' ll be 
amazed at how il 
works. 

In'llcad of 
one window o r 

ten, imagine up to 64,OOO! 1ne uses are 
endless. 

"Rarefy do t 
rocommencl a 
pmduct as 
wtdehoortedly" 
David Harvey, 
Comp. Shopper 

"Beats the pants 
on~l abrut 
everything else." 
Jeffrey Parker, 
PCM 

Are you forgetful? 
Were you born ",ith a memory 

situated squarely on the tip o f your 
tongue'? Do you forget things like which 
day you placed an order or impon ant 
numbers? If you are forgetful you 
especially need INFO SELECT - the 

sortware that remembers almost 
everyth ing for you. 

Thinking tool 
Have you ever worked on a complex 

project and felt los t'? Wi th INFO 
SELECT you'll group, scan. and cross 
seart:h through al l your notes so fast 
you' ll see the big picture in seconds. 

Willi be better off doing this now or 
that later? Keeping prio rities straight can 
make or break your caru:r or your 
business. INFO SB..ECT lets you keep 
o n top or what's ho t. 

Should you use an east or \'\" est coast 

supplier? To make decisions you need 
facts. Now you can view the facts any 
way you like ... as fast as you can think. 
You' lI make the best decisions ever ­
and fewer ex~nsh'e miSlakcs. 

The #1 PIM 
What's all the fu ss 

about PIMs (Personal 
Information 

Phone: notes Mangers)? 

Ownel$ ofour TORNADO sor"'"3ll: (symbolized 
by the: f:unotu "blue tom3d<n c:m Ir3de up Kl \hi: 
sc:cund-&ellCntion Info Select undttour special 

olTa. 1lIcn: arc over 200 impro'-emcntl.. 

Feature packed 
INFO SELECT is memory resident 

(if you choose). so you can quickly jump 
in from o ther programs. Info Select 
windows can hold : notes. plans, lists. 
facts. leiters. contacts. and moch more.. 
You can search for a window o r a group 
of windows re lated by a word or phrusc. 
11lere are fi ve ways to see o\'erviews: 
hypenext. 0 fa.~t sort, and line drawing. 
SO\'C time with the dialer. date tickler: 
and searching by tex t or date ranges. 

Simple· you 
probably ha\'c 
more RANDOM 
infonn:uio n than 
any other type and 
you need a PIM to 
properly handle 
this kind of 
infonnation. The 
rightPIM will 
save you time and 
make c\"l!rything 

you do go 
smoothly. 

If you l\aYe: nett:$.. ideas. C'OIUdli 

or other ullOrpnUcd RANDOM 
inform:Ltion. you nocd Info Select. 

Info Select allows 
),OU to: add 
columns of 
num~rs: store 
data in EMS: use 
template or 
free-form 
windows: impon 
and export files. 
screens. and 
databases: ffiO\'e, 

join. and duplicalc 
windows and 
much more. 

LAN 
option 

Management 

Why is Info 
Select the 1# 1 PIM ? 
Because Info Select is based 
o n i d ea.~ you can identify 
wi th · like stacks of paper. 
And it's free-fonn too. You 

won't waste days or weeks learning 
com plex struc tures. Instead you'll be up 
and running in minutes. Info Select also 
does men: and costs less than other PIMs. 

"/J-s easy as 
remorri)ering 
your own name." 
Patrick Marshall, 
Inlo Wood 

EdtCl's Choi<:e 
°AISt ra le" 
PC Magame 

The new LAN \'Crsion allows 
imcgmted E-mai l. sharing company 
rotodcxes and distributing company 
policies. You can shan:: an)' kind of 
info mlalion. It's your first step imo the 
excit ing new world of groupware! Ask 
nbout the fi\'e node LAN sta rter pack. 

Easy power 
Info Select is easy to usc yet offers 

the power you need with infobases up to 
10 megabytes: text sean::hes up to 
700kbl~ up to 32.000 ch:uactcrs per 
window; and up to 64.000 windows per 
infoba!ie. Even beller. Info Select can 
swap down to:lS lin le as 7 K memory! 

TORNADO owners 
INFO SELECT is based o n the 

pioneering TORNADOnt sofiware PC 
World called MExcellcnt. Excellent. 
Excellent. Excd1cnt M and PC Magazine 
awarded Editor's Ooice - twice. Call 
about our special trade-up offer. 

do much more than manage 
a ll your RANDOM 
infoml:uion. Use it to 
manage business correspondence. sales 
Iead. .. , orders, and client notes. Truck 
facts, plan projL'Cts. or interrelate al l your 
idClls. You can catalogue parts. 
docume nts. and inventory itcln'l. Match 
buyers and sellers o r doctors and patients. 
Setup an information desk. Edit E-mail. 
Store notes on magazine articles. 
software operation techniques.. or just 
names arw:! addresses. Whether you are a 
lawyer tracking coun cases or a zoologisl 
collecting feed ing habi ts you' lI find 
L'OUntJess uses for Info Select. 

Info Select keeps your infomwion in intelligent 
aUlom:uieally positioned ..... indo"''S. 

Risk-Free Guarantee 

Info Select is soeffectil'e)'Ou will be 
ama:t.cd. Thal"J ",hy we ofJerour 

rnoncy-back auarantee. Tty iI for 30 da)'5. 
If you :an: not ru lly AtisflCd, xcq:c our rull 
prompt n:rund. Could aDY orret" be ~ 

''''' 

All f or just 

$149.95! 
New: 

Ver 2.01 
INFO SELECT has a special price of 

just 5149.95. You can even try it 
risk-free with a 3D-day money back 
guamntcc. But hurry - this is a limited 
time offer. 

Doesn' t it make sense to ge t the 
softwafC package thu t can open up a 
whole new world of important uses for 
yourcomputer'! Ontcr today. Call 
toll-free: 

(800)342·5930 
... and get !'Cady for a new dimension 

of computing. 

Micro Jlogic 
POB 70. Dept. A608 
Hackensack, NJ 07602 

(800) 342-5930 (201) 342-6518 
Fax: (lOt) 342-0370 

MakefS of: Tomado, Info Select, 
Key Watch & Micro Charts 

MAII. ORDt:ltS: Send rwn:. ad~ phone: number. ~nd payment by check. Visa. or Me 10 address shown. l'Ic:l..~ include S3.50shipping (515 outside «WIlincnllll USA). fU ROPt:AN CUSTOMERS· 
COOtX"l Atl.:1n lc:o. U.s.A. (203) 655-6980. TKA !)t'MAKKS: Trudc:nurl; (owner): Tor-n;It!o. lnroSeIcct. Ke:y Wllch (Mkroi.opc), J8M PC. Xl: AT. PSI2 (1UM). C 1990 Micro Logic Cot'p. U.S.A. 



COMPUTE/NET
Troy Tucker

Online services

can easily

transport you to a

world where

information is king.

THE PERFECT TIME

TO GET ONLINE
If you're new to the online

scene, then you'll be pleased

to learn that COMPUTE

resides on both GEnie and

America Online. Our section is

called COMPUTE/NET, and in

it you'll find the same high-

quality programs and articles

that you enjoy in our maga

zine. If you're not online yet,

then you probably don't know

what you're missing.

Online services have much

to offer you. Subscribers enjoy

instant access to news, weath

er, travel, stocks, reviews, soft

ware, and more. You'll find the

rates very reasonable, too.

You can sign on to GEnie for

free and access the basic serv

ices during nonprime time

hours for about $4.95 a

month. America Online offers

free software, a free trial mem

bership, and free connect

time so you can try out their

service. The rate for basic serv

ices on America Online is

$5.95 a month. So, if you're

not online-get online. And,

don't forget to visit us when

you do.

This month in COMPUTE/

NET we're featuring a few da

ta management utilities that

we think you'll enjoy. We have

a super spreadsheet called

QubeCaic, a file viewer called

List64, and an incredible da

tabase program called PC Da

ta Control. We also have sev

eral games such as: Ed's

Chess, Mah Jongg, Hearts,

and Bass Tour.

You'll find QubeCaic quite

useful. It's a low-cost spread

sheet alternative that doesn't

skimp on features. You can

store all kinds of data in row,

column, and page format. You

can calculate across, up,

down, and through other

spreadsheets that you create

by linking modules together.

This powerful program in

cludes sixty functions, mac

ros, sorting, context-sensitive

help, and graphics.

List64 is an excellent multi

purpose Jiie viewer. It lets you

search files for text, mark and

write selected text, and clean

up files written in nontext for

mats. You move around in the

documents with all of the usu

al commands. It features on

line help, a ruler, a hex dis

play, and it even allows you to

customize the colors.

Our last feature program is

PC Data Control. With it, you

can create large databases.

You can sort, calculate totals,

create reports, and search as

many as 25 parameters at

once using wildcards, values,

ranges. You can opt for case-

sensitive searches, too. It

even autodials numbers, if

your computer is equipped

with a modem.

Ed's Chess is a challenging

chess game. The playing piec

es are drawn with character

graphics, so almost anyone

can play. Mah Jongg is a clas

sic strategy puzzle game that

will have you happily per

plexed for hours. Avid bass fish

ermen will want to be sure to

downloaad Bass Tour, an ex

cellent bass fishing simulator.

Look for this month's fea

ture programs in our New

Uploads library. When you en

ter the COMPUTE/NET area,

just access this library to find

the latest program uploads.

Featured programs will reside

in this library for a few weeks,

then they'll be transferred to

our main pc library.

COMPUTE/NET has much

more to offer than just soft

ware. Be sure to visit our prod

uct ordering section for the lat

est products. COMPUTE

Books has added some new

titles that you can purchase di

rectly online. Titles include

Desktop Publishing with Geo-

Works, Big Book of PC Sports,

Castlevania: The Official Hint

Book, Official Guide to Sid

Meir's Civilization, and more.

Ordering is simple. First, go

to the COMPUTE/NET section.

Use the keyword COMPUTE.

If you're on America Online,

click on the Product Ordering

icon, then select COMPUTE

Books. You'll see all of the ti

tles available. Select one of

the titles to get a description

and the price. Jot down the or

der number of the books that

interest you, then return to the

main Product Ordering menu.

Click on the Order a Product

icon and fill out the order

form. For GEnie users, select

option 9 from the menu, then

select COMPUTE Books by

pressing option 3. You'll see a

description of each book and

its price. Then you'll see a

prompt to order the book or

move on to the next book.

For those of you who visit

COMPUTE/NET on America

Online, I have a surprise for

you. COMPUTE/NET is getting

a whole new look and feel.

We're re-structuring the entire

area so that it's much easier to

navigate. You'll be able to

quickly find all the information

you're looking for. The col

umns and reviews will be bro

ken down into more special

ized categories. We'll be add

ing new things, too. Look for

our color logo and exclusive

chat area. We hope to have

most of these changes in ef

fect by the time you read this,

so stop in and take a look.

We're working hard to meet

your online needs. If you have

any questions, comments, or

suggestions about COMPUTE/

NET, please feel free to write

to me here at COMPUTE Pub

lications in Greensboro or

send E-mail. My GEnie ad

dress is TROYGT, and my

America Online screen name

is TROY GT—that's with a ze

ro. I'm on both services daily,

and I'm looking forward to hear

ing from you. Don't forget to

stop in and visit COMPUTE/

NET. See you online! D
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COMPUTE/NET 
Troy Tucker 

THE PERFECT TIME 
TO GET ONLINE 
If you're new to the on line 
scene, then you'll be pleased 
to learn that COMPUTE 
resides on both GEnie and 
America Online. Our section is 
called COMPUTE/NET, and in 
it you'll find the same high­
quality programs and articles 
that you enjoy in our maga­
zine. If you're not online yet, 
then you probably don't know 
what you're missing. 

Online services have much 
to offer you. Subscribers enjoy 
instant access to news, weath· 
er, travel, stocks, reviews, soft­
ware, and more. You'll find the 
rates very reasonable, too. 
You can sign on to GEnie for 
free and access the basic serv­
ices during nonp rime time 
hours for about $4 .95 a 
month. America Online offers 
free software, a free trial mem­
bership, and free connect 
time so you can tryout their 
service. The rate for basic serv­
ices on America Online is 
$5.95 a month. So, if you're 
not onl ine--get online. And , 
don' t forget to visit us when 
you do. 

Th is month in COMPUTE/ 
NET we're featuring a few da­
ta management utilit ies that 
we think you'll enjoy. We have 
a super spreadsheet called 
QubeCalc, a file viewer called 
List64, and an incredible da­
tabase program called PC Da­
ta Control. We also have sev­
eral games such as : Ed's 
Chess, Mah Jongg, Hea rts, 
and Bass Tour. 

You'll fi nd QubeCalc quite 
useful. It's a low-cost spread­
sheet alternative that doesn't 
skimp on fea tures. You can 
store all kinds of data in row, 
column, and page format. You 
can calculate across, up, 
down, and through other 
spreadsheets that you create 
by linking modules together. 
This powerful prog ram in-

el udes Sixty functions, mac­
ros, sorting, context-sensitive 
help, and graphics. 

List64 is an excellent multi­
purpose file viewer. It lets you 
search files for text, mark and 
write selected text, and clean 
up files written in nontext for­
mats. You move around in the 
documents with all of the usu­
al commands. It features on­
line help , a ruler, a hex dis­
play, and it even allows you to 
customize the colars. 

Our last feature program is 
PC Data Control. With it, you 
can create large databases. 
You can sort. calculate totals, 
create reports, and search as 
many as 25 parameters at 
once using wildcards, values, 
ranges. You can opt for case­
sensitive searches, too. It 
even autodials numbers, if 
your computer is equipped 
with a modem. 

Ed's Chess is a challenging 
chess game. The playing piec­
es are drawn wi th character 
graphics, so almost anyone 
can play. Mah Jongg is a clas­
sic strategy puzzle game that 
wi ll have you happi ly per­
plexed for hours. Avid bass fish­
ermen will want to be sure to 
downloaad Bass Tour, an ex­
cellent bass fi shing simulator. 

Look for this month's fea­
ture programs in our New 
Uploads library. When you en­
ter the COMPUTE/NET area, 
just access this library to find 
the latest program uploads. 
Featured programs will reside 
in this library for a few weeks, 
then they'll be transferred to 
our main pc library. 

COMPUTE/NET has much 
more to offer than just soft­
ware. Be sure to visit our prod­
uct ordering section for the lat­
est products. COMPUTE 
Books has added some new 
tit les that you can purchase di­
rectly online. Titles include 
Desktop Publishing with Geo­
Works, Big Book of PC Sports, 
Castlevania: The Official Hint 
Book, Official Guide to Sid 

Meir's Civilization, and more. 
Ordering is simple. First, go 

to the COMPUTE/NET section. 
Use the keyword COMPUTE. 
If you 're on America Onl ine, 
click on the Product Ordering 
icon, then select COMPUTE 
Books. You 'll see all of the ti­
tles available. Select one of 
the titles to get a description 
and the price. Jot down the or­
der number of the books that 
interest you , then return to the 
main Product Ordering menu. 
Click on the Order a Product 
icon and fill out the order 
form. For GEnie users, select 
option 9 from the menu, then 
select COMPUTE Books by 
pressing option 3. You'll see a 
description of each book and 
its price . Then you'll see a 
prompt to order the book or 
move on to the next book. 

For those of you who visit 
COMPUTE/NET on America 
Online, I have a surprise for 
you. COMPUTE/NET is gett ing 
a whole new look and feel. 
We're re-structuring the entire 
area so that it's much easier to 
navigate. You 'll be able to 
quickly find all the information 
you 're looking for. The col ­
umns and reviews will be bro­
ken down into more special­
ized categories. We' ll be add­
ing new things, too. Look for 
our color logo and exclusive 
chat area. We hope to have 
most of these changes in ef­
fect by the time you read this, 
so stop in and take a look. 

We're working hard to meet 
your online needs. If you have 
any questions, comments, or 
suggestions about COMPUTE! 
NET, please feel free to write 
to me here at COMPUTE Pub­
lications in Greensboro or 
send E-mail. My GEnie ad­
dress is TROYGT, and my 
America Online screen name 
is TROY GT -that's with a ze­
ro. I'm on both services daily, 
and I'm looking forward to hear­
ing from you. Don't forget to 
stop in and visit COMPUTE/ 
NET. See you online ' 0 



ON DISK
Tony Roberts

ORGANIZE YOUR

HARD DRIVE
This issue's PC Disk offers you

a computer system tuneup.

You'll be able to defragment

your hard disk, tune your cach

ing software, copy high-capac

ity disks in a single pass, and

keep close tabs on disk, mem

ory, and environment space.

WinPost lets Windows us

ers create computerized yel

low sticky notes, and Switcher

makes changing screen res

olutions a snap.

Disk Organizer
After a hard disk has been

used for a few months, some

of its luster seems to fade. Ac

cess to files becomes slug

gish and labored.

This is a result of the way

DOS stores files. Over time

files become fragmented, or

spread out across the disk.

DOS keeps a road map to

these fragmented files, so it

has no problem locating

them, but access time may

be increased.

To bring a fragmented

hard disk back up to speed,

you use a software tool

called a defragmenter. Disk Or

ganizer, from Soft GAM'S Soft

ware, is just such a tool.

Disk Organizer straightens

up your hard disk by moving

files and directories into opti

mal positions. Disk Organizer

includes several switches and

modes that permit you to spec

ify how the defragmentation

and subsequent testing

should occur.

But first, a word of warning.

As the program itself will tell

you, back up your data first.

Defragging a disk involves

moving files and rewriting the

disk's FAT (File Allocation Ta

ble). Normally, all goes well,

but it's possible for unusual

hardware, TSR conflicts, or nat

ural disaster to upset the proc

ess. Be sure to have back

ups. Also, if you use disk-com

pression software, follow the

manufacturer's advice about

defragmenting compressed

volumes.

Allen Morris's Disk Organiz

er is shareware and carries a

$30 registration fee. A good

defragger has a place in

everyone's software library.

Cache Test
Disk-caching programs are

one of today's most popular

performance enhancers. Every

one running Windows uses

one, and DOS users can

speed up their systems by set

ting up disk caches. Disk cach

es really make a difference if

you run disk-

intensive pro

grams such as

database man

agers.

The big ques

tion, though, is

howmuchmem

ory to allocate

to the cache.

The idea is to

achieve the

greatest per

formance gain

for the small

est amount of

memory. George Spafford

faced this problem with the

computers at his office and cre

ated Cache Test to help him

determine the b'est settings.

Using the program is sim

ple. Set up your cache, run

the program, and record the

results. Then adjust the

cache and test again until

you discover what works best

for your specific system.

Cache Test is shareware

and can be registered for $5.

CPYDSK
I've yet to meet anyone who

enjoys the disk swapping

that's required to copy a high-

density disk. All that aggrava

tion shouldn't be necessary,

and now, thanks to CPYDSK,

your swapping days are over!

With a normal DISKCOPY,

floppy shuffling is necessary

because DOS cannot access

enough memory to make the

complete copy in a single

pass. CPYDSK skirts this prob

lem by using your hard disk

as a temporary storage area

if memory runs short.

Copies can be made in a

single pass, and what's

more, multiple copies can be

created with only one reading

of the source disk. CPYDSK al

so can speed your work by

copying only live data.

CPYDSK is shareware cre

ated by Rawls Frazier and

Mark Ferrel. The registration

fee is only $10.

Space
Ever wonder how much disk

space is left? Space offers a

unique look at available disk

space. Space creates a graph

ic display of disk use for one

or more drives. If multiple

drives are specified, statistics

are provided for the combina

tion of all the drives as well as

for each drive individually.

The program also can pro

vide visual and auditory warn

ings if disk space falls below

user-specified percentages.

These warning points can be

specified for each drive individ

ually as well as for the combi

nation of all drives.

Space, programmed by

loannis Hadjiionnou, is share

ware. Space can be regis

tered for only $10.

WinPost lets you

create and manage

up to 100 little

yellow Post-it-type

notes, and

they don't tall oil!
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ORGANIZE YOUR 
HARD DRIVE 
This issue's PC Disk offers you 
a computer system tuneup. 
You'll be able to defragment 
your hard disk, tune your cach­
ing software, copy high-capac­
ity disks in a single pass, and 
keep close tabs on disk, mem­
ory, and environment space. 

WinPost lets Windows us­
ers creale computerized yel­
low sticky notes, and Switcher 
makes changing screen res~ 
olutions a snap. 

Disk Organizer 
After a hard disk has been 
used for a few months, some 
of its luster seems to fade. Ac­
cess to files becomes slug­
gish and labored. 

This is a result of the way 
DOS stores files. Over time 
files become fragmented, or 
spread out across the disk. 
DOS keeps a road map to 
these fragmented files, so it 
has no problem locating 
them, but access time may 
be increased. 

To bring a fragmented 
hard disk back up to speed, 
you use a software tool 
called a defragmenter. Disk Or­
ganizer, from Soft GAM's Soft­
ware, is just such a tool. 

Disk Organizer straightens 
up your hard disk by moving 
files and directories into opti­
mal positions. Disk Organizer 
includes several switches and 
modes that permit you to spec­
ify how the defragmentation 
and subsequent testing 
should occur. 

But first, a word of warning. 
As the program itself will tell 
you, back up your data first. 
Defragging a disk involves 
moving files and rewriting the 
disk's FAT (File Allocation Ta­
ble). Normally, all goes well , 
but it's possible for unusual 
hardware, TSR conflicts, or nat­
ural disaster to upset the proc­
ess. Be sure to have back-

ups. Also, if you use disk-com­
pression software, follow the 
manufacturer's advice about 
defragmenting compressed 
volumes. 

Allen Morris's Disk Organiz­
er is shareware and carries a 
$30 registration fee. A good 
defragger has a place in 
everyone's software library. 

(ache Test 
Disk-caching programs are 
one of today's most popular 
performance enhancers. Every­
one running Windows uses 
one, and DOS users can 
speed up their systems by set­
ting up disk caches. Disk cach­
es really make a difference if 
you run disk­
intensive pro­
grams such as 
dalabase man­
agers. 

The big ques­
lion, though, is 
howmuchmem­
ory to allocate 
to the cache. 
The idea is to 
achieve the 
greatest per­
formance gain 
for the small­
est amount of 
memory. George Spafford 
faced this problem with the 
computers at his office and cre­
ated Cache Test to help him 
determine the tiest settings. 

Using the program is sim­
ple. Sel up your cache, run 
the program, and record the 
results. Then adjust Ihe 
cache and test again until 
you discover what works best 
for your specific system. 

Cache Test is shareware 
and can be regislered for $5. 

(PYDSK 
I've yet to meet anyone who 
enjoys the disk swapping 
that's required to copy a high­
density disk. All that aggrava­
tion shouldn't be necessary, 
and now, thanks to CPYDSK, 
your swapping days are over! 

With a normal DISKCOPY, 
floppy shuffling is necessary 
because DOS cannot access 
enough memory to make the 
complete copy in a sing le 
pass. CPYDSK skirts this prob­
lem by using your hard disk 
as a temporary storage area 
if memory runs short. 

Copies can be made in a 
single pass, and what's 
more, multiple copies can be 
created with only one reading 
of the source disk. CPYDSK al­
so can speed your work by 
copying only live data. 

CPYDSK is shareware cre­
ated by Rawls Frazier and 
Mark Ferrel. The registration 
fee is only $10. 

Space 
Ever wonder how much disk 
space is left? Space offers a 
unique look at available disk 
space. Space creates a graph­
ic display of disk use for one 
or more drives. If multiple 
drives are specified, statistics 
are provided for the combina­
tion of all the drives as well as 
for each drive individually. 

The program also can pro­
vide visual and auditory warn­
ings if disk space falls below 
user-specified percentages . 
These warning points can be 
specified for each drive individ­
ually as well as for the combi­
nation of all drives. 

Space, programmed by 
loannis Hadjiionnou, is share­
ware. Space can be regis­
tered for only $10. 

WlnPost lets YOU 
create and manage 
UP to 100 lillie 
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ON DISK

FOR SINGLE DISKS

YES! I want 10 power up my PC. Send me this issue's COMPOTE'S

PC Disk. I'll pay $9.95 for each 5'/4-inch or 372-inch disk plus $2.00

shipping and handling per disk.

Please indicate how many disks of each formal you'd like;

5V4-incn disks at $9.95 each

3Vz-incti disks at $9.95 each

Subtotal

Sales tax (Residents of NC and NY, please add appropriate

sales tax for your area. Canadian orders, add 7% goods and

services tax.)

Shipping and handling ($2.00 U.S. and Canada. $3-00

surface mail, $5.00 airmail per disk)

Total enclosed

Send your order lo

COMPUTE'S PC Disk

324 W. Wendover Ave., Ste. 200

Greensboro, NC 27408

SUBSCRIPTIONS

I want to save even more! Start my one-year magazine and disk sub

scription to COMPUTE'S PC right away.

574-inch $49.95 per year

372-inch $49.95 per year

For delivery outside the U.S. or Canada, add $10.00 for postage and

handling.

Name.

Address.

City

State/Province

ZIP/Postal Code

Total Enclosed _

Check or money order.

MasterCard.

VISA

Credit Card No.

Expiration Dale.

Signature

Daytime Telephone No.

Send your order to

COMPUTE'S PC Disk

P.O. Box 3244

Harlan, IA 51539-2424

All orders must be paid in U.S. funds by check drawn on a U.S. bank or by mon

ey order. MasterCard or VISA accepted for oiders over $20. This oiler will be

filled only at the above address and is nol made in conjunction with any other

magazine or disk-subscription offer. Please allow -1-6 weeks for delivery of

single issues or for subscription to begin. Sorry, but telephone orders cannot be

accepted.

Disks available onty for IBM PC and compatible computers.

Offet good while supplies last.

WinPost
WinPost is a Windows person

al information manager that

follows the little-yeilow-sticky-

note metaphor. The program

allows you to create and man

age up to 100 reminder

notes.

Each WinPost note can be

colored and sized according

to your desires, and each

note offers full editing capabil

ities, including cut-and-paste

options. Notes are created,

modified, and viewed easily

through menu selections, but

all commands have keyboard

equivalents to provide faster

access.

WinPost includes a layout

feature, which allows you to

group related notes into logi

cal categories, and an alarm

feature, which allows you to

create reminder notes that

pop up onscreen at specified

dates and times so you won't

forget an appointment.

Nobuya "Higgy" Hi-

gashiyama, the creator of Win

Post, says the program was

born as a Windows program

ming exercise. After his effort

was enthusiastically received

by friends and associates, he

decided to make it available

as shareware. WinPost car

ries a $30 registration fee.

Switcher
Switcher gives Windows us

ers who frequently switch

screen modes an ingenious

way to save time and trouble.

The program, from Robert Sa-

lesas of Echalon Develop

ment, makes changing from

16-color to 256-color modes,

or vice versa, a snap.

To use the program, you

simply teach Switcher what

modes you regularly use. Af

ter that, just run the program,

select the desired mode from

a menu, and click on the Re

start Windows button. Switch

er handles the rest.

All of this is much simpler—

and far faster—than going

Cache Test

CPYDSK

Disk Organizer

Space

through the Windows Setup

program. And there's an add

ed bonus for anyone who us

es a customized Windows

startup screen. Switcher pre

serves your startup screen

rather than reinstalling the Mi

crosoft logo screen.

Switcher, which comes

from the creators of WinCLI

and other Windows software,

is a free program. No registra

tion fee is required. □
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select the desired mode from 
a menu, and click on the Re­
start Windows button. Switch­
er handles the rest. 
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program. And there's an add­
ed bonus for anyone who us­
es a customized Windows 
star tup screen. Switcher pre­
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PROGRAMMING POWER
Tom Campbell

TVHC is surely

a no-frills

program, but It

makes online

help a cakewalk.

MAKE YOUR OWN
ONLINE HELP
This month we'll start off with

a bang by transforming some

Turbo Pascal example code

from an interesting demo into

a commercial-quality applica

tion. And it's all free for the

downloading.

One of my favorite addi

tions to Turbo Pascal 6.0 is the

EDITORS unit; it lets you add

a multiwindow text editor with

search and replace to your ap

plications by adding just a few

lines of code.

it suffers a couple of limita

tions; namely, there's no on

line help, and word-wrap isn't

supported. This month on

COMPUTE/NET you'll find solu

tions to both problems and an

example of adding help to

your application.

The executable file size of

the multiwindow editor TVED2

is 111K—not bad for an editor

with state-of-the-art menus,

snappy dialogs, multiple win

dows, hypertext help, search

and replace, support for any

wacky text mode you can

throw at it, and word-wrap.

(The self-extracting archive file

TVED.EXE is quite large, as it

also includes the source, help

files, and documentation.)

It ail began as a communal

project on CompuServe's

BPROGA {Borland's Pascal fo

rum) late last year. Al Ander

son (ID 71610,3214) modified

the EDITORS.PAS example

file so that it supported word

wrap, and he requested volun

teers for testing and assembly

language optimization. I dis

patched the latter in record

time because it didn't need

optimization: Al's code was so

efficient that it didn't even

show up on the profiler.

I then foolishly offered to

implement a help system

based on the help engine pro

vided as one of the example

files. In three hours, I had the

code up and running; I wrote

the text for the help system in

another day and a half. I had

the easy part; Al pulled yeoman

duty and made his code availa

ble free, a remarkable gift de

serving special praise.

Borland's documentation

on both the editor and the

help system is hard to come

by. You have to scrape it out

of obscurely named files in at

least three directories, and

depending on the manual's

edition, you'll find little or no

mention of it in print. That's be

cause Borland terms this "ex

ample" code.

This column details the con

struction of an editor employ

ing online help and its help

files. TVED.EXE repackages

all the relevant information in

one place; refer to the files

TVED2.PAS and HELP.DOC

while reading. Even if you

don't need a text editor, all of

the lessons apply to any Tur

bo Vision application using on

line help.

Following is an overview of

the processes used to add hy

pertext help to your applica

tion; they're detailed step by

step in README.! (the theo

ry) and TVED2.PAS (the

implementation).

First, you must write a help

source file to run through

TVHC.PAS, the help compiler.

TVHC eats your source and

spits out an indexed HLP file

for your application to use at

runtime and a PAS file you'll

need at compile time. Here's

a tiny heip source file: .topic

NoContext=0.h. To quit, hold

down ALT and press X.

The line .topic Save File-

Save Save writes the docu

ment to a file on disk. See al

so {Save as...:SaveAsj.

The line .topic SaveAs File-

Save as . . . lets you write the

document to a different file

name, thus preserving the cur

rent document and automat

ically replacing it with the new

ly created one.

The topic whose value is 0

will be displayed whenever

help is requested in a context

for which no help has been

defined.

Later topics will be given

values that increment by 1

each time, so Save will be 1

and Save as . . . will be 2.

Lines starting with a period

are used to generate values

for the help system, and com

mands embedded within the

text are set off by curly brac

es to indicate hypertext links.

The source file above would

create this PAS file:

unit edhelp; interface

const hcNoContext = D; hcSave

= 1; hcSaveAs = 2;

implementation

end.

It took the .topic links, insert

ed he in front of each, and

wrapped up these constant

values in public unit declara

tions. Add that file to your US

ES clause and mix well.

TVHC is surely a no-frills pro

gram, but it makes online

help a cakewalk.

After creating the help file,

you need to add a couple of

methods to your TApplication

descendant, add a help com

mand to the status line, and as

sign help constants to any

menu or TView-descended ob

ject for which you need help,

like this: HelpCtx := hcSaveAs;.

HelpCtx is a field in all

TView descendants; it pro

vides a hook for help systems

like the one that comes with

Turbo Vision. If you can't re

member which objects are de

scended from TView, the com

piler willingly reminds you: An

Unknown identifier message

when you try to write to

HeipCtx means it isn't!

Don't settle for less. Just

download TVED.ZIP and fol

low these steps; you'll end up

with a help system rivaling

that of any commercial prod

uct. All for free. 3
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implement a help system 
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files. In three hours, I had the 

code up and running; I wrote 
the text for the help system in 
another day and a half. I had 
the easy part; AI pulled yeoman 
duty and made his code availa­
ble free, a remarkable gift de­
serving special praise. 
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of obscurely named files in at 
least three directories, and 
depending on the manual 's 
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one place ; refer to the files 
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Following is an overview of 
the processes used to add hy­
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tion; they're detailed step by 
step in README.1 (the theo­
ry) and TVED2.PAS (the 
implementation). 

First, you must write a help 
source file to run through 
TVHC.PAS, the help compiler. 
TVHC eats your source and 
spits out an indexed HLP file 
for your application to use at 
runtime and a PAS file you'll 
need at compile lime. Here's 
a tiny help source file: . topic 
NoContext=O.h. To quit, hold 
down ALT and press X. 

The line .topic Save File­
Save Save writes the docu­
ment to a file on disk. See al­
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Save as ... lets you write the 
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tions. Add that file to your US­
ES clause and mix well. 
TVHC is surely a no-frills pro­
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Alter creating the help file , 
you need to add a couple of 
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INTRODOS
Tony Roberts

With large

hard drives, you

need to pay

special attention to

partitions

and cluster size.

ORGANIZING
LARGE DRIVES
Having a big, fat hard drive is

wonderful, but managing

large amounts of storage pre

sents a new set of challenges.

For example, how should

you set up your hard disk-

one huge partition or two or

more smaller ones? Let's look

at the advantages and draw

backs of each setup.

The main advantage of as

signing the entire disk to one

large partition is convenience.

Navigation is a little easier

with everything in one place,

but you run some risks.

Keeping huge amounts of

data in one partition is like car

rying all your eggs in one bas

ket. If the FAT {File Allocation

Table) for that partition gets

scrambled, your entire data

set could end up fried.

By breaking up your disk in

to partitions, each with its own

FAT, you have some protec

tion. If one FAT becomes dam

aged, your loss will be limited

to the information in that

partition.

Another issue to consider is

cluster size and wasted

space. A cluster is the small

est unit of assignable disk

space, and an unnecessarily

large cluster size wastes

some of that precious space.

To check the cluster size of

your disk, run CHKDSK. Near

the bottom of the CHKDSK dis

play, you'll see a line saying X

bytes in each allocation unit.

This tells you the cluster size.

Every file is allocated disk

space in clusters.

If your disk is a floppy disk,

that cluster will likely be 1024

bytes. A 1-byte file would be

allocated one cluster and occu

py 1024 bytes of disk space.

Hard disks ranging in size

from about 18MB to 120MB

have cluster sizes of 2048K.

Larger hard disks assign

space in units of 4096K. So a

1-byte file on a 100MB hard

disk would occupy 2048

bytes, and the same file on a

200MB hard disk would occu

py 4096 bytes.

Let's say you have a hard

disk with a 4096-byte cluster.

Assume the disk holds 2500

files. The data in each file fills

some clusters and partially

fills one—the last—cluster.

Some of these last clusters

will be nearly empty, some will

be nearly full, and most will be

somewhere in between. For

the sake of discussion, let's

say the last cluster of each file

averages one-half cluster

{2048 bytes) of unfilled

space.

Multiply the average un

filled space (2048 bytes) by

the number of files (2500). You

get 5,120,000 bytes of space

that your files occupy but

don't actually use.

If you break your hard disk

into smaller partitions which

use 2048-byte clusters, you

can recover half of that un

filled space. Assuming that

the average last cluster is still

half-full, you've reduced your

occupied but unused space

to 2,560,000 bytes.

If you keep thousands of

files on your hard disk, a small

er cluster size can pay off by

giving you extra room to work.

On the other hand, if your disk

is used to store only a few

multimegabyte database files,

larger partitions may be a bet

ter choice. Your database will

have room to grow, and you

won't be concerned about

running out of real estate for

your data.

Breaking up a disk into par

titions also helps at backup

time. Imagine backing up a

200MB disk onto floppies. You

can see that you'll want to be

selective about what you back

up. Some data you'll want to

back up daily, some occasion

ally, some never.

I have all of my work files on

one partition, and I back up

my changed files on that par

tition daily. I use a second par

tition for files I never want to

back up. I use this for test files

or shareware programs that

I'm trying out. If I like the prod

uct and intend to use it and

register it. I move it to my main

partition. If not, ! just delete it.

My third partition is used for

telecommunications activity—

files to upload or download as

well as incoming and outgoing

messages. I back up this par

tition occasionally to make

sure I can restore all of my pro

grams, scripts, and configura

tion files, but I'm not too con

cerned about the data on this

partition, if the file is important,

it gets either printed out or

moved to my primary partition.

Because I've arranged my

disk this way, my daily back

ups are much faster and.less

intrusive than they would be if

I had to deal with the entire

hard disk.

Whether you have one

huge partition or many small

er ones, you still have the

same amount of data, and you

must take pains to protect it.

The larger your hard disk, the

larger your loss if something

goes wrong.

At the very least, run

CHKDSK on each of your

hard disk partitions daily. You

can put the commands to do

this in your AUTOEXEC.BAT

file, and you'll learn early if

anything is out of whack on

your drive. At the first hint of a

problem, take quick corrective

action.

If you have a more powerful

disk-fix utility, use it rather

than CHKDSK to make sure

your storage areas are sound.

Such utilities are more compre

hensive and easier to use

than CHKDSK.

If your hard disk isn't set up

the way you'd like, stay tuned.

Next month we'll look at the

FDISK command and discuss

how to use it to partition your

computer's hard disk. 3
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Hard disks ranging in size 
from about 18MB to 120MB 
have cluster sizes of 2048K. 
Larger hard disks assign 
space in units of 4096K. So a 

1-byte file on a 100MB hard 
disk would occupy 2048 
bytes, and the same file on a 
200MB hard disk would occu­
py 4096 bytes. 

Let's say you have a hard 
disk with a 4096-byte cluster. 
Assume the disk holds 2500 
files. The data in each file fills 
some clusters and partially 
fills one-the last-cluster. 
Some of these last clusters 
will be nearly empty, some will 
be nearly full, and most will be 
somewhere in between . For 
the sake of discussion, let 's 
say the last cluster of each file 
averages one-half cluster 
(2048 bytes) of unfilled 
space. 

Multiply the average un­
filled space (2048 bytes) by 
the number of files (2500). You 
get 5,120,000 bytes of space 
that your files occupy but 
don't actually use. 

If you break your hard disk 
into smaller partitions which 
use 2048-byte clusters , you 
can recover half of that un­
filled space. Assuming that 
the average last cluster is st ill 
half-full , you've reduced your 
occupied but unused space 
to 2,560,000 bytes. 

If you keep thousands of 
files on your hard disk, a small­
er clus ter size can payoff by 
giving you extra room to work. 
On the other hand, if your disk 
is used to store only a few 
multi megabyte database files, 
larger partitions may be a bet­
ter choice. Your database will 
have room to grow, and you 
won' t be concerned about 
running out of real estate for 
your data. 

Breaking up a disk into par­
titions also helps at backup 
time. Imagine backing up a 
200MB disk onto floppies. You 
can see that you' ll want to be 
selective about what you back­
up. Some data you'll want to 
back up daily, some occasion­
ally, some never. 

I have all of my work files on 
one partition, and I back up 

my changed files on 1I1at par­
tition daily. I use a second par­
tition for files I never want to 
back up. I use this for test files 
or shareware programs that 
I'm trying out. If I like the prod­
uct and intend to use it and 
register it, I move it to my main 
partition. If not, I just delete it. 

My third partition is used for 
telecommunications activity­
files to upload or download as 
well as incoming and outgoing 
messages. I back up this par­
tition occasionally to make 
sure I can restore all of my pro­
grams, scripts, and configura­
tion files, but I'm not too con­
cerned about the data on this 
partition. If the file is important, 
it gets either printed out or 
moved to my primary partition . 

Because I've arranged my 
disk this way, my daily back­
ups are much faster and. less 
intrusive than they would be if 
I had to deal with the entire 
hard disk. 

Whether you have one 
huge partition or many small­
er ones , you st ill have the 
same amount of data, and you 
must take pains to protect it. 
The larger your hard disk, the 
larger your loss if something 
goes wrong. 

At the very least , run 
CHKDSK on each of your 
hard disk partitions daily. You 
can put the commands to do 
this in your AUTOEXEC.BAT 
file , and you'll learn early if 
anything is out of whack on 
your drive. At the first hint of a 
problem, take quick corrective 
action. 

If you have a more powerful 
disk-fix util ity, use it rather 
than CHKDSK to make sure 
your storage areas are sound. 
Such utilities are more compre­
hensive and easier to use 
than CHKDSK. 

If your hard disk isn' t set up 
the way you'd like , stay tuned. 
Next month we'll look at the 
FDISK command and discuss 
how to use it to part ition your 
computer's hard disk. 0 
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HARDWARE CLINIC
Mark Minasi

New modem

protocols have

made online

communications a

lot easier.

HOW MODEMS
WORK, PART 2
Last month, we looked at how

PCs transferred data over

phone lines at the start of the

computer revolution.

Originally, a bulletin board

system (BBS) would basically

toss the data over the phone

lines to the receiving comput

er, and the computer would

capture the data as it came in,

line noise and all. Line noise

wasn't a problem then, as we

were usually communicating

at 300 bps, and phone lines

look almost perfectly clean to

300-bps modems.

Then came faster modems,

at 1200 bps and up. Pushing

phone performance made for

occasional errors—still no

more than a bad bit every

hour or two, but a measurable

amount.

XMODEM was the first at

tempt in the PC world to solve

the problem of transporting da

ta over phone lines and ensur

ing that any errors in transmis

sion were caught and automat

ically corrected.

XMODEM has been largely

outclassed by newer transfer

methods, but it retains a great

strength—it's ubiquitous. You

can find the old guy every

where. Every communications

program supports XMODEM,

at a minimum.

Nonetheless, XMODEM has

four deficiencies. First, its

block size is too small and

makes for inefficient transfers.

(We'll see why this month.) Sec

ond, it requires the operator to

tell both the receiver and the

sender the name of the file.

Third, it only transfers one file

at a time. Fourth, its checksum-

based error-detection scheme

is too simple in the eyes of

some people. These four weak

nesses led to the development
of today's file-transfer methods

or, as they're commonly

called, protocols.

Block Party
For the rest of this column, I'll

talk about that first character

istic, block size. It's the really

big difference in the newer pro

tocols—the transfer block

size. That's the big story—and

the secret to increasing the

speed of your file transfers by

as much as 300 percent.

Recall how XMODEM

works. The sender sends the

first 128 bytes of the file, then

waits while the receiver deter

mines whether or not the 128-

byte block has transferred with

out transmission errors, using

a simple checksum. Once the

receiver has acknowledged

the receipt of the first block,

the sender sends the next

128 bytes, and so on.

The key to understanding

why this is really inefficient

(for most applications) is

in knowing that the process

of the receiver's checking

the checksum and sending

the acknowledgment to

the sender may take more

time than is required to send

the entire block in the first

place.

To see this, imagine this ex

aggerated scenario. You're

communicating at 9600 bps

with a BBS. This is 960 bytes

per second, so each

XMODEM 128-byte block

takes about .13 second. Sup

pose it took 1 second for each

acknowledgment to be comput

ed and sent. That would mean

that the sender would be

spending .13 second sending,

then 1 second waiting, then

.13second sending, then 1 sec

ond waiting, and so on. You

would only be transmitting the

file 11 percent of the time.

While the average situation

isn't that bad, it's close. For ex

ample, many communications

programs save each block to

disk as it's being received, so

changing the block size from

128 to 1024 would reduce the

number of disk accesses by a

factor of 8.

Catching Some Z's
Today's protocols allow for

blocks ranging in size from

128 bytes to 1024 bytes.

YMODEM, ZMODEM, and the

CompuServe Quick "B" proto

col are three popular exam

ples. Your communications

software probably allows you

to set your block size, but the

interesting question is, What

is it already set to? I use

Crosstalk for Windows exten

sively, and I like it a lot, but I'd

used it for about a month be

fore I realized that it set all pro

tocol block sizes to 128 bytes

by default. To see just how im

portant block sizes are, I trans

ferred several large files from

CompuServe using block siz

es of 128 and 1024. The 128-

byte block size averaged a

throughput of 362 bytes per

second; the 1024-byte block

averaged 987 bytes per sec

ond. A stunning difference

that didn't cost me a cent—

but it sure saves me money in

CompuServe charges.

Now, there's a caveat to un

derstand about setting your

block sizes large. If you have a

noisy line and your protocol dis

covers that a 128-byte block

has been garbled, the sender

need only resend 128 bytes.

But when lines are noisy and

you're using 1024-byte

blocks, every block with even

a single bad bit in it requires

that you resend 1024 bytes.

So the rule in picking block siz

es is this: The cleaner the line,

the larger the block size. Ex

periment to find the best block

size, and don't just accept the

default block size. You'll prob

ably find that local calls are

more noise-free than long-dis

tance calls—optical fiber lines

notwithstanding.

Calling a Timeout
A related performance tip has

to do with timing. After the

sender has sent the block of

data, it will wait a specified

amount of time for the ACK
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HOW MODEMS 
WORK, PART 2 
Last month, we looked at how 
PCs transferred data over 
phone lines at the start of the 
computer revolution. 

Originally, a bulletin board 
system (BBS) would basically 
toss the data over the phone 
lines to the receiving comput­
er, and the computer would 
capture the data as it came in, 
line noise and al l. Line noise 
wasn't a problem then , as we 
were usually communicating 
at 300 bps, and phone lines 
look almost perfectly clean to 
300-bps modems. 

Then came faster modems, 
at 1200 bps and up. Pushing 
phone performance made for 
occasional errors-still no 
more than a bad bit every 
hour or two, but a measurable 
amount. 

XMODEM was the first at­
tempt in the PC world to solve 
the problem of transporting da­
ta over phone lines and ensur~ 
ing that any errors in transmis­
sion were caught and automat­
ically corrected . 

XMODEM has been largely 
outclassed by newer transfer 
methods, but it retains a great 
strength-it's ubiquitous. You 
can find the old guy every­
where. Every communications 
program supports XMODEM, 
at a minimum. 

Nonetheless, XMODEM has 
four deficiencies. First, its 
block size is too small and 
makes for inefficient transfers. 
(We'll see why this month.) Sec­
ond, it requires the operator to 
tell both the receiver and the 
sender the name of the file . 
Third, it only transfers one file 
at a time. Fourth, its checksum­
based error-detection scheme 
is too simple in the eyes of 
some people. These foV' weak­
nesses led to the development 
of today's file-transfer methods 
or, as they're commonly 
called, protocols. 

Block Party 
For the rest of this column, I'l l 
talk about that first character­
istic, block size. It's the really 
big diHerence in the newer pro­
tocols-the transfer block 
size. That's the big story-and 
the secret to increasing the 
speed of your file transfers by 
as much as 300 percent. 

Recall how XMODEM 
works. The sender sends the 
first 128 bytes of the file, then 
waits while the receiver deter­
mines whether or not the 128-
byte block has transferred with­
out transmission errots , using 
a simple checksum. Once the 
receiver has acknowledged 
the receipt of the first block, 
the sender sends the next 
128 bytes , and so on. 

The key to understanding 
why this is really inefficient 
(for most applications) is 
in knowing that the process 
of the receiver 's checking 
the checksum and sending 
the acknowledgment to 
the sender may take more 
time than is required to send 
the enti re block in the first 
place. 

To see this, imagine this ex­
aggerated scenario . You're 
communicating at 9600 bps 
with a BBS. This is 960 bytes 
per second, so each 
XMODEM 128-byte block 
takes about .13 second. Sup­
pose it took 1 second for each 
acknowledgment to be comput­
ed and sent. That would mean 
that the sender would be 
spending .13 second sending, 
then 1 second waiting, then 
.13 second sending, then 1 sec­
ond waiting, and so on. You 
would only be transmitting the 
file 11 percent of the time. 
While the average situation 
isn't that bad, it's close. For ex­
ample, many communications 
programs save each block to 
disk as it's being received, so 
changing the block size from 
128 to 1024 would reduce the 
number of disk accesses by a 
factor of 8. 

Catching Some Z'5 
Today's protocols allow for 
blocks ranging in size from 
128 bytes to 1024 bytes. 
YMODEM, ZMODEM, and the 
CompuServe Quick "B" proto­
col are three popular exam­
ples. Your commun ications 
software probably allows you 
to set your block size, but the 
interesting question is , What 
is it already set to? I use 
Crosstalk for Windows exten­
sively, and I like it a lot, but I'd 
used it for about a month be­
fore I realized that it set all pro­
tocol block sizes to 128 bytes 
by default. To see just how im­
portant block sizes are, I trans­
ferred several large fi les from 
CompuServe using block siz­
es of 128 and 1024. The 128-
byte block size averaged a 
throughput of 362 bytes per 
second; the 1024-byte block 
averaged 987 bytes per sec­
ond. A stunning difference 
that didn't cost me a cent­
but it sure saves me money in 
CompuServe charges. 

Now, there's a caveat to un­
derstand about setting your 
block sizes large. If you have a 
noisy line and your protocol dis­
covers that a 128-byte block 
has been garbled, the sender 
need only resend 128 bytes. 
But when lines are noisy and 
you're using 1024-byte 
blocks, every block with even 
a single bad bit in it requires 
that you res end 1024 bytes. 
So the rule in picking block siz­
es is this: The cleaner the line, 
the larger the block size. Ex­
periment to find the best block 
size, and don't just accept the 
default block size. You 'll prob­
ably find that local calls are 
more noise-free than long-dis­
tance calls-optical fiber lines 
notwithstanding. 

Calling a Timeout 
A related performance tip has 
to do with timing. After the 
sender has sent the block of 
data , it will wait a specified 
amount of time for the ACK 
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that means "I got the data

OK; send me the next block"

or the" NAK that means "I

didn't quite get that; please re-

send it." But the receiver

can't acknowledge what it

didn't get, so in case there's

been a line hit that obliterates

an entire block, the sender

will only wait a certain amount

of time for the receiver's re

sponse. If it doesn't get it, the

sender assumes that the data

was lost, and resends. The

question of how long it waits

is where timing comes in.

Crosstalk for Windows, for ex

ample, allows you to set pro

tocol timings to sloppy (wait a

long time for acknowledg

ments), loose, normal, and

tight. As before, a clean line

can handle more strenuous tim

ing than a noisy line, so finding

your best settings will require

some experimentation. I found

that the best throughput I

could achieve with sloppy tim

ing was 894 bytes per second,

but I got a throughput of 974

with tight timing. In both cases,

I was doing 1024-byte block

size transfers with a 9600-bps

modem. That's 9 percent knock

ed oft my CompuServe bill.

My final suggestion this

month for speeding up your

file transfer has to do with er

ror-correcting modems.

We've been talking about pro

tocols such as XMODEM,

YMODEM, and ZMODEM that

let the computers on either

end of a conversation make

sure that the data transfer is er

ror-free. Notice the word com

puters. There are programs

running in your computer and

the sender's computer that

support the file-transfer proto

col. It takes two to tango, so

you've got to have both sides

supporting the same protocol.

But some modem manufactur

ers have taken a different

tack. They've built a file-trans

fer protocol into the modems

themselves. To see why, let's

look at a non-PC application

of data communications.

Once, I was doing some

consulting for a doctor. I no

ticed that he had a printer

and a modem sitting all by

themselves off in the corner. I

asked what the printer did.

"That sends us the results

of our lab tests," he replied.

"We used to have to wait for re

sults in the mail, or we'd have

to pester the lab on the

phone. Now, the printer just

comes to life a few times a

day, and their computer uses

our printer to deliver the lab

test reports."

Nifty, I thought. The lab

sold him a normal Okidata dot-

matrix printer with a serial in

terface and a modem—a reg

ular old PC-type smart mo

dem. But a problem occurred

to me—what about line noise?

I'd hate to get a report that

said, "CANCER DIAGNOSIS:

PA%SKD##||." Looking close

ly at the modem, I noticed that

it had a label that said, "MNP

Level 5/Error Free." The testing

company uses modems with

built-in file-transfer protocols.

Such modems use protocols

with small blocks, usually un

der 32 bytes in size. One way

to tell if you're working with an

error-correcting modem is to

see if the text appears on your

screen in spurts. The modems

are examining the data in

small groups, so, after acknowl

edging that the data is error-

free, the data is released to

the PC, which quickly puts it

up on the screen.

If you have an MNP mo

dem or one that supports

V.42 or V.42 bis, you've got

an error-correcting modem.

MNP stands for Microcom Net

working Protocol, and it's an er

ror-detecting and -correcting

standard developed by Micro

com. V.42 is the name of a mo

dem standard promulgated

by the CCITT (Consultative

Committee on International

Telephones and Telegraphs,

a committee of a commission

of the United Nations). All the

V. standards refer to -mo

dems. V.22 bis is the stan

dard that most 2400-bps mo

dems are built around, V.32 is

a very popular 9600-bps stan

dard, and V.24 is the stan

dard that describes the serial

ports on your PC.

Paying the Overhead
It seems that if the modems

do the hard work of file trans

ferring, that can't be a bad

thing. In fact, it's valuable in

many cases, but the vast ma

jority of phone lines (in the

U.S., anyway) are fairly clear.

And, of course, there's a

price to pay—it takes time for

the modems to do the error

checking, and that's time that

they're not transferring data.

My experience is that the ex

tra overhead of the modem er

ror checking usually doesn't

pay off.

Think about disabling error

checking (it's sometimes

called ARQ) if your modem

has this built in. You can gen

erally turn it off either with a

DIP switch or by altering your

modem's setup string to in

clude the three characters

&M0. Again, my experimenta

tion showed a best-case trans

fer of 974 bytes per second

when error checking was dis

abled versus 894 bytes per

second when it was left on.

What about when you do

have noisy lines? Should you

disable error checking and set

your protocol block size small,

or should you let the modems

handle the error checking and

use the maximum protocol

block size? Definitely the latter,

for two reasons. First, modem

protocols have less overhead

than most PC file-transfer pro

tocols. Second, my unscientific

tests with noisy phone lines

have shown that modem proto

cols recover from noise much

better than PC file-transfer proto

cols do. Given the choice, let

the modem do it. □
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SHAREPAK
Bruce M. Bowden

July's SharePak

brings you

a powerful selection

of software.

A FANTASTIC
FOURSOME
July's SharePak disk contains

an interesting mix of three

wide-ranging utilities and one

highly original game.

SeekEasy searches your files

for approximate text strings us

ing a "fuzzy logic" technique.

EZ-SHOW lets you capture

graphic and text screens, and

then create a slide show with

them. Appointment Book will

handle the appointment calen

dars for ten people simultane

ously. The arcade-style game

Save fellow godmothers in

RGodmom.

~» -Tf..--»;■■!. M» ,H:

Fuzzy logic looks for files in

SeekEasy.

F.Godmom will keep you on

the edge of your seat through

50 levels.

Shareware is software re

leased to bulletin board sys

tems and computer networks

as an alternate way of market

ing. COMPUTE'S SharePak

comes to you with programs

which are among the best of

the shareware we've seen,

and we see a lot—hundreds

of titles every month. The sav

ings to SharePak subscribers

in time, energy, and online

fees are significant.

SeekEasy
SeekEasy is a text-search util

ity with intelligence. With

SeekEasy, you don't have to

remember the exact wording

or spelling of the text. The pro

gram will scan your disk files

to find text that even approxi

mately matches what you

asked for. For example, if a

fiie somewhere on your disk

holds the text "The trunk of

the elephant is. . . ,"

SeekEasy can find it even if

your request is for ephalant's

trunq. The text it finds is dis

played in "best-matches-

shown-first" order.

SeekEasy can be set to

search through one file, all

the files in a directory, those

in a directory and all its sub

directories, or those within a

whole drive's worth of files. It

will scan all file types: word

processor, database, even

COM and EXE files. It can be

told which filenames or file

types to include or ignore. It

shows you the items it finds

during its search in the order

of best matches first, as deter

mined by its "fuzzy logic" al

gorithms. As you can see,

SeekEasy is a well-written

and thoroughly fascinating utili

ty to use.

SeekEasy works on any PC

or compatible with DOS 2.0

or higher and at least 256K of

RAM. The program also runs

under Windows 3.0.

EZ-SHOW 1.0
EZ-SHOW helps you create

professional desktop presenta

tions, slide shows, and prod

uct demos without using

scripts! The set of files con

tains a screen-capture pro

gram, a presentation-creation

program, and a royalty-free

show program. The capture

program works with almost an

ything your screen can dis

play, from text screens to Su

per VGA graphics. It's a TSR,

sitting in about 9K of memory

until you invoke it to do a

screen capture with specially

designated hot keys. The pres

entation creator lets you

group your pictures for a

slide show, using point-and-

shoot menus, mouse support,

and built-in help. The features

include picture fades, individ

ual picture delays, user flow

control, branching, back

ground processing, EGA pal

ette editor, and much more.

EZ-SHOW requires an IBM

PC or compatible running

DOS 2.1 or higher with a

CGA, EGA, MCGA, or VGA

display.

Appointment Book 1.0
Appointment Book is a gener

al-purpose appointment mak

er that lets you keep track of

appointments for up to ten

people. When you invoke the

program, it gives you the cur

rent day's appointments. If

more than one appointment

at the same time has been

made for a person, the soft

ware will highlight the times

for which there is a conflict.

You can search for open ap

pointment slots on any date

or for any scheduled appoint

ments according to date or us

er parameters.

Appointment Book works

on any IBM PC or compatible

with DOS 2.0 or higher.

F.Godmom Version 2.1
F.Godmom stands for fairy

godmother. In this ar

cade-style game you play a

fairy godmother on a mission

to free 50 of your fellow fairy

godmothers. Armed with a

magic wand of transforma

tion, you must make your way

across 50 levels while avoid

ing killer crabs and danger

ous dimensional implosions. If

you succeed, your fellow fairy

godmothers will be freed and

will dance for joy in your hon

or. If not, it's curtains for you.

F.Godmom was written for

machines with CGA, EGA, or

VGA monitors. D
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With COruiPUTE's SharePak, You'll

SHARE IN THE SAVINGS!
SAVE TIME
We carefully select and test all programs for you

SAVE MONEY
Each disk includes two to five programs for one low price

SAVE KEYSTROKES
Our free DOS shell lets you bypass the DOS command line

July's

SharePak

disk

$1.49

per program!

Back Issues Available

NOV 89: CheckMate, maintain multiple checking and savings ac
counts: Contact Manager, keep track of all your contacts.
(#CDSK1189)

FEB 90: Fastbutfer, speed up key-repeat rates; Flu Shot, ward
off computer viruses; PC-KWIK, speed up your hard disk access;
CompuShow, view GIF pictures on your PC. #CDSK0290)

APR 90: Pianoman, play and record music on your keyboard;
Tune Trivia, test your music trivia; Morse Code Trainer, increase

your Morse code proficiency; RealSound Sampler, create digit
ized sounds. (#CDSK0490)

DEC 90: Audiqlog, catalog your audio collections; VideoTest, ad
just your monitor for maximum performance; Video Librarian,
track your VCR tapes. (#CDSK1290)

FEB 91: Our United States, develop your knowledge of the U.S.;

Trivia Whiz, great trivia game; Word Whiz, great vocabulary drill/
game; The World, enhance your world qeoqraphy.
(#CDSK0291)

MAY 91: Click! Filer, excellent program manager and file man

ager; PBIcon, make your own icons for Windows applications;
PCBUDGET, full-featured budgeting tool; Resume Professional,
create the best possible resume. (#CDSK0591)

JUL 91: SimplyWrite. exceptional ASCII text editor; PROspector,
keep track of business prospects; Filesync, quickly update the

right files. (#CDSK0791)

COMPUTE'S SharePak disk contains the best
of shareware—handpicked and tested by our staff—to

complement this month's focus. You'll sample entertainment,

learning, and home office software at a great savings. Each

SharePak disk includes two to five programs plus complete

documentation for one low price:

$5.95 for 5V4-inch disk «

$6.95for3l/2-inchdisk

For even more savings,

Subscribe to SharePak and receive

COMPUTE'S SuperShelt FREE!

For a limited time, you can subscribe to COMPUTE'S

SharePak and save more than 37% off the regular cost

of the disks—plus get COMPUTE'S SuperShell FREE.

With a one-year paid subscription, you'll get

• A new 3'/2- or 5'/4-inch disk delivered to your home

every month

• Savings of over 37% off the regular disk prices

• Advance notices of COMPUTE special offers

• COMPUTE'S SuperSheil at no additional cost!

Subscribe for a year at the special rates of $59.95 for

5V4-inch disks and $64.95 for 31/2-inch disks—and get

COMPUTE'S SuperShell FREE!

COMPUTE'S SuperShell requires DOS 3.0 or higher.

Disks available only for IBM PC and compatibles. Offer good while supplies last.

For Single Disks

Please indicate how many disks of each format you would like:

5%-lnch at $5.95 3'/:-inch at S6.95

This month's disk ^_^

#CDSK1189 -

#CDSK0290 ____^

#CDSK0490

#CDSK1290 '

#CDSK0291

#CDSK0591

#CDSK0791 .

Subtotal

__— Sales Tax (Residents of NC and NY, please add appro

priate sales tax for your area. Canadian orders, add 7%

goods and services tax.}

Shipping and Handling ($2.00 U.S. and Canada, $3.00 sur

face mail, S5.00 airmail per disk)

„ Total Enclosed

Subscriptions
I want to save even more! Start my one-year subscription to COM

PUTE's SharePak right away. With my paid subscription, I'll get a
FREE copy of COMPUTE's SuperShell plus all the savings listed above.

Please indicate the disk size desired:

5%-inch a! $59.95 per year 3Vt-inch at $64.95 per year

For delivery outside the U.S. or Canada, add S10.00 for postage and handling.

Name

Address

Ciiy

Stale/Province.

Tola! Enclosed

ZIP/Posial Code_

Check or Money Order MasterCard VISA

Credit Card No. E«p. Date.

Signature

(Required)

Daytime Telephone No.

Send your order to COMPUTE's SharePak, 324 West Wendover Avenue,
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All orders mus! be paid in U.S. funds by check drawn on a U.S. bank or by money order.
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ry, but telephone orders cannot be accepted.

Important Notice: COMPUTE's SharePak is not associated with COMPUTES
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GET

RIGHT, GET

LIGHT
Any calendar will tell you the

eighties are over, but you'd

never know it by looking

around an airport. America's

get-it-now business road

show teems with mobile ex

ecutives squeezing every

ounce of productivity they

can from pay phones, sky

pagers, cellular linkups, and

public fax stations.

Enter another weapon:

the portable computer. Small

er, faster, more powerful,

and less expensive than ev

er, laptop and notebook com

puters have become terror

weapons in the road warri

or's arsenal.

But portable computers

aren't just for business any

more. They make great sec

ond computers for the of

fice, for home, or for school.

Or they can be used as mo

bile communications cen

ters. And while you might

not believe it, the time is com

ing when a portable comput

er will replace that desktop

computer you're using now.

Portable computers are

the fastest growing segment

of the computer market and

have garnered a loyal follow

ing among computer users

of all stripes. These small

and powerful systems have

the potential for increasing

productivity while at the

same time granting flexibility

in work schedules and envi

ronments. They can serve

as a second computer in

the office or at home, can

travel as a communications

tool, or even take over the

functions of a desktop per

sonal computer.

But for first-time buyers,

the array of laptops and note

books can be intimidating.

Balancing the expense

against the gains is possible

only when you can deter

mine your needs, and then

match a system to those re

quirements and your person

al preferences.

To make the right fit be

tween your power needs

and the constraints of your

budget, you must develop a

strategy. This guide will

help you determine where

you stand in the field of port

able computing. Use it to de

velop your personal strategy

for buying the laptop or note

book system you need.

For Under a Grand
Here's the kind of machine

you can expect to find for

less than $1,000.

System Profile:

• 80C86, V20, or 10-MHz

80286 processor

• CGA-compatible super-

twist backlit LCD display

• 1MB of RAM

• Internal high-density 3V4-

inch floppy drive

• 20MB hard drive

Buyer Profiles:

• Students

• Writers

• Occasional travelers

• Anyone looking for a sec

ond home computer

If you're ready for a sec

ond computer but the mon

ey around your house is

tight, you can get a service

able laptop computer for un

der $1,000. You probably

won't get VGA-compatible

displays or 20-MHz process

ing speed, but you'll get

enough of a machine for

word processing, modest

number crunching, and tele

communicating. If you're a

ARTICLE ■
BY PETER SCISCO

Computer
hardware is getting smaller

and changing faster

Here's a guide for keeping up

student or if you have a stu

dent in your house, if you

plan to do only word process

ing, or if you need a laptop

only for occasional travel,

then a portable computer in

this price range should en

ter your consideration.

You'll be able to find sever

al brand-name laptops in

this category through mail

order outlets, including the

Toshiba 1000XE, the Hyun

dai Super LT-3, and the

Bondwell B310SX. The Toshi

ba is an XT-class system,

the Hyundai offers AT-class

performance, and the Bond-

well actually contains a

386SX chip. Each of the

packages in this price

range includes a hard

drive, backlit LCD, and high-

density floppy drive. At the

time this feature was written,

each package was adver

tised in the $1,000 range.

Bundle any of these lap

tops—or comparable sys

tems—with the right soft

ware, and you have a very

capable portable computer.

Use an integrated software

package such as Microsoft

Works or Spinnaker's Eight-

Any calendar will tell you the 
eighties are over, but you'd 
never know it by looking 
around an airport. America's 
get-it-now business road 
show teems with mobile ex­
ecutives squeezing every 
ounce of productivity they 
can from pay phones, sky 
pagers, cellular linkups, and 
public fax stations. 

Enter another weapon : 
the- portable computer. Small­
er, faster, more powerful , 
and less expensive than ev­
er, laptop and notebook com­
puters have become terror 
weapons in the road warri­
or's arsenal. 

But portable computers 
aren' t just for business any­
more. They make great sec­
ond computers for the of­
fice, for home, or for school. 
Or they can be used as mo­
bile communications cen­
ters. And while you might 
not believe it, the time is com­
ing when a portable comput­
er will replace that desktop 
computer you're using now. 

Portable computers are 
the fastest growing segment 
of the computer market and 
have garnered a loyal follow-
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ing among computer users 
of all stripes. These small 
and powerful systems have 
the potential for increasing 
productivity whi le at the 
same time granting flexibility 
in work schedules and envi­
ronments. They can serve 
as a second computer in 
the office or at home, can 
travel as a communications 
tool , or even take over the 
functions of a desktop per­
sonal computer. 

But for first-time buyers, 
the array of laptops and note­
books can be intimidating. 
Balancing the expense 
against the gains is possible 
only when you can deter­
mine your needs, and then 
match a system to those re­
quirements and your person­
al preferences. 

To make the right fit be­
tween your power needs 
and the constraints of your 
budget, you must develop a 
strategy. This guide will 
help you determine where 
you stand in the field of port­
able computing. Use it to de­
velop your personal strategy 
for buying the laptop or note­
book system you need. 

For Under a Grand 
Here's the kind of machine 
you can expect to find for 
less than $1 ,000. 

System Prolife: 
• 80C86, V20, or 10-MHz 

80286 processor 
• CGA-compatible super­

twist backlit LCD display 
• 1MB of RAM 
• Internal high-density 3 ;<" ­

inch floppy drive 
• 20MB hard drive 

Buyer Profiles: 
• Students 
• Writers 
• Occasional travelers 
• Anyone looking for a sec­

ond home computer 

If you're ready for a sec­
ond computer but the mon­
ey around your house is 
tight, you can get a service­
able laptop computer for un­
der $1 ,000. You probably 
won't get VGA-compatible 
displays or 2O-MHz process­
ing speed , but you'll get 
enough of a machine for 
word processing, modest 
number crunching, and tele­
communicating. If you're a 

ARTICLE -
BY PETER SCISCO 

Computer 
hardware is getting smaller 

and changing faster. 
Here's a guide for keeping up 

student or if you have a stu­
dent in your house, if you 
plan to do only word process­
ing, or if you need a laptop 
only for occasional travel, 
then a portable computer in 
this price range should en­
ter your consideration. 

You'll be able to find sever­
al brand-name laptops in 
this category through mail­
order outlets, including the 
Toshiba 1000XE, the Hyun­
dai Super LT-3, and the 
Bondwell B31OSX. The Toshi­
ba is an XT-class system, 
the Hyundai offers AT-etass 
performance, and the Bond­
well actually contains a 
386SX chip. Each of the 
packages in this price 
range includes a hard 
drive, backlit LCD, and high­
density floppy drive. At the 
time this feature was written, 
each package was adver­
tised in the $1,000 range. 

Bundle any of these lap­
tops-or comparable sys­
tems-with the right soft­
ware, and you have a very 
capable portable computer. 
Use an integrated software 
package such as Microsoft 
Works or Spinnaker's Eight-



In-One for light number crunching,

word processing, and contact manage

ment (with the built-in database mod

ules). If you want a more intuitive envi

ronment, you could use DeskMate or

GeoWorks Ensemble. Integrated pack

ages usually offer file import/export ca

pabilities in standard formats such as

ASCII, WK1, and dBASE. Tandy's Desk-

Mate adds task switching (as does

DOS 5.0); Ensemble provides multi

tasking within its own applications,

even with an XT-class machine.

Save the money you would have

spent on a more powerful system to out

fit your inexpensive laptop with an exter

nal pocket modem. That will increase

your productivity by linking you to infor

mation sen/ices and by providing a re

mote link to your desktop computer.

For a Couple of G's
This is what you can expect to find for

between $1,000 and $2,000.

System Profile:

• 12-MHz 80286, 16- or 20-MHz 386SX

processor

VGA-compatible backlit LCD display

1MB of RAM (minimum)

High-density 3'/2-inch floppy drive

20MB hard drive (minimum)

Internal or external modem

DOS 5.0

Buyer Profiles:

• Business students

• Number-crunchers

• Traveling salespeople

• Telecommunicators

• Marketing professionals

If you find that your computing

needs are more substantial than those

described in our first category, you can

spend a little more for a speedy AT-

class (or better) laptop that will work

nearly as well as your desktop comput

er. As prices continue to drop, the

price differential between the 286- and

the 386SX-based notebooks becomes

less and less a factor.

It's clear that if you need to run mod

erately powerful character-based appli

cations while on the road, you'll need

the power and extra memory that a lap

top in this price range will give you. If

your work is in marketing and account

ing, you'll appreciate the ability to run

applications like Lotus 1-2-3 or

Borland's Quattro Pro. Salespeople

will want the extra speed and power to

run contact-management software.

And every professional who needs to

communicate with corporate headquar

ters or with home will appreciate the

telecommunications capabilities availa

ble in this price range.

To find top-end machines at the low
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The midrange ZEOS notebook computer is

both practical and popular.

The Sharp PC-6781 offers monochrome

graphics at $3,599.

YOU CAN HEAR IT COMING

Last fall at COMDEX, Media Vision—the

maker of the Pro Audio Spectrum and

Thunderboard sound cards—was talking

about a board-level sound device for lap

tops and portables that would allow com

puter users to take advantage of sound-

enhanced applications while on the

road.

This past January, the company an

nounced what it called Transportable

Sound Technology for use in battery-

powered sound peripherals designed for

laptops. Media Vision uses a proprietary

audio chip set that takes up less space

and has lower power requirements than

other leading chip-set designs.

A second peripheral manufacturer, Me

dia (without the Vision) showed what it

called the Sound Commander T last fall

at COMDEX. The portable sound device

was designed to connect with a portable

computer via a shared serial port. It's

compatible with Sound Blaster and will

run on a single nine-volt battery.

end of this price range, you'll have to

shop mail-order companies or direct

sellers. The number of notebooks that

promise the power of desktop comput

ers is mind-boggling. But among

these, a few recognizable names

stand out. ZEOS, for example, offers

several notebook computers that fit our

profile ranging in price from $1,295 (12-

MHz 286) to $1,795 (20-MHz 386SX).

Recent advertisements list the NEC UI-

tralite 286f at $999.

Radio Shack has had the Tandy

1800 HD sale priced at $1,299. This sys

tem matches the basic system profile

for this group and comes with Desk-

Mate and America Online software (an

internal 2400-bps modem is optional at

$199). The 1800 HD is housed in a

smart-looking black case that resists

dirt and scratches.

Further up the price and features lad

der, Wyse Technology recently cut the

price of its DecisionMate Model 30 to

$1,895. This 20-MHz 386SX system

tips the scales at barely 4V2 pounds (in

cluding battery) and offers one of the

most comfortable keyboards on the mar

ket (though the small function keys in

a double row in the upper right corner

take some getting used to).

The DecisionMate exceeds our sys

tem profile with its 30MB hard drive,

soft leather carrying case, copy of Trav

eling Software's Laplink (with cables),

and Battery Watch. Optional equip

ment includes an extended-life battery

(for up to 4'/2 hours of battery power at

an additional two pounds) and snap-

in modules for fax/modem capabilities,

mouse input, and a second serial port

(each module weighs between five

and seven ounces). An external

1.44MB floppy drive is included.

Another 386SX 20-MHz notebook

computer within this price range is the

Acer Acros (available at several con

sumer electronics stores). This system

boasts a fast hard drive and comes bun

dled with MS-DOS 5.0, Windows, and

Spinnaker's PFS WindowWorks.

With the variety of systems available

between $1,000 and $2,000, it's easy

to find portables as powerful and func

tional as the typical desktop machine.

You might not be able to put all of

your applications on a 20MB hard

drive, but you should be able to get

your critical applications loaded. If

your system gets crowded, you can al

ways use a compression program like

Stac Electronics' Stacker to increase

your hard disk space.

Two Thousand to Infinity
If you have plenty of money to spend,

you can get plenty of computer.

Here's the kind of highflier you can

find if the sky's the limit.

In-One for lighl number crunching, 
word processing, and conlact manage­
ment (with the built-in database mod­
ules). If you want a more intuitive envi­
ronment, you could use DeskMate or 
GeoWorks Ensemble. Integrated pack­
ages usually offer file imporVexport ca­
pabilities in standard formats such as 
ASCII, WI< 1, and dBASE. Tandy's Desk­
Mate adds task switching (as does 
DOS 5.0); Ensemble provides multi­
tasking within its own applications, 
even with an XT-class machine. 

Save the money you would have 
spent on a more powerful system to out­
fit your inexpensive laptop with an exter­
nal pocket modem. That will increase 
your productivity by linking you to infor­
mation services and by providing a re­
mote link to your desktop computer. 

For 0 Couple of G's 
This is what you can expect to find for 
between $1,000 and $2,000. 

System Profile: 
• 12-MHz 80286, 16- or 20-MHz 386SX 

processor 
• VGA-compatible backlit LCD display 
• 1 MB of RAM (minimum) 
• High-density 3~inch floppy drive 
• 20MB hard drive (minimum) 
• Internal or external modem 
• DOS 5.0 

Buyer Profiles: 
• Business students 
• Number-crunchers 
• Traveling salespeople 
• Telecommunicators 
• Marketing professionals 

If you find that your computing 
needs are more substantial than those 
described in our first category, you can 
spend a little more for a speedy AT­
class (or better) laptop that will work 
nearly as well as your desktop comput­
er. As prices continue to drop, the 
price differential between the 286- and 
the 386SX-based notebooks becomes 
less and less a factor. 

It's clear that if you need to run mod­
erately powerful character-based appli­
cations while on the road, you'll need 
the power and extra memory that a lap­
top in this price range will give you. If 
your work is in marketing and account­
ing, you'll appreCiate the ability to run 
applications like Lotus 1-2-3 or 
Borland's Quattro Pro. Salespeople 
will want the extra speed and power to 
run contact-management software. 
And every professional who needs to 
communicate with corporate headquar­
ters or with home will appreciate the 
telecommunications capabilities availa­
ble in this price range. 

To find top-end machines at the low 
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The midrange ZEOS notebook computer is 
both practical and popular. 

The Sharp PC-6781 offers monochrome 
graphics al $3,5GG. 

YOU CAN HEAR IT COMING 
last fall at COMDEX, Media Vision-Ihe 
maker of the Pro Audio Spectrum and 
Thunderboard sound cards-was talking 
abou1 a board-level sound device lor lap­
lops and portables that would allow com­
puter users to lake advantage of sound­
enhanced applications while on the 
road. 

This past January, the company an­
nounced what it called Transportable 
Sound Technology for use in battery­
poNered sound peripherals designed for 
laptops. Media Vision uses a proprietary 
audio chip set that takes up less space 
and has lower power requirements than 
other leading chip-set designs. 

A second peripheral manufacturer, Me­
dia (without the Vision) showed what it 
called the Sound Commander T last fall 
at COMDEX. The portable sound device 
was designed to connect with a portable 
computer via a shared serial port. II's 
compatible with Sound Blaster and will 
run on a single nine-volt baUery. 

end of this price range, you'll have to 
shop mail-order companies or direct 
seliers. The number of notebooks that 
promise the power of desktop comput­
ers is mind-boggling. But among 
these , a few recognizable names 
stand out. ZEOS, for example, offers 
several notebock computers that fit our 
profile ranging in price from $1,295 (12-
MHz 286) to $1,795 (20-MHz 386SX). 
Recent advertisements list the NEC UI­
tralite 286f at $999. 

Radio Shack has had the Tandy 
1800 HD sale priced at $1,299. This sys­
tem matches the basic system profile 
for this group and comes with Desk­
Mate and America Online so~ware (an 
internal 2400-bps modem is optional at 
$199). The 1800 HD is housed in a 
smart-looking black case that resists 
dirt and scratches. 

Further up the price and features lad­
der, Wyse Technology recently cut the 
price of its DecisionMate Model 30 to 
$1,895. This 20-MHz 386SX system 
tips the scales at barely 4 Vz pounds (in­
cluding battery) and offers one of the 
most comfortable keyboards on the mar­
ket (though the small function keys in 
a double row in the upper right corner 
take some getting used to). 

The DecisionMate exceeds our sys­
tem profile with its 30MB hard drive, 
so~ leather carrying case, copy of Trav­
eling So~ware's Laplink (with cables), 
and Battery Watch. Optional equip­
ment includes an extended-life battery 
(for up to 4 Vz hours of battery power at 
an additional two pounds) and snap­
in modules for fax/modem capabilities, 
mouse input, and a second serial port 
(each module weighs between five 
and seven ounces) . An external 
1.44MB floppy drive is included. 

Another 386SX 20-MHz notebook 
computer within this price range is the 
Acer Acros (available at several con­
sumer electronics stores). This system 
boasts a fast hard drive and comes bun­
dled with MS-DOS 5.0, Windows, and 
Spinnaker's PFS WindowWorks. 

With the variety of systems available 
between $1,000 and $2,000, it's easy 
to find portables as powerful and func­
tional as the typical desktop machine. 
You might not be able to put all of 
your applications on a 20MB hard 
drive, but you should be able to get 
your critical applications loaded. If 
your system gets crowded, you can al­
ways use a compression program like 
Stac Electronics' Stacker to increase 
your hard disk space. 

Two Thousand to Infinity 
If you have plenty of money to spend, 
you can get plenty of computer. 
Here's the kind of highflier you can 
find if the sky's the limit. 



System Profile:

• 20- or 25-MHz 386SX or 386SL proc

essor

• VGA-compatible backlit LCD display

• 2MB of RAM (minimum)

• High-density 3'/?-inch floppy drive

• 40MB hard drive (minimum)

• Internal or external modem

• DOS 5.0

Buyer Profiles:

• Critical field personnel

• Mobile executives

• Windows users

• Status seekers

Once you get above the $2,000

mark, there are few limits on what a port

able computer can do. Leading-edge

engineering has put 80MB hard

drives, 25-MHz processors, pa

per-white VGA displays, and graphical

interfaces within reach of power-hun

gry professionals. In fact, with the

right components, you could easily con

figure a portable computer to work as

your only computer (adding an exter

nal monitor and keyboard for the of

fice). No longer would you have to trans

fer or copy files or log on to your desk

top machine from a remote site (at long

distance charges). All of your critical ap

plications and files would stay with you

wherever you go.

This kind of price range also brings

into view Intel's top-of-the-line note

book processor, the 386SL, which is de

signed to extend battery life by using

less power than its 386SX counterpart.

Some notebook and laptop computer

makers are using AMD's 386SXL proc

essor (and watch for additional Intel

competition from other chip compa

nies). Either way, a notebook or laptop

in this category can rightfully boast the

speed and power to scream past

many desktop systems.

So what's the latest in this top cate

gory? If you work with sensitive data

and you believe that James Bond mov

ies carry a cachet of adrena

line-charged excitement, the BCC

SL007 from Beaver Computer is your

machine. Its 20-MHz 386SL chip rides

herd on a 32K cache memory and

works In tandem with a DES encryption

processor (optional) to encode and de

code sensitive data on the fly. The

SL007 ships standard with 4MB of

RAM, a 62MB hard drive, VGA graph

ics, send/receive fax/modem, Win

dows, WinFAX, plus other features, all

housed in a soft-touch black casing

that resists scratches. Very cool stuff.

If you're a power user who needs

room to move, consider Advanced Log

ic Research's line of expandable port

ables, the VIP M series. Each VIP M

notebook can move from a 20-MHz

386SX workhorse to a 25-MHz 486DX

screaming demon through a CPU-mod

ule upgrade. If you need something in

between, a 20-MHz 486SX upgrade is

also available.

The advent of color laptops and note

books makes this upper echelon even

more attractive. Sharp and Toshiba—

to name but two companies—offer col-

The Bondweil B310SX offers 386SX

performance for a low price.

GUERRILLA CONNECTIONS

Not every hotel will be kind enough to fur

nish your room with a data-capable

phone—or even modular phone line

jacks. If you find yourself in this situation,

your first option is to call the front desk

and ask that an RJ-11 jack be connect

ed to the existing telephone line- Speak

with authority and make it clear that

you're a modern businessperson who re

quires the latest technology. Many hotels

are willing to do anything within reason to

accommodate their business customers.

If the hotel management won't cooper

ate, cordially inform them that your com

pany won't use their facilities in the fu

ture. Then get to work setting up your

own connection. Rather than ripping the

phone lines from the wall (bad form,

that—and it leaves you liable to pros

ecution), use a kit you can pick up at

most electronic stores. Your kit should

contain one RJ-11 module with four

wires with attached clips, a set of clip

leads, and wire snips.

Cut off all of the leads from the RJ-11

module but the red and green ones (you

can do this ahead of time). Now, if you

take off the telephone receiver mouth

piece, you can remove the voice pickup

just inside. (If the telephone doesn't

have a removable mouthpiece, you're on

your own.) Attach your clip leads (the

ones connected to the green and red

wires) to the prongs that are now visible.

When you want to use your modem,

take the telephone off the hook and dial

through your computer.

or notebooks with fantastic displays

that are even sharper than what you

see on a desktop. These machines top

out at about the price of a Saturn GSL

automobile. Start saving now. Sharp's

active matrix color PC-6881 should be

available by the time you see this.

What You Need
Here are some items you should look

for in your portable computer package.

• Flexible power-saving features for

extending battery life. Such features

might include an automatic "sleep

mode" for disk drives and screen,

the ability to switch to a slower proc

essing speed, the use of nonvolatile

RAM for data storage, and the abil

ity to switch off unused I/O ports.

• Software bundles that add value to

your purchase, like MS-DOS 5.0, Win

dows, an integrated productivity pro

gram like Eight-In-One, or a file-trans

fer program like LapLink.

• A sharp, fast display (VGA compati

ble if you can afford it) with sufficient

backlighting and easy-to-work adjust

ment controls that will allow you to

work in varied lighting conditions.

• A hard drive that tests faster than a

20-millisecond average access

time. If you use a slower drive, you'll

feel that you've sacrificed too much

to get away from your desk.

• A comfortable, well-spaced keyboard

that fits your typing style and resists

double-strikes.

• Well-spaced I/O ports that will accept

a printer, an external monitor, and a

serial device simultaneously.

Microsoft's Portable Initiative
Last winter, Microsoft announced its

Portable Computing Initiative, the first

phase of which is Advanced Power

Management (APM); a ROM version of

MS-DOS 5.0; a data-transfer utility; and

solid-state memory support.

The APM specification was devel

oped jointly by Microsoft and Intel and

is designed to extend the battery life of

portable computers by up to 25 per

cent during full-on conditions. APM

works by allowing the system BIOS

and operating system to share critical

power-management data while preserv

ing compatibility between the hard

ware and software during the power-

conservation process. An APM driver

for MS-DOS 5.0 has shipped, and a

Windows 3.1 driver followed soon after.

APM is also compatible with non-APM

applications. Though APM can be im

plemented on any of the i86-processor

family, Intel built specific APM-support

features into its 386SL chip. These fea

tures allow portable computer makers

to implement APM functions and to

keep APM overhead to a minimum.
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System Profile: 
• 20- or 25-MHz 386SX or 386SL proc-

essor 
• VGA-compatible backlit LCD display 
• 2MB of RAM (minimum) 
• High-density 3V2-inch floppy drive 
• 40MB hard drive (minimum) 
• Internal or external modem 
• DOS 5.0 

Buyer Profiles: 
• Critical field personnel 
• Mobile executives 
• Windows users 
• Status seekers 

Once you get above the $2,000 
mark, there are few limits on what a port­
able computer can do. Leading-edge 
engineering has put 80MB hard 
drives, 25-MHz processors , pa­
per-white VGA displays, and graphical 
interfaces within reach of power-hun­
gry professionals . In fact, with the 
right components, you could easily con­
figure a portable computer to work as 
your only computer (adding an exter­
nal monitor and keyboard for the of­
fice). No longer would you have to trans­
fer or copy files or log on to your desk­
top machine from a remote site (at long­
distance charges). All of your critical ap­
plications and files would stay with you 
wherever you go. 

This kind of price range also brings 
into view Intel's top-of-the-line note­
book processor, the 386SL, which is de­
signed to extend battery life by using 
less power than its 386SX counterpart. 
Some notebook and laptop computer 
makers are using AMD's 3S6SXL proc­
essor (and watch for additional Intel 
competition from other chip compa­
nies). Either way, a notebook or laptop 
in this category can rightfully boast the 
speed and power to scream past 
many desktop systems. 

So what's the latest in this top cate­
gory? If you work with sensitive data 
and you believe that James Bond mov­
ies ca rry a cachet of adrena­
line-charged exci tement, the BCC 
SLOO? from Beaver Computer is your 
machine. Its 20-MHz 386SL chip rides 
herd on a 32K cache memory and 
works in tandem with a DES encryption 
processor (optional) to encode and de­
code sensitive data on the fly. The 
SLOO? ships standard with 4MB of 
RAM, a 62MB hard drive, VGA graph­
ics, send/receive fax/modem , Win­
dows, WinFAX, plus other features, all 
housed in a soft-touch black casing 
that resists scratches. Very cool stuff. 

If you're a power user who needs 
room to move, consider Advanced Log­
ic Research's line of expandable port­
ables, the VIP M series. ·Each VIP M 
notebook can move from a 20-MHz 

386SX workhorse to a 25-MHz 486DX 
screaming demon through a CPU-mod­
ule upgrade. If you need something in 
between, a 20-MHz 486SX upgrade is 
also available. 

The advent of color laptops and note­
books makes this upper echelon even 
more attractive. Sharp and Toshiba­
to name but two companies-offer col-

The Bondwell B310SX offers 386SX 
performance for a fow price. 

GUERRILLA CONNECTIONS 
Not every hotel will be kind enough to fur­
nish your room with a data-capable 
phone-or even modular phone line 
jacks. If you find yourself in this situation, 
your first option is to call the front desk 
and ask that an RJ·l1 jack be connect­
ed to the existing telephone line. Speak 
with authority and make it clear that 
you're a modern businessperson who re­
quires the latest technology. Many hotels 
are willing to do anything within reason to 
accommodate their business customers. 

If the hotel management won't cooper­
ate, cordially inform them that your com­
pany won't use their facilities in the fu­
lure. Then get to work setting up your 
own connection. Rather than ripping the 
phone lines from the wall (bad form, 
that-and it leaves you liable to pros­
ecution), use a kit you can pick up at 
most electronic stores. Your kit should 
contain one RJ-11 module with four 
wires with attached clips, a set of clip 
leads, and wire snips. 

Cut off all of the leads from the RJ-" 
module but the red and green ones (you 
can do this ahead of time). Now, if you 
take off the telephone receiver mouth­
piece, you can remove the voice pickup 
just inside. (11 the te lephone doesn't 
have a removable mouthpiece, you're on 
your own.) Attach your clip leads (the 
ones connected 10 the green and red 
wires) to the prongs that are now visible. 
When you want to use your modem, 
take the telephone off the hook and dial 
through your computer. 

or notebooks with fantastic displays 
that are even sharper than what you 
see on a desktop. These machines top 
out at about the price of a Saturn GSL 
automobile. Start saving now. Sharp's 
active matrix color PC-6SS1 should be 
available by the time you see this. 

What You Need 
Here are some items you should look 
for in your portable computer package. 
• Flexible power-saving features for 

extending battery life. Such features 
might include an automatic "sleep 
mode" for disk drives and screen , 
the ability to switch to a slower proc­
essing speed, the use of nonvolatile 
RAM for data storage, and the abil ­
ity to switch off unused I/O ports. 

• SoKware bundles that add value to 
your purchase, like MS-DOS 5.0, Win­
dows, an integrated productivity pro­
gram like Eight-In-One, or a file-trans­
fer program like LapLink. 

• A sharp, fast display (VGA compati­
ble if you can afford it) with sufficient 
backlighting and easy-to-work adjust­
ment controls that will allow you to 
work in varied lighting conditions. 

• A hard drive that tests faster than a 
20-millisecond average access 
time. If you use a slower drive, you'll 
feel that you've sacrificed too much 
to get away from your desk. 

• A comfortable, well-spaced keyboard 
that fits your typing style and resists 
double-strikes. 

• Well-spaced I/O ports that will accept 
a printer, an external monitor, and a 
serial device simultaneously. 

Microsoft's Portable Initiative 
Last winter, Microsoft announced its 
Portable Computing Initiative, the first 
phase of which is Advanced Power 
Management (APM); a ROM version of 
MS-DOS 5.0; a data-transfer utility; and 
solid-state memory support. 

The APM specification was devel­
oped jointly by Microsoft and Intel and 
is designed to extend the battery life of 
portable computers by up to 25 per­
cent during full-on conditions. APM 
works by allowing the system BIOS 
and operating system to share critical 
power-management data while preserv­
ing compatibility between the hard­
ware and software during the power­
conservation process. An APM driver 
for MS-DOS 5.0 has shipped, and a 
Windows 3.1 driver followed soon after. 
APM is also compatible with non-APM 
applications. Though APM can be im­
plemented on any of the i86-processor 
family, Intel built specific APM-support 
features into its 386SL Chip. These fea­
tures allow portable computer makers 
to implement APM functions and to 
keep APM overhead to a minimum. 
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The data-transfer utility, called In-

terlnk, supports a transfer rate of up to

36K per second via a parallel port. It al

so supports serial transfers. Microsoft's

support of solid-state memory will help

developers port their disk-based DOS

applications to "smart cards" like

Flash Memory and SRAM cards.

Several portable computer makers,

including Toshiba, Everex, Epson, Ze

nith, and NEC, support the Portable

Computing Initiative. Portable comput

ers designed according to the new

specifications should be available on

the market in early 1993.

So What's It Gonna Be?
No matter what kind of computer user

you are—hobbyist, white-collar worker,

student, mobile executive, road warri

or, power user—there's a portable com

puter in your future. The latest laptops

and notebooks compete with desktop

systems in terms of power and speed

and are far better machines in terms of

desktop real estate and portability. But

don't write off older 8088-based, dual-

floppy systems. You can get them

used for a very good price, and even

older portable systems with less proc

essing power still offer a flexible so

lution to the problems of a fluid informa

tion environment. And flexibility is the

best power you can buy. D

PICK ONE UP AND WALK AWAY

For more information about the computer systems mentioned in this article or for informa

tion on other laptop, notebook, and portable computers, contact the companies listed

below.

ACER AMERICA

2641 Orchard Pkwy.

San Jose, CA 95134

(800) 733-2237

ADVANCED LOGIC RESEARCH

9401 Jeronimo

Irvine, CA 92718

(714) 581-6770

AST

16215 Alton Pkwy.

Irvine, CA 92713

(714) 727-4141

BCC

(Beaver Computer)

174 Component Dr.

San Jose, CA 95131

(408) 944-9000

BONDWELL INDUSTRIAL

47485 Seabridge Dr.

Fremont, CA 94538

(510) 490-4300

HYUNDAI ELECTRONICS AMERICA

166Baypointe Pkwy.

San Jose, CA 95134

(800) 727-6972

SHARP ELECTRONICS

Sharp Piaza

Mahwah, NJ 07430

(201)529-8200

STANDARD COMPUTER

12803 Schabarum Ave.

Irwindale, CA 91706

(800)662-6111

TANDY

400 Tandy Center Atrium

Fort Worth, TX 76102

(817)390-3011

TOSHIBA AMERICA

9740 Irvine Blvd.

Irvine, CA 92718

(800) 334-3445

WYSE TECHNOLOGY

3471 N. First St.

San Jose, CA 95134

(408)473-1200

ZEOS INTERNATIONAL

530 Fifth Ave. NW

St. Paul, MN 55112

(800) 423-5891

COMPUTE Has the Official Guides to Sierra Adventures

liiHJiiiialluk ■ THE OFFICIAL BOOK OF

KING'S
QUEST"

The Official Book of

Leisure Suit Larry,

Second Edition
288 pages (2567)

$14.95

The Official Guide

to Roger Wilco's

Space Adventures
272 pages (2370)

$14.95

The Official Book of

King's Quest,

Second Edition
176 pages (2451)

$12.95

To order your copies send the appropriate amount plus $2 shipping and handling per book U.S. ($4 Canada and $6 other) to

COMPUTE Books, c/o CCC, 2500 McCleflan Ave., Pennsauken, NJ 08109. (Residents of NC, NY, and NJ please add appropriate

sales tax; Canadian orders add 7% GST).

All orders must be paid in U.S. funds drawn on a U.S. bank. Orders will be shipped via UPS Ground Service. Offer good while supplies last.

Coming in July ... The Official Book of Police Quest
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The data-transfer util ity, called In­
terlnk, supports a transfer rate of up to 
36K per second via a parallel port. It al­
so supports serial transfers. Microsoft's 
support of solid-slate memory will help 
developers port their disk-based DOS 
applications to "smart cards" like 
Flash Memory and SRAM cards. 

Several portable computer makers, 
including Toshiba, Everex, Epson, Ze­
nith, and NEC, support the Portable 
Computing Initiative. Portable comput­
ers designed accordi ng to the new 
specifications should be available on 
the market in early 1993. 

So What's It Ganna Be? 
No matter what kind of computer user 
you are-hobbyist, white-collar worker, 
student, mobile executive, road warri ­
or, power user-there's a portable com­
puter in your future. The latest laptops 
and notebooks compete with desktop 
systems in terms of power and speed 
and are far better machines in terms of 
desktop real estate and portability. But 
don't write off older 8088-based, dual­
floppy systems. You can get them 
used for a very good price, and even 
older portable systems with less proc­
essing power still offer a flexible so­
lution to the problems of a fluid informa­
tion environment. And flexibil ity is the 
best power you can buy. 0 

PICK ONE UP AND WALK AWAY 
For more information about the computer systems mentioned in this article or for informa­
tion on other laptop, notebook, and portable computers, contact the companies listed 
below. 

ACER AMERICA 
264 1 Orchard Pkv.'Y. 
San Jose, CA 95134 
(800) 733-2237 

ADVANCED LOGIC RESEARCH 
9401 Jeronimo 
Irvine, CA 92718 
(71 4) 581·6770 

AST 
16215 Allon Pkwy. 
Irvine, CA 92713 
(714) 727·4141 

BCC 
(Beaver Computer) 
174 Component Dr. 
San Jose, CA 95131 
(408) 944-9000 

BONDWELL INDUSTRIAL 
47485 Seabridge Dr. 
Fremont , CA 94538 
(510) 490·4300 

HYUNDAI ELECTRONICS AMERICA 
166 Baypointe Pkwy. 
San Jose, CA 95134 
(800) 727·6972 

SHARP ELECTRONICS 
Sharp Plaza 
Mahwah, NJ 07430 
(201) 529·8200 

STANDARD COMPUTER 
12803 Schabarum Ave. 
Irwindale, CA 91706 
(800) 662·6111 

TANDY 
400 Tandy Center Atrium 
Fort Worth, TX 76102 
(817) 390·3011 

TOSHIBA AMERICA 
9740 Irvine Blvd. 
Irvine, CA 927 18 
(800) 334·3445 

WYSE TECHNOLOGY 
347 1 N. First 81. 
San Jose, CA 95134 
(408) 473·1200 

ZEOS INTERNATIONAL 
530 Fifth Ave. NW 
SI. Paul, MN 55112 
(800) 423-5891 

COMPUTE Has the Official Guides to Sierra Adventures 

The Official Book of 
Leisure Suit Larry, 
Second Edition 

288 pages (2567) 

$14.95 

The Official Guide 
to Roger Wilco's 

Space Adventures 
272 pages (2370) 

$14.95 
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The Official Book of 
King's Quest, 

Second Edition 
176 pages (2451) 

$12.95 
To order your copies send the appropriate amount plus $2 shipping and handling per book U.S. ($4 Canada and $6 other) to 

COMPUTE Books, cia CCC, 2500 McClellan Ave., Pennsauken, NJ 08109. (Residents of NC, NY, and NJ please add appropriate 
sales tax; Canadian orders add 7% GSl). 

All orders must be paid in U.S. funds drawn on a U.S. bank. Order.; .. II be shipped via UPS Ground Service. Offer good while supplies last. 
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ADVENTURE INTO

A LIVING UNIVERSE!

TH£ POWr OF intERac

GOMPUMB

Help solve the mystery of the vanishedplanet Earth,

You and your comrades will follow a

path of clues across the adventure-

filled cosmos on a quest to return

the Earth to its own space-time

continuum. Buckle up, lay in your

course and hang on...you've just

crossed over the PLANETS EDGE!

SPACE
combat si

ILLATION'

HOTTEST GR

Learn more about Planet's Edge...

Available at your local retailer or direct from New World at

1-800-325-8898 (U.S. and Canada) or at 1-818-999-0607.

@ copyright 1991 Planet's Edge is a trademark of New World Computing. Inc.

New World Computing is a trademark of New World Computing, Inc.

IBM screens shown, aclual screens may vary. Circle Reader Service Number 153

WMPUMG
P.O. Box 4302, Hollywood. CA. 90078



PRODUCTIVITY CHOICE

This integrated package may be ail

the software you need to be productive in

your home office or small business.

Peter Scisco

MICROSOFT
WORKS FOR
WINDOWS

You might never get your

hands on a free lunch, but

your business can still feast

on Microsoft Works. Of all the

integrated software packages

available for IBM and compat

ible computers, Works is supe

rior in its blend of critical

home office and small busi

ness applications. Easy to

learn, it boasts a consistent

interface and is affordable.

The word processor, data

base, spreadsheet, and tele

communications modules of

fer solid if not breathtaking

performance. If you're run

ning a home office or a small

business, Works might be the

only software you need.

Several subtle changes

make the Windows version of

Works different from the DOS

version. For example, there's

no telecommunications mod

ule because you can use Win

dows' Terminal. This illustrates

the major advantage of the Win

dows version: instant access

to the Windows accessories.

Differences are immediate

ly apparent when you launch

Works from the Program Man

ager. The opening screen of

fers a selection of five but

tons: Word Processor, Spread

sheet, Database, WorksWiz-

ards, and Open Existing File.

A single click on one of these

buttons propels you to almost

instant productivity.

Each application module

shares common functions with

the others. For example, no mat

ter which of the applications

you're using, you can always

open an existing file, regard

less of the native format. If

you're writing a letter, you

can open

a spreadsheet- If your spread

sheet and word processor are

open, you can open a data

base. Each module is fully op

erational within its application

and within its own window. Win

dows can be cascaded or

tiled for easy task switching

and viewing, and cutting and

pasting between the applica

tions is a snap.

Veteran Works users who've

recently moved to Windows

will be surprised to find that

the DOS command structure

works side by side with the

Windows commands. For exam

ple, you can cut a block of

text using keyboard com

mands from Windows (Shift-

Delete) or DOS (Ctrl-X). This

may confuse some Windows

users, as the Edit menu lists on

ly the DOS commands.

Each application has a row

of icons across the top of its

window, a familiar sight to vet

eran Windows users. These

buttons put the most common

editing tasks right at your fin

gertips and are easily related

to the functions they perform.

Generally, the icon buttons

from the upper left to the cen

ter of the screen govern com

mon functions such as font

selection, type size, typefac

es, and alignment. A group of

buttons to the right of center

features functions specific to

each application.

In the database, for example,

this group switches between

list and form view, launches a

query, and creates a report.

This general overview of

Works hints at the program's

greatest strength—its interac

tive sharing of information

and data between applica

tions. This sort of sharing is

general to all well-designed

Windows applications, but

not all software developers ex

ploit the benefits of DDE and

DLL. In Works, however, the

solid interactive design

doesn't come at the expense

of any particular application.

The Works word processor

is much more robust than Win

dows Write. It will import Write

files and documents produced

in WordPerfect (5.0 and 5.1)

and Word for Windows (1.x) as

well as those saved in ASCII,

RTF, or dBASE formats. This

translation capability makes it

well suited for use as an extend

ed-office application. When

you take work home, you won't

have to spend hundreds of dol

lars buying the high-powered

applications you use at the of-
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PRODUCTIVITY CHOICE 
This integrated package may be all 
the software you need to be productive in 
your home office or small business. 

Peter Scisco 

MICROSOFT 
WORKS FOR 
WINDOWS 
You might never get your 
hands on a free lunch, but 
your business can still feast 
on Microsoft Works. Of all the 
integrated software packages 
available for IBM and compat­
ible computers, Wbrks is supe­
rior in its blend of critical 
home office and small busi­
ness applications. Easy to 
learn, it boasts a consistent 
interface and is affo rdable. 
The wo rd processor, data­
base, spreadsheet, and tele­
communications modules of­
fer solid if not breathtaking 
performance. If you 're run­
ning a home office or a small 
business, Works might be the 
only software you need. 

Several subtle changes 
make the Windows version of 
Wbrks different from the DOS 
version. For example, there's 
no telecommunications mod­
ule because you can use Win­
dows' Terminal. This illustrates 
the major advantage of the Win­
dows version: instant access 
to the Windows accessories. 

Differences are immediate­
ly apparent when you launch 
Works from the Program Man­
ager. The opening screen of­
fers a selection of five but­
tons: Wbrd Processor, Spread­
sheet, Database, Wo rksWiz­
ards, and Open Existing File. 
A single click on one of these 
buttons propels you to almost 
instant productivity. 

Each application module 
shares common functions with 
the others. For example, no mat­
ter which of the applications 
you're using, you can always 
open an existing file, regard­
less of the native format. If 
you 're writ ing a letter, you 

can open 
a spreadsheet. If your spread­
sheet and word processor are 
open, you can open a data­
base. Each module is fully op­
erational within its application 
and within its own window. Win­
dows can be cascaded or 
tiled for easy task switching 
and viewing, and cutting and 
pasting between the applica­
tions is a snap. 

Veteran Wbrks users who've 
recently moved to Windows 
will be surprised to find that 
the DOS command structure 
works side by side with the 
Windows commands. For exam­
ple, you can cut a block of 
text using keyboard com­
mands from Windows (Shift­
Delete) or DOS (Ctrl-X). This 
may confuse some Windows 
users, as the Edit menu lists on­
ly the DOS commands. 

Each application has a row 
of icons across the top of its 
window, a familiar sight to vet­
eran Windows users. These 
buttons put the most common 
editing tasks right at your fin­
gertips and are easity related 
to the functions they perform. 
Generally, the icon buttons 
from the upper left to the cen­
ter of the screen govern com­
mon functions such as font 
selection , type size, typefac­
es, and atignment. A group of 
buttons to the right of center 
features functions specific to 

each application. 
In the database, for example, 
this group switches between 
list and form view, launches a 
query, and creates a report. 

This general overview of 
Works hints at the program's 
greatest strength-its interac­
tive sharing of information 
and data between applica­
tions. This sort of sha ring is 
generat to all well-designed 
Windows applications, but 
not all software developers ex­
ploit the benefits of DOE and 
Dll. In Works , however, the 
sol id interactive design 
doesn't come at the expense 
of any particutar application. 

The Wbrks word processor 
is much more robust than Win­
dows Write. It will import Write 
files and documents produced 
in WordPerfect (5.0 and 5.1) 
and Wbrd for Windows (1 .x) as 
well as those saved in ASCII, 
RTF, or dBASE formats. This 
transtation capability makes it 
well suited for use as an extend­
ed-office application . When 
you take work home, you won't 
have to spend hundreds of dol­
tars buying the high-powered 
applications you use at the of-



fice; just save your files to disk

in the right format and import

them into Works for editing.

You won't confuse Works'

word processor with high-end

programs like Ami Pro, but

any small business worker

will be able to create smart-

looking documents right

away. Want to include a

sketch? Open up the integrat

ed Draw program, create a

picture, and place it in your

document. Want to create a

form letter? Select the data

base fields you want from any

available Works database

file, create objects in any of

the other applications, and

then paste them into your doc

ument. Commands and tasks

are especially intuitive.

The word processor also

has a Note-It function that you

can use to place a prede

signed icon in your text, accom

panied by captions. Place the

icon and the associated text

note in your document. Then,

when you double-click on the

icon, the note is displayed.

Unfortunately, Note-It is severe

ly underdocumented and is

available only in the word proc

essor. You can append a note

to a spreadsheet or database

file, however, by bringing

those files into the word proc

essor and then appending a

note near the placed object.

Weaker than the word proc

essor, Works' spreadsheet is

good enough for most small

business tasks and for home

budgeting. As in Excel, an "in

stant sum" key allows you to

add columns or rows of num

bers quickly without having to

enter a formula. If the range

of cells you want isn't select

ed, you can modify the selec

tion with your mouse.

You can use buttons for set

ting cell-number attributes

such as currency, percent

age, or general. Chart making

is also easy.

Microsoft has succeeded

in keeping the Works spread

sheet from stealing away po

tential Excel customers. But

the company omits functions

that would've made this a

stronger home office applica

tion. For example, the spread

sheet won't import Excel files

directly. You have to save

your Excel worksheet as a

WKS file or as a Lotus-compat

ible WK1 file and then open it

as a spreadsheet in Works.

The spreadsheet is also

light on text formatting. If, for

instance, you try to change

the point size of the text with

in a ceil, the change is made

to the entire spreadsheet.

Again, you can paste the work

sheet into the word processor

to make these changes.

Works' free-form, flat-file da

tabase is its strongest element.

The database plays host to

WorksWizards, predesigned in

teractive "macrotemplates"

that guide users through vari

ous database functions and re

ports, such as creating mailing

labels, address books, and

form letters. In this version of

Works, the Wizards are linked

closely to the database func

tions. Wizards are different

from standard templates (also

provided) in that they prompt

you for information and then cre

ate the document that match

es your input—the program

compiles the forms and im

ports the necessary data.

If you have a computerized

contact list (an address book,

for example) at work, you can

export it as a text file and then

import it into the Works data

base. Works will also directly im

port and export dBASE III and

IV files, retaining field names

during translation.

Anyone using Works as a
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small business application

will be able to produce re

ports for inventory, accounts

receivable, and sales track

ing. Works' database reports

can also be copied to the oth

er modules; database fields

are separated by tabs when

you send them to the word

processor and by rows and

columns in the spreadsheet.

This kind of ease and au

tomation prompts Microsoft to

put the slogan "Software for

people" on the Works for Win

dows box. Along with many

other companies, Microsoft re

alizes that exploiting the pow

er of the PC means making

that power readily accessible.

Combine Works with Win

dows, and you have just

about all of the productivity

software you'll ever need. D

Circle Reader Service Number 303

IBM PC and

compatibles

(80286 or faster);

640K RAM, 256K

configured as

extended memory

(1MB recommended);

EGA. VGA, 85H/A.

or Hercules; one

floppy drive and

one hard drive;

Microsoft or

compatible

mouse—$199;

multimedia PC

version—$199

MICROSOFT

One Microsoft Way

Redmond, WA

98052-6399

(800) 426-9400
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fice; just save your files to disk 
in the right format and import 
them into Works for editing. 

You won'l confuse Works ' 
word processor with high-end 
programs like Ami Pro , but 
any smal l business worker 
will be able to create smart­
looking documents right 
away. Want to include a 
sketch? Open up the integrat­
ed Draw program , create a 
picture, and place it in your 
document. Want to create a 
form letter? Select the data­
base fields you want from any 
available Works database 
file, create objects in any of 
the other appl ications , and 
then paste them into your doc­
ument. Commands and tasks 
are especially intuitive. 

The word processor also 
has a Note-It function that you 
can use to place a prede­
signed icon in your text, accom­
panied by captions. Place the 
icon and the associated text 
note in your document. Then, 
when you double-click on the 
icon , the note is displayed. 
Unfortunately, Note-It is severe­
ly underdocumented and is 
available only in Ihe word proc­
essor. You can append a note 
to a spreadsheet or database 
file, however, by bringing 
those files into the word proc­
essor and Ihen appending a 
note near the placed object. 

Weaker than the word proc­
essor, Works ' spreadsheet is 
good enough for most small 
business tasks and for home 
budgeting. As in Excel, an "in­
stant sum" key allows you to 
add columns or rows of num­
bers quickly without having 10 
enter a formula. If the range 
of cells you want isn't select­
ed, you can modify the selec­
tion with your mouse. 

You can use buttons for set­
ting cell -number attributes 
such as currency, percent-

age, or general. Chart making 
is also easy. 

Microsoft has succeeded 
in keeping the Works spread­
sheet from stealing away po­
tential Excel customers. But 
the company omits functions 
that would 've made this a 
stronger home office applica­
tion. For example, the spread­
sheet won't import Excel files 
direct ly. You have to save 
your Excel worksheet as a 
WKS file or as a Lotus-compat­
ible WKl file and then open it 
as a spreadsheet in Works. 

The spreadsheet is also 
light on text formatting. If, for 
instance, you try to change 
the point size of the text with­
in a cell , the change is made 
to the entire spreadsheet. 
Again, you can paste the work­
sheet into the word processor 
to make these changes. 

Works' free-form, flat-fi le da­
tabase is its slrongest element. 
The database plays host 10 
WorksWizards, predesigned in­
teractive "macrotemplates" 
that guide users through vari­
ous database functions and re­
ports, such as creating mailing 
labels , address books, and 
form letters. In this version of 
Works, the Wizards are linked 
closely to the database func­
tions. Wizards are different 
from standard templates (also 
provided) in that they prompt 
you for information and then cre­
ate the document that match­
es your input-the program 
compiles the forms and im­
ports the necessary data. 

If you have a computerized 
contact list (an address book, 
for example) at work, you can 
export it as a text file and then 
import it in to the Works data­
base. Works will also directly im­
port and export dBASE III and 
IV files, retaining field names 
during translation. 

Anyone using Works as a 
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.small business application 
will be able to produce re­
ports for inventory, accounts 
receivable, and sales track­
ing. Works' database reports 
can also be copied to the oth­
er modules; database fields 
are separated by tabs when 
you send them to the wo rd 
processor and by rows and 
columns in the spreadsheet. 

This kind of ease and au­
tomation prompts Microsoh to 
put the slogan "Software for 
people" on the Works for Win­
dows box. Along with many 
other companies, Microsoft re­
alizes that exploiting the pow­
er of the PC means making 
that power readily accessible. 
Combine Works with Win­
dows, and you have just 
about all of the productivity 
software you'll ever need. 0 
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If you're like many technophiles, your house is wired for

sound, with a stereo in the living room feeding speakers in

rooms far away. Your television down in the den is connect

ed to cable, a VCR, and another set of speakers to crank

out "The Simpsons," "Dinosaurs," and "Northern Exposure"

in stereo. Your house is threaded with phone lines; you

have extensions in every room, a second line for the kids,

and maybe a third in your home office. Your fax machine is

linked to your phone, phone to modem, modem to PC.

But your computers, crucial to your lifestyle and home of

fice, suffer in isolation. They're islands, entire of themselves,

with no way to connect other than low-tech sneakernet,

where you wear out shoe leather shuffling disks from one ma

chine to another.

A computer network for the home office can serve the

same purpose as one in the corporate office: It links PCs for

easy file transfer and communication, and makes it possi

ble to share a printer among several systems. Your home

computer network can save you time—and money, too—

just as a downtown business's computer connections

make it a more productive workplace.

And though the word network may conjure up images of

cables snaking underfoot, it can be no more difficult to cre

ate, install, and run a home office net than it is to connect

a printer, plug in a cable, or dial the phone.

Full Service or a la Carte?
Office-bound networks serve four basic functions.

• Sharing files between or among computers

• Printing to a central printer from any machine

• Running applications from a central system

• Passing along electronic mail

The first three make sense in a home network, but the

last, E-mail, may seem ridiculous unless your office is

spread throughout a very large house. But E-mail makes

sense if there are more than two employees in your office,

whether it's located in a house or an office building. It allows

for paperless memos, messages for coworkers who are

away temporarily, and an alternate route for the friendly give-

and-take that makes an office cohesive and fun.

Depending on how much money and effort you want to
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put into your home computer network, you can go for full serv

ice—file sharing, printer sharing, and software pooling—or

simply share files and perhaps a peripheral or two.

LAN software and hardware packages are popping up eve

rywhere—from computer store shelves to back pages of com

puter magazines. There are also numerous non-LAN prod

ucts that can perform basic LAN tasks like file transfer. File-

transfer utility programs like LapLink Pro and modem-orient

ed products like ProComm can handle the simplest needs.

From this modest beginning, you can work your way

from a two-node, "peer-to-peer" (which means that no one

computer is dedicated to operating the network) LAN all the

way to fuil-scafe multinode networks traversing thousands of

miles. To find the right LAN for you, first evaluate the equip

ment you want to tie together. Where is that equipment locat

ed? What do you want to do with it? And how much equip

ment will you add to it later?

Most small LANs operate on the Ethernet standard. The

Ethernet standard is analogous to the Hayes standard

used for modems. Other standards include ARCnet and

IBM'sToken Ring. A good LAN works in the background un

noticed by the computer user. Typical LANs require each

node—each individual computer system tied into the net

work—to have an Ethernet-compatible or other standard net

work adapter card.

Most LAN starter kits come with two Ethernet-compatible

cards, thereby providing a simple two-node LAN. Peripheral

equipment (printers, modems, plotters, scanners, CD-ROM

drives, fax boards, and so forth) generally don't require indi

vidual nodes but are linked through a computer on the LAN

instead. Most LANs can share printers and CD-ROM

drives. Modems, plotters, and/or scanners are handled by

only a few.

At a minimum, the average LAN offers file transfer, periph

eral and software applications sharing, and electronic mail.

Most include security features.

There are two basic LAN configurations: peer-to-peer and

client-server. In a peer-to-peer network any machine can ac

cess applications and files on any other machine on the net

work. A client-server network is a hierarchical structure in

which a client machine accesses another machine called a
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simply share files and perhaps a peripheral or two. 
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IBM'sToken Ring. A good LAN works in the background un­
noticed by the computer user. Typical LANs require each 
node--each individual computer system tied into the net­
work- to have an Ethernet-compatible or other standard net­
work adapter card . 

Most LAN starter kits come with two Ethernet-compatible 
cards, thereby providing a simple two-node LAN. Peripheral 
equipment (printers, modems, plotters, scanners, CD-ROM 
drives, fax boards, and so forth) generally don't require indi­
vidual nodes but are linked through a computer on the LAN 
instead . Most LANs can share printers and CD-ROM 
drives. Modems, plotters, and/or scanners are handled by 
only a few. 

At a minimum, the average LAN offers file transfer, periph­
eral and software applications sharing , and electronic mail. 
Most include security features . 

There are two basic LAN configurations: peer-to· peer and 
client·seN er. In a peeHo·peer network any machine can ac­
cess applications and fi les on any other machine on the net­
work. A client-server network is a hierarchical structure in 
which a client machine accesses another machine called a 



server. The client uses applications from and stores files on

the server's hard disk. A client is also sometimes called a

redirector or a workstation. Some LANs (PromiseLAN in

particular) can have peer-to-peer units, client units, and a

server unit on the same network. The best LANs for person

al productivity are peer-to-peer, unless you have a spare

386 lying around that you can use as the network server.

When you're shopping for a LAN, variables to compare

include maximum number of nodes, total RAM required,

unique features, system requirements, additional purchases

required, and price. See the accompanying grid ("LAN Al

ternatives") for information on low-cost LANs.

Number of the Network
The simplest and least expensive network is one that

simply moves files from one computer to another via exist

ing phone lines.

One file-transfer network takes advantage of your local

phone company and LapLink Pro, a state-of-the-art file-

transfer package for the PC. It may not be a network per se,

but in a two-computer, two-phone line household, the com

bination gets you the same results.

LapLink Pro makes it easy to transfer files over a serial ca

ble, but Traveling Software, the manufacturer, also sells con

nectors that allow you to string simple four-connector

phone line between serial ports. A company spokesman

said that he had successfully sent messages over 150 feet

of serial cable, but if you are using unshielded phone line

or live in an area with lots of radio emissions (from comput

ers, CBs, and even garage door openers), you will need to

keep the distances shorter than this or risk data corruption.

LapLink Pro's batch file transfer, clear progress gauges,

and split screen—familiar to users of the earlier laptop-to-

desktop LapLink software—make it a snap to use. Of

course, with the program running, the source PC can't be

used for anything else, but if your network needs are limited

to moving files, it's a workable, bargain-basement remedy.

Mixing Metaphors
If you're connecting Macintoshes and PCs at home, you're

only able to share files and printers. Since Macintoshes and

ARTICLE BY GREGG KEIZER

Save time and energy.
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applications, talk to each other.
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PCs use different microprocessors and

different operating systems, you can't

run Mac applications on the PC.

Apple's own LocalTalk network,

with capabilities built into the most re

cent Macintosh operating system soft

ware, System 7.0, lets you link to PCs.

Like the LapLink Pro connection, the

simplest Mac-to-DOS LocalTalk net

work relies on the standard telephone

lines in your house or office.

You'll need a PhoneNet Card PC

from Farallon for your PC, one of the

company's PhoneNet connectors for

the Macintosh, and a phone outlet

near each computer. Farallon's Phone

Net is completely compatible with Ap

ple's own LocalTalk, but it sends the

bits and bytes across the two unused

wires found in most home phone lines

(if your phone line doesn't have them,

you can install separate phone wire

and jacks yourself or have a phone-

company installer do it). By relying on

existing cabling, PhoneNet can save

you a considerable amount of money,

particularly if your computers are at

some distance from one another.

The PhoneNet Card PC only works

with PCs that operate at 25 MHz or slow

er, but for those computers, it's a terri

fic way to share files with Macs or to

use a laser printer with two different sys

tems. In effect, the PhoneNet Card PC

and its accompanying software turn

the PC into just another workstation on

the LocalTalk network. You can share

files and transfer them from Mac to PC,

PC to PC, or PC to Mac, as well as

print to a PostScript printer connected

to the net.

If your PCs are using DOS 5.0, you

can move all but 2K of the 134K re-

WHY NETWORK?

The hardest par! about installing a

home computer network might be con

vincing yourself (or your family) that it

makes sense. It does in many situations,

and here's what you can do if you invest

your system-improvement dollars in a

net:

• Store everything on a 386 or 486

equipped with a large hard drive; then

run applications and call files over ihe net

work to cut costs and centralize backup.

• Make any employees of your home-

based business as productive as you

are on the PC.

• Justify more easily the cost of a print

er, since it can be used with several

computers.

• Mix Macs and PCs in the same

house, and still keep them talking.

• Let your kids run programs from

their own PCs—games, educational ti

tles, applications for homework—without

worrying about keeping track of disks.

quired for the PhoneNet memory-resi

dent software into high memory, out of

the way of your applications.

Of ail the true network alternatives,

PhoneNet is the quickest way to get

your Macintoshes and PCs talking.

Dollar Net
You might think full-fledged networks

are prohibitively expensive. If your im

age is of tens of computers, yards of ca

ble, and pricey network software, then

you're probably right. In a home office,

though, you can get by inexpensively,

even if you need a full-blown network

that's capable of moving files, sharing

printers, and running applications

from a central system.

MOSES Computers' PromiseLAN is

a good example. For $199 (about a

third less if you buy it by mail), you get

a starter kit that links two PCs in a full-

service network. Included in the kit are

the necessary network adapters, soft

ware, and telephone cabling.

PromiseLAN is a real network, in

that you can transfer files between com

puters and run applications from one

PC's hard drive on another machine.

You do get what you pay for, though.

PromiseLAN can only connect as

many as five computers, and it trans

mits data at a slow 1.79 megabits per

second (Mbps). while most office net

works move data at the Ethernet stan

dard of 10 Mbps. But in many home of

fices, where convenience and low cost

are as important as a long features

list, neither limitation matters.

Do you want to stretch your cash

even farther? Then The $25 Network

may be just the thing. This software

and cable package reaily costs only

$25, and it connects as many as five

systems with phone wire jacked into a

serial port in each machine. Transmis

sion speed is even slower than Promise-

LAN's—only 115 kilobits per second

(Kbps)—but certainly acceptable for

printing and file copying (a 150K file

moves from PC to PC in just over ten

seconds, for instance). The $25 Net

work lets you run programs on any of

the networked PCs, but unless the pro

grams are fairly small, the data-transfer

speed makes this impractical.

Much faster and more complete in

its features than either PromiseLAN or

The $25 Network, LANtastic is a net

work that's inexpensive enough for the

home office. Buy the LANtastic AE-2

Although setting up a home network might

be an enjoyable project, particularly for

someone who enjoys setting up stereos

and stringing cable, there are many other

practical ways to coordinate the use of a

small number of personal computers,

most of which are less expensive than in

stalling a network.

• Newer Macintoshes can read and

write 3V2-inch PC disks, so you can run a

small office with Macs and PCs on sneak-

ernet: Simply shuttle files back and forth on

floppies, using the Mac as the translator.

(Older Macs can be upgraded to read and

write PC disks.)

• Removable hard disks allow you to use

sneakernet with huge files and whole

suites of applications. If you don't want to

spend that much, tape drives are becom

ing remarkably inexpensive and are very

compact, allowing you to move multimeg-

abytes from machine to machine for

around $250 plus the $30 cost of a tape car

tridge. The downside of networking with

WHY NOT?

sneakertape is that tape devices have a rel

atively slow data-transfer rate. They were de

signed for backing up document files, not

moving applications around. Bernoulli

drives would be another portable mass-

storage option.

• Many programs have severe restric

tions on network use. A true network won't

let more than one machine have read-

write access to a given document at one

time (because one user could save the file

and then another could save a different ver

sion of the same file, destroying the work

of the first person). But many applications

also have restrictions on their use when in

stalled on a network. Check your applica

tion manual under the section on network

use. More than likely, it will tell you that on

ly one person can use the application at a

time. You'll often find that software can't be

used on a network unless you purchase a

special version or a special utility that

makes it network compatible. This kind of

software often makes a statement in the us

er's agreement that using it on a network

without a site license is illegal— and site li

censes can be very expensive.

• Because of the costs involved, a full-

featured network doesn't begin to pay for

itself in dollars or in convenience unless

you have four or five nodes operating. The

lesson here is that starting a two- or three-

node network using most network options

makes sense if you have plans to expand

in the near future, but it would be prohibi

tively expensive if that's as far as you in

tend to go.

• For printer sharing, a simple A/B

switch box will serve as well as a network

and cost far less. Even sneakernet works

pretty well for printer sharing. For print

jobs that will generate printer tiles smaller

than the capacity of a floppy disk, I direct

the printer output to disk, transfer the disk

to the computer connected to the printer,

and use the command COPY A:PRINT.FIL

PRN to send the file to the printer.

—ROBERT BIXBY
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tion manual under the section on network 
use. More than likely, it will tell you that on­
ly one person can use the application at a 
lime. You'll often find that software can't be 
used on a network unless you purchase a 
special version or a special utility that 
makes it network compatible. This kind of 
software often makes a statement in the us-

MOSES Computers ' Promise LAN is 
a good example. For $199 (about a 
third less if you buy it by mail), you get 
a starter kit that tinks two PCs in a fult­
service network. Included in the kit are 
the necessary network adapters, soft­
ware, and telephone cabl ing. 

Promise LAN is a real network, in 
that you can transfer fites between com­
puters and fun applications from one 
PC's hard drive on another machine. 
You do get what you pay for, though . 
Prom ise LAN can only connect as 
many as five computers, and it trans­
mits data at a slow 1.79 megabits per 
second (Mbps), while most office net­
works move data at the Ethernet stan­
dard of 10 Mbps. But in many home of­
fices, where convenience and low cost 
are as important as a long featu res 
list, neither limitation matters. 

Do you want to stretch your cash 
even farther? Then The $25 Network 
may be just the th ing. This softwa re 
and cable package realty costs onty 
$25, and it connects as many as five 
systems with phone wire jacked into a 
serial port in each machine. Transmis­
sion speed is even slower than Promise­
LAN 's- onty 115 kilobits per second 
(Kbps)- but certainly acceptabte for 
print ing and fi le copying (a 150K file 
moves from PC to PC in just over ten 
seconds, for instance). The $25 Net­
work lets you run programs on any of 
the networked PCs, but untess the pro­
grams are fairly smatl, the data-transfer 
speed makes this impractical. 

Much faster and more complete in 
its features than either PromiseLAN or 
The $25 Network, LANtastic is a net­
work that 's inexpensive enough for the 
home office. Buy the LANtastic AE-2 

er's agreement that using it on a network 
without a site license is illegal- and site li­
censes can be very expensive. 

• Because of the costs involved, a full­
featured network doesn't begin to pay for 
itself in dollars or in convenience unless 
you have lour or five nodes operating. The 
lesson here is that starting a two- or three­
node network using most network options 
makes sense if you have plans to expand 
in the near luture, but it would be prOhibi­
tively expensive if that's as far as you in­
tend to go. 

• For printer sharing, a simple AlB 
switch box will serve as well as a network 
and cost far less. Even sneakernet works 
pretty well for printer sharing. For print 
jobs that will generate printer liles smaller 
than the capacity of a floppy disk, I direct 
the printer output to disk, transfer the disk 
to the computer connected to the printer, 
and use the command COPY A:PRINIFIL 
PRN to send the file to the printer. 

-ROBERT BIXBY 



Ethernet Starter Kit for $699 (less by

mail), and you get two AE-2 Ethernet

adapter cards, a 25-foot length of co

axial cable, and the software to con

nect as many as 300 workstations.

Expandability is less important than

the fact that the network runs at a full

10 Mbps, you get built-in electronic

mail (in case you have an assistant),

and you have access to all disk and

printer resources on the network. This

is called a peer-to-peer network—all

the networked PCs act simultaneously

as both servers and workstations.

The result is a lightning-fast network

that can take advantage of a large

hard disk on one system and a laser

printer connected to another.

Through the Ether
But what if you don't want to drill holes

through walls or floors, or even go to

the trouble of laying cable? Though it

may seem like science fiction, you can

connect computers in the home office

with a wireless network that sends its

signals via radio waves.

The LAWN (Local Area Wireless Net

work) boxes from O'Neill Communica

tions cost $398 each (the printer node

needs a special adapter, so it costs

$489); connect to the serial port of

each PC and printer on the network;

and though not extraordinarily fast

(19.2 Kbps), offer file transfer, E-mail,

and printer sharing.

If you have computers scattered

around the house, LAWN dramatically

cuts the network-setup time. It easily

transmits data through waifs, even

floors. It's rated as an FCC Class B de

vice, which means that it won't interfere

with other computers, televisions, or

high-fidelity equipment in the house.

LAWN is expensive to install—a two-

computer-one-printer network runs near

ly $1,300—but if you'd rather compute

than lay cable, it's an excellent alterna

tive for a 1990s home office.

Tomorrow's Home Office Today
You may think that a home office net

work is a frivolous expense when

you've got a business to run and mon

ey to make. But put a network pur

chase into the same context as any oth

er office upgrade, like a hard disk or a

CD-ROM drive, and you may discover

that the money (and perhaps time)

spent will be worthwhile.

If you work by yourself in a one-com

puter office, a network is obviously un

necessary. But if your home sports

more than one computer (whether

they are used for business or not), a net

work can pay for itself.

Home-based businesses with more

than one PC and more than one work

er benefit most from a network. If you

hire help, even for such clerical con

cerns as correspondence or filing, link

another PC to your primary machine,

and you can improve your employees'

productivity and your own. In fact, the

more computers and workers you

have to coordinate, the greater your net

work payoff will be. Therefore, any

small business with five or more employ

ees, all using computers, should seri

ously consider the network alternative.

Next in line is the single-system of

fice that shares the house with anoth

er PC, perhaps one used by your

spouse or children. With a peer-to-

peer network like PromiseLAN, it's eas

ier to justify the cost of a large hard

drive or a laser printer because the

end cost is distributed over several us

ers and machines. Your kids can keep

their applications and files on your

PC's drive, even use your laser printer,

if you have a network.

A home computer network may

sound like an exotic beast, but it can

be an inexpensive way to multiply the

capabilities of all the machines—and

computer users—under your roof.

COMPUTE intern Autumn Miller contrib

uted to this article and created the

chart on the following pages. 0
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Ethernet Starter Kit for $699 (less by 
mail), and you get two AE-2 Ethernet 
adapter cards, a 25-foot length of co­
axial cable, and the software to con­
nect as many as 300 workstations. 

Expandability is less important than 
the fact that the network runs at a full 
10 Mbps, you get built-in electronic 
mail (in case you have an assistant), 
and you have access to all disk and 
printer resources on the network. This 
is called a peer-to-peer network-all 
the networked PCs act simultaneously 
as both servers and workstations. 

The result is a lightning-fast network 
that can take advantage of a large 
hard disk on one system and a laser 
printer connected to another. 

Through the Ether 
But what if you don't want to drill holes 
through walls or floors, or even go to 
the trouble of laying cable? Though it 
may seem like science fiction, you can 
connect computers in the home office 
with a wireless network that sends its 
signals via radio waves. 

The LAWN (Local Area Wireless Net­
work) boxes from O'Neill Communica­
tions cost $398 each (the printer node 
needs a special adapter, so it costs 
$489); connect to the serial port of 
each PC and printer on the network; 
and though not extraordinarily fast 

(19.2 Kbps), offer file transfer, E-mail , 
and printer sharing. 

If you have computers scattered 
around the house, LAWN dramatically 
cuts the network-setup time . It easily 
transmits data through walls , even 
floors. It 's rated as an FCC Class B de­
vice, which means that it won't interfere 
with other computers , televisions, or 
high-fidelity equipment in the house. 

LAWN is expensive to install-a two­
computer-one-printer network runs near­
ly $1 ,300-but if you'd rather compute 
than lay cable, it's an excellent alterna­
tive for a 1990s home office. 

Tomorrow's Home Offile Todoy 
You may think that a home office net­
work is a frivolous expense when 
you've got a business to run and mon­
ey to make. But put a network pur­
chase into the same context as any oth­
er office upgrade, like a hard disk or a 
CO-ROM drive, and you may discover 
that the money (and perhaps time) 
spent will be worthwhile. 

If you work by yourself in a one-com­
puter office, a network is obviously un­
necessary. But if your home sports 
more than one computer (whether 
they are used for business or not), a net­
work can pay for itself. 

Home-based businesses with more 
than one PC and more than one work-

er benefit most from a network. If you 
hire help, even for such clerical con­
cerns as correspondence or filing, link 
another PC to your primary machine, 
and you can improve your employees' 
productivity and your own. In fact, the 
more computers and workers you 
have to coordinate, the greater your net­
work payoff will be . Therefore, any 
small business with five or more employ­
ees, all using computers, should seri­
ously consider the network alternative. 

Next in line is the single-system of­
fice that shares the house with anoth­
er PC , perhaps one used by you r 
spouse or children. With a peer-to­
peer network like PromiseLAN, it's eas­
ier to justify the cost of a large hard 
drive or a laser printer because the 
end cost is distributed over several us­
ers and machines. Your kids can keep 
their applications and files on your 
PC's drive, even use your laser printer, 
if you have a network. 

A home computer network may 
sound like an exotic beast, but it can 
be an inexpensive way to multiply the 
capabilities of all the machines-and 
computer users-under your roof. 

COMPUTE intern Autumn Miller contrib­
uted to this article and created the 
chart on the following pages. 0 
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LAN

LANtastic

Artisoft

691 E. River Rd.

Tucson, AZ 857Q4

(800) 846-9726

(602) 293-6363

PhoneNET Card PC/LocalTalk

Farallon Computing

2000 Powell St., Ste. 600

Emeryville, CA 94608

(510) 596-9000

The S25 Network

Information Modes

P.O. Drawer F

Denton, TX 76202

(800) 628-7992

(817)898-1294

MAXLAN

MAXLAN

11083 Wilkinson Ave.

Cupertino, CA 95014

(800) 234-1688

(408) 739-2581

PromiseLAN

MOSES Computers

15466 Los Gatos Blvd.. Ste. 201

Los Gatos. CA 95032

(408) 358-1550

NetWare Lite (software)

Novell

122 E 1700 S

Provo. UT 84606

(800) 526-5463

LAWN

O'Neill Communications

100 Thanet Cir.

Princeton, NJ 08540

(609) 497-6800

EasyOFFICE Network

Server Technology

2332-B Walsh Ave.

Santa Clara, CA 95051

(800) 835-1515

10NET (software)

Sitka

950 Marina Village Pkwy.

Alameda, CA 94501

(800) 445-8677

LapLink Pro

Traveling Software

18702 N.Creek Pkwy.

Bothell. WA 98011

(800) 343-8080

Comment

LANtastic is one of the most full-featured LANs available for

a small-to-medium operation, Fast data transmission; quick

data access with resource caching and random access cach

ing, and a multitude of printing, security, and system-

management features too numerous to mention put LANtas

tic at the top of the list.

The new Macintosh computers come with buiit-in network

capability. PhoneNET ties a PC into an established Mac Lo-

calTalk network, permitting PCs to access and share Apple/

Mac printers and files. Will work with Windows.

The S25 Network ties computers together by connecting stan

dard telephone wire to standard serial por;s. No adapter

cards are necessary. Its abilities are limited (no file locking),

but the price is a grabber.

MAXLAN supports sharing fax, disk drives, printers, files,

and applications and will soon have E-mail. While it can be

used as a peer-to-peer network, the developers state that

network performance increases by dedicating one computer

as the server. Will work with Windows.

While PromiseLAN is slower than some previously mentioned

LANs, it offers many full-scale features, such as print spool

ing and file and record locking. PromiseLAN adjusts trans

mission speeds to accommodate slower XTs without af

fecting the other computers tied into the network, MOSES

Computers also sells the more powerful ChosenLAN, for up

to 53 nodes, and SwiftLAN, which connects notebook com

puters through an external adapter card attached to the par

allel port. The PromiseLAN software isn't available without

the MOSES Computer adapter cards, since MOSES's propri

etary standard makes the software incompatible with other

cards. Will work with Windows with no special installation.

Novell has adapted its full-scale NetWare server-based soft

ware into a peer-to-peer small-scale LAN for a small busi

ness environment. Will work with Windows.

LAWN is a wireless computer connectivity device using spe

cial radio transmitters attached to the serial ports of the

computersand peripherals involved. LAWN software also con

tains the option of dividing the LAWN network into four sepa

rate networks. If you need a LAN for sharing a large data

base file, LAWN is not the option to choose. LAWN is

primarily intended for E-mail, transferring files, and sharing

peripherals. Will work with Windows.

EasyOFFICE connects computers and peripherals by their

serial ports through a small central control box. No network

adapter cards are needed, and the standard LAN features

of peripheral sharing, file transfer, and messaging are incor

porated. The major difference is that wilh the EasyOFFICE

Network, one computer cannot access applications from an

other computer's disk drive, but you can transfer files. You

can also operate another computer from your computer,

with the remote PC's video display appearing on your

screen. This limits application sharing to text-based applica

tions, like word-processing programs and spreadsheets.

10NET is a full-featured LAN suitable for home office use.

It offers numerous printing and security options. Will work

with Windows.

LapLink Pro is not a LAN; it's a file-transfer utility program

designed for laptop computers. It can be used equally well

with desktop computers. No adapter cards required.

Capacity

2-300 nodes

With AppleTalk Phase 2.

address support for up to

16 million nodes

2-5 nodes

2-64 nodes

2-8 nodes

2-25 nodes

2-100 nodes

2-32 nodes

Determined by cabling

2 nodes

Distance

Determined by cabling

Up to 4500 feet

Up to 160 feet

Up to 1670 feet

Up to 500 feet between machines

Determined by cabling

Up to 500 feet without obstruc

tions

Up to 500 feet

Determined by cabling

Up to 25 feei
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LAN Comment Capacity Distance 

LANtaslic lANlastic is one 01 the most full-featured tANs available fot 2-300 nodes Determined by cabling 
Artisoft a small-la-medium operation , Fast dala transmission; quick 
691 E. River Rd. data access with resource caching and random access each-
Tucson, A2 85704 iog; and a multitude of printing, security, and system-
(BOO) 846-9726 management features too numerous to mention put LAMas-
(602) 293-6363 tic at the top of the list. 

PhoneNET Card PCllocalTa!k The new Macintosh compulers come with buill-in network With AppleTalk Phase 2, Up 10 4500 feet 
Farallon Computing capability. PhoneNET lies a PC inlo an established Mac lo- address support for up to 
2<XX) Powell St.. Ste. 600 calTalk network, permining PCs to access ard share Apple! 16 million nodes 
Emeryville, CA 94608 Mac printers and liles. Will work with Windows. 
(510)596-9000 

The $25 Networ1< The $25 Network ties computers together by connecting stan- 2-5 nodes Up to 160 feet 
Information Modes dard telephone wire 10 standard serial poris. No adapter 
P.O. Drawer F cards are necessary. liS abilities are limited (no file locking), 
Denton. TX 76202 but the price is a grabber. 
(BOO) 628-7992 
(817) 898-1294 

MAXlAN MAXLAN supports sharing fax. disk drives, prinlers. files, 2--64 nodes Up to 1670 feet 
MAXlAN and applications and win soon have E-mail. While it can be 
11083 Wilkinson Ave. used as a peer-la-peer network, the developers state thai 
Cupertino. CA 95014 network performance increases by dedicating one computer 
(BOO) 234·1688 as the server. Will work with Windows. 
(408)739-2581 

PromiseLAN While PromiseLAN is slower than some previously menlioned 2-8 nodes Up to 500 feel between machines 
MOSES Computers LANs, it otters many full-scale fealUres. such as print spool-
15466 los Gatos Blvd .. Ste. 201 ing and file and record locking. PromiseLAN adjusts trans-
Los Gatos, CA 95032 mission speeds 10 accommodate slower XTs without al-
(408) 358-1550 fecling the other computers tied inlo the network. MOSES 

Computers also sells the more powerful ChosenlAN, for up 
to 53 nodes. and SwittLAN. which connects notebook com-
puters through an external adapter card attached to the par-
allel port. The PromiseLAN software isn't available wilhout 
the MOSES Computer adapter cards, since MOSES's propri-
etary standard makes the software incompatible wilh other 
cards. Vlill work with Windows with no special installation. 

NetWare Lite (software) Novell has adapted its full -scale NelWare server-based soH- 2-25 nodes Determined by cabling 
Novell ware into a peer-ta-peer small-scale LAN for a small busi-
122 E 1700 S ness environment. Will work with Windows. 
Provo, UT 84606 
(BOO) 526-5463 

LAWN LAWN is a wireless computer connectivity device using spa- 2-100 nodes Up 10 500 feel wi thout obstruc-
O'Neill Communications cial radio transmitters attached to the serial ports of the tions 
100 Thane! Cir. computers and peripherals involved. LAWN software also con-
Princeton. NJ 08540 tains the option 01 dividing the LAWN netwofk into four sepa-
(609) 497·6800 rate networks. If you need a LAN for sharing a large data-

base liIe , LAWN is not the option to choose. LAWN is 
primarily intended for E-mail, transferring files, and sharing 
peripherals. Will work with Windows. 

EasyOFFlCE Netv.'Ork EasyOFFICE connects compulers and peripherals by their 2--32 nodes Up to 500 feet 
Server Technology serial porlS through a smalJ central control box. No network 
2332-8 walsh Ave. adapter cards are needed, and the standard LAN features 
Santa Clara . CA 95051 of peripheral sharing, file transfer. and messaging are incor-
(BOO) 835·15 15 porated. The major difference is that with the EasyOFFICE 

Network, one computer cannot access applications from an-
other computer's disk drive, but you can transfer files. You 
can also operate another computer from your computer, 
with the remote PC's video display appearing on your 
screen. This limits application sharing to text-based applica-
lions. like word-processing programs and spreadsheets. 

10NET (software) 10NET is a full· featured LAN suitable for home ollice use. Determined by cabling Determined by cabling 
Sitka II oilers numerous printing and security options. Will work 
950 Marina Village Pkwy. with Windows. 
Alameda, CA 9450t 
(BOO) 445-ll677 

LapLink Pro Lap Link Pro is not a LAN; it's a lile-transfer ulility program 2 nodes Up to 25 feet 
Traveling Software designed for laptop computers. II can be used equally well 
18702 N.Creek Pkwy. wilh desktop computers. No adapter cards required. 
Bothell. WA 980 II 
(BOO) 343-8080 
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Transmission

Rate

10 Mbps (megabits per

second)

Up to 230.4 Kbps (kilobits per

second; speed depends on

network type)

115 Kbps

10 Mbps

2 Mbps

Determined by cabling

Serial link 19.2 Kbps

115 Kbps on ATs and 386s,

19.2 Kbps on XTs

Determined by cabling

115 Kbps (cable), 9.6 Kbps

(modem)

RAM Used

40K on server, 12K on client

Not available

30K

Less than 52K for client/server

26K for full peer-to-peer net

work, 16K for server, 10K for

client

50K on client server. 25K on

client

■K

45K

93K minimum (comes with its

own memory manager)

440K RAM

System

Requirements

IBM PC or compatible, hard

disk recommended

IBM PC or compatible (up to 25

MHz), 384K RAM, hard disk

recommended

IBM PC or compatible

IBM PC or compatible, 512K

RAM, hard disk recommended

IBM PC or compatible, 640K

RAM, hard disk (not required for

client)

IBM PC or compatible, hard

disk

IBM PC or compatible, 512K

RAM, hard disk recommended

I3M PC or compatible, 640K

RAM, serial port, hard disk

recommended

IBM PC or compatible, 640K

RAM. hard disk recommended

IBM PC or compatible, 512K

RAM, modem

Add-Ons

Longer cables, if desired

None

None

Longer cable, if desired

Longer telephone wire or ca

bles, if desired

Network adapter card for

each PC

None

Longer cable, if desired

Network adapter cards and ca

bles not included in starter

pack

None

Price

$699 for AE-2 starter kit, includ

ing two adapter cards, software

for up to 300 nodes, and ca

bles: $299 for node add-ons

$295 for software and hardware

for one node, $195 for software

only (adapter card required,

node hardware cannot be pur

chased without the software)

$25 for startup kit

S515 for starter kit with two 8-

bit adapter cards, software, and

20-foot cable; $575 for starter

kit with two 16-bit adapter

cards, software, and 20-foot ca

ble; $149 for software only (un

limited users, adapter cards re

quired): node add-ons: S205 for

8-bit card; S229 for 16-bit card

$199 for starter kit with two

adapter cards, software, and 25

feet of telephone wire; node

add-ons: $109 per adapter card

$99 per node

$398 for each PC, serial printer,

and modem transmitter; $489

for each parallel printer transmit

ter (software is included with

each transmitter)

$499.95 for four connections;

$749.95 for eight connections

$299 for three-node starter

pack, software only; $799 for

ten-node value pack, software

only; $129 for node add-ons, soft

ware only

$169.95 lor software and cables

—AUTUMN MILLER

JULY 1992 COMPUTE 75

Transmission 
Rate 

10 Mbps (megabits pe. 
second) 

Up to 230,4 Kbps (kilobits per 
second; speed depends on 
network type) 

lIS Kbps 

10 Mbps 

2 Mbps 

Determined by cabling 

Serial link 19.2 Kbps 

115 Kbps on ATs and 386s, 
19.2 Kbps on XTs 

Determined by cabling 

115 Kbps (cable). 9.6 Kbps 
(modem) 

RAM Used 

40K on server, 12K on cliem 

Not available 

30K 

less than 52K for c~entlserver 

26K for lull peer-la-peer net­
work. 16K lor server, 10K for 
client 

50K on cHent server, 25K on 
client 

25K 

45K 

93K minimum (comes with its 
own memory manager) 

440K RAM 

System 
Requirements 

IBM PC or compatible, hard 
disk recorrvnended 

IBM PC or compatible (up to 25 
MHz), 384K RAM, hard disk 
recommended 

IBM PC or compatible 

IBM PC or compatible, 512K 
RAM, hard disk recOlTl11ended 

IBM PC or compatible, 640K 
RAM. hard disk (not required lor 
client) 

IBM PC or compatible. hard 
disk 

IBM PC or compatible. 512K 
RAM, hard disk recommended 

IBM PC or compatible. 640K 
RAM. serial port. hard disk 
recommended 

IBM PC or compatible, 640K 
RAM. hard disk recorrmended 

IBM PC or compatible, 512K 
RAM. modem 

Add·Ons 

longer cables, if desired 

None 

None 

Longer cable, if desired 

telephone wire or ca­
bles, il desired 

Network adapter card for 
each PC 

None 

longer cable. il desired 

Network adapler cards and ca· 
bles not included in starter 
pack 

None 

Price 

S699 for AE-2 slaner kit, inctud· 
ing two adapter cards, software 
for up to 300 nodes, and ca· 
bles; $299 for node add·ons 

$295 for software and hardware 
for one node, $195 for software 
only (adapter card reqUIred , 
node hardware cannot be pur-
chased wl\hout the software) 

$25 for startup kit 

$515 for starter kit w.th two 8-
bit adapter cards, software, and 
20-loot cable; $575 lor staner 
kit with two 16-bit adapter 
cards, software, and ~Ioot ca­
ble; $149 for software only (un­
limited users. adapler cards re­
quired); node add-ons: $205 for 
8-bit card: 5229 for 16-bit card 

$199 for starler kit With two 
adapter cards. software, and 25 
feet of telephone wire: node 
add-ons: $109 per adcpter card 

$99 per node 

$398 for each pc, serial printer, 
and modem transmitter; $489 
for each parallel printer transmit· 
ter (software is included with 
each transminer) 

$499.95 lor lour connections; 
S749.95 for eight conneclioos 

$299 for Ihree-node starter 
pack, software only: 5799 for 
len-node value pack, software 
only; $129 for nocle add-ons. soft· 
ware only 

$169.95 for software and cables 

- AUTUMN 
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PERSONAL PRODUCTIVITY
Rosalind Resnick

Load the program Into

your computer

and have one of the

richest men in

America as your

personal

investment coach.

BETTER TO GIVENS
THAN TO RECEIVE
Charles Givens has made a for

tune telling other people how

to get rich. Now, the king of

self-help financial books has

set his sights on conquering

the market for money-manage

ment software. His debut pro

gram is WealthStarter with

Charles J. Givens {Reality Tech

nologies. 3624 Market Street,

Philadelphia, Pennsylvania

19104; 215-387-6055; $59.95).

Simply load the Givens pro

gram into your home comput

er (the sales pitch goes) and

make the master—Charles Giv

ens himself—your personal

investment coach.

"My strategies change peo

ple's lives," Givens says.

"There hasn't been software be

fore that did that."

Indeed, there hasn't. But Giv-

ens's rags-to-riches story

shows that he's no stranger to

doing what others believe to

be impossible. Born in Deca-

tur, Illinois, to middle-class par

ents, Givens got hooked on

self-improvement books grow

ing up, dropped out of col

lege, and went on to make

and lose three fortunes. In the

early 1980s, he started ped

dling tapes on investing.

When a local newspaper re

porter mistakenly overstated

his wealth, Givens seized up

on the angle of the millionaire

telling ordinary folks how to

make money.

Today, the Charles J. Giv

ens Organization in Orlando

has 425,000 dues-paying mem

bers nationwide. Givens's

books, Wealth Without Risk

and Financial Self-Defense,

have sold millions of copies

and topped the New York

Times bestseller list (or years.

But along with success has

come controversy. Givens's de

tractors say that his advice—

tips such as "Don't buy bonds

when interest rates are rising"

and "When in doubt, deduct

it"—is simplistic at best and, at

worst, downright dangerous.

Last year, the Wall Street Jour

nal reported that the Securities

and Exchange Commission

and North Dakota state securi

ties regulators were investigat

ing several Givens companies.

Givens isn't fazed by peo

ple who say his investment ad

vice is too simple. Givens

says that investment is a long-

term strategy and it's better in

the short run to increase the

power of the money you cur

rently earn. As for the govern

ment regulators: "When a busi

ness is as big as [ours], they

ought to take a look."

How you'll feel about Giv

ens's software will probably de

pend on your view of his invest

ment philosophy. As Givens

says in his promotional litera

ture, "If you like my books,

you'll love my software." If, on

the other hand, you think the

books are hogwash, you prob

ably won't think much of the

software, either.

Stripped down to its essen

tials, WealthStarter with Char

les J. Givens is little more than

a set of basic spreadsheets

with 300 of Givens's trade

mark tips tossed in. Some ex

amples are "Put your financial

goals in writing," "Purchase a

plastic box for checks," and

"Create your dream list." In

fact, one of the program's key

features is a blank Dream List

worksheet with room for 100

dreams such as "Buy two po

nies" and "Retire with lots of

money." Another feature is an

electronic version of Givens's

7-Step Financial Plan, which in

cludes some rather obvious

planning steps like "Itemize

Your Expenses" and "Achieve

Your Goals." Givens's spread

sheets, meanwhile, don't do

much more than you could do

with a sheet of paper and a $5

calculator.

That's not to say, of course,

that WealthStarter is totally with

out merit. For financial novic

es who've never mapped out

a budget or tallied up their net

worth, Givens's program is a

good place to start. The pro

gram's easy-to-follow screens

prompt you to type in person

al financial data and help you

build a 12-month budget and

personal balance sheet in a

matter of minutes. If you're al

ready using Quicken to pay

your bills and write your

checks, you can import this da

ta directly into WealthStarter.

For newcomers, WealthStar

ter offers 400 pages of tutori

als on stocks, bonds, mutual

funds, and other topics.

WealthStarter with Charles

J. Givens won't make you rich

overnight—though it can help

you get your financial house in

order and give you the disci

pline you need to sock away

money and invest it wisely.

And, finally, consider this: Giv

ens himself has lived out 175

of his 188 original dreams, in

cluding becoming one of the

richest men in America. lI
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PERSONAL PRODUCTIVITY 
Rosalind Resnick 

BETTER TO GIVENS 
THAN TO RECEIVE 
Charles Givens has made a lor­
lune telling other people how 
10 get rich. Now. the king of 
self-help financial books has 
set his sights on conquering 
the market for money-manage­
ment software. His debut pro­
gram is WeallhStarier wilh 
Charles J. Givens (Reality Tech­
nologies, 3624 Market Street , 
Philadelphia, Pennsylvania 
19104; 215-387-6055; $59.95). 
Simply load the Givens pro­
gram into your home comput­
er (the sales pitch goes) and 
make the master-Gharles Giv­
ens himself- your personal 
investment coach. 

"My strategies change peo­
p le's lives," Givens says. 
"There hasn't been software be­
fore that did thaI. " 

Indeed, there hasn't. But Giv­
ens's rags-to-riches story 
shows that he's no stranger to 
doing what others believe to 
be impossible. Born in Deca-

tur, Illinois, to middle-class par­
ents , Givens got hooked on 
self-improvement books grow­
ing up, dropped out of col ­
lege, and went on to make 
and lose three fortunes. In the 
early 1980s, he started ped­
dling tapes on investing. 
When a local newspaper re­
parler mistakenly overstated 
his wealth, Givens seized up­
on the angle of the millionaire 
telling ordinary folks how to 
make money. 

Today, the Charles J. Giv­
ens Organization in Orlando 
has 425,000 dues-paying mem­
bers nationwide. Givens's 
books, Wealth Without Risk 
and Financial Self-Defense, 
have sold millions of copies 
and topped the New York 
Times bestseller list for years. 

But along with success has 
come controversy. Givens's de­
tractors say that his advice­
tips such as "Don' t buy bonds 
when interest rales are rising" 
and "When in doubt, deduct 
it"-is simplistic at best and, at 
worst, downright dangerous. 
Last year, the Waft Street Jour­
nal reported that the Securities 
and Exchange Commission 
and North Dakota state securi­
ties regulators were investigat­
ing several Givens companies. 

Givens isn't fazed by peo­
ple who say his investment ad­
vice is too simple . Givens 
says that investment is a long­
term strategy and it's beller in 
the short run to increase the 
power of the money you cur­
rently earn . As for the govern­
ment regulators: "When a busi­
ness is as big as [ours], they 
ought to take a look." 

How you 'll feel about Giv­
ens's software will probably de­
pend on your view of his invest­
ment philosophy. As Givens 
says in his promotional litera­
ture , " If you like my books , 
you 'll love my software." If, on 
the other hand, you think the 
books are hogwash, you prob­
ably won't think much of the 
software, either. 

Stripped down to its essen­
tials, WealthStarter with Char­
les J. Givens is lillie more than 
a set of basic spreadsheets 
with 300 of Givens's trade­
mark tips tossed in . Some ex­
amples are "Put your financial 
goals in writing, " "Purchase a 
plastic box for checks," and 
" Create your dream lisl. " In 
fact , one of the program's key 
features is a blank Dream List 
worksheet with room for 100 
dreams such as "Buy two po­
nies" and "Retire with lots of 
money." Another feature is an 
electronic version of Givens's 
7 -Step Financial Plan, which in­
cludes some rather obvious 
planning steps like "Itemize 
Your Expenses" and "Achieve 
Your Goals." Givens's spread­
sheets, meanwhile, don't do 
much more than you could do 
with a sheet of paper and a $5 
calculator. 

That's not to say, of course, 
that WealthStarter is totally with­
out merit. For financial novic­
es who've never mapped out 
a budget or tallied up their net 
worth , Givens's program is a 
good place to start. The pro­
gram's easy-to-follow screens 
prompt you to type in person­
al financial data and help you 
build a 12-month budget and 
personal balance sheet in a 
mailer of minutes. If you 're al­
ready using Quicken to pay 
your bills and write your 
checks, you can import this da­
ta directly into WealthStarter. 

For newcomers, WealthStar­
ter offers 400 pages of tutori­
als on stocks, bonds, mutual 
funds, and other topics. 

WealthStarter with Charles 
J. Givens won't make you rich 
overnight- though it can help 
you get your financial house in 
order and give you the disci­
pline you need to sock away 
money and invest it wisely. 
And , finally, consider th is: Giv­
ens himself has lived out 175 
of his 188 original dreams, in­
cluding becoming one of the 
richest men in America. 0 
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ART WORKS
Robert Bixby

People base serious

judgments about

your intelligence on

whether your

writing follows the

rules of

standard English.

TAKING CARE OF

THE TENSE
Desktop publishers need a

ready resource for style and

grammatical advice. I consid

er myself lucky in this regard

because I live in a university

town where there are plenty of

people experienced in profes

sional copy editing. We have

a city library with an excellent

reference desk staff. And on

top of this, I work for a mag

azine of national reputation.

Any questions 1 have regard

ing style or usage are a tele

phone call away from being an

swered. In fact, I might spend

less time getting the question

answered than deciding

which of my many resources

is the most appropriate to use

under the circumstances.

It's a lonelier task elsewhere

in the world, particularly for a

desktop publisher who

doesn't have a community of

writers and editors. Most writ

ers end up editing their own

work as they turn to publish

ing, and in that situation, it isn't

what you don't know that's dan

gerous, but what you know for

sure that may be wrong.

That last sentence was left

knotty on purpose. It's long

and difficult and full of depend

ent clauses and seemingly an-

tecedentless pronouns. It's an

example of the kind of sen

tence that gives a writer/editor

fits. Is it right? Is it wrong? If it's

wrong, how do you fix it? Some

times it's all right to make

small grammatical mistakes, if

doing so improves the flow of

the writing. But someone has

to draw the line between bad

writing and a refreshing depar

ture from the strictures of the

language. The author is the

worst person for that job.

And then there are the mis

takes that everyone makes,

particularly if he/she/they

didn't have the kind of Eng

lish instruction that seems to

have become obsolete—

agreement between subject

and verb and between pro

noun and antecedent. Here's

a simple test to check your

knowledge: Is data singular,

or are data plural? (Actually,

it/they can be either.)

If you face these questions

every day, you need a gram

mar checker. Grammar check

ers will save you from embar

rassment, from error, and from

obfuscation. Despite what

might seem to be a liberal cli

mate in the writing world,

where virtually anything is con

sidered acceptable syntax, se

rious judgments are made

about you and your intelli

gence based on whether your

writing follows the rules of stan

dard English. You can say, "It

don't matter to me" and be

well thought of. But if you write

it in anything but dialogue,

you'll lose all your authority.

On the other hand, if you

don't face questions about

grammar every day in your ed

iting, you're in even greater

need of a grammar checker.

The English language has

more catches than a mile of

barbed wire. If they aren't snag

ging you regularly, that might in

dicate a surpassing knowl

edge of the language, but it's

more likely that you aren't no

ticing the problems because

you aren't aware of them.

True, the work done by

grammar checkers is some

times too complex for them.

The more creative you are in

your word use, the more like

ly they are to misunderstand

your intent and improperly

flag a sentence. That was the

kernel from which many of the

derisive early reviews grew:

Reviewers, usually profession

al writers with years of experi

ence, would run their copy

through the checker and

then poke fun at the results.

Checkers have improved to

the extent that professionals of

ten use them routinely. The

chief improvements (beyond

better programming) include

allowing you to shut off one

feature or another and provid

ing specialized feature pre

sets for checking technical

writing, business writing, cas

ual writing, and so forth.

in addition to detecting ac

tual errors in your writing, how

ever, a grammar checker can

catch you when you lapse in

to passive voice. Believe it or

not, even if your sentences

hew to all of the rules of good

grammar, they can still be ter

rible sentences if they're writ

ten in passive voice. If you

write "The window was bro

ken, and the house was bur

glarized" instead of "The bur

glar smashed the window

and ransacked the house,"

you're guilty of using passive

voice. Grammar checkers will

alert you to this bad habit and

force you to mend your ways.

A grammar checker won't

necessarily make you a better

writer. But a grammar checker

can be your best friend when

it comes to making copy as

clean as possible. □
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TAKING CARE OF 
THE TENSE 
Desktop publishers need a 
ready resource for style and 
grammatical advice. I consid­
er myself lucky in this regard 
because I live in a university 
town where there are plenty of 
people experienced in profes­
sional 'copy edi ting. We have 
a city library with an excelfent 
reference desk staff. And on 
top of this, I work for a mag­
azine of national reputation. 
Any questions I have regard­
ing style or usage are a tele­
phone call away from being an­
swered. In fact , I might spend 
less time getting the question 
answered than deciding 
which of my many resources 
is the most appropriate 10 use 
under the circumstances. 

It's a lonelier task elsewhere 
in the world, particularly for a 
desktop publisher who 
doesn't have a community of 
writers and editors. Most writ­
ers end up editing their own 
work as they turn 10 publish­
ing , and in thai situation , it isn't 

what you don't know that's dan­
gerous, but what you know for 
sure that may be wrong. 

That last sentence was left 
knotty on purpose. It's long 
and difficult and full of depend­
ent clauses and seemingly an­
tecedentiess pronouns. It's an 
example of the kind of sen­
tence that gives a writer/editor 
fits. Is it right" Is it wrong? If it's 
wrong, how do you fix it" Some­
times it's all right to make 
small grammatical mistakes, if 
doing so improves the flow of 
the writing. But someone has 
to draw the line between bad 
writing and a refreshing depar­
ture from the strictures of the 
language. The author is the 
worst person for that job. 

And then there are the mis­
takes that everyone makes, 
particularly if he/she/they 
didn't have the kind of Eng­
lish instruction that seems to 
have become obsolete­
agreement between subject 
and verb and between pro­
noun and antecedent. Here's 
a simple test to check your 
knowledge: Is data singular, 
or are data plural? (Actually, 
iVthey can be either.) 

If you face these questions 
every day, you need a gram­
mar checker. Grammar check­
ers wi ll save you from embar­
rassment, from error, and from 
obfuscation . Despite what 
might seem to be a liberal cli­
mate in the writing world, 
where virtually anything is con­
sidered acceptable syntax, se­
rious judgments are made 
about you and your intelli­
gence based on whether your 
writing follows the rules of stan­
dard English. You can say, "It 
don' t matter to me" and be 
well thought of. But if you write 
it in anything but dialogue, 
you'll lose all your authority. 

On the other hand, if you 
don't face questions about 
grammar every day in your ed­
iting, you're in even greater 
need of a grammar checker. 
The English language has 

more catches than a mile of 
barbed wire. If they aren't snag­
ging you regularly, Ihat might in­
dicate a surpassing knowl­
edge of the language, but it's 
more likely that you aren't no­
ticing the problems because 
you aren't aware of them. 

True, the work done by 
grammar checkers is some­
times too complex for them. 
The more creative you are in 
your word use, the more like­
ly they are to misunderstand 
your intent and improperly 
flag a sentence. That was the 
kernel from which many of the 
derisive early reviews grew: 
Reviewers, usually profession­
al writers with years of experi­
ence, would run their copy 
through the checker and 
then poke fun at the results. 
Checkers have improved to 
the extent Ihat professionals of­
ten use them routinely. The 
chief improvements (beyond 
better programming) include 
allowing you to shut off one 
feature or another and provid­
ing specialized feature pre­
sets for checking technical 
writing , business writing, cas­
ual writing, and so forth. 

In addition to detecting ac­
tual errors in your writing, how­
ever, a grammar checker can 
catch you when you lapse in­
to passive voice. Believe it or 
not, even if your sentences 
hew to all of the rules of good 
grammar, they can still be ter­
rible sentences if they're writ­
ten in passive voice. If you 
write "The window was bro­
ken, and the house was bur­
glarized" instead of "The bur­
glar smashed the window 
and ransacked the house," 
you're guilty of using passive 
voice. Grammar checkers will 
alert you to this bad habit and 
force you to mend your ways. 

A grammar checker won't 
necessarily make you a better 
writer. But a grammar checker 
can be your best friend when 
it comes to making copy as 
clean as possible. 0 
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DISCOVERY CHOICE

ANTicipate the needs of your

colony and fight hand-to-hand combat

in this captivating simulation.

Clayton Walnum

SIMANT
Maxis's first software "toy,"

SimCity, let simulation lovers

become the mayors of their

own towns. SimEarth, the sec

ond program in the line, im

bued players with the power

to forge a world. Now, Maxis

gives us SimAnt, which takes

us not farther out into the uni

verse, but down into the

ground, where we control the

destiny of a nest of ants.

This switch from the grand

scale of SimEarth to the back

yard microcosm of SimAnt

marks Maxis's return to a

more easily manageable sce

nario. Players who found the im

mensity of SimEarth overwhelm

ing will be pleased with Sim-

Ant's relative simplicity. With

the excellent onscreen and in-

manual tutorials, a novice ant

lord needs only an hour or two

to master basic gameplay.

Still, in spite of its restraint,

SimAnt provides both an en

grossing game and an interest

ing introduction to the lives

and times of these pesky, ubiq

uitous six-legged critters.

Over the course of the simula

tion, you'll control where the

ants build their homes, how

they find their food, and

when they invade rival nests.

You'll even lead them to ulti

mate victory as they overrun

the yard's house and drive its

occupants screaming into the

night. Along with the fun,

you'll learn much about these

amazing insects.

The program's easily man

ageable, Windows-like inter

face makes controlling your

colony a snap. Using the Edit

window, you can zoom in on

the underground nest. There

you'll see ants hatching, stor

ing food, nurturing their

young, and performing other

activities. By switching to the

surface view, you

can see your ants

scurrying across

the ground as they hunt

for food, battle enemies, and

avoid such deadly dangers

as spiders, ant lions, and

lawn mowers. Finally, in the

Map window, you get a bird's-

eye view of an entire patch or

an expanded view that in

cludes ail 192 patches, with

graph lines showing the rela

tive strengths of the black

and red armies.

Like SimEarth, SimAnt can

be played on several levels. If

you're a beginner, you'll prob

ably start with the quick

game, in which you must in

crease the size of your colony

until you can kill all the red

ants in your patch. When

you've graduated to the full

game, you must not only in

crease the size of your colony

but also migrate to other patch

es in a quest to annihilate the

red ants and drive the humans

from their house. Finally, in the

experimental mode, you manip

ulate the ants' universe in sev

eral ways, studying the effects

your actions have on your tiny

guinea pigs.

A full game of SimAnt in

volves leading your horde

through several stages of

play. At first, you have only a

newly hatched queen, who

must dig

a hole and start

laying eggs. The first egg

hatches into the yellow ant,

which is the ant you control.

Your initial task is to guide it

to food.

You find food by switching

to the overhead view in the

Map window, which shows

the entire patch. After you've

located the green area that

marks a food cache, send

your yellow ant scurrying after

it. Watch out for spiders and

ant lions, which love to

munch on unwary insects. By

the time you bring a few food

balls back to the nest, other

ants will have hatched. You

can then recruit them to help

gather food.

Before long, you'll have

built up a strong and thriving

nest. When you've outpopulat-

ed the red ants (and have plen

ty of food for energy), you can

recruit an army of soldier ants

to attack the red nest and de

stroy the red queen. Then you

can breed new queens to

send to new patches. You contin

ue in this way until you've de

stroyed all the red ants and tak

en over the humans' house.

During a game, you have

many tools at your disposal
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SIMANT 
Maxis's first software " toy," 
SimCity, let simulation lovers 
become the mayors of their 
own towns. SimEarth , the sec­
ond program in the line, im­
bued ptayers with the power 
to forge a world. Now, Maxis 
gives us SimAnt, which takes 
us not farther out into the uni­
verse, but down into the 
ground, where we control the 
destiny of a nest of ants. 

This switch from the grand 
scale of SimEarth to the back­
yard microcosm of SimAnt 
marks Maxis's return to a 
more easily manageable sce­
nario. Players who found the im­
mensity of SimEarth ovenwhelm­
ing wi ll be pleased with Sim­
Ant's relative simplicity. With 
the excellent onscreen and in­
manual tutorials, a novice ant 
lord needs only an hour or two 
to master basic gameplay. 

Still, in spite of ils restraint , 
SimAnt provides both an en­
grossing game and an interest­
ing introduction to the lives 
and times of these pesky, ubiq­
uitous six-legged c ritters. 
Over the course of the simula­
tion, you'll control where the 
ants build their homes, how 
they find their food, and 
when they invade rival nests. 
You'll even lead them to ulti­
mate victory as they overrun 
the yard's house and drive its 
occupants screaming into the 
night. Along with the fun, 
you'll learn much about these 
amazing insects. 

The program's easily man­
ageable , Windows-like inter­
face makes controlling your 
colony a snap. Using the Edit 
window, you can zoom in on 
the underground nest. There 
you'll see ants hatching, stor­
ing food , nurturing the ir 
young, and performing other 
activities. By switching to the 

surface view, you 
can see your ants 
scurrying across 
the ground as they hunt 
for food, battle enemies, and 
avoid such deadly dangers 
as spiders, ant lions, and 
lawn mowers. Finally, in the 
Map window, you get a bird's­
eye view of an entire patch or 
an expanded view that in ­
cludes all 192 patches, with 
graph lines showing the rela­
tive strengths of the black 
and red armies. 

Like SimEarth, SimAnt can 
be played on several levels. If 
you're a beginner, you'll prob­
ably start with the quick 
game, in which you must in­
crease the size of your colony 
until you can kill all the red 
ants in your patch. When 
you 've graduated to the full 
game, you must not only in­
crease the size of your colony 
but also migrate to other patch­
es in a quest to annihilate the 
red ants and drive the humans 
from their house. Finally, in the 
experimental mode, you manip­
ulate the ants' universe in sev­
eral ways, studying the effects 
your actions have on your tiny 
guinea pigs. 

A full game of SimAnt in­
volves leading your horde 
through several stages of 
play. At fi rst, you have only a 
newly hatched queen, who 

must dig 
a hole and start 

laying eggs . The first egg 
hatches into the yellow ant , 
which is the ant you control. 
Your initial task is to guide it 
to food. 

You find food by switching 
to the overhead view in the 
Map window, which shows 
the entire patch . After you've 
located the green area that 
marks a food cache, send 
your yellow ant scurrying after 
it. Watch out for spiders and 
ant lions, which love to 
munch on unwary insects. By 
the time you bring a few food 
balls back to the nest , other 
ants will have hatched. You 
can then recruit them to help 
gather food. 

Before long, you'll have 
built up a strong and thriving 
nest. When you've outpopulat­
ed the red ants (and have plen­
ty of food for energy), you can 
recruit an army of soldier ants 
to attack the red nest and de­
stroy the red queen. Then you 
can breed new queens to 
send to new patches. You contino 
ue in this way until you've de­
stroyed all the red ants and tak­
en over the humans' house. 

During a game, you have 
many tools at your disposal 



which allow you to control the

ants and their universe (a

backyard). You can, for exam

ple, display the various chem

ical scents (nest, trail, and

alarm) your ants leave behind

as they move about a patch.

In addition, the Caste control

allows you to choose the per

centage of breeders, workers,

and soldiers born into your

nest. The Behavior control

lets you decide how many

ants forage for food, dig new

tunnels, or nurture the young.

The History window provides

access to graphs depicting

ant populations, food storage,

colony health, and even the

number of ants eaten or

killed.

For ease of play, the most

commonly used functions are
represented by buttons on the

windows. Also, a menu bar pro

vides access to many addition

al functions, including game

saving and loading, game

speed, music and sound tog

gles, and window selection.

One menu function, aptly

named Silly, turns your ants in

to wisecracking smart alecks

who frequently stop what

they're doing to blurt out such

nonsense as "Eat poison, spi

der face!" and "Better dead

than red!"

In the experimental mode,

the simulation operates much

differently than in either of the

game modes. To start, you're

given a patch containing small

black-ant and red-ant nests.

You're also given a menu of

tools that you can apply to the

nests and their occupants. The

Barriers tool, for example, lets

you build walls anywhere you

like on the current patch. Oth

er tools include the Dig/Fill tool

for digging or filling in holes,

the Add Food tool for feeding

hungry ants, the Drop Trails

tool for creating chemical

trails, and the Insecticide tool

for quickly killing off excess

population.

One of SimAnt's most impres

sive features is its Information

window, which is a HyperCard-

like database containing

mounds of information about

ants. Clicking on a card's sub

ject buttons takes you to other

cards, while clicking on a high

lighted word displays a little

pop-up window containing the

word's definition. All the cards

are linked into a complex tree

that lets you follow any subject

line you like. Most of the cards

in the stack contain pictures

as well as text.

SimAnt's well-written man

ual is a joy to read. Every

page contains not only de

tailed program instructions

but also plenty of humorous

sidelines that will keep you

grinning as you learn.

As with any good manual,

you first get a quick overview

of the game's objective. Then

you're guided through a

hands-on tutorial that will

have you controlling your

ants in a surprisingly short

time. Peppered throughout

the manual are dozens of ant

puns. You'll groan at such

atrocities as "An ant with a

split personality is a sibilANT."

The second section of the

manual offers a wealth of infor

mation about ants in the real

world to readers who want to

improve their gameplay or

just increase their knowledge

about these tiny insects.

From general facts about

ants to the specifics of how

they eat, communicate, repro

duce, and fight—everything

you've ever wanted to know

about these insects is here.

The manual's third section

offers ANTcillary (blame Max-

is) information about ants, in

cluding many sources for fur

ther study, both fictional and

nonfictional. Section 4 of the

manual is a complete glossa

ry, bibliography, and index.

All said and done, SimAnt

is a war game, albeit one that

blends education with blood

letting. What sets it apart

from other war games is its

unique scenario. Your sol

diers don't have two legs;

they have six. The battlefield

isn't the countryside of Eu

rope; it's a house and its back

yard. Your soldiers use no fan

cy weaponry; they fight hand

to hand. Nevertheless, as in

any other war game, the ob

ject is to defeat the enemy

and take over its territory.

Of course, to be success

ful in SimAnt, you must learn

all you can about ants and

their behavior. What a sneaky

way to get an education. O

Circle ReadBr Service Number 301

IBM PC and compatibles;

640K RAM; EGA, MCGA,

VGA, Hercules, or Tandy

graphics; hard drive;

supports Ad Lib, Sound

Blaster, Sound Master,

Roland MT-32, and Tandy

sound—$59.95

MAXIS

Two Theatre Sq., Ste. 230

Orinda, CA 94563-3346

(800) 33-MAXIS

JULY 1992 COMPUTE 81

which allow you to control the 
ants and their universe (a 
backyard). You can, for exam­
ple, display the various chem­
ical scents (nest , trail, and 
alarm) your ants leave behind 
as they move about a patch. 
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are linked into a complex tree 
that lets you follow any subject 
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in the stack contain pictures 
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you first get a quick overview 
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you' re guided through a 
hands-on tutorial that will 
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time. Peppered throughout 
the manual are dozens of ant 
puns. You'l l groan at such 
atrocities as "An ant with a 
split personality is a sibilANT." 

The second section of the 
manual offers a wealth of infor­
mation about ants in the real 
world to readers who want to 
improve their gameplay or 
just increase their knowledge 
about these tiny insects. 
From general facts about 
ants to the specifics of how 
they eat, communicate, repro­
duce, and fight-everything 
you 've ever wanted to know 
about these insects is here. 

The manual 's third section 
offers ANTciliary (blame Max­
is) information about ants, in­
cluding many sources for fur-

ther study, both fictional and 
nonfictional. Section 4 of the 
manual is a complete glossa­
ry, bibliography, and index. 

All said and done, SimAnt 
is a war game, albeit one that 
blends education with blood­
letting . What sets it apart 
from other war games is its 
unique scenario. You r sol ­
diers don' t have two legs; 
they have six. The battlefield 
isn't the countryside of Eu­
rope; it's a house and its back­
yard. Your soldiers use no fan­
cy weaponry; they fight hand 
to hand. Nevertheless, as in 
any other war game, the ob­
ject is to defeat the enemy 
and take over its territory. 

Of course, to be success­
ful in SimAnt, you must learn 
all you can about ants and 
their behavior. What a sneaky 
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PATHWAYS
Steven Anzovin

ECO LOGIC

Going green

makes good sense

for business

and for personal

reasons.

Green computing seems to be

catching on in many forms—

especially in telecommuting

and recycling,

Telework advocates have

long predicted that the comput

er will replace the car, and re

cently you could see some sol

id evidence of that. Commut

ers who once had to drive for

hours to corporate centers in

Los Angeles and San Diego

now have an alternative that's

closer to home. The Riverside

Telecommuting Center, about

60 miles southeast of Los An

geles in the town of Riverside,

is a pioneering effort at cre

ating a satellite corporate com

puting center. Several

companies, including Pacific

Bell, Edison, Xerox, IBM, and

Disney, are leasing or pian to

lease office space in the cen

ter for white-collar employees

who live in the Riverside area

to let them avoid the three-

hour commute into the city.

CD-ROMs have finally ar

rived, along with the Multime

dia PC. Because many CD-

ROMs contain time-depend

ent information, the discs be

come useless as soon as the

information on them is outdat

ed. And unlike floppy disks,

useless CD-ROMs can't be

reused, so most people just

toss them. A CD manufacturer

called Digital Audio Disc, a So

ny subsidiary in Terre Haute,

Indiana, melts down discs

that don't pass quality control

and uses them to make CD

packaging, but as yet there's

no company that recycles

used CD-ROMs and audio

CDs from consumers. Like

wise, it's possible to recycle

the jewel box and plastic tray

that CD-ROMs and audio CDs

are packaged in, but so far on

ly the world's largest jewel box

and tray manufacturer, Atlan

ta Precision Molding, has the

facilities to do it, and the com

pany recycles only its own

scrap. There's a niche for an

enterprising plastics entre

preneur who wants to get into

compact disc recycling.

In another development,

some CD-ROM distributors

are turning away from plastic

CD packaging altogether. Ap

ple Computer, which sends

out thousands of CD-ROMs to

Apple developers every

month, now protects its discs

with a cardboard sleeve in

stead of a jewel box, as does

Educorp, the biggest distribu

tor of commercial Macintosh

CD-ROMs. By the way, if you

have lots of floppy disks you

want to recycle, a company

called Covenant Recycling

Services (201-838-1336) will re

condition them and sell them

through a middleman to

schools and other outlets.

In a previous column I men

tioned a Mac program called

DynoPage that makes it easy

to print documents on both

sides of the paper. Robert G.

Chaplick of Wheaton, Mary

land, notes that there are two

much less expensive PC utili

ties for double-sided printing.

One is a shareware program

called Microtxt, which can be

found in shareware catalogs

and on several online servic

es; the other is PRNCOL (avail

able for $15 from Steve Fox,

11515 113th Place NE,

Kirkland. Washington 98033).

Chaplick uses PRNCOL for all

his printing and recommends

it highly. If you want recycled

paper to print on, there are sev

eral mail-order sources, includ

ing Earth Care Paper (4601

Hammersley Road, Madison,

Wisconsin 53711; 608-277-

2900) and Inmac (1111 West

North Carrier Parkway, Suite

200, Grand Prairie, Texas

75050; 800-547-5444). Inmac

even offers hard-to-find recy

cled fanfold paper.

More and more people are

saving money by recycling

their laser toner cartridges

and reinking their printer rib

bons. Be sure, by the way, to

use the newer soy-based rib

bon inks rather than petroleum-

based inks and to keep rib

bons well inked to lubricate

the printer head. Did you

know that you can refill the ink

cartridge in your Hewlett-Pack

ard DeskJet or DeskWriter print

er by yourself? Bruce Marche-

sani of Lyndhurst, New Jer

sey, sent in this tip. Simply use

a hypodermic syringe to inject

the empty cartridge with a

new supply from a bottle of

standard Shaeffer ink, which

can be purchased in any sta

tionery store, or use a soy-

based ink of similar viscosity.

(Syringes are available from

your local surgical supply

house.) There's a little pinhole

in the top of the ink cartridge

that allows you to do this.

Share your tips on green com

puting. Send your ideas to me

at Box 2173, Amherst, Massa

chusetts 01004. Maybe you'll

see your name and idea in a fu

ture column. □
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Startrek 25th Aniversfy $36

Time Quest $19

Train S 6

Uninvited $ 9

Where Amrcas Pst CSD $37

Where Europ, USA, time$30

Where World CSD $27

Where World CSD Dlx $49

IBM SPORTS

4D Boxing (17

4l!i 8 Inches $ 9

ABC Boxing $32

All American College Fb$36

APBA Baseball S28

APBA 1908-9^Ea $21

APSA Basketball $28

APBA Bowling $19

APBA Football $49

APBA Micro Manager S32

Greens $34

Gretsky Hockey 2 $34

IBM SPORTS

GretskyLeague $26

Hardba 12 $28

Hardba'l 3 $34

John El<vay's QB $ 6

LH 3 in 1 Football $36

LH Box:ng $36

LH College Basketball $36

LHFuil Count Baseball $36

LH Hockey $36

LH Pro Basketball $36

IBM TRADITIONAL

Centerfold Squares $21

Check Mate DOS/WIN $36

ChessmasterSOOO $32

Chessmaster3000WIN$38

Dealers Choice Poker $32

Edwrd 0 Thrp Blch Jck $19

Femmes Fatale $26

Femmes Fatal e Disk $18

GO Master 5 Dli $109

GO Master 5 DOS/WIN $39

■DREADNOUGHTS

s a surface fleet

Dattle simulator. It

ecreates lhe look,

speoficatons, and

tactics of fleet com-

bat. Features 30

views, comprehen

sive manuals and

sea charts, a po

tent English com

mand parser, lor 2

player mode and

mpuier con-

■lied ships, gun

nery and damage

control. $42

LH Team DisKs $16

LHLeacue Leaders $16

LH Utility Disks $16

Links Golf $37

Links Golf WIN $39

Links Course 1 -6Ea $17

Madden Football 2 $32

MagicJohnsonFstB* $6

Mario Andretti Racing $17

MLBasbllMngr'sChllng$24

ML World Series Disks $17

MLTD-9B2-1990 Ea $17

ML Frarchise Disks Ea $20

Microleague Basketball $28

ML Personal Pro Golf S28

ML Football Deluxe $39

ML Ftbali Team Disks $17

Michael Jordan Rt Sim $«

Mike Ditka Football $32

NFL Challenge $60

NFL Football $31

NFL 1984-1987 Ea $15

NFL 1988-1991 Ea $22

NFLProleague Football $24

Nicklaus Signature Edrt S39

Nicklaus SE Clip Art $24

Nicklaus Unlimited Golf $29

NG Clip Art $17

NG Course 1,2,3.4.or5$15

Peie Rose Baseball $ 9

PGA Tour Golf $32

PGA Tour Golf WIN $38

PGA Tour Goll Disk 1 S17

PGA Tour Goll Ltd Edt $45

Pro Football Analyst $34

Pro Teni'S Tour 2 $32

Road to the Final Four $37

Heel Fish'n $12

Tom Landry Football $29

Tony LaRussa Basebll $29

TLaR Fantasy Managr $15

T LaRussa Stad'urs $15

GO Master 5 Toolkit >39

Grand Slam Bridge $22

Hong Kong Mali Jong S3?

Hoyle Book Games ior2S2i

Hoyle Book Games 3or4 E29

Jeopardy Silver Edition B15

Monopoly $24

Omar Shanf on Bridge E37

Penthouse Jigsaw $24

Risk WIN $29

Scrabb'e Deluxe £34

Shanghai 2 $24

Siratego $31

Strip Poker 3 $31

Strip Poker Data 1-5 Ea $19

Trump Castle 2 $29

Video Poker DOS WIN $34

Wheel oi Fortune Gold $15

Wordtris $29

Work) Champ Backgmn $24

WorHChampCnbbage $24

IBM ROLE PLAYING

Bard's Tale 2 $19

Bards Tale 3 $31

Bards Tale Cnstrctn St $19

Battletech 2 $31

Buck Rogers 1 $12

Buck 2: Matrix Cubed $32

Caplam Blood S 9

Celtic Legends $32

Champions $37

CHARACTR EDITORS $16

Conan $29

Cyberspace $29

Darklands $39

Dusk of the Gods $38

Elvira 1 Mistress Dark $34

Elvira 2 Jaws Cerberus $39

Flames ol Freedom S28

Hero's Quest 2 or 3 $34

Hyperspeed $34

Immortal $17

TLaRTeamsl901-56 $15

Weaver Baseball 2.0 S32

Weaver Commisnr 2.0 $21

Weaver20i990Teams$16

Weaver 2 OComm Edt $56

World Crcuil $34

IBM TRADITIONAL

Amanllo Slim Poker $12

Backgammon WIN $19

Battle Chess WIN $29

Blackjact DOSW1N $19

Legacy of Necromancer $29

Lord of the Rings 1 S34

Lord of the Rings 2 $37

Loremaster $39

Lure ol the Temptress $37

Magic Candle 1 $12

Magic Candle 2 $37

Mechwamor $34

Megatraveller 1 $16

Megatraveller2 $19

Megatraveller 3 $39

IBM ROLE PLAYING

Might S Magic 1 or 2 $12

Might & Magic 3 $37

Might t Magic 4 $39

Pirates S 9

Planei's Edge $37

Sea Rogue $39

Seminel Worlds $15

Space 1889 $16

Space Inc $34

Spellbound 539

Starlight 1 or 2 SIS

Sword of the Samurai $ 9

Swrd Samrai 8 Pirates $16

Tales Mage Prophcy S $38

Third Couner $ 6

Tunnels 5 Trolls $12

Twilight 2000 $34

Ultima Martian Dreams $37

Ultima Savage Empire S34

Ultrma TnSogy $35

Ultima Tnlogy 2 S45

Ultima 1-6 Bundle CD $59

Ultima 6 False Prophet $39

Ultima 7 Black Gale $45

Ultima Stygian Abyss $48

Uncharted Waters $42

Wnardry Trilogy $32

Wizardry 4 $19

Wizardry 5 $32

Wizardry 6 CosmcFrg $37

Wizardry 7 Crusaders $39

IBM AD 4 0

ADSD Bundle $38

Champions o I Krynn $20

Curse of Azure Bonds $15

Dark Queen of Krynn $32

Death Knights of Krynn $20

Dragons ol Flame $12

Eye of lhe Beholder $32

Eye ol the Beholder 2 $38

IBM SIMULATION

F15SE2ScenanoDiSk $17

F15 Strike Eagle 3 $44

F19 Stealth Fighter $24

F22 ATF $39

Falcon 3.0 $42

Flight Simulator 4 0 $39

Fly Grand Canyon 3D $45

Gunship $12

Gunship2000 $39

Harrier Combat Sim $ 6

HINT BOOKS

ADSD HINTBOOKS $10

Bard's Tale 1 ■ 3 Ea $10

Suck Rogers 1 $10

Buck 2: Matrix Cubed $10

Civilization $16

Dynx Great War Planes $16

Elvira lor 2 $10

Ha-poon Battle book $19

Indy Jones Lst Crsade $ 10

Indy Jones Fate Atlantis $10

i i

4%. lAi

~~- Ti»*\ ■-■"■
d ■:• \

^. i. ,r iiT>i«

strategy game in a

fantasy setting.

Youcan control 128

armies, each a

thousand strong

with definable

battle formations

consisting of 6 dis

tinct humanoid

races. March your

men over 125,003

square miles of

(racially generated

landscape lo obtan

co jntless followers

and gold $29

Heros of the 357th

Hyperspeed

Jet Fighter 2.0

Land. Sea & Air Ior2

Life S Death 1or2

Ml Tank Platoon

Mantis Exprmntl Fghlr $34

Megafortress $37

MegafrtrssMssnior2 S27

fled Baron VGA $34

Red Baron Mssn 1 or 2 $24

fled Storm Rising $12

'PERFECT GEN-

ERAL' is a turn

based ground war

game. Features!2

ears of play tesl-

ng. VGA maps,

easy to use mouse

or keyboard inier-

face. 14 scenarios,

strong artificial in

telligence, hidden

movement, line of

sight option, in

Jetfighter 2 $16

Loom $10

Lord of lhe Rings 1 or 2 $10

LucasAns Adventure $16

Mage Candle 1 or 2 $10

Marian Dreams $13

Mamx Cubed $10

Might S Magic 3 $16

Planet's Edge $16

Populous 182OffidSlr $16

Power Monger $16

Quest lor Clues 2.3or4 $2!

Railroad Tycoon $10

Savage Empire $10

Secret Mnkylslnd lor 2 $10

SIERRA HINTBOOKS $10

Simaty'Simearth $20

Starflighi 1 or 2 $10

StrategyPlus3-ii Ea $ 8

Strategy Plus 12-18 $ S

Ultima 4 - 7 Ea $10

Ultima Avaiar Adventrs $14

Wizardry 6 Cosmic Frg $12

Wizardry 7 Crusade $12

Yeager's Air Combat $16

Gateway Savge Frontr $32

HeroesoltheLance $12

Pool of Darkness $38

Pool of Radiance $15

Secret ol Silver Blades $15

Shadow Sorcerer $32

Treasurs Savage Frontr $32

War of the Lance S 9

IBM HARDWARE

Ad Lib Sound Card $59

Ad Lib Gold 1000 $179

Adhb Surround Sound $64

Ad lib Telephone Module $64

Ad Lib Speakers $15

Flight Stick $43

Flight Stick w Falcon $46

SoundBlaster $109

Sound Blaster Pro $189

Snd Blaster Speakers $15

Thrustm aster Joystick $69

ThrustmstrProJoystickJKS

Thrustmstr Weapn Cntrl $79

Thunder Board SrdBrd $84

Thunder Board Spkrs $15

IBM SIMULATION

AlOAvenger $43

Aces of the Pacific $39

Aces Pacific Mssn 1 or2$27

Aces over Europe $46

Aces Europe Mssn 1 or 2$27

ATP $37

B1? Flying Fortress $39

Buzz Aldrin Race Spc $37

Car & Driver $3B

Design yr own Railroad $29

Dynamics Bundle $39

Elite Plus $19

Eye ol the Storm $29

F117AfJighthawk $42

F14 Tomcat $26

F15 Strike Eagle 2 $19

Sailing Simulator $39

Sailing Sim Voyages Ea $34

Secret Weapons Lftwff $44

S Weapons Expi-4 $21

Shuttle $34

Silent Service 2 $34

Strike Commander $45

Team Yankee $34

Team Yantee 2 $29

Test Dnve 2: Collection $34

Test Drive 3 $32

TD3 Road £ Car Disk $19

CHIPS & BITS
PO Box 234

Rochester VT 05767

Fax 8O2-767-33B2

802-767-3033

800-753-4263

GEnie Keyword CHIPS

We accept Visa. MC SMoney

Orders. COD add $5. Checks

Held 4 Weeks Most items

shippedsameday. All shipping

rat es are pe r o rd er noi pe r ite m.

UPSS4:2DayAir$6:Mari$5:

AirmaFlCanada$6:HI,AK,PR.

■RORKES drift-

is a detailed simu

lation of the battle

between 137 Srtl-

ish soldiers J. 4D0C

Zulu warriors that

took place Jan 22

1879. Youcontrol

each man, stand

ing, sitting, prone,

aiming, firing, re

loading, running or

walking. With 3D

map, animated

combat S move

ment mouse sup

port 8 VGA. $34

TFH&8H1942

Ultrabots

Virtual Reality Slud«

Wing Commander 1

WC1 Mission 1 or 2

WC1 Bundle

Wing Commander 2

WC2 Operations lor 2

WC2 Speach Pack

Wolfpack

Yeager's Air ComOat

$44 2 Day Air $12: Airmail Europe

$37 Si2firstitemplus$6peradd-

$49 tonal item.

$39

$19 All Sales Final. Check

$45 compatibility before you buy,

$45 Shipping limes not

S27 guaranteed. Detectives

$15 replaced with same product.

S15 Price S availability subject

$33 lo change.

Circle Reader Service Number 149

CHIPS&BITS GAMES FOR LESS CALL 800 753 GAME 
IBM WARGAMES 

ActIOI'! Stalions S29 
Acton Sta~ons Seen 1 SI4 
Allied Forces Sundle S29 
Amel CMI War 1 ·3 Ea S22 
Ancient An 01 War S29 
Banles 01 Napoleon S32 
Bfsmark $12 
BlllZWeg Ardennes S29 
Sla'lO Romeo Delta 537 

IBM STRATEGY 
Conquered Kingdoms $.36 
Crisis in the KIemlin $37 
OragooLord $12 

""~ '" Empire $31 
Empne Deluxe S42 
Final Conllict $34 
FlleTeam2200 S29 
Fire Team ConSIKit S25 

IBM STRATEGY 
~mEarth '" Slar Control 2 537 
Starileel 1 or 2 538 
TaskForce 1942 $39 
Theatre 01 War 532 
Traders '" Utopia 53' 
VISions 01 Aftermath '" Warlords '" Worlds al War '19 

IBM ADVENTURE 

IBM SPORTS IBM TRAOrnoNAL IBM ROLE PLAYING 
Grets~y League $26 Centerfold Squares '" MigI'lI & Mage 1 or 2 $12 
Hardba:12 52S Check Mate OOS/WIN $.36 Mighl & Magic 3 537 
Hardba'13 '" Chessmasler 3000 532 Mighl & Mage 4 S39 
John EINaY'S OS " Chessmasler 3000 WIN S38 Pirates $ 9 
lH 3 in 1 Football 536 Dealers Choice Poker 532 Planers Edge 537 
LH Bourg 536 Edwfd 0 Thrp Sick Jck $19 Sea Rogue S39 
LH College 8asItetball 536 Femmes Fatale '" Sentinel WDfIds $15 
LH Fun Coun! Baseball S36 Femmes Fatale Disk '18 Space 1689 S16 

536 GO Master 5 Db $11B Spaca Jne $34 

_'" $39 $\arflighl1 01 2 $19 
Advnts Wiaie BeamS! S34 Sword 01 the Samurai S 9 

Advnts Wilil! Beamisll 2 S39 1~2$s~~1 Swrd Samrai & Pirates S16 CocIenalM Iceman 2 SJ9 Tales Magic: PrDjlhcy 5 S3a 
Colonel Beques12 S34 Thud Con S 5 
Conquestsollongbow $34 Tu/mels & Trois $12 
ConspitacyDeadlcck $34 T....uighl2000 $34 

Cowl ""'" '" """"'''''''''"",: I Ultma MaRian Dreams 537 Cnllse lor a capse S34 r Ultima Savage Empire $34 
[)ejaVu 2 los 1;' LV 512 UltinaTrilogy S35 

j:!:~:::;: 1 Don', Go AlonE S 9 Uhima Trilogy 2 $45 
Ero Ouest 1 $34 t/ItIIIla t.6 Bundle CO $59 
Felony $12 Ultma6FalseProphel $39 
Frei! DC $29 Ultima 7 Black Gale $45 

";';~:::~ I Gateway S36 l!~ii=~_ii~ UHima Stygian Abyss $48 ~ Godfather $32 UrdlartedWalelS $42 

Heart 01 China $34 "!:tt~~::-~~ Wizardry TriIogy $32 '::'= c:c:::--""'=:="= -.::L:c:c,----::::! Hostage $ 9 :' Wizardfy 4 $19 
Caniers at War 537 GlobalConquesl S39 IndyJoneslCrsdvga $27 LHTeamDisks $16 GO Masler 5 Tooildl S39 WilardryS $32 
Carrier Slrike 542 Global ENact S32 Indy Jones Fate Atlantis $3B LHleague leaders S16 Grand Slam Bridge S22 Wizardfy 6 Cosmic F r~ $37 
Charge Ughl Brigade S34 KoshanConspiracy S32 King'S QuesllEnhncd $34 LH Utilily Disks S16 Hong Kong MahJong S32 Wizardry 7 Crusaders S39 
Civil War SS! $42 Lemmings S32 Krng's 0ues120r J S28 Unks GoH $37 Hoyle Book Games lor2$21 !BM AO & 0 
Cohcw1 S34 Lemmings Data D!$I\ $19 KIIlQ'S 0ues1 4 $34 Unks Gotl WIN S39 Hoyle Book Games 3of4 S29 AO&O Bundle 
Confla: Korea S37 L'Empereur S37 !<lng's Dues15 or 6 VGA$39 Unks Course 1 ·6 Ea S17 Jeopardy ~tver EdiOOn SIS Champions 01 Krynn 
Conll.ct: Middle Easl S37 UDerty or Death S37 LealhefGodde:.ses2 $42 Madden Football 2 S32 Monopoly $24 Curse ot Azure Bonds 
ConflcrinVietnam S 9 LoSlAdmi al S34 LeisUleStr.1Lny2,J, 5 S34 MagicJohnsonFS1Brk S 6 OmarSharitOllBrW:Ige S37 
Oeosioo al GertySburg S29 LoSlAdmiral Enhanced S38 Leisufe Sull UIY Bundle S39 Mario Arldreni Racing S17 PenlllouseJigsaw $24 
Dreadrooghts $42 lost Admiral Scenario $lJ Loom $19 ML BasbI Mngr's Ch~ 524 Risk WIN S29 
Dreadnoughts: Ironclads S29 Medieval Lords S37 Losl in LA S37 ML Wo~ Serie5 Oisks S 17 Saabb!e Deluxe S34 

Dreadnoughts: Bismark S29 ~~~~b=;"'~...!!lO~"~T~"~""~"'~'~'-~~"':; Ml TO 1982· 1990 Ea $17 Shanghai 2 $24 
Fl'e 60Gade S34 r- Ml Franctise Disks Ea S20 Stralego S31 
GEN OTRS GAMES $24 MiaoIeague Basltetbal $28 Strip Pokel3 S31 
GettySburg:Tuming Pm $37 Ml Personal Pro GoH S2S Strip Pokef OaUl 1-5 Ea $19 
Ha!lsolMontezuma $24 I ~~::'~~£;£ MlFoo:DalI Oe!uxe S39 TnmpCastle2 S29 
Harpoon S25 t- ML Ftball Team Disks S17 Vdeo Pokef OOsrwlN S34 
Harpoon Se12 or 3 S19 Michael Jordan At Sim 5" Whee!ol FortlJfle Gok:I $15 
Harpoon Sel 4 $24 4'&tf,ll~*",e;,..: Mike ~ Footbal S32 Wordtris S29 
Harpoon Cha!lengefPakS42 I NFL Challenge $60 World ChampBacl\gmn $24 
KamplOJ\4lPE! $37 NFLFoo!b.il S31 WorldCtlampCribbage $24 
MacAr!tI\J( sWar S29 NFL 19a4 ' 1987Ea SIS IBM ROLE PLAYING 
PanzerBanles S22 NFl1988·1991Ea S22 Sard'sTale2 $19 
Patriot S3B NFLPro!eagve Footbal S24 Bard's Tale 3 S31 
Palriol Sanle Sets Ea S24 Niclllaus Signalure Ed~ S39 Batd's Tale Cnslrctn St $19 
Panon Strikes Back 537 Nicklaus SE Clip An 524 Banlelech 2 $31 
Red Ughtning S12 Nk:ldaus Untimi!1KI Gol! S29 Buck Rogers 1 $12 
ROII)mal North A!rica S24 NG Clip Art S17 Buck 2: Malrix Cubed S32 
Rorke's Dnh S34 NG Couse 1,2,3, 4, or 5S15 CapUlin Blood $ 9 
Socood Fronl $37 "":::''<'''J...."....--:::"....l:--.i:':''::7,,,,:? Pele Rose Saseball S 9 Celtic Legends S32 
SIM CAN GAMES S36 Nobunaga 1 or 2 S31 Magnm 5cfolls Bnd! S34 PGA Toor GoII S32 CIlampions S37 Gateway Savge Frontr $32 
StOimAcross Eulope S12 NudearWar S12 MartianMemOIandum S37 PGAToorGollWtN S38 CHARACTREDITORSS16 Hflroesot1he~ $12 
llurd Reich 527 ObjectJCn S34 0u1 ot !Ius Wor'd S36 PGA Tour Golf Disk I $17 Conan S29 Pool 01 Oarkness S38 
Typhoon 01 S:eel S12 OperationCombal SIS Plan 9'rom Ott.er SpaceS31 PGA Toor Golf Ltd Edl S45 Cyber Space S29 Pool 01 Radiance S15 
UMS 2 S19 Pacific Theater 01 Oper $42 Poke 0ue511 S28 Pro FootbaU Analysl S34 Oarklands S39 Secrel 01 Silver Blades $15 
UMS2 CIVi War sz: Perfect General S34 Pob Quesl1 VGA S34 Pro T en,iis Tour 2 S32 0Usk of !he Gods S38 Shadow Sorcerer $32 
UMS 2 Desert Slorm S20 Perfect GeReral 0isII2 S23 Poke 0ues12 or 3 S34 Road' 10 the FInal FoUl' S37 Etvia 1 Mistress Darll S34 Treasurs Savage Frontr S32 
UMS 2 Planel Ed~Of S28 Popu!ous2 S38 Rrse ot the Dragon S34 Reel FISh'n S12 Ema 2 Jaws Celbarus S39 Warol1he Lance $ 9 
VIorVrctory S3B PowetManger $34 Sect1l.4onkylsn:llvga S23 Tom Landry Footbal S29 flames 01 Freedom $28 IBM HARDWARE 
Walerbo S12 PO'«e1 Monger WWl $21 Secrt MoriI.y Ishd 2 S3B TOIlylaRUS5a BasebU S29 Hero's 0ves12 or 3 $34 Ad lib Sound cam $59 
Western Front $.17 OOPBundIe $59 SexOiympics $24 TlaRFantasyManagr SIS Hyperspeed AdlibGoldIOOO $179 

i Siefra Adven!\lfe BundleSJ9 Adlib Telephone Module S64 

IBM SlMULAnON 
F15SE2 Scenario Disk $17 
F1 5SlTikeEag!(r3 $44 
F19 Sleat:li Frgh!er 

ATF 

Heros of the 357th $32 H_ '" 
Jet Frghler 2.0 $39 
land, Sea <I. Air 1012 $39 
Ufe & Death 10f2 $23 
1.41 Tank PLalOO1l S34 
Manns Exprmn1l F9!W S34 
Megafortress 537 
Megalrtrss Mssn 1 or 2 S27 
Red Baron VGA S34 
Red Baron Mssn 1 or 2 $24 
Red SlOfm $12 

Sailing SimuLalOr $39 
Sailing Sim Voyages Ea S34 
Seaet Weapons Lhwf! $44 
SWe~~1·4 521 
Shuttle S34 

HINT BOOKS 
A05D HINTBOOKS $10 
8a~'s Tale 1 ·3 Ea $10 
Buck Rogers 1 $10 
Buck 2: Matrix Cubed SID 
Civitila!ion $15 
Dynx Greal War Planes $16 
EMra 1 or 2 $10 

'" $10 

Jefrghter2 $16 
Loom $10 
Lon:! 0' the Rings 1 or 2 $10 
LucasArtsAdventule $16 
MagicCandlelor2 $10 
Martian Dreams S13 
Ma:rixCubed $10 
Might & Magic 3 $15 
Pla'lefs Edge S15 
PopuloUS 152 OffICI Sir S16 
Powerl.longel $16 
Duesl lor Clues 2, 3014 $21 
RaJroadT)'alOIl $10 
Savage Emprre $10 
Secrel~tsndlor2 $10 
SIERRA HINTBOOKS $10 
Simcity/Simearth S20 
Sta1Iighl1 Of 2 $10 
Stralegy Plus 3 ,11 Ea $ 8 
StrateqyPtus 12·18 $ 5 
UItr:na4·7Ea $10 
UkiTla Avalal' Adventrs S14 
WIZardlY 6 Cosmic Fro $12 
Wizardry 7 Crusade $12 
Yeage(s Alt Combal $16 

CHIPS & BITS 
PO 80x 234 

Rochester VT 05767 
Fax 602·767·3382 

602·767·3033 
600-753-4263 

GEnIe Keyword CHIPS 

Silenl SeMce 2 S34 We accept Visa, Me &Money 
SlrikeCommander S45 Orders. COO add $5. Cheds 
TeamYaAAee S34 Held 4 Weeks, Masl ~ems 
Team Yanilee 2 S29 slippedsameday. AIIs/'1ippir9 
Test Drive 2: CoUectkln $34 ra~esaraperordernotpet~em, 
Tesl Drive J S32 UPS $4: 2 Day Air S6: Mai $5: 
TD3 Road & car Disk $19 AmaiGanadaS6:Ht Al<.PR, 'WM~'~O~"~.'---__ ~"'~~~~~~=~"'~ Sex Vixenslfon5pace S12 ~T~",~R£"",~~S~""""~'~'7~SI~'r'mmo]~,,"~~~:~~ AdlibSurrotn:lSotm S64 

I I~~,:,:::~I SpaceOues12 S2B Ad Lib Speakers $15 isade1ailedsimu. 
jo Space Ouest 1, J or 4 S34 Flighl Stick S43 Lation 01 the battle 

Space Cues15 VGA S39 Flighl Slid<. w Falcon S46 belWt1efl 137 Bnt. 

·RORKES ORIFT' 

RORKE~ DRIFT 
Space0ue51 Bundle S39 Sound Biaslar $109 ishst*!iers&4000 
Spellcasting 101 S19 Sound Biasler Pro $189 Zulu warriors thaI 
SpeUcasling 2{l1 S36 Snd Biasler Speakers $15 look place Jan 22 
S1aftrek5 $12 ThrustmasterJoystic:k S69 1879, You control 
Slartrek 251h Aniversry S36 Thrustmstr Pro JoystickSl09 each man, sIano', 

~
~"i~i~::~1 Time Quesl S19 Thrustmstr Weapn Cn!~ $79 . , , Train S 6 Thunder Board SndBrd $84 1IlQ, Sitting, prone, 

aiming, firing, reo 
Unit'Mted $ 9 Thundef Board Spkts $15 ~,runningOl 
Where Amrcas Pst CSD537 IBM SIMULAT10N walking. With 30 
Whele EUIOj), USA, lime$31 Al0Avenger S43 map, animated 

"~P """. :~ I Whele World CSD $27 Aces 01 the Pacific S39 combal & move. 
IVhere Wor'cI CSD Db. 549 Aces PacifIC Mssrr 1 or 2$27 menl mouse sup-

IBM SPORTS AcesoverEurope S46 port&VGA. $34 

---;:c=c:'-----::::! 40 BoXIng $17 Aces Europe Mssn 1 or 2527 ";;::7====::7-::-;~~~=:::::C=' 
Rampart 4t1\& lnches S9 TLaRTeamsl90HiS SIS LegacyotNecromancerS29 ATP 537 TFH&SHI942 S£4 2 Day Air $12: Airmail Europe 
Realms $29 ASCBoXIog S32 WeaverBasebaH.O S32 lo«I 01 !he Rlngs 1 $34 Bl1FtyingForuess S39 UltrallolS 537 $12tirst~emplusS6pe!'3IH· 
Rer.egadeLeg:on ~trcp1S12 AI American College FbS36 Weavt'l'Commisnr2.0 $21 loId 01 the Rings 2 537 Buu AldM Race Spc 537 Vrrtuar Reafity Studio $49 tiona! Hem. 
RevoMron76 $29 APBABasebalI S28 WeiMf2.01990Teams$16 Loremastef S39 Car&Oriwr S3B WrrgCommnSerl S39 
Romarrc31<ngdmlor2 $42 APBA I9()9· 91Ea $21 Weaver2.0Comm Edl $56 Lureot1heTempltess $37 OesignyrownRaIroad S29 WClMissionlor2 $19 AU S.IIII Fln. 1. Check 
Ru!esol Engagemenl S31 APBA Baskel1)af1 S28 World Ctcult S34 Magic cand!e 1 $12 Dynamics EkJrde S39 WCl Burde S45 comp.Ublllty betoI! YOUbuy, 
Second Contlict WIN $34 APSA BoYoing SI9 IBM TRADITIONAL MagicCancle2 $37 Eli1e Plus $19 WrngComll\al"der2 $45 ShippIng limn not 
Siege S38 APBA Foolbal1 549 Amati\o Slim Poker S12 MedIwafri:)r $34 Eyt! of the StOfm S29 WC2 Operations 1 Of 2 s:n gua ranteed. Oetectives 
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MULTIMEDIA PC
David English

Great Literature-

Personal

Library Series

oilers over

900 classic literary

works on a

single CD-ROM.

INSTANT LIBRARY
We hear a lot about how a sin

gle CD-ROM can hold a room

ful of books. It sounds great,

but do you really want your

books on a small plastic disc?

You wouldn't want your phone

book available only on disc;

you would have to boot up

your computer every time you

needed to make a phone call.

On the other hand, you

might like an encyclopedia on

CD-ROM—you could perform

elaborate searches, paste por

tions of the text directly into

your word processor, hear

music and speeches, and pay

much less for the electronic ver

sion than the traditional multi-

volume hardcover edition.

The company that's done

the most to champion the

cause of books on disc is the

Bureau of Electronic Publish

ing (141 New Road, Parsippa-

ny, New Jersey 07054; 800-

828-4766).

The Bureau not only publish

es its own titles but sells other

CD-ROMs as well. Its catalog

is an excellent short course in

the technology of CD-ROM

and the many titles that are

available in this rapidly chang

ing market.

The Bureau's most recent ti

tle under its own name is

Great Literature—Personal Li

brary Series ($99). It contains

over 900 classic literary

works: 72 plays (including

those of Aeschylus and nearly

all of Shakespeare's); 75 es

says (including "The Sayings

of Confucius" and "The Get

tysburg Address"); 31 biogra

phies, journals, and letters (in

cluding Plutarch's Lives and

The Autobiography ofJohn Stu

art Mill); 461 poems (including

Paradise Lost and Rime of the

Ancient Mariner); 199 fiction

al works (including Thousand

and One Nights, Canterbury

Tales, Divine Comedy, and Al

ice's Adventures in Wonder

land); 32 historical docu

ments (including "The Declara

tion of Independence" and

"The Constitution of the United

States"); and more.

It's a treasure trove of well-

known and obscure works com

bined with hundreds of color

illustrations, excerpts of period

music, and CD-quality read

ings by television and movie

stars. (Where else can you

hear George Kennedy read An

tony's "Friends, Romans, coun

trymen . . ." speech?)

The easy-to-use search en

gine lets you quickly find any

word or passage on the disc

and organize the index by au

thor, title, or type of literature.

It may not all be great litera

ture, and you may miss the fan

cy leather bindings, but you

certainly get your money's

worth with this CD-ROM.

You say you don't have time

to read the great works of lit

erature? You're more a Mon

arch Notes type of person?

Then you'll be interested in the

Bureau's Monarch Notes on

CD-ROM ($99). It contains the

full text of the entire collection—

over 200 different titles. Use it

to help you through that nine

teenth-century novel course or

to impress your semiliterate

friends.

Actually, Monarch Notes on

CD-ROM can be a valuable sup

plement to your reading of the

great works of literature and is

a useful companion piece to

the Bureau's Great Literature

CD-ROM. Like the Literature

CD-ROM, Monarch Notes

includes pictures and illustra

tions, as well as selected

readings.

For history buffs, the Bureau

offers U.S. History on CD-ROM

($395). It contains the full text

of 107 books on U.S. history, in

cluding books on Pearl Harbor,

the Apollo expeditions to the

moon, the Manhattan Project,

America's drug habit, U.S. en

vironmental quality, black Amer

icans, and much more. Throw

in the Nixon Watergate tapes,

Congress's three-volume Iran-

Contra Affair report, and 1000

VGA photos, maps, and tables

of historical events, and you

have enough material to chal

lenge any armchair historian.

If your quest for knowledge

leads you toward a more glob

al view, you might take on the

Bureau's two world-class titles:

Countries of the World ($395)

and World Fact Book ($99).

Countries of the World in

cludes 106 different U.S. Army

Country Handbooks, each rang

ing from 200 to 500 pages. The

Handbooks are supplemented

with information from 151 U.S.

embassies and hundreds of col

or maps.

World Fact Book is pro

duced annually by the CIA for

U.S. government officials.

Along with the text, it includes

selected maps, flags, and na

tional anthems. No, the CIA

didn't include its classified

information.

All five of these CD-ROMs

run under DOS. While they

don't require an MPC, they will

run on one. In addition, the

same disc works with both PCs

and Macs.

If you're looking to build up

your reading library but you

don't have a lot of shelf space,

take a look at these and other

CD-ROMs from the Bureau of

Electronic Publishing. □
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GET THE
OFFICIAL CLUES TO THE

HOTTEST GAMES!
THE OFFICIAL BOOK OF

KING'S

THE OFFICIAL GUIDE TO

t£] hint and strategic* for solving

rsJ i-V 2nd the West no Sinn's
CD-ROM dcvrlopmnl

THE OFFICIAL BOOK OF

KING'S QUEST
SECOND EDITION

Here's the source for hints,

tips, and background for the newest

adventure, King's Quest V.

This new volume includes more clues,

maps, and inside details,

along with more ways to add even

■ more fun to all five of the

best-selling King's Quest games.
Covers King's Quest I ■ V.

THE OFFICIAL GUIDE TO

SID MEIER'S
RAILROAD TYCOON

This is the book that makes

railroading and the game come alive.

Inside piayers will find interviews

with Sid Meier, the designer of Railroad

Tycoon, along with facts

on how the product was conceived

and developed. Also

includes formulas the program uses to

determine income and expense.

THE OFFICIAL GUIDE TO

ROGER WILCO-S

SPACE ADVENTURES

For the first time,

Space Questers can learn what goes
on in the mind of the most

legendary janitor in the universe. Inside,

you'fl find complete maps for every

Space Quest scenario, point values for
every reaction, and Roger's

walk-through to the finish of all the games.
Covers Space Quest I ■ IV.

YES I 1 I t wanl more hints and tips! Please
• send me the books checked below.

D The Official Book of King's Quest, Second Edition (2452) $12.95

D The Official Guide lo Roger Wilco's Space Adventures (237) S14.95

D The Official Guide lo Sid Meier's Railroad Tycoon (2443) S12.95

Total Number of Boohs

Total Cost of Books Ordered

□ Check or Money Order

Signature

D MC D VISA

"1

[Requied)

Acct. No.
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Exp. Dale.

Please Print

Street Address

City

LT

Sales Tax (Residents of NY, NC, aid NJ add appropriate sales tax (or

your area. Canadian orders add 7% goods and services tax.)

Shipping and Handling: $2 per book U.S.; $4 Canada;

$6 foreign.

Total Enclosed

State. Zip.

All orders must be paid in U.S. funds drawn on a U.S. bank.

Mail this entire coupon to:

COMPUTE Books

c/oCCC

2500 UcClellan Ave.

Pennsauken, NJ 08109

Offer good while supplies last. 7H92C

GET THE 
OFFICIAL CLUES TO THE 

HOTTEST GAMES! 
«' 

Io. .. ~~ THE OFFICIAL 
~~~ -Y.'-" ''-' 

DonaJd B. Trh~1' 
Fc.......t by Rl;lbftu WUlI.a .. 

~rital "ma.aAd~fwtol..u.e 
KiII(~Qwsr r-l ' .l>4tlatWiI:III "" SIftn's 

(])..1tO)t.t~t 

THE OFFICIAL BOOK OF 
KING'S OUEST, 

SECOND EDITION 

Here's the source for hints, 
tips, and background for the newest 

adventure, King's Quest V. 
This new volume includes more clues, 

maps, and inside details, 
along with more ways to add even 

. more fun to all five at the 
best-selling King 's Quest games. 

Covers King's Quest I - V. 

THE OFFICIAL GUIDE TO 

THE OFFICIAL GUIDE TIl 
SID MEIER'S 

RAILRDAD TYCOON 

This is the book that makes 
railroading and the game come alive. 

Inside players will find interviews 
with Sid Meier, the designer of Railroad 

Tycoon, along with facts 
on how the product was conceived 

and developed. Also 
includes formulas the program uses to 

determine income and expense. 

THE OFFICIAL aUIDE TIl 
ROGER WILeD'S 

SPACE ADVENTURES 

For the first time, 
Space Questers can learn what goes 

on in the mind of the most 
legendary janitor in the universe. InSide, 

you 'll find complete maps for every 
Space Quest scenario, point values for 

every reaction, and Roger's 
wak-through to the finish of all the games. 

Covers Space Quest I - IV. 

1.-----------

I YE51 0 I wanl more hints and tips! Please 
• send me the books checked below. 

---I 

I 
I 
I 
I 
I 
I 

o The Official Book 01 King's Quesl, Second Edition (2452) $12.95 
o The Olflelel Guide 10 Roger Wilco's Space Adventures (237) 514.95 
o The Official Guide to Sid Meier's Railroad Tycoon (2443) 512.95 

Total Number of Books 

Total Cost of Books Ordered 

Sales Tax (Residents of NY. NC, and NJ add appropriate sales tax for 
your area. Canadian orders add 7'l'o goods and services tax.) 

Shipping and Handling: $2 per book U.S. ; $4 Canada; 

I 
L_ 

$6 foreign. 

Total Enclosed 

o Check or Money Order 0 Me 0 VISA I 
Signature _____ -----,,"'_="'.------------
Acct. No. ___________ Exp. Dale ___ I 

Please Print I 
Name ________________ _ 

Street Address --------------- I 
City _______ 5Ialo ---- Zip ---- I 
All orders must be paid in U.S. lunds drawn on a U.S. bank. 

Mall this entire coupon to: 

COMPUTE Books 
clo cec 
2500 McClellan Ave. 
Pennsauken, NJ 08109 

Oller good while supplies last. 7H92C 



ENTERTAINMENT CHOICE

Sharp graphics and digitized sounds make

this game's absorbing story line come to life and

captivate you with unsurpassed adventuring.

Alfred C. Giovetti

EYE OF THE

BEHOLDER II:
THE LEGEND OF
DARKMOON
You and [he other heroes of

the battle for the sewers have

settled in for your night's re

past before the warm hearth

of the most inviting inn in Wa-

terdeep when there comes a

call for assistance. Soon, you

find yourself slogging

through the torrential rain

with your friends, wincing at

the peals of thunder as you ap

proach a dark doorway. A

rough-looking, large servant

greets you and quickly ushers

you into the presence of

Khelben, one of the ruling

lords of Waterdeep. After be

ing briefed on recent disap

pearances of important

agents and some other

strange happenings in the ar

ea, you're teleported into the

center of an adventure—far

from the meal and bed of the

inn.

And you're launched into

perhaps the best of all first-

person adventure games, full

of seat-of-the-pants suspense

and hair-pulling mystery. Stra

tegic Simulations' Eye of the

Beholder II: The Legend of

Darkmoon will capture your

imagination and hold you pris

oner in front of your computer

for days—nay, weeks—of en

tertainment.

Darkmoon is true to the

rules, classes, artifacts, and lo

cations contained within the

Forgotten Realms Fantasy

World, a favorite world in Ad

vanced Dungeons and Drag

ons. In many ways, one of the

most exciting things about

this excellent adventure is its

faithful portrayal of this popu

lar fantasy world.

Darkmoon

has its share

of gratuitous vio

lence, from the slaying of

the suspiciously friendly

clerics to the gruesome

and dangerous final bat

tle with the red dragon.

Many of the monsters

from the first Eye of the Behold

er are back to plague the par

ty of four adventurers and as

many as two nonplayer char

acters. There are new, more le

thal monsters. Frost giants pum

mel your entire group with one

blow from a massive six-foot

fist. Medusas positively rivet

those unable to escape their

irresistible charms. You're nev

er really sure what will be lurk

ing around the next corner or

what will come looking for you

out of the distant shadows.

Exploration and mapping

are needed to get through the

maze, so get out the pencils,

rulers, and graph paper, as

this game lacks an automap-

ping feature. Some of the puz

zles are the find-the-minuscule-

button type; others involve

knowing the pattern of levers

to pull or the floor switches to

weight with stones. Solutions

range from the obvious to the

obscure. Some require the te

dious process of kicking all

walls to see if they hide a se

cret wall; others require a ba

sic knowledge of statistical com

binations and permutations.

Characters can be rolled

up by the com

puter, transferred

from the original

Eye of the Beholder,

selected from a pre-

rolled quick-start party, or

modified to fit the statistics

of your favorite character

from any computer or paper-

and-pencil role-playing game.

They're constructed from two

genders, six basic attributes,

nine types of two-dimensional

moral alignment, and six ba

sic professions as provided in

the Advanced Dungeons and

Dragons second edition. You

can—and should—take your

favorite characters and weap

ons into the game.

Darkmoon's interface is lit

tle changed from its award-

winning predecessor. The first-

person perspective uses the

upper left portion of the

screen. The remainder of the

screen is filled by the charac

ter display, compass, mouse-

activated cursor icons, and

message area. The compass

is replaced by a Spell menu

when a holy symbol or spell

book is clicked on. Clicking

on a character portrait chang

es the character display to an

equipment or attribute list.

Equipment is displayed in pa

per-doll fashion, so that you ac

tually put "clothes" on the char

acter graphics or place weap

ons in their hands.

The first-person display
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moral alignment, and six ba­
sic professions as provided in 
the Advanced Dungeons and 
Dragons second edition. You 
can-and should-take your 
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changes little in combat,

save for the approach of the

antagonist. Played through a

Sound Blaster sound card, dig

itized sounds of metal on met

al and grunts of characters

punctuate the battle realistical

ly. Combat is carried out in real

time and involves clicking on

weapons to strike opponents

in a melee, to launch missiles,

or to open the Spell menu to se

lect an appropriate combat

spell. Arrows, daggers, rocks,

and spells can be seen flying

through the air toward their in

tended targets.

If the battle grows too in

tense, you can back away or

turn and run to find a safe

place on another level or be

yond a stout door that you

hope will hold the monsters

back. Objects and characters

shown in the 3-D-perspective

window are represented with

a depth and substance that

suspend disbelief, giving you

a feeling of truly being there.

Click on switches to oper

ate them, on beds to search

them, on items in the scene

for more precise descriptions

of how they feel, or on Dwar-

ven, Elven, or other script for

an instant translation from par

ty members who know the lan

guage. Exploration is very

much like walking down a hall

way and picking up objects

to examine them. And when

you place an object on the

floor, it stays there until you re

turn to retrieve it.

Darkmoon's engrossing

plot is revealed in a series of

character-interaction scenes.

In each of these scenes, the

dungeon display is replaced

by a screenwide graphic of

the nonplayer character

who's talking or a prominent

game feature, such as the tem

ple of Darkmoon.

Characters are awarded ex

perience for completing

quests, finding significant

items, solving puzzles, and

making the correct choice

when given an option. Adven

turing players' characters

speak right up when they

have the skill to notice some

thing important about the im

mediate surroundings of the

party, giving you the feeling

that you're part of a group of re

al people. Characters also

speak up if the party is asked

to commit an act contrary to

their moral alignment with re

spect to good, evil, chaos, and

order, adding more personali

ty to the characters.

Strategic Simulations re

sponded to some of the crit

icism of the first Eye of the Be

holder by adding several new

features to Darkmoon. For in

stance, Darkmoon has six

user-definable save-games,

which will be needed, since

there are several dead-end sit

uations you can encounter in

the game. Also, there's a high

er level of player interaction

and story development that en

gages you in the conflict.

Player interaction is, how

ever, still somewhat limited.

Darkmoon allows for the re

cruitment of only six nonplay

er characters, but they're very

interesting and unpredictable,

giving character recruitment

some bite. And there's only

manual combat.

Darkmoon does have a few

bugs. Make sure that the par

ty has three glowing orbs pri

or to passing through the un

intentionally one-way crimson

ring portal in the crimson tow

er. Cleric-fighter-mage multi-

class characters cause the

game to lock up when area-

affect spells are thrown at the

party. The keyboard control

of movement occasionally is

unresponsive during a battle,

Beholder H
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which caused my party to be

killed off several times in the fi

nal climactic battle with Dran

Draggore. Still, these prob

lems were only a little annoy

ing when compared to the en

joyable gameplay that snuck

up and stole 40 hours of time

from my life.

This is one of the best real

time, first-person-perspective

games ever produced. The

graphics are much sharper

and more attractive than those

of previous games; when com

bined with the coordinated dig

itized sound effects, they pull

you into the realtime action.

Eye of the Beholder II: The Leg

end of Darkmoon has a rich sto

ry line, improved graphics,

spectacular animation, and a

satisfying finale. Also, it's a lot

of fun to play. d
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changes little in combat, 
save for the approach of the 
antagonist. Played through a 
Sound Blaster sound card, dig-, 
itized sounds of metal on met­
al and grunts of characters 
punctuate the battle realistical­
ly. Combat is carried out in real­
time and involves clicking on 
weapons to strike opponents 
in a melee, to launch missiles, 
or to open the Spell menu to se­
lect an appropriate combat 
spell. Arrows, daggers, rocks, 
and spells can be seen flying 
through the air toward their in­
tended targets. 

If the batt le grows too in­
tense, you can back away or 
turn and run to find a safe 
place on another level or be­
yond a stout door that you 
hope wi ll hold the monsters 
back. Objects and characters 
shown in the 3-D-perspective 
window are represented with 
a depth and substance that 
suspend disbelief, giving you 
a feeling of truly being there. 

Click on switches to oper­
ate them, on beds to search 
them, on items in the scene 
for more precise descriptions 
of how they feel , or on Dwar­
ven, Elven, or other script for 
an instant translation from par­
ty members who know the lan­
guage. Exploration is very 
much like walking down a hall­
way and picking up objects 
to examine them. And when 
you place an object on the 
floor, it stays there until you re­
turn to retrieve it. 

Darkmoon's engrossing 
plot is revealed in a series of 
character-interaction scenes. 
In each of these scenes, the 
dungeon display is replaced 
by a screenwide graphic of 
the non p layer character 
who's talking or a prominent 
game feature, such as the tem­
ple of Darkmoon. 

Characters are awarded ex-

perience for completing 
quests , finding significant 
items , solving puzzles , and 
making the correct choice 
when given an option. Adven­
tur ing players' characters 
speak right up when they 
have the skill to notice some­
thing important about the im­
mediate surroundings of the 
party, giving you the feeling 
that you're part of a group of re­
al people. Characters also 
speak up if the party is asked 
to commit an act contrary to 
their moral alignment with re­
specl to good, evil, chaos, and 
order, adding more personali­
ty to the characters. 

Strategic Simulations re­
sponded to some of the crit­
icism of the first Eye of the Be­
holder by adding several new 
features to Darkmoon. For in­
stance, Darkmoon has six 
user-definable save-games, 
which will be needed, since 
there are several dead-end sit­
uations you can encounter in 
Ihe game. Also, there's a high­
er level of player interaction 
and story development that en­
gages you in the conflict. 

Player interaction is, how­
ever, still somewhat limited. 
Darkmoon allows for the re­
cruitment of only six nonplay­
er characters, but they're very 
interesting and unpredictable, 
giving character recruitment 
some bite. And there's only 
manual combat. 

Darkmoon does have a few 
bugs. Make sure that the par­
ty has three glowing orbs pri­
or to passing through the un­
intentionally one-way crimson 
ring portal in the crimson tow­
er. Cleric-fighter-mage multi­
class characters cause the 
game to lock up when area­
affect spells are thrown at the 
party. The keyboard control 
of movement occasionally is 
unresponsive during a battle, 

which caused my party to be 
killed off several times in the fi­
nal climaclic battle with Dran 
Draggore. Sti ll, these prob­
lems were only a litt le annoy­
ing when compared to the en­
joyable game play that snuck 
up and stole 40 hours of time 
from my life. 

This is one of the best real­
time, first-person-perspective 
games ever produced. The 
graphics are much sharper 
and more attractive than those 
of previous games; when com­
bined with Ihe coordinated dig­
itized sound effects, they pull 
you into the realtime action. 
Eye of the Beholder II : The Leg­
end of Darkmoon has a rich sto­
ry line, improved graphics, 
spectacular animation, and a 
satisfying finale. Also, it's a lot 
of fun to play. 0 
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C/ass/c sw/nff characteristics.

The ideal swing for every club

in the bag. Woods are hit with a

full turn aid trie short irons with

a smooth, three quarter backswing

From drives to chips to putts

every shot is textbook Nicklaus

Created by Jack Nicklaus. t

Voted Golfer of the Century. The V.
preeminent course architect of our time.

Signature Edition" is Nicklaus' third

golf game and his crowning achievement

on the computer. "It's [he newest, most

comprehensive game on the market!'

The only 256 Color VGA Course Designer on the market

Another first from Nicklaus. The powerful 256 Color

VGA Course Designer is the "magic wand of golf" Create
an unlimited number of golf courses in breathtaking color.

Refine each hole with "Plot & Play."tue the bunkers

in unfair positions? Don't wait until your course design is

completed to find out - play the hole instantly, while

design is in progress, and feel out its payability.

True-to-life ball flight Like real golf,

club length and loft will determine trajectory and

distance. A 2 iron wil! hit long and roll hot, a PW will fiy high and

land soft. And don't ignore Mother Nature. Wind and terrain can alter ball flight and bounce.

(^> 619HA:ca*» l-e A

Refine each hole wIth "Pial & Play." Are the bunkers 
in unfair positions? Don't walt until your course design Is 

completed to find out - play the hole instantly, while 
design is in progress, and feel out its playabili ty. 

Classic swfng characterlsUcs ... 
The ideal swing lor every club 

In the bag. WoOds are hit with a 
lulilurn and Ihe short Irons wilh 

a smooth, three Quarter backswing. 
From drives to chips 10 putts, 

every shot is texlbook Nicklaus. 

"II Created by Jack Nicklaus. , -
Voted Goller 01 the Century. The ......... 
preeminent course architect of our time. 

Sionarure Edition'" is Nicklaus' third 
gall game and his crowning achievement 

on the computer. "It's the newest, most 
comprehensive game on the market:' 

The only 256 Calor VGA Course DesIgner on the market 
Another lirst from Nicklaus. The powerful 256 Color 
VGA Course Designer is the "magic wand of golt:'Create 
an unlimited number of golf courses In breathtaking color. 

True·la·life ball (fight Like real goll, 
club length and loft will determine trajectory and 

distance. A 2 iron will hit long and roll hot, a PW will fly high and 
land soft. And don't ignore Mother Nature. Wind and terrain can alter ballllight and bounce. 



jolfGame

Compatible with Jack Nicklaus

Unlimited Golf." Existing courses

created with Unlimited'"can be

mported to trie Signature Edition

Hear golf's greatest hits.

Digitized sound effects

add to the total wealth of realism.

The unmistakable sound of a forged

blade cutting the air The perfect

"click" of a club catching the sweet

spot. It just doesn't get any better

than this.

Jack Nicki

Jack Nlcklaus'256 color masterpiece. Feature rich, with five digitized golfer animations (including the Golden Bear

himself); authentic tour statistics and up to five rounds of tournament play. Tee off

with friends - or computerized opponents, whose

abilities can be altered with the Player Editor.

AVOID SLOW PLAY

The fastest screen

redraws. Slow play is the

bane of golf. Signature

Etf/f/on1" solves that prob

lem with fastest screen

drawing speeds of any

comparable golf game

Includes two Nicklaus designed

courses. Create an unlimited number of

layouts with the 256 Color VGA Course

Designer or tee oft on two, leady-to-

play Nicklaus signature courses -

Sherwood Country Club and English Turn.

The all-new

Jack Nicklaus

Signature Edition?" Unprecedented realism combined with unmatched
payability. Or in the language of the links, "dead solid perfect:' But

what else wouldyou expect from Jack Nicklaus and Accolade?
To order, visit your

\ tfavorite software retailer

Coming this fall for the

Apple' Mac'mtOStt:

The best in entertainment software."11
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Compatible with Jack Nicklaus 
Unlimited Golf .... Existing courses 
created with Unlimited"' can be 
Imported to the Signature Editlon~ 

• 

Hear golf's greatest hits. 
Digillzed sound effects 

add to the total wealth 01 realism. 
The unmistakable sound of a forged 

blade cUlling the air. The perfect 
"cUCk" of a club catching the sweet 

spot. It just doesn't get any beller 
than this. 

Jack NIcklaus' 256 cofor masterpiece. Feature rich, with five digitized golfer animations (including the Golden Bear 
himself); authentic tour statistics and up to live rounds of tournament play. Tee off 

with friends - or computerized opponents, whose 
abilities can be altered with the Player Editor. 

fncludes two NIcklaus designed .. 
courses. Create an unlimited number 01 
layouts with the 256 Color VGA Course 

Designer or lee off on two, ready-to­
play Nicklaus signature courses­

Sherwood Country Club and English Turn. 

Theall-new 
Jack Nicklaus 

Signature Edit1on~ Unprecedented realism combfned with unn'atc~e<J 
playability. Or in the lanouaoe of the finks. "dead solid perfect." But 

whal else would you expect lrom Jack Nicklaus and Accolade? 
To order. visit your "" 

'av,rltesoNwareretaller 'rr~1 'nr_ 
"call 1-800-245-7744_ ,",'-'-\....Ilf"'UJL 

The best in entertainm ent software.'" 
Coming Ihls fall for the 
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GAMEPLAY
Orson Scott Card

Simplicity and fun are

the watchwords

for the early crop of

Windows games

from Microsoft and

Symantec.

A DIFFERENT
KIND OF GAME
Let's face it—the Windows en

vironment hasn't exactly been

a gamer's paradise. It's a mat

ter of s-p-e-e-d—Windows

doesn't have any!

Admittedly, on a 486 ma

chine with a graphics

coprocessor and 8MB of

RAM, Windows can run any

game fast enough for fun. But

even on this Mother of All Ma

chines, which we use for all

the serious applications (like

typesetting and playing Mon

key Island 2), it still takes a no

ticeable amount of time to re

draw the screen and shift from

one view to another. And

that's deadly for action and sto

ry games.

But that doesn't mean there

can't be good games for Win

dows. They just have to be

games of a different kind. Mi

crosoft itself pointed the way

with the first Windows Entertain

ment Pack (WEP). The con

cept was simple and obvious.

(All good ideas are obvious

once somebody has thought

of them.) Develop a bunch of

small games that are graphical

ly simple or that can be

played in a slow environment,

package them together, and

sell the whole caboodle for an

irresistible price.

The first Windows Entertain

ment Pack must have been fi

nancially successful, because

Microsoft has come back with

the sequels: Windows Enter

tainment Pack Two and Win

dows Entertainment Pack

Three (WEP2 and WEP3). Fur

thermore, Symantec has

joined in with the Symantec

Game Pack, which has the

same concept but brings to

the form a style of its own.

i can safely say that no

games have ever been

played by so many people for

so many hours in my house.

Part of the reason is the Win

dows environment itself. That

friendly tabletop has a warm,

familiar sense

of clutter that

reminds every

body of sitting

around the

kitchen table.

You get a

window full of

great games,

and most im

portantly, the

games them

selves are like

Windows—very

friendly, simple

to use, kind of

fun just to hang around with.

The Symantec games, in fact,

are downright familiar, since

they're the games we all

played as school kids. For in

stance, there's a pretty good

Hangman (you can select cat

egories like states or cities or

computer companies), and

there's also an excellent ver

sion of Mastermind called

Code Breaker. Memory

Blocks is an attractive version

of Concentration. My wife and

I have found that you can play

well only once a day. Your

score gets worse every time

you play, because you keep

remembering where objects

were in the games you played

previously.

In the familiar Smart Dots,

you first draw rows and col

umns of dots and then try to

combine them to make

squares. The Symantec set in

cludes enjoyable versions of

Jacks and Pickup Sticks, both

of which will give your mouse

a serious workout.

The Microsoft packs have

the usual mix of solitaire card

games and tile puzzles, a li

censed version of Pipe

Dream, and even some simple

action games—golf, skiing,

and some arcade-style

games like the one where you

maneuver an ever-growing

snake through a maze and a

cat-and-mouse chase-and-

strategy game. Every one of

them is fun, and some of them

are brilliant. FreeCell, for exam

ple, is simply the best single

solitaire game I've ever

played. It would be a pain to

play with real cards, but the pro

grammers have made the

card handling smooth and

easy. These entertainment

packages prove that there's

room in the world for games

that don't give you frantic dead

lines and that don't take place

in a kill-or-be-killed world.

Oh, there are problems

here and there. Most of us

have pretty much given up on

Pipe Dream; at the higher lev

els, the game occasionally

gives you screens that can't

be won because the starting

or finishing pipe unit is block

ed by an immovable obstacle.

And the word game WordZap

(kind of a high-tech Boggle) is

marred by a second-rate dic

tionary: It refuses to allow

three- and four-letter words

that every Scrabble player

knows. It's frustrating to lose to

the computer because it

doesn't know that fey and fay

are words, for instance.

Nothing is perfect, but I want

to emphasize that the glitches

here are few and far between.

Until you can lay your hands

on a fast 486 with a graphics

accelerator to make Windows

handle real animation, these

games are worth opening the

window to see. D
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fhe watchwords 
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Windows games 
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A DIFFERENT 
KIND OF GAME 
Let's face it-the Windows en· 
vironment hasn't exactly been 
a gamer"s paradise. It's a mat­
ter of s-p-e-e-d-Windows 
doesn't have anyl 

Admittedly, on a 486 ma­
chine with a graphics 
coprocessor and 8MB of 
RAM, Windows can run any 
game fast enough for fun. But 
even on this Mother of All Ma­
chines, which we use for all 
the serious apptications (like 
typesetting and playing Mon-

key Island 2), it still takes a no­
ticeable amount of time to re­
draw the screen and shift from 
one view to another. And 
that's deadly for action and sto­
ry games. 

But that doesn't mean there 
can't be good games for Win­
dows. They just have to be 
games of a different kind . Mi­
crosoft itself pointed Ihe way 
with the first Windows Entertain­
ment Pack (WEP). The con­
cept was simple and obvious. 
(All good ideas are obvious 
once somebody has thought 
of them.) Develop a bunch of 
small games that are graphical­
ly simple or that can be 
played in a slow environment, 
package them together, and 
sell the whole caboodle for an 
irresistible price. 

The first Windows Entertain­
ment Pack must have been fi-

nancia"y successful, because 
Microsoft has come back with 
the sequels: Windows Enter­
tainment Pack Two and Win­
dows Entertainment Pack 
Three (WEP2 and WEP3). Fur­
thermore , Symantec has 
joined in with the Symantec 
Game Pack, which has the 
same concept but brings to 
the form a style of its own. 

I can safely say that no 
games have ever been 
played by so many people for 
so many hours in my house. 
Part of the reason is the Win­
dows environment itself. That 
friendly tabletop has a warm, 

familiar sense 
of clutter that 
reminds every­
body of sitting 
around the 
kitchen table. 

You get a 
window fu ll of 
great games, 
and most im­
portantly, the 
games them­
selves are like 
Windows-very 
friendly, simple 
to use, kind of 

fun just to hang around with. 
The Symantec games, in fact, 
are downright familiar, since 
they're the games we all 
played as school kids. For in­
stance, there 's a pretty good 
Hangman (you can select cat­
egories like slates or cities or 
computer companies) , and 
there's also an excellent ver­
sion of Mastermind called 
Code Breaker. Memory 
Blocks is an attractive version 
of Concentration. My wife and 
I have found that you can play 
well only once a day. You r 
score gets worse every time 
you play, because you keep 
remember ing where objects 
were in the games you played 
previously. 

In the familiar Smart Dots, 
you first draw rows and col­
umns of dots and then try to 
combine them to make 

squares. The Symantec set in­
cludes enjoyable versions of 
Jacks and Pickup Sticks, both 
of which will give your mouse 
a serious workout. 

The Microsoft packs have 
the usual mix of solitaire ca rd 
games and tile puzzles, a li­
censed version of Pipe 
Dream, and even some simple 
action games-golf, skiing, 
and some arcade-style 
games like the one where you 
maneuver an ever-g rowing 
snake through a maze and a 
cat-and-mouse chase-and­
strategy game. Everyone of 
them is fun , and some of them 
are brilliant. FreeCell, for exam­
ple, is simply the best single 
solitaire game I've ever 
played. It would be a pain to 
play with real cards, but the pro­
grammers have made the 
card handling smooth and 
easy. These entertainment 
packages prove that there's 
room in the world for games 
that don't give you frantic dead­
lines and that don' t take place 
in a ki"-or-be-killed world . 

Oh, there are problems 
here and there. Most of us 
have pretty much given up on 
Pipe Dream; at the higher lev­
els, the game occasionally 
gives you screens that can't 
be won because the starting 
or finishing pipe unit is block­
ed by an immovable obstacle. 
And the word game WordZap 
(kind of a high-tech Boggle) is 
marred by a second-rate dic­
tionary : It refu ses to allow 
three- and four-letter words 
that every Scrabble player 
knows. It's frustrating to lose to 
the computer because it 
doesn't know that fey and fay 
are words, for instance. 
Nothing is perfect, but I want 
to emphasize that the glitches 
here are few and far between. 
Until you can lay your hands 
on a fast 486 with a graphics 
accelerator to make Windows 
handle real animation, these 
games are worth opening the 
window to see. 0 
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he Crisis

Giant insect-like creatures are

ireatening the survival of our planet,

irst they nAi?d us from space. Now

fiental Space Fighter (codename:

IS). Our first world government,

f Earth (F.O.E.) developed it to fight

enemy.' Now they're looking for

leone .to fly if — in combat.

A Fighter Pilot's Dream

It's up to you to avenge Earth. You'll

fly the MANTIS, a high-tech wonder

armed with futuristic firepower.

The Sirians aren't your run-of-the-mill insect

aliens. Individually, they're powerless pests,

but together they form .a powerful collective

that can "oblit .e human r

State of the Art 3-D

ANTIS in thrilling, realistic 3-D

ant graphics, cinematic digitized

lents, chilling sound effects, and a

I musical score add to the adventure.

Saving the planet from destructions no small

chore. The Sirians are returning to finish what

they began. Are you up to the challenge?

Marketed by MicroPros^

iWes. For the latest infm^fon on release dates and
" ■12-838-1173,9srTi to 5rim FST,w<---.[|-!v

Coming Soon: MegaTraveller3and Spellbound: Challenge of the Five Realms
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Multimedia
ARTICLE

BY GREGG KEIZER

WHAT IS THIS THING CALLED

MULTIMEDIA?

AND WHAT WILL IT DO FOR

ENTERTAINMENT?

IS
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ultimedia gets tossed around

like a chip of ice in the North

Atlantic, bandied about by

PR drones who know it on

ly as a hot button that's supposed to

make entertainment-software consum

ers salivate. But don't be intimidated:

you already know multimedia.

If you're playing PC games that

have been produced in the last cou

ple of years, they're probably full of

multimedia: still images, animated

graphics, sound effects, sweeping mu

sical scores, even human-sounding

speech. When you use multimedia as

an adjective today, though, you

mean all that and a little more. The

term refers to an integrated presenta

tion that includes massive numbers of

images, herky-jerky video clips, soar

ing stereophonic music, and plenty of

digitized speech. More often than not.

the presentation comes on a compact

disc, not a floppy.

In fact. MPC (Multimedia Personal

Computer), the single established mul

timedia hardware'software standard,

relies on the compact disc, among oth

er requirements. So while multimedia

may be a burning buzzword, it's real

ly nothing more than another step

down the same entertainment road

you've been traveling all along.

Still, you're probably not prepared

for the multimedia game titles that

will straggle onto the shelves this

year. To keep up with the technolog

ical times, you need to beef up your

home PC. Assuming you have a

386SX or 386 equipped with 2MB-



4MB of RAM, VGA or Super VGA, and

a hard disk in the 40MB-80MB range,

you'll spend $600-$1,200 to make it

multimedia-ready.

The most expensive add-on is a CD-

ROM drive. Multimedia of all kinds,

games included, needs the storage

space that only a compact disc—with

more than 600MB—provides.

Once priced at stratospheric levels,

CD-ROM drives now are much more af

fordable. One of the lowest-priced is

Tandy's CDR-1000, a $400 internal

drive that's fairly easy to install yourself.

An external drive is a possibility, too, if

your PC doesn't have an empty drive

bay or if you don't mind losing a bit of

desktop real estate. A good choice

here is the Sony Laser Library, a drive-

and-software combination that features

an external Sony CD-ROM drive and

six CD-ROM titles; the Laser Library typ

ically costs around $600.

As you look for a CD-ROM drive, re

member that many {but not all) of

1992's multimedia entertainment pro

grams will sport the MPC logo. Only

MPC-compatible drives are guaran

teed to play MPC-labeled software.

The Tandy CDR-1000 meets MPC

specs, for example, while the Sony

CDU-535 included in the Laser Library

doesn't (though the Sony CDU-541 in

ternal drive is MPC-ready).

An MPC CD-ROM drive will run MPC

and non-MPC multimedia CD titles,

while a non-MPC CD-ROM drive re

stricts you to DOS multimedia CDs.

While the future of MPC isn't guaran

teed, Microsoft's interest and backing

can't be ignored. Whether MPC suc

ceeds or fails is a matter that will be de

cided by PC users as a whole, but by

sticking with MPC-compatible compo

nents, you're covering all bets. If MPC

takes off, you're ready. If it doesn't,

your PC will still be able to run DOS

CD multimedia titles.

Final verdict? The smart move is to

get an MPC-compatible CD-ROM

drive for your computer.

Sound On!
Your second major multimedia addition

is a sound card. Something has to

pump out the stereo sound effects, mu

sical scores, and voice-overs.

If your PC sounds off with an Ad Lib

audio board, one of the two de facto

standards in PC audio, yank it out. It

just can't carry the tunes and speech

that developers are cramming on com

pact disc-based multimedia games. If

your system includes a Sound Blaster

board, the other current standard,

you're safe—for now.

What if you haven't made the move

to audio or you settled for a pre-Gold

Ad Lib? Then you can choose from a va-
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riety of audio cards, including Sound

Blaster Pro, Ad Lib Gold 1000, and the

new 16-bit Media Vision Pro AudioSpec-

trum and Ad Lib Gold 2000 boards.

All are more expensive than previ

ous-generation cards, but as a rule,

they are easier to install, they sound bet

ter, and they include more features. AI!

four meet MPC specifications, in that

they're capable of producing digitized

speech and can be connected to MIDI

equipment (the latter's for creating mul

timedia presentations of your own, not

for gamepi ay).

Only two of these boards offer 16-

bit sound: the Media Vision and the Ad

Lib Gold 2000 cards. You can't get 16-

bit sound from any of the current up

grade kits. The next jump in PC audio

will be 16-bit sound, so while all the

cards satisfy current multimedia

needs, only two are ready for the future

of multimedia. The others will do for the

next couple of years, though, as pub

lishers stretch to take advantage of

their features. Keep this in mind as you

decide how much to spend for sound

on your multimedia system.

One thing you can safely buy is a

pair of self-amplified speakers to put be

side your PC. Headphones handle mul

timedia sound, of course—every audio

board includes a headphone jack—

but you'll find the experience much

more comfortable and natural when

the roar of dragons and the wail of the

wounded come out of larger speakers.

After all, you don't watch television

with headphones on, do you?

Self-amplified speakers—some

made expressly for PCs, some not—

are available from a variety of sources.

Both Radio Shack and Bose market

excellent powered speaker systems.

Put Card A in Slot B
The quickest way to move up to multi

media entertainment is with an up

grade kit. Several companies sell

these all-in-one collections of CD-ROM

drive, interface card, audio board, con

necting cables, and Microsoft Win

dows 3.1 with multimedia functionality.

All you add is your home PC.

The adventurous will strike out on

their own and patch together a multime

dia game-playing machine by grabbing

a CD-ROM drive here and a sound

card there. That much work isn't worth it

for most. Nor is it a big money saver.

The fact is that a package like Me

dia Vision's Multimedia PC Upgrade Kit

is hard to turn down. Although it lists at

nearly $1,000, most mail-order dealers

PRODUCT INFORMATION

Ad Lib Gold 1000

$299.95

Ad Lib Gold 2000

$399.95

Ad Lib

220 Grande-Ai!e E, Ste. 850

Quebec City, PQ

Canada G1R2J1

(800) 463-2686

Where in the World is Carmen

Sandiego?, Deluxe CD-ROM
■RflQ qc;

Br0derbund

500 Redwood Blvd.

NovatO, CA 94948-6162

(800) 521-6263

CompuAdd Multimedia Upgrade Kit

$1,069.00 (internal CD-ROM drive)

$1,295-00 (external CD-ROM drive)

$425.00 (kit without CD-ROM drive)

CompuAdd

12303 Technology Bivd.

Austin, TX 78727

(800) 627-1967

Sound Blaster Multimedia Upgrade Kit

$849.95 (internal CD-ROM drive)

$949.95 (external CD-ROM drive)

Sound Blaster Pro

$299.95

Creative Labs

1901 McCarthy Blvd.

Mtlpitas, CA 95035

(408) 428-6600

BattieChess MPC

$79.95

Interplay

3710 S. Susan, Ste. 100

Santa Ana, CA 92704

(800) 969-4263

Multimedia PC Upgrade Kit

$995.00

Pro AudioSpectrum

$389.00

Media Vision

47221 Fremont Blvd.

Fremont, CA 94538

(800) 845-5870

King's Quest V-CD

$69.95

Sierra On-Line

P.O. Box 485

Coarsegold, CA 93614

(800) 326-6654

Sony Laser Library

$699.95

Sony

655 River Oaks Pkwy.

San Jose, CA 95134

(800) 222-0878

CDR-1000 CD-ROM Drive

$399.95

Tandy

700 One Tandy Center

Ft. Worth, TX 76102

(817)390-3011

4MB of RAM, VGA or Super VGA, and 
a hard disk in the 40MB-BOMB range, 
you'l l spend $600-$1,200 to make it 
multimedia-ready. 

The most expensive add-on is a CD­
ROM drive . Multimedia of all kinds , 
games included , needs the storage 
space that only a compact disc-with 
more than 600MB-provides. 

Once priced at stratospheric levels, 
CD-ROM drives now are much more af­
fordable. One of the lowest-priced is 
Tandy's CDR-lOOO, a $400 internal 
drive that's fairly easy to install yourself. 
An external drive is a possibility, too, if 
your PC doesn' t have an empty drive 
bay or if you don' t mind losing a bit of 
desktop real estate . A good choice 
here is the Sony Laser Library, a drive­
and-software combination that features 
an external Sony CD-ROM drive and 
six CD-ROM titles; the Laser Library typ­
ically costs around $600. 

As you look for a CD-ROM drive, re­
member that many (but not al l) of 
1992's multimedia entertainment pro­
grams will sport the MPC logo. Only 
MPC-compatible drives are guaran­
teed to play MPC-Iabeled software. 
The Tandy CDR-lOOO meets MPC 
specs, for example, while the Sony 
CDU-535 included in the Laser Library 
doesn't (though the Sony CDU-541 in­
ternal drive is MPC-ready). 

An MPC CD-ROM drive will run MPC 
and non-MPC multimedia CD titles, 
while a non-MPC CD-ROM drive re­
stricts you to DOS multimedia CDs. 
While the future of MPC isn't guaran­
teed , Microsoft's interest and backing 
can't be ignored. Whether MPC suc­
ceeds or fails is a matter that will be de­
cided by PC users as a whole, but by 
sticking with MPC-compatible compo­
nents, you're covering all bets. If MPC 
takes off, you 're ready. If it doesn't, 
your PC will still be able to run DOS 
CD multimedia titles. 

Final verdict? The smart move is to 
get an MPC-compatible CD-ROM 
drive for your computer. 

Sound On! 
Your second major multimedia addition 
is a sound card. Something has to 
pump out the stereo sound effects, mu­
sical scores, and voice-overs. 

If your PC sounds off with an Ad Lib 
audio board, one of the two de facto 
standards in PC audio, yank it out. It 
just can 't carry the tunes and speech 
that developers are cramming on com­
pact disc-based multimedia games. If 
your system includes a Sound Blaster 
board, the other current standard, 
you're safe-for now. 

What if you haven't made the move 
to audio or you settled for a pre-Gold 
Ad Lib? Then you can choose from a va-
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riety of audio cards, including Sound 
Blaster Pro, Ad Lib Gold 1000, and the 
new 16-bit Media Vision Pro AudioSpec­
trum and Ad Lib Gold 2000 boards. 

All are more expensive than previ­
ous-generation ca rds , but as a rule , 
they are easier to install, they sound bet­
ter, and they include more features. All 
four meet MPC specifications, in that 
they 're capable of producing digitized 
speech and can be connected to MIDI 
equipment (the laUer's for creating mul­
timedia presentations of your'own , not 

. for gameplay). 
Only two of these boards offer 16-

bit sound: the Media Vision and the Ad 
Lib Gold 2000 cards. You can't get 16-
bit sound from any of the current up­
grade kits. The next jump in PC audio 
will be 16-bit sound, so while all the 
cards satisfy current multimed ia 
needs, only two are ready for the future 
of multimedia. The others will do for the 
next couple of years, though, as pub­
lishers stretch to take advantage of 
their features. Keep this in mind as you 
decide how much to spend for sound 
on your multimedia system. 

One thing you can safely buy is a 
pair of self-amplified speakers to put be­
side your PC. Headphones handle mul­
timedia sound, of course--€very audio 

board includes a headphone jack­
but you'll find the experience much 
more comfortable and natural when 
the roar of dragons and the wail of the 
wounded come out of larger speakers. 
After all , you don ' t watch television 
with headphones on, do you? 

Self-amplified speakers-some 
made expressly for PCs, some not­
are available from a variety of sources. 
Both Rad io Shac k and Bose market 
excellent powered speaker systems. 

Pul Cord A in 5101 B 
The quickest way to move up to multi­
media entertainment is with an up­
grade kit. Several companies sell 
these all -in-one collections of CD-ROM 
drive, interface card, audio board, con­
nec ting cables, and Microsoft Win­
dows 3.1 with multimedia functionality. 
All you add is your home PC. 

The adventurous will str ike out on 
their own and patch together a multime­
dia game-playing machine by grabbing 
a CD-ROM drive here and a sound 
card there. That much work isn't worth it 
for most. Nor is it a big money saver. 

The fact is that a package like Me­
dia Vision's Multimedia PC Upgrade Kit 
is hard to turn down. Although it lists at 
nearly $1 ,000, most mail-order dealers 

Ad Lib Gold 1000 
$299.95 

PRODUCT INFORMATION 
BattleChess MPC 
$79.95 

Ad Lib Gold 2000 
$399.95 
Ad Lib 
220 Grande-Aile E, Ste. 850 
Quebec City, PQ 
Canada G 1 R 2J1 
(800) 463-2686 

Where In the World Is Carmen 
Sandlego?, Deluxe CD-ROM 
$89.95 
8r0derbund 
500 Redwood Blvd. 
Novato, CA 94948-6162 
(800) 521 -6263 

CompuAdd Multimedia Upgrade Kit 
$1,069.00 (internal CD-ROM drive) 
$1,295.00 (external CD-ROM drive) 
$425.00 (kit without CD-ROM drive) 
CompuAdd 
12303 Technology Blvd. 
Austin, TX 78727 
(800) 627-1967 

Sound Blaster Multimedia Upgrade Kit 
$849.95 (internal CD-ROM drive) 
$949.95 (external CD-ROM drive) 
Sound Blaster Pro 
$299.95 
Creative Labs 
1901 McCarthy Blvd. 
Milpitas, CA 95035 
(408) 428-6600 

Interplay 
3710 S. Susan, Ste. 100 
Santa Ana, CA 92704 
(800) 969-4263 

Multimedia PC Upgrade Kit 
$995.00 
Pro AudioSpectrum 
$389.00 
Media Vision 
47221 Fremont Blvd. 
Fremonl, CA 94538 
(800) 845-5870 

King's Quest V-CD 
$69.95 
Sierra On-Line 
P.O. Box 485 
Coarsegold, CA 93614 
(800) 326-6654 

Sony Laser Library 
$699.95 
Sony 
655 River Oaks Pkwy. 
San Jose, CA 95134 
(800) 222-0878 

CDR-1000 CD-ROM Drive 
$399.95 
Tandy 
700 One Tandy Center 
Ft. Worth, TX 76102 
(817) 390-3011 
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"A SUPERHERO TO COLLECT"

Adventure? Animation?

Sound? What is this

soma kinda' game?

—N.Y. Times

"...make way for

Lance Stone, future

hero of electronic pop

literature."
—Marketing Computers

"Its cliff-hanger

ending leaves you

itching for more."

—Business Week

PC Comix Inc.

400 Williamson Way

A5hland, OR 97520

(800) 944-0181

$20 plus Shipping
(shipping S3 U.5, 55 foreign)

IBM/VQA/640K

Lance 5tone and hyperComix

are trademarks of PC Comix Inc.

Circle Reader Service Number 196

ew tronflL MPUTE
TheOffidalGuideTo

Sid Meier's

CIVILIZAT

r

Here's the official guide to the

latest simulation from best-

selling game designer, Sid

Meier. Author Keith Ferrell has

worked closely with Sid Meier

and includes insider information,

hints, strategies, and back

ground information that enhanc

es and complements the simula

tion. This is the most readable,

information-packed guide to Civ

ilization, Ferrell is editorial direc

tor of COMPUTE magazine and

editor of OMNi magazine. He is

the author of scores of maga

zine articles and the author of

several books, including the re

cently released Big Book of PC

Sports.

To order your copy send $14.95 plus

$2 shipping and handling U.S. ($4

Canada, $6 other) to COMPUTE

Books, c/o CCC, 2500 McClellan Ave.. Pennsauken, NJ 08109. (Residents of NC,

N J, and NY please add appropriate sales tax; Canadian orders add 7% Goods and

Services Tax.)

All orders must be paid in U.S. funds drawn on a U.S. bank. Orders will be shipped via UPS Ground Service.

Otfer good while supplies las!.

Kdtlift-rrdl

T3teAuthoritative Guide

sell it for around $750. Included in the

Upgrade Kit are a Sony CDU-541 exter

nal CD-ROM drive, a Pro AudioSpec-

trum sound card that doubles as the

SCSI interface card, Windows with Mul

timedia Extensions, and two CD titles.

Fill an empty slot with the Pro Audio-

Spectrum and an empty drive bay

with the CDU-541, and inside an hour,

your PC's ready to play CD games.

Other companies promise similar

feats of computer transformation. Com-

puAdd, Creative Labs (Sound Blaster),

Tandy, and Video Seven are four

more sources for multimedia upgrade

kits. Each relies on its own pairing of

sound board and CD-ROM drive, but

in the end, any one of them makes

your PC a multimedia game machine.

That's a Lot of Quarters, Pal
For all the ease with which you can

turn your current PC into a multimedia

game player, though, the biggest ques

tion still hasn't been asked.

Is the price you pay for the move to

multimedia worth it? After all, that

much money translates into 15-20 top-

priced PC games or a lot of quarters

down at the mall arcade.

Whether the price is a bargain de

pends on how badly you want to lead

the charge into multimedia games.

It's unlikely that you'll see more than

a couple of dozen CD and/or MPC

games through the end of 1992. A

scant few have made it out developers'

doors so far—BattleChess, Where in

the World is Carmen Sandiego?, and

King's Quest V, for starters—and the

trickle won't turn into a flood anytime

soon, And PCs won't even be the only

place you can play CD games. Video

game decks from Sega and Nintendo

will get CD capability either late this

year or early next.

On the positive side, remember that

a multimedia computer can do more

than play games. It'll run any CD title,

whether a reference work for the

home office or an educational disc for

the kids. And it'll keep working hard

with word processors, page-layout soft

ware, spreadsheets, and databases.

The bottom line for multimedia enter

tainment is fuzzy. If you want to stay

state-of-the-art and can't bear to miss

even the beginning of the most amaz

ing home entertainment since VGA col

or met PC games, go multimedia now.

If you can bide your time, do so; when

an irresistible game comes along, you

can upgrade quickly and easily.

Clearly, computers are headed for a

more integrated way of dealing with

sound, speech, and moving images.

Whether that trend makes its way into

your house depends on how important

games are to you and your family. G
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- ... make way for 
Lance Stone, future 
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-Business Week 
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Here's the official guide to the 
latest simulation from best­
selling game des igner, Sid 
Meier. Author Keith Ferrell has 
worked closely with Sid Meier 
and includes insider information, 
hints , strategies, and back­
ground information that enhanc­
es and complements the simula­
tion . This is the most readable, 
information-packed guide to Civ­
ilization. Ferrell is editorial direc­
tor of COMPUTE magazine and 
editor of OMNI magazine. He is 
the author of scores of maga­
zine articles and the author of 
several books, including the re­
cently released Big Book of PC 
Sports. 

To order your copy send $14.95 plus 
$2 shipping and handling U.S. ($4 
Canada. $6 other) to COMPUTE 

Books. clo CCC. 2500 McClellan Ave .. Pennsauken, NJ O8t09. (Residents of NC, 
NJ, and NY please add appropriate sales tax: Canadian orders add 7% Goods and 
Services Tax.) 
All orders must be paid in U.S. funds drawn on a U.S. bank. Orders will be shipped via UPS Ground Service. 
Oller good while supplies lasl. 
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sell it for around $750. Included in the 
Upgrade Kit are a Sony CDU-541 exter­
nal CD-ROM drive, a Pro AudioSpec­
trum sound card that doubles as the 
SCSI interface card, Windows with Mul­
timedia Extensions, and two CD titles. 
Fill an empty slot with the Pro Audio­
Spectrum and an empty drive bay 
with the CDU-541 , and inside an hour, 
your PC's ready to play CD games. 

Other companies promise similar 
feats of computer transformation. Com­
puAdd, Creative Labs (Sound Blaster), 
Tandy, and Video Seven are four 
more sources for multimedia upgrade 
kits. Each relies on its own pairing of 
sound board and CD-ROM drive, but 
in the end , anyone of them makes 
your PC a multimedia game machine. 

That's a Lat af Quarters, Pol 
For all the ease with which you can 
turn your current PC into a multimedia 
game player, though, the biggest ques­
tion still hasn't been asked. 

Is the price you pay for the move to 
multimedia worth it? After all , that 
much money translates into 15-20 top­
priced PC games or a lot of quarters 
down at the mall arcade. 

Whether the price is a bargain de­
pends on how badly you want to lead 
the charge into multimedia games. 

I!'s unlikely that you'll see more than 
a couple of dozen CD and/or MPC 
games through the end of 1992. A 
scant few have made it out developers' 
doors so far-BattleChess, Where in 
the World is Carmen Sandiego?, and 
King's Quest V, for starters-and the 
trickle won't turn into a flood anytime 
soon. And PCs won't even be the only 
place you can play CD games. Video­
game decks from Sega and Nintendo 
will get CD capability either late this 
year or early next. 

On the positive side, remember that 
a multimedia computer can do more 
than play games. It'll run any CD title, 
whether a reference work for the 
home office or an educational disc for 
the kids . And it'll keep working hard 
with word processors, page-layout soft­
ware, spreadsheets, and databases. 

The bottom line for multimedia enter­
tainment is fuzzy. If you want to stay 
state-of-the-art and can't bear to miss 
even the beginning of the most amaz­
ing home entertainment since VGA col ­
or met PC games, go multimedia now. 
If you can bide your time, do so: when 
an irresistible game comes along, you 
can upgrade quickly and easily. 

Clearly, computers are headed for a 
more integrated way of dealing with 
sound, speech, and moving images. 
Whether that trend makes its way into 
your house depends on how important 
games are to you and your fami ly. 0 



64/128 VIEW
Mad Man Software is a new company with

a new adventure game for the 64. Its average

playing time is between 200 and 400 hours.

Tom Netsel

The rat looked as big as

a Volkswagen, and it

was charging straight at

our hero. Outrunning

such a creature was impos

sible. His only chance was

to stand and fight, a pitifully

small sword his only weap

on. He drew it and took a

swing at the rampaging ro

dent. Would the rat engulf

him, or would his puny blow

strike home?

As we held our breaths

awaiting the outcome, it

took a minute before we re

alized that nothing had hap

pened. The rat was still

there, our hero was stilt

there, but the screen had fro

zen. Our first encounter with

the game's first monster,

and the program locked up.

This was one of those embar

rassing moments that can oc

cur when a software repre

sentative demonstrates his

company's latest product.

Reboot. Try again. Same

thing. Groan! I was feeling

sorry for Gene Barker. He's

a recent graduate from the

Colorado School of Mines

who'd flown to North Caroli

na from Colorado to show

the Gazette staff Messiah III:

Nemisis, an adventure

game for the 64 that he's

been developing for almost

six years. Now, when the

game's lead character aims

his first blow at the very first

monster, years of program

ming grind to a halt.

Wait a minute! This 128

has a defective SID chip,

and the program relies on

one of the computer's voic

es to generate random num

bers to help decide a bat

tle's outcome. The pro

gram's in a loop, waiting for

a random number to ap

pear, and that chip is as si

lent as Harpo Marx! We

could be here until Godzilla

comes home. Let's go

down the hall and try anoth

er machine.

As I said, when someone

comes all this way to demon

strate a major new release

for the 64, you want things

to go well After all, there's

not exactly a flood of new ti

tles sweeping that market

these days. In fact, it would

take a madman to start a

new company aimed at de

veloping software for that vet

eran market. And that's just

what Barker and ten associ

ates have done. Their com

pany is called Mad Man Soft

ware (7610 West 5th Ave

nue, Suite 200, Lakewood,

Colorado). For the past

year, they've been polishing

Barker's game, and

Messiah III should be ready

by this fall or Christmas.

Messiah III is no light

weight arcade adventure,

as we saw when we ran it

on another machine. We

were treated to a richly de

tailed adventure game

that's the first of a six-game

saga. Messiah III, which

should sell for around $60,

consists of more than one

megabyte of code. That's

six disk sides. Disk access

times have been reduced,

however, so that the longest

load should take no more

than 12 seconds.

While we await the final

version for review, Barker esti

mates the average playing

time will take between 200

and 400 hours. When many

new games are measured

in megabytes, Barker

doesn't feel the 64's memo

ry constraints have placed

limits on his creativity. "It's

the game's design which dic

tates its power," he says,

"not the machine." O

GAZETTE
64/128 VIEW

Anybody who'd start a new company based on

adventure game for the 64 must be a madmar

that's just what Gene Barker and friends have

By Tom Netsel.
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64/128 VIEW 
Mad Man Software is a new company with 
a new adventure game for the 64. Its average 
playing time is between 200 and 400 hours. 

Tom Netsel 

The rat looked as big as 
a Volkswagen, and it 
was charging straight at 
our hero. Outrunning 

such a creature was impos­
sible. His only chance was 
to stand and fight, a pitifully 
small sword his only weap­
on . He drew it and took a 
swing at the rampaging ro­
dent. Would the rat engulf 
him, or would his puny blow 
strike home? 

As we held ou r breaths 
awaiting the outcome, it 
took a minute before we re­
alized that nothing had hap­
pened . The rat was stil l 
there, ou r hero was stil l 
there, but the screen had fro­
zen. Our fi rst encounter with 
the game 's first monster, 
and the program locked up. 
This was one of those embar­
rassing moments that can oc­
cur when a software repre­
sentative demonstrates his 
company's latest product. 

Reboot. Try again. Same 
thing. Groan! I was feeling 
sorry for Gene Barker. He's 
a recent graduate from the 
Colorado School of Mines 
who'd flown to North Caroli­
na from Colorado to show 
the Gazette staff Messiah III : 
Nemisis, an adventure 
game for the 64 that he's 
been developing for almost 
six years. Now, when the 
game's lead character aims 
his first blow at the very first 
monster, years of program­
ming grind to a halt. 

Wait a minute! Th is 128 
has a defective SID chip, 
and the program rel ies on 
one of the computer's voic­
es to generate random num­
bers to help decide a bat­
tle's outcome. The pro­
gram's in a loop, waiting for 
a random number to ap­
pear, and that chip is as si­
lent as Harpo Marx! We 

could be here until Godzilla 
comes home. Let 's go 
down the hall and try anoth­
er machine. 

As I said , when someone 
comes all th is way to demon­
strate a major new release 
for the 64 , you want things 
to go well. After all, there 's 
not exactly a flood of new ti­
tles sweeping that market 
these days. In fact, it would 
take a madman to start a 
new company aimed at de­
veloping software for that vet­
eran market. And that 's just 
what Barker and ten associ­
ates have done. Their com­
pany is called Mad Man Soft­
ware (7610 West 5th Ave­
nue, Suite 200, Lakewood, 
Colorado) . For the past 
year, they've been polishing 
Barker's game, and 
Messiah III should be ready 
by this fall or Christmas. 

Messiah III is no light­
weight arcade adventure, 
as we saw when we ran it 
on another machine. We 
were treated to a richly de­
tai led adventure game 
that's the first of a six-game 
saga. Messiah III, which 
should sell for around $60, 
consists of more than one 
megabyte of code. That 's 
six disk sides. Disk access 
times have been reduced , 
however, so that the longest 
load should take no more 
than 12 seconds. 

While we await the fina l 
version for review, Barker esti­
mates the average playing 
time will take between 200 
and 400 hours. When many 
new games are measured 
in megabytes, Barker 
doesn't feel the 64's memo­
ry constraints have placed 
limits on his creativity. "It 's 
the game's design which dic­
tates its power, " he says, 
"not the machine. " 0 
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FEEDBACK

Questions and

answeis about time,

word processors,

modems, programming

languayes, and MIDI

INPUT Time
Is there a way to change the

value of TIS by using an IN

PUT statement from within a

BASIC program?

KARL ROSEMANN

DENVER. CO

Try the following line in your

program. It should do the

trick nicely.

10 INPUT "NEW TIME"; Tl$

When the program runs and

you see the INPUTprompt, en

ter your response with six dig

its in an HHMMSS format. HH

equals hours, MM equals min

utes, and SS equals seconds.

For example, 123456 will set

TIS to read 12:34:56. If you en

ter more or fewer digits, you'll

get an ILLEGAL QUANTITY

message. If the number is

greater than 23:59:59, the

clock resets to 00:00:00.

Bug-Swatter
The ending address of File

Lord (May 1992) is incorrect.

The correct address is 14C0.

This affects MLX only and not

the File Lord program. We pre

pared the listing after the doc

umentation, and it was then

that we noticed how long the

program was. To make it eas

ier to type in, we compressed

the program with Mega-

Squeeze but neglected to

change the ending address.

The compression program

may have affected the way

the program starts. If you

type RUN and get a READY

message, simply type RUN

again, and File Lord should

start. The program on Ga

zette Disk wasn't affected.

80-Column Word Processor
Is there a word processor for

the 64 that has a true 80-col-

umn screen? I am looking for

one that's like the 128 or IBM,

not a 40-column screen such

as GEOS, which scrolls to re

veal 80 columns. I am not look

ing for one that simply has a

preview screen either. Is

there one that exists with this

feature?

JON PERSINGER

INDIANAPOLIS. IN

You might try Script 64, pub

lished by Richvale Telecommu

nications of Canada. To the

best of my knowledge, howev

er, that company is no longer

in business. You might locate

a used copy of the program

for about $9 at Bare Bones

Software, 940 4th Avenue,

Suite 222, Huntington, West

Virginia 25701, (800) 638-

1123. Call or write for a free

catalogue of used 64 and

128 software. They also carry

Amiga products. Supplies are

limited, so check with the com

pany before ordering.

Modem Woes
I have a 64 with an Aprotek

12C modem used as a Volks

6480. I would like to play mo

dem games with a friend, but

I need the originate and an

swer codes that will corre

spond with my friend's Com

modore 1670 modem. I can't

find this information in the man

ual. Can you supply me with

these codes?

MARTIN BOUTIN

LONGUEUIL. PQ

CANADA

Your modem, which can be

used as a Volks 6480, is no

longer in production, but you

should have no problem us

ing it to connect with your

friend. It requires no special

originate or answer codes or

settings. It's Hayes compati

ble in that it supports automat

ic answering (ATA) and auto

matic dialing (ATDT) com

mands, just as your friend's

1670 does. You should be

able to contact each other

just as easily as you can con

nect with a local BBS.

Check the terminal or

game software you're using

for requirements specific to

that program. It may require

manual dialing or answering.

Also check the echo or du

plex modes to make sure you

both can see what each of

you is typing. If you still think

the modem is at fault, call

Aprotek's service department

at (503) 582-2118 from 8:00

a.m. to 4:30 p.m. Pacific time

on weekdays.

Pascal Wanted
I am currently taking a

course in Pascal at high

school, using Turbo Pascal

on a Macintosh. I have a 64

at home, and I would like to

use Pascal with it. Is there

such a compiler and where

can I obtain it?

MIKE SMITH

CRYSTAL. MN

Contact Abacus, 5370 52nd

Street SE, Grand Rapids, Mich

igan; (800) 451-4319, and

ask about Super Pascal 64

($19.95). It implements the

full Jensen & Wirth compiler

plus extensions for graphics.

It has a complete source file

editor, a full assembler, and a

utility package.

MIDI Info
I am interested in music and

would like to get into MIDI. Is

there a MIDI system available

for the 64?

EDNA WILLIAMS

BRIDGEPORT, CT

Contact Dr. T's Music Soft

ware, 100 Crescent Road,

Needham, Massachusetts

02194; (617) 455-1454, and

ask for its free catalog of

MIDI hardware and software.

Dr. T offers a 64 MIDI starter

pack that includes its Key

board Controlled Sequencer,

a MIDI interface, and two

MIDI cables for $180. A ver

sion for the 128 retails for

$275. You'll have to supply

your own MIDI keyboard or

other MIDI instrument. D
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INPUT Time 
Is there a way to change the 
value of TI$ by using an IN­
PUT statement from within a 
BASIC program? 
KARL AQSEMANN 
DENVER, CO 

Try the following line in your 
program. It should do the 
trick nicely 

10 INPUT " NEW TIME"; Tt$ 

When the program runs and 
you see the INPUT prompt, en­
ter your response with six dig­
its in an HHMMSS format. HH 
equals hours, MM equals min­
utes, and SS equals seconds. 
For example, 123456 will set 
TI$ to read 12:34:56. If you en­
ter more or fewer digits, you'll 
get an ILLEGAL QUANTITY 
message. If the number is 
greater than 23:59:59, the 
clock resets to 00:00:00. 

Bug-Swatter 
The ending address of File 
Lord (May 1992) is incorrect. 
The correct address is 14CO. 
This affects MLX only and not 
the File Lord program. We pre­
pared the listing after the doc­
umentation , and it was then 
that we noticed how long the 
program was. To make it eas­
ier to type in, we compressed 
the program with Mega­
Squeeze but neglected to 
change the ending address. 

The compression program 
may have affected the way 
the program starts . If you 
type RUN and get a READY 
message, simply type RUN 
again, and File Lord should 
start. The program on Ga­
zette Disk wasn't affected. 

80-Column Word Processor 
Is there a word processor for 
the 64 that has a true 80-col­
umn screen? I am looking for 
one that's like the 128 or IBM, 
not a 40-column screen such 
as GEOS, which scrolls to re­
veal 80 columns. I am not look-

ing for one that simply has a 
preview screen either. Is 
there one that exists with this 
feature? 
JON PERSINGER 
INDIANAPOLIS. IN 

You might try Script 64, pub­
lished by Richvale Telecommu­
nications of Canada. To the 
best of my knowledge, howev­
er, that company is no longer 
in business. You might locate 
a used copy of the program 
for about $9 at Bare Bones 
Software, 940 4th Avenue, 
Suite 222, Huntington, West 
Virgin ia 25701 , (800) 638-
1123. Call or write for a free 
catalogue of used 64 and 
128 software. They also carry 
Amiga products. Supplies are 
limited, so check with the com­
pany before ordering. 

Modem Woes 
I have a 64 with an Aprotek 
12C modem used as a Volks 
6480. I would like to play mo­
dem games with a friend, but 
I need the originate and an­
swer codes that wi ll corre­
spond with my friend's Com­
modore 1670 modem. I can't 
find this information in the man­
ual. Can you supply me with 
these codes? 
MARTIN BOUTIN 
LONGUEUIL, PO 
CANADA 

Your modem, which can be 
used as a Volks 6480, is no 
longer in production, but you 
should have no problem us­
ing it to connect with your 
friend. It requires no special 
originate or answer codes or 
settings. It's Hayes compati­
ble in that it supports automat­
ic answering (ATA) and auto­
matic dialing (ATOT) com­
mands, just as your friend 's 
1670 does. You should be 
able to contact each other 
just as easily as you can con­
nect with a local BBS. 

Check the terminal or 
game software you're using 

for requirements specific to 
that program. It may require 
manual dialing or answering. 
Also check the echo or du­
plex modes to make sure you 
both can see what each of 
you is typing. If you still think 
the modem is at fault, call 
Aprotek's service department 
at (503) 582-2118 from 8:00 
a.m. to 4:30 p.m. Pacific time 
on weekdays. 

Pascal Wanted 
I am currently taking a 
course in Pascal at high 
school, using Turbo Pascal 
on a Macintosh. I have a 64 
at home, and I would like to 
use Pascal with it. Is there 
slIch a compiler and where 
can I obtain it? 
MIKE SMITH 
CRYSTAL, MN 

Contact Abacus, 5370 52nd 
Street SE, Grand Rapids, Mich­
igan; (800) 451-4319, and 
ask about Super Pascal 64 
($19.95). It implements the 
full Jensen & Wirth compiler 
plus extensions for graphics. 
It has a complete source file 
editor, a full assembler, and a 
utility package. 

MIDI Info 
I am interested in music and 
would like to get into MIDI. Is 
there a MIDI system available 
for the 64? 
EDNA WILLIAMS 
BRIDGEPORT, CT 

Contact Dr. T's Music Soft­
ware, 100 Crescent Road, 
Needham, Massachusetts 
02194; (617) 455-1454, and 
ask for its free catalog of 
MIDI hardware and software. 
Dr. T offers a 64 MIDI starter 
pack that includes its Key­
board Controlled Sequencer, 
a MIDI interface, and two 
MIDI cables for $180. A ver­
sion for the 128 retails for 
$275. You'll have to supply 
your own MIDI keyboard or 
other MIDI instrument. 0 


